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Chapter 1: Content model overview

Content model
The Avaya content model provides an organizational framework for categorizing and organizing 
Avaya product content so that it can be delivered and reused in a variety of ways.

The Avaya content model defines the types of content we develop and the structure of that 
content, and is based on the principles of topic-based authoring, information typing, structured 
authoring, content relevance, and semantic intent.

The content model includes a collection of standard information types and deliverable standards:

• Each information type represents one type of content that we create, at a topic level, and has 
a specific intent.

• Each information type is made up of a series of content elements, in a prescribed order.

• Each deliverable standard is designed to meet a specific need of one or more of our defined 
user types. The typed content topics are “mapped” into the standard outline. The standards 
are available in Compas and the supporting files are in SDL repository.

The content model is independent of any particular technology or tools. The technology and the 
tools are enablers; the content is still the focus. We can apply our model to different technologies 
and authoring tools. The content model is the foundation of what we do and sets us up for the 
future.

The goal of developing the content model is to enable us to create relevant, consistent content 
that supports our users’ goals, and supports our goals for our outputs in the future.

Metadata can also be applied to content at the element, topic, or map level. Metadata is 
information about the content, like audience, product, platform, and version. This information 
describes the context in which the content should be used. Metadata can be used during 
processing to filter content for outputs, to customize navigation, or to prepare search indexes, 
to name a few.

Related links
Publications on page 29
DITA on page 13
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Why XML
The following are the primary reasons why the Avaya Global Information Solutions (GIS) team 
moved to an XML environment:

• Separate content from presentation
• Structural integrity
• Semantic markup

Separate content from presentation
In an XML environment, the creation of the content is separated from the presentation of that 
content, which provides the following benefits:

• Writers work with greater efficiency when they no longer have responsibility for presentation.
• Common look and feel is achieved because the production system applies presentation 

styles rather than individual authors.
• Content is easier to include in multiple information products.
• Translations costs are reduced because multiple outputs are derived from the same source 

and content production is done by the production system rather than by translations vendors.
• Presentation is out of the way until it is needed.
• Vendor independence; no conversion required to move to another vendor.

Structural integrity
With XML, content has a prescribed structure to which the authors must adhere. With this, authors 
can focus more on the actual content, since the topic structure prescribes the elements that must 
be included. Structural integrity has the following additional benefits:

• Despite the change in ownership from one writer to another, document structure remains 
consistent.

• Documents across projects owned by different writers remain consistent.
• Consistent structure makes it much easier to get consistent, successful results from 

automated production tools.

Semantic markup
In XML, DTDs can express the semantics of a writing methodology through element naming and 
element content rules. This enables a shift in focus of the writing effort from presentation to the 
underlying semantics of the content. This shift in focus can enhance an author's ability to create 
content that more closely adheres to the intent of the writing methodology. Each author must 
consider the purpose of the content they're creating, which helps produce more relevant content 
and reduces the inclusion of irrelevant content.

DITA
The Darwin Information Typing Architecture (DITA) is an OASIS-standard XML framework for 
creating topic-oriented, information-typed content that is rapidly becoming the standard in the 

Why XML
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information development community. Many of the principles behind DITA are aligned with the 
authoring principles and user-focused strategy that we’re moving to for content development. DITA 
provides a standard set of DTDs that prescribe content structure, but allows customization to meet 
our specific needs (through a feature of DITA called specialization).

In DITA, a topic is the basic unit of authoring and of reuse. A topic is a unit of information with a 
title and some form of content, short enough to be specific to a single subject or answer a single 
question, but long enough to make sense on its own and written as a unit.

The following basic topic types are defined in DITA:

• Task: Describes the steps to perform a task.

• Concept: Introduces the background or overview information for tasks or reference topics.

• Reference: Describes regular features of sets of things, such as commands in a 
programming language and specifications of a hardware component.

In addition to these basic topic types, we have defined three additional information types for our 
model: Resolution, Scenario, and Structure.

Topics are mapped into deliverables using a special object type called a DITA map. A DITA map 
identifies the sequence and hierarchy (outline) of the topics in a deliverable. Different output types 
(PDF, Web content, application-embedded assistance, online help, etc.) can all be constructed 
from the same set of underlying topic content. However, there may be some topics that are unique 
to a particular deliverable type, and the organization of topics may differ to take advantage of the 
unique capabilities of each delivery mechanism.

Related links
Content model on page 12

Content relevance guidelines
The following are some tips for creating relevant content in our content model:

• Identify user goals and validate them with your users
• Keep the sentences simple that your user can read once and understand
• Trim the fat:

- Use active voice—find the true subject and verb to improve clarity
- Remove unnecessary adjectives and adverbs
- Remove redundancy
- Use one word instead of many

• Rewrite and restructure existing content as it transitions to XML to remove unnecessary 
content

Content model overview
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• Remove “glue” text:
- No transitional text between topics
- No mini TOCs at the start of components, unless required for context-sensitive help
- No stem sentences in tasks

• Eliminate unneeded introductory explanations. Write only the overviews that users need
• Do not explain what’s obvious
• Do not present the entire screen image, crop the required portion of the image
• If there are more than one way, explain the most common way
• Layer the information for different users (progressive disclosure)

Starting a new DITA project
Procedure

1. Contact the information architect to discuss about the project, including the current content 
and any requirements such as any specific requirements for context-sensitive help.

2. Determine if any use cases are available for the project. If available, use the use 
cases, any project requirements/design documents, and any recent user research to help 
determine the content that must be developed for the release.

3. Review the common patterns for deliverables and map the current project content into the 
structure at a high level.

4. Look at the common topics and reusable elements available in the /Common directory in 
the repository to see if any element can be reused in your content.

5. Start developing new topics using the appropriate topic types.

6. Begin developing maps based on initial structures you defined, and start including the 
topics you create in the maps.

7. Identify any initial candidates for reuse in the new content, including topics or elements that 
you think are good candidates for common topics or elements for multiple projects.

8. Update or create reusable element topics (project names, application names, glossary 
topics, etc.) as necessary for your project.

9. Continue to build topics, component DITA Maps, and deliverable DITA Maps.

Starting a new DITA project
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Chapter 2: Topic types

Concept topics
Concept contains information that helps a reader understand something. Conceptual information 
can define a term, describe a product or a feature, or provide other information that can help a 
reader to reach a goal. Examples of concepts include definitions of features, product descriptions, 
and so on.

Definition
Conceptual information explains ideas to a reader. Examples include:

• Functional descriptions
• Terminology
• Scenarios
• Abstractions

Purpose
Writers include conceptual information for several reasons:

• Provide supporting information for tasks
• Define terminology
• Furnish context
• Increase understanding

Role in product content
Concept topics support tasks in information domains where tasks can be concretely described. 
Concept topics assume more importance in information domains where readers must synthesize 
tasks to accomplish their goals. For example, an API guide for a product would not lend itself to 
task-oriented documentation. In this case, the content would have to furnish enough concept and 
reference information so that the reader would have enough background to synthesize tasks.

Concept types
A Description concept provides background information that users must know before they can 
successfully work with a product or interface.
A type of description concept is a process, which will be presented in an ordered list. It’s a 
concept rather than a task because, while events are taking place in a sequence, the user is 
not performing actions. For example, a series of functions that the system performs would be 
considered a process but a high-level set of steps that a user performs would be a task.
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Concept topic templates
The Concept.dita template is available in SDL repository for concept topics.

Task topics
Task contains procedural information.

Definition
Task is exactly what you think it would be. It consists of the following:

• Prerequisites
• Context
• Steps
• Results
• Post-requisites (next steps)

Purpose
Writers include task information to tell readers how to perform a task.

Role in product content
Task topics are the focal point of task-oriented content. Other information types are often used to 
support tasks. You can also use task topics to present scenarios that include steps.

Task types

Standard 
task

The Standard task provides the information a user needs to perform a procedure 
that requires more than one step. At a minimum, a Standard task must include 
all steps the user must perform and the correct order of those steps. A Standard 
task can also provide:
• Notes and other useful details
• Expected results of the procedure
• Any prerequisites or postrequisites

Graphical 
task

A Graphical task is a series of steps that are expressed in a graphical format. At a 
minimum, a Graphical task must include a single step that includes the image file 
that depicts the steps the user must perform. A Graphical task can also provide:
• Notes and other useful details
• Expected results of the procedure
• Any prerequisites or postrequisites

Task topic templates
The following templates are available in SDL repository for the Task topic types:
Standard task: A template named Task.dita is available for standard task topics.

Task topics

July 2024 DITA and TDocs Work Instructions and Guidelines 17
Comments on this document? 

18

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Graphical task: A template named GraphicalTask.dita is available for tasks that are a graphical 
representation of a task.
Scenario task: A template named ScenarioTask.dita is available for tasks that depict a scenario.

Reference topics
Reference contains factual information that readers need to look up. This data or facts can be 
necessary to understand a concept or perform a task correctly.

Definition
Reference information contains facts, specifications, or data that readers might want to access. 
Examples include:

• API descriptions
• Command syntax
• Specifications
• Requirements
• Performance data
• Database schema definitions

Purpose
Writers include reference information to:

• Provide supporting information for tasks
• Make facts available

Role in product content
Reference topics support tasks in information domains where tasks can be concretely described. 
Reference topics gain more importance in information domains that do not lend themselves to 
task-oriented content.

Reference types

Requirements The Requirements type provides values for required elements, such as 
required hardware, software, and tools.

Specifications The Specifications type provides values for hardware-related elements of a 
system that includes the following:
• dimensions, such as height and weight
• environmental, such as temperature and density
• capacities, such as memory and bandwidth
• system or components, such as power, jumper settings, and pinouts

Topic types
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Command 
Reference

The Command Reference provides a list of system commands and can 
include command names, descriptions, variables, and examples. Sections 
of this information can be used in other topics.

Worksheet The worksheets type includes information the user must gather and record 
or lists of tasks that the user must complete in sequence.

General 
reference

The General Reference type includes lists and tables of reference 
information that does not fit into one of the other defined reference types. 
An example of a general reference is a related documents list.

API The API type provides API information and can include description, syntax, 
example, and usage.

Reference topic templates
The following templates are available to create reference type topics:

Topic type Template name
Requirements Requirements
Specifications Specifications
Command Reference Command
Worksheet Checklist

Worksheet — simple table, use for worksheets with 
a simple structure
Worksheet — complex table, use for worksheets 
that require a more complex structure.

General reference Reference
API API name

In addition to the standard templates, you can also use the specific reference-type templates: 
Documentation, Document titles, and Prerequisites.

Structure topics
Structure contains information describes the parts that make up a collection.

Definition
Structure information describes the constituent parts of a collection or assembly, such as

• Part descriptions for any assembly
• Field descriptions for a user interface screen

Structure topics
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Note:
For field descriptions that are very complicated and require additional structure, such as 
tables within a field description, you can use a separate concept topic for each field and then 
aggregate the topics together in the map.

Purpose
Writers include structure information to quickly describe the function or purpose of each part in a 
collection.

Role in product content
Structure topics support tasks in information domains where tasks can be concretely described. 
Structure topics gain more importance in information domains that do not lend themselves to 
task-oriented content.
This information is also an Avaya specialization. Before deciding to do that, we tried to classify this 
sort of information as either concept or reference. We found that equally convincing arguments 
could be given for either choice. At that point, we decided that the information was really its own 
type, so we created a specialization for it.

Structure topic template
The following templates are available to create the Structure type topic:
Structure:  Use the Structure template for standard structure topics.
Graphical structure:  Use the Graphical Structure template for structure topics that describe the 
components in a container depicted graphically, such as the back view of a server. A callout table 
is included in the template.

Scenario topics
A Scenario type is a topic-length example that helps a user to understand a concept or a task.

Definition
A scenario can include both text and graphics, and can also include an example task. A scenario 
can be a concept or a task, depending on the type of information being included in the scenario.

Purpose
Writers include scenarios to provide a long example to help users understand a concept or how to 
perform a task.

Scenario topic templates
The following templates are available to create Scenario type topics:
Concept scenario:  Use the Scenario Concept template for scenario topics that provide a 
conceptual-based illustration of a scenario.
Task scenario:  Use the Scenario Task template for scenario topics that provide a task-based 
illustration of a scenario.

Topic types
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Resolution topics
Resolution contains information about system state and corrective actions.

Definition
Resolution includes information and corrective actions for:

• Alarms
• Errors
• Events
• Troubleshooting

This topic type is based on the troubleshooting topic model in DITA.

Purpose
Writers include resolution information for these reasons:

• Describe a system state that may occur
• Present procedures for resolving problems when the system is in an undesirable state

Resolution topic templates
The following templates are available to create the resolution type topics:
Alarm, event, error:  Use the Event alarm error template.
Troubleshooting:  Use the Troubleshooting template.

Related links
Creating troubleshooting, alarm, event, and error topics on page 77

Glossary topic
The Glossary topic type provides a term and its definition.

Glossary topic templates
Use the Glossary template to create a glossary term.

Resolution topics

July 2024 DITA and TDocs Work Instructions and Guidelines 21
Comments on this document? 

22

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Chapter 3: Working with the repository

Browsing the repository

Browsing the repository from Publication Manager
About this task
Use the Browse Repository window to create a topic or map, check out a topic, view properties for 
a topic, map, or image, import an image, and other tasks.

Before you begin
Start Publication Manager.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the navigation pane, select the folder that you want to browse.

The contents of the folder are displayed in the right pane.

Browsing the repository from Oxygen XML Author
Before you begin
Start Oxygen XML Author.

About this task
Use the Browse Repository window to create a topic or map, check out a topic, view properties for 
a topic, map, or image, import an image, and other tasks.

Procedure
1. In Oxygen XML Author, click SDL Tridion Docs > Browse Repository.

The page displays the Browse Repository window.

2. In the navigation pane, select the folder that you want to browse.

The contents of the folder are displayed in the right pane.
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Previewing an object in the repository
You can preview topics, maps, or graphics in the repository. Previewing is really helpful to look for 
content to reuse and you do not have permissions to check it out or you want to use a graphic and 
the names are not descriptive.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the navigation pane, select the folder that contains the topic, map, or graphic to preview.

The contents of the folder display in the right pane.

3. To view a preview of an object, click the object, and then click Views > Preview in the tool 
bar.

To close the preview, click Views > List in the tool bar.

Folders
Content in the SDL Tridion Docs repository is stored in folders. When creating a folder, you define 
the type of content that the folder can contain. Tridion Docs does not use the file name or location 
of an object for addressing or linking. Therefore, folders are created for organizing, storing, and 
locating objects.

Tridion Docs assigns each object a unique ID (GUID). Therefore, you can move or rename objects 
or folders to different locations without breaking links or references.

Content folders contain objects, such as DITA maps, DITA topics, reuse files, folders, or images. 
When you create a folder, you must specify the type of object to be stored in the folder. The folder 
and the subfolders can contain objects only of the specified type.

The types are:

• Image: Illustrations or photographs

• Map: DITA maps that include, Bookmap, maps, and Avaya-specified maps

• Topic: DITA topics

• Publications

• Other (Word, PDF, ...): Non-XML documents, such as Microsoft Word, Excel, PDF, 
PowerPoint files, and Zip files.

• Library topic: Currently the Library topic folder type is not in use.

If you need a new project folder in the repository, create a request on the Infosolutions project. 
There are additional steps required when adding a new project in Tridion Docs. After the project 
folder is created, you can create subfolders for each deliverable and common content.

Previewing an object in the repository
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Information to create a new project in Tridion Docs
To request for a new project folder in Tridion Docs, you need to create a ticket on Infosolutions 
project with the following information:

• Product name: To set this metadata when you create topics and maps for this project.

• User group: To set the permissions to the project folder.

• Project name. Project name

• Parent folder: To set a parent folder for the new project folder if the new project does not 
belong to the existing high-level solution or product family folder. You must check with GIS 
Program Manager or Program Owner of the project, and let Information Architect know.

• Permissions: Get writer permissions to the new project.

• Product name that must be added in the Product names topic.

• Localization: Inform the localization coordinator to add the new user group to the ServiceUser 
user.

Add the localization coordinator to the ticket.

• Conditions.

• Product name and release number, if the documents need to be published on Avaya 
Documentation Center.

Creating a new folder from Browse Repository
About this task
You can also create a new folder from the web client.

Before you begin
Ensure that you have write permission to the parent folder.
Submit an issue on the Infosolutions project.

Procedure
1. Right-click the folder under which you want to create the new folder and select New > 

Folder.
2. In the Add Folder dialog box, type the folder name and set the type of content that the 

folder should contain.

To create a folder for one deliverable, for example deploying, set the content type as 
None. Within the deliverable folder, you can create the following subfolders, and set the 
appropriate content type for each subfolder:

• Images

• Maps

• Publications

Working with the repository
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• Topics

3. On the Security tab, in the Owner field, select the correct user group that is appropriate for 
the project.

Important:

All indicates that anyone with RWS account can access your project folder and modify 
the content. This could be a major concern.

4. Click OK.

Related links
Importing images on page 259

Moving objects across folders in Browse Repository
About this task
Use this procedure to move a map, topic, or graphic from one folder to another.
Note that the movement of the object does not impact the references that made to this object.

Before you begin
• You require write permissions to the source and destination folders.

You might not have write permissions to most high-level folders.
• If you do not have permissions to the destination folder, submit an issue to the Infosolutions 

project with a request to move the objects to the destination folder.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the navigation pane, select the folder that has the object you want to move.

3. In the right pane, select one or more objects that you want to move, and do one of the 
following:

• Do the following:

a. Right-click and select Move to folder.
b. On the Move Object dialog box, browse to the destination folder to which you want 

to move the objects.

c. Click Move.

• Drag and drop the objects in the destination folder.

Moving objects across folders in Browse Repository
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Moving folder from one location to another
About this task
You can move a folder from one location to another in the repository.
Note that the permissions set to the folder might impact the access to the folder.

Before you begin
• You require write permissions to the source and destination folders.

You might not have write permissions to most high-level folders.
• If you do not have permissions to the destination folder, submit an issue to the Infosolutions 

project with a request to move the objects to the destination folder.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the left navigation pane, select the folder that you want to move.

3. At the top of the navigation pane, click the Move folder icon ( ).

4. In Move folder, browse to the folder to which you want to move the folder.

5. Click Move.

The folder is now available in the new location.

Logging on to the Tridion Docs web interface
About this task
Tridion Docs supports Internet Explorer 11, and latest versions of Google Chrome and Mozilla 
Firefox.

Procedure
1. On the web browser, type https://avaya001.sdlproducts.com/ISHCM.

2. Type your SDL username and password, and then click Login.

Working with the repository
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Viewing checkin history for an object
About this task
Every time you check in a topic, map, or image, Tridion Docs creates a new revision. This helps in 
tracking changes made in every checkin. You can use the revision to identify when the error has 
occurred, and resolve the issue or roll back to the previous revision.
You can view the changes made in a topic, map, or image in each revision of a version, which is 
checkout and checkin. This feature helps in identifying any error that must have crept in and roll 
back to previous revision.

Procedure
1. Log in to the web interface.

2. Browse to and select the folder where the object, that is a topic or map, is located.

The objects in the folder are displayed in the right pane.

3. Select the check box for the object.

Versions of the object display in the lower pane.

4. Scroll the list of versions to the far right, and select the version that you want to view.

You must select a version, even if only one version exists. Do not select the check box at 
the far left. You cannot perform the next step if the check box on the far left is selected.

5. Click Show History.

A new window opens and displays the history of the object.

6. Click Show/Hide Revision to view all versions.

This button toggles the display between all checkins and only first and last checkin.

7. Click Preview to compare between revisions.

Changing your SDL account password
About this task
Do not change your password in the Tridion Docs web interface because you will be required to 
reenter it when you try to perform an action in Publication Manager.

Procedure
1. On the Publication Manager menu bar, click Tools > Account.
2. In the Accounts dialog box, select your account and then click Change Password on the 

toolbar.

The Change Password dialog box is displayed.

Viewing checkin history for an object
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3. In Old Password, type your current password.

4. In New password, type a new password.

5. In Confirm password, retype the new password.

6. Click OK.

Importing non-DITA files to Tridion Docs
About this task
You can import non-DITA files to the Tridion Docs repository to reference in an HTML output or to 
store for safekeeping. Do not import a lot of non-DITA files into Tridion Docs repository that are not 
intended to be used in HTML outputs.

Before you begin
Create a folder with the Content type set to Other (Word, PDF, ..) if you don not already have 
one. The folder name can be anything, usually, we provide the name Template.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

2. In the navigation pane, browse to and select the folder to which you want to upload the file.

3. On the toolbar of the right pane, click the import icon, which is second to the left .

4. On the Import File dialog box, browse and select the file to import, and then click Open.

You can select multiple files to import simultaneously from a directory. The file types must 
be word, PDF, excel, zip that the Other (Word, PDF, ..) category supports.

The file is imported to the Tridion Docs repository.

5. Add a title in the repository to a descriptive name rather than the filename:

a. Right-click the file and select Properties.

b. On the Properties dialog box, modify the value in Title.

c. Click OK.

Related links
Adding a non-DITA file to a map on page 51

You can reference a non-DITA files, such as PDF and Excel in a map.

Working with the repository
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Chapter 4: Working with publications

Publications
In Tridion Docs, you can manage your deliverables by using publications.

Publications control the following factors:

• Versions of referenced objects (topics, DITA maps, and images) that are included. The list of 
referenced objects is called the baseline of the publication.

• Values of variables

• Values of conditions that are included or excluded

• Output format

Each publication references a single DITA map or book map that serves as the deliverable map. 
The deliverable map can reference as many topics and DITA maps as are needed.

Publication lifecycle
Publications can have multiple versions. When a version is released, no additional changes can 
be made to it or any of its content. Releasing a publication ensures that the output can always 
be reproduced exactly. Before a publication can be released, all objects within it must be in the 
Release state.
Once all of the content is released, you can freeze the baseline. This means that you cannot 
change the content. However, you can change condition settings and output formats. When output 
formats generate correctly, you can release the publication. After a publication is released, no 
changes can be made to that version of the publication.
The sequence of steps in the lifecycle of a publication are:

1. Move the status of all publication components (topics, images, and so on) to Release.
2. Freeze the baseline.
3. Adjust condition settings, output formats.
4. Release the publication.

You cannot make any changes to the frozen version of the publication. To make changes, 
you must create a new version of the publication.
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Starting Publication Manager
Procedure
From the Start menu, click SDL Tridion Docs > Publication Manager 14.0.

Opening a publication
Procedure

1. On the Publication Manager menu bar, click Publication > Open.

2. In the Open Publication dialog box, browse to and select the folder where the publication is 
located.

The publications in the folder are displayed in the right pane of the dialog box.

3. To view the latest version of a publication, select the publication, and then click Open.

The publication can take a few minutes to open, depending on the size. The system 
displays the progress. Make sure that you allow the publication to fully open before trying 
to view other tabs, like the Baseline or Output tabs. If you go to them before the publication 
is fully open, they’ll appear as blank.

4. To open a specific version of a publication:

a. Click the Versions button.
b. Select the version you want to open.
c. Click OK.
d. Click Open.

5. To view specific version of a publication:

a. Select the publication, and then click Versions.
b. In the Select Version dialog box, select the version that you want to open, and then 

click OK.
c. In the Open Publication dialog box, click Open.

Creating a publication

Creating a new publication
About this task
Create a new publication when you are creating a brand new deliverable. If you are updating an 
existing deliverable, create a new version of the existing publication.
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Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the navigation pane, select the folder where you want the publication saved.

Publications must be saved in a folder that is named Publications and has the Content 
type set to Publications.

3. On the toolbar of the right pane, click .

The system displays the Select Template dialog box.

4. Click Empty Publication, and then click Next.
5. Complete the fields on each tab as appropriate.

6. Click OK.

Related links
Publication properties on page 32

Creating a new version of a publication
About this task
Create a new version of a publication when you want to modify the publication after it has been 
released. The new version is a copy of the old version.

Important:
If you create a new version of a publication from a released version of the publication, all 
content in the new version is in a released state. You must create new versions of the objects 
that you want to edit. Also, if you publish the output immediately after creating a new version 
of a publication, you’ll notice that the Status is Release Candidate. This is because all of the 
objects are in the Released state. After you create a new version of any of the objects in the 
publication, the status changes to Draft the next time you publish it.

Procedure
1. On the Publication Manager menu bar, click Publication > Open.

2. In the Open Publication dialog box, browse to and select the folder where the publication is 
located.

The publications in the folder are displayed in the right pane of the dialog box.

3. Select the publication for which you are creating a new version, and then click Versions at 
the bottom-left of the page.

The Select Version dialog box is displayed.

4. Right-click the version from which to create a new version, and then click New Version.

A new version is displayed in the Select Version dialog box.
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5. Click OK.

6. Modify the properties of the new publication version if necessary.

Related links
Using Publication Manager to create a new version or branch on page 239

Saving a publication as a new publication
About this task
You can save a publication as a new publication to create a variant of the original publication. You 
might want to create a variant to change an aspect of the original publication such as a condition. 
Do not save a publication as a new publication just to make updates or work on the next release of 
the product. In those cases, you should create a new version of the existing publication.
The publication is saved as a new publication in the repository. Note what is copied to the new 
publication:

• The reference to the deliverable map is copied; however, the deliverable map is not copied.
• The content of the original baseline is copied into a new baseline.
• The conditions selected to include in the output.
• The publication output formats are the same as the original, and the status changes to To be 

Published.

Procedure
1. In Publication Manager, open the publication to use as the basis for the new publication.

2. On the toolbar, click Publication > Save As.

If you have made changes, the system prompts you to save the changes.

3. Click Yes to save changes if prompted.

4. In the Select Target Folder dialog box, select the folder in the repository to put the copy of 
the publication. Then click Next.

5. In the Add Publication dialog box, enter the necessary metadata, and then click OK.

Related links
Publication properties on page 32
Opening a publication on page 30

Publication properties
These properties are displayed in the New Publication dialog box and in the Properties dialog box 
for a publication.
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General tab

Name Description
Title Title for the publication. The title can contain 

alphanumeric characters, spaces, hyphens, and 
underscores. Do not use slashes, asterisks, or other 
special characters. This is a required field.

Example: Administering Communication 
Manager 8.

The title appears as the filename of the 
output, additionally, the publication version, 
language, and output format is appended. For 
example, Administering Communication Manager 
8.0=3=Avaya Book=en-us. The maximum number 
of characters in an output filename is 116 
characters. Out of which, 9 characters are used 
for the version number, language, and separators. 
The length of the output format name can vary, with 
the maximum being 30 for the “Avaya 3–column 
Quick Reference”. The remaining characters are 
used for the publication title. If the title is long 
and if there are no enough remaining characters, 
the complete publication title is not included in 
the output filename. You can rename the output 
filename after you download it, or you can shorten 
the name that fits within the supported characters.

Table continues…
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Name Description
Publication Type The type of publication. This is a required field. The 

options are:

• Administering

• Article

• Article for Administrator

• Deploying

• Documentation Library

• Feature Description

• Feature Pack Description

• Getting Started

• Glossary

• Help System

• Job Aid

• Maintaining

• Overview and Specification

• Quick Reference

• Reference Configuration

• Release Notes

• Snap-in Reference

• Solution Description

• Troubleshooting

• Upgrading

• Using

• Videos

• What's New
Description A description of the publication. This field can 

contain any text and is optional.
Requested languages For localization only.

Version tab

Name Description
Version Version of the publication. This field is auto-

populated and cannot be modified.

Table continues…
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Name Description
Changes A description of changes in this publication. This 

field can contain any text and is mandatory for 
new versions and branches. The description must 
contain the reason for creating this version. For 
example, For 8.0 updates, Localization updates, 
and SMGR-12345 updates.

Working language en-us
Working resolution Low

Avaya-specific fields tab

Name Description
Created Date Date on which you create the publication. This field 

is required.

Do not modify Created Date, instead provide or 
modify the Revised Date to specify the publication 
updated date.

This date appears in the following locations:

• The cover page of the book in the month year 
format. For example, November 2020

• Copyright year in the legal page

• Footer

Important:

Do not enter the first or last day of a month 
in the date. The first or last day of the month 
might display incorrect month on the front 
cover of the book due to time zone differences.

Release Number Product release number for which you created this 
version of the publication. This number appears on 
the front cover of the book with the text “Release” 
prepended.

However, if you type “Release 8.0”, you still see 
Release 8.0 in the output because Tridion Docs 
removes the text “Release” from the field.

The text you include after the number continues to 
display on the front cover of the book.

Table continues…
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Name Description
Revised Date The date of a new release of the publication.

The date in this field takes precedence over the 
date in Created Date and appears on the front 
cover of the book.

The Created Date and Revised Date fields are 
used to automatically generate a copyright range in 
the legal page and in the footer of the output. See 
“Specifying a copyright range for an output”.

You can use the Revised Date to specify that the 
date on the cover must automatically reflect the 
publish date. See “Setting the date of your outputs 
to the current date”.

Important:

Do not enter the first or last day of a month 
in the date. The first or last day of the month 
might display incorrect month on the front 
cover of the book due to time zone differences.

Issue number The issue number of the publication.

This number is displayed on the front cover of the 
book with the text “Issue” prepended. This field is 
optional.

However, if you type “Issue 2.0”, the output displays 
“Issue 2” in the PDF output because Tridion Docs 
removes the text “Issue”, decimal, and any number 
after the decimal.

The text you include after the number continues to 
display on the front cover of the book.

For draft outputs you can use issue numbers such 
as 1.0.5.

Book number The book number for the publication. This number 
appears on the cover of the book. This field is 
optional.

Related links
Creating a new publication on page 30
Viewing or changing the properties of a publication on page 37
Saving a publication as a new publication on page 32
Specifying a copyright range for an output on page 127
Setting the date of your outputs to the current date on page 128
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Viewing or changing the properties of a publication
About this task
You can change the title, publication type, description, baseline, or add comments to an existing 
publication.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the Browse Repository dialog box, browse to and select the folder where the publication 
is located.

The publications in the folder are displayed in the right pane of the dialog box.

3. To view the properties of the most current version of the publication:

a. Right-click the publication, and then click Properties. Alternately, you can click  on 
the toolbar.

b. (Optional) Change or add properties.

c. Click OK.

4. To view the properties of a version other than the most current:

a. Select the publication for which you are viewing or changing properties, and then click 
Versions at the bottom of the right pane.

The Select Version dialog box is displayed.

b. Right-click a version, and then click Properties. Alternately, you can click the 
Properties icon in the toolbar.

c. (Optional) Change or add properties.

d. Click OK.

Related links
Publication properties on page 32

Copying objects from one publication to another
About this task
You can copy a part, chapter, or other object in one publication and paste the object in another 
publication. But if you want to include the same chapter or part in another publication, the 
preferred method is to just add the chapter or part directly to the other publication.
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Procedure
1. In Publication Manager, open the publication from which you want to copy.

2. In the publication tree, right-click the object to copy, and then click Copy. This can be an 
entire part, an entire chapter, or a link to another object.

3. Open the publication to which you want to copy.

4. Check out the map into which you want to paste the copied item.

5. In the publication tree, right-click the desired location in the map.

6. On the menu bar, click Edit > Paste Special.
7. In the Paste Special dialog box, select Structure and baseline information and click OK.

Saving a publication
About this task
When you finish modifying a publication, you must save to update the repository with changes.
Use this procedure to save a publication that is currently opened and displayed in the Publication 
Manager.
All changes you have made to the publication are saved to the repository: changes to all maps, 
selected version of topics and graphics, metadata updates, and so on.

Procedure
1. On the Publication Manager toolbar, click Publication > Save.

If any objects in the publication are checked out, you are prompted to save them and 
check them in.

2. (Optional) If you are prompted to save and check in objects that are checked out, select 
Apply to all to suppress individual prompts to save and check in.

Any checked out objects are automatically saved and checked in.

Closing a publication
Procedure

1. On the Publication Manager toolbar, click Publication > Close.

If objects in the publication are checked out, you are prompted to check them in. If the 
publication has changed, you are prompted to save it.
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2. If prompted to check in an object:

a. Select an option: Check in current object, Undo checkout, or Make available in 
local storage.

b. To apply your selection to all objects that are checked out and suppress additional 
prompts, select Apply To All.

c. Click OK.

3. If prompted to save the publication, click:

• Save to save and close the publication.

• Don't Save to close the publication without saving the changes.

• Cancel to leave the publication open without saving changes.

Capturing the word count for a document
You can use the Tridion Docs workflow report to capture the word count for a document. This is 
useful if your content is translated and you need to provide an estimate to Localization.

Note:

The word count from the workflow report is based on the publication baseline. The baseline 
includes all objects referenced in the publication, such as topics you reuse from and content 
that might be excluded from the output using conditions. So the word count based on the 
baseline can include more words than what’s in the output. This is the appropriate word count 
to provide to Localization.

Before you begin
A publication must exist for the document.

Procedure
1. Generate a workflow report for the publication.

2. Export the Details section of the report:

a. Click Download Statistics Report in the toolbar.

b. Click Save in the File Download dialog box.

c. Browse to and select a location to save the report, and then click Save.

Note:

Do not click Send and Export or Export in the toolbar. These buttons export the 
publication, not the report.

The report is exported as a .csv file. This file does not include the Statistics section of the 
report.
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3. Open the statistics report you downloaded.

4. Select the Word Count column and sum the entries to capture the total word count.

Related links
Generating a workflow report on page 217

Capturing the file count in a publication
You can use the Tridion Docs workflow report to find the number of topics, maps, and images in a 
publication. You might need this information to plan for activities, such as review and conversion.

Note:

The file count from the workflow report is based on the publication baseline. The baseline 
includes all objects referenced in the publication, such as topics that you reuse from and 
content that might be excluded from the output using conditions. So the files in the baseline 
can include more objects than that available in the output.

Procedure
1. Log in to the Tridion Docs web interface.

2. Click the Repository tab.

3. Navigate to the folder that contains the publication for which you want to generate a 
workflow report.

The page displays the contents of the folder in the right pane.

4. Click the title of the publication for which you want to generate the report.

When you only select the box next to the title, the page does not display the details of the 
publication.

The page displays versions in the lower right pane.

5. Select the check box next to the publication version for which you want to generate the 
report, and then click Workflow in the toolbar of the lower right pane.

The page displays a Workflow management window.

6. In the Workflow management window, click use baseline information only, and click OK.

A new window opens and the reports begins to display. A message displays to confirm if 
you want to load the details section of the report, as it can take several minutes to display 
depending on the number of objects in the publication.
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7. Click Cancel.
8. To export the Details section of the workflow report:

a. Click Download Statistics Report in the toolbar.

b. Click Save in the File Download dialog box.

c. Browse to and select a location to save the report, and then click Save.

Note:

Do not click Send and Export or Export in the toolbar. These buttons export the 
publication, and not the report.

The report is exported as a .csv file. This file does not include the Statistics section of the 
report.

9. Open the statistics report you downloaded.

The row count gives the number of objects in the publication. The objects include the 
topics, maps, and images.

10. To find the topic count in the publication, do the following:

a. Open the .csv file in Microsoft Excel.

b. To sort by topics, click Data > Filter, and in the Type column, select ISHModule.

c. Take the count of the topics in the Title column.

Note:

Ensure that you account the following topics only once:

• Topics common to all programs: For example, Product names, Application 
names, Snap-in names, Variables, Languages

• Topics common to specific project: For example, common steps, common 
terms, common uicontrol elements, common wintitle elements, documentation 
titles, legal page.

• Topics reused from other projects: For example, common steps, common 
terms, common uicontrol elements, common wintitle elements.
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July 2024 DITA and TDocs Work Instructions and Guidelines 41
Comments on this document? 

42

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


d. To find the topic count in all documents of a product, do the following:

a. Open the .csv file of the first document in Microsoft Excel, example, POS.

b. Open the .csv file of the second document, copy all rows except the header 
row, and paste the rows in the first Excel sheet below the existing data. Similarly, 
copy the rows from remaining csv files of documents for the product into the first 
Excel file.

You now have all the data from all documents in the product.

c. Press Ctrl+A to select all the data and click Data, in the Data Tools group, click 
Remove Duplicates icon ( .

d. In the Remove Duplicates dialog box, click Unselect All, and select the GUID 
check box, and click OK.

e. To sort the data by topics, click Data > Filter, and in the Type column, select 
ISHModule.

The message in the footer displays <num1> of <num2> records found. 
Where, num1 is the topic count in all publications of the product. For example, in 
340 of 420 records found, 340 is the total topic count.
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Chapter 5: Creating and modifying DITA 
maps

Content components
A component of information is “the largest group of topics that won't ever be split apart as a 
result of remarketing, repackaging, technological componentization, user tasks, or scenarios” (as 
defined by IBM).

Our practice is to create a component for each chapter (a chapter map). If you have a complicated 
deliverable, you can create component maps within a chapter. Then the chapter map will 
reference the component maps. You can have a mix of component maps and individual topics 
in a chapter map.

DITA Maps and BookMaps
DITA Maps and BookMaps are special types of DITA topics that define the organization, order, 
hierarchy, and linking of topics in a deliverable. Maps provide the context for DITA topics.

DITA Maps and BookMaps provide only pointers to topics, the topics are not embedded inside the 
maps. This allows the same topic to appear in different deliverables.

DITA Maps and BookMaps have specific uses:

• Use the DITA Maps to create component maps. Component maps can be at the chapter level 
or at lower levels if you have a complicated chapter. Create a map to contain topics at the 
chapter level.

• Use the BookMap for deliverable maps. DITA Maps is used to produce PDF, HTML, and .chm 
and other customized outputs. You will nest component DITA Maps in a Bookmap. However, 
you cannot nest BookMaps in a BookMap.

You must create only one BookMap for a publication.

You can also select a template BookMap appropriate for the document that you plan to 
create. For example, Administering and Deploying.

A DITA Map and BookMap typically contains two parts:

• The top part of the map defines the order and hierarchy of the topics in the deliverable.
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• The bottom part contains the relationship table. A relationship table defines the linking 
between the topics.

Deliverable map
A publication has only one deliverable map. Use only book map as a deliverable map for the 
publication. The structure (hierarchy) of the references determines the structure of the publication.
You can also select a template BookMap appropriate for the document that you plan to create. For 
example, Administering and Deploying.

Creating a map
About this task
A video about creating and editing maps in Tridion Docs is available at Basics of creating a 
document.

Before you begin
Save maps in the Maps folder, and set the Content type to Map.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the navigation pane, browse to and select the folder where you want the map saved.

3. On the toolbar of the right pane, click .

The system displays the Select Template dialog box.

4. Click Bookmap, Map or any bookmap template, for example, Deploying, and then click 
Next.

The system displays the Add Object dialog box.

5. Complete the fields on each tab as appropriate.

6. Click OK.

Related links
Map properties on page 45

Creating and modifying DITA maps

July 2024 DITA and TDocs Work Instructions and Guidelines 44
Comments on this document? 

45

https://cdn.avaya-learning.com//CDN_CT/DITA_DocTrn/sav/index.html?id=d568580c19b077b8bb9ea7dd738df368
https://cdn.avaya-learning.com//CDN_CT/DITA_DocTrn/sav/index.html?id=d568580c19b077b8bb9ea7dd738df368
https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Map properties
These properties are displayed in the Add Object dialog box and in the Properties dialog box for a 
map.

General tab

Name Description
Title Title for the map. The title can contain alphanumeric 

characters, spaces, hyphens, and underscores. 
Do not use slashes, asterisks, or other special 
characters. This is a required field.

Example: Managing users
Content type Map or Bookmap. Auto-populated based on your 

selection when you created the map.
Description A description of the map. This field can contain any 

text and is optional.
Enable translation management For localization only.
Requested languages For localization only.

Version tab

Name Description
Version Version of the map. This field is auto-populated and 

cannot be modified.
Changes A description of changes in this map. This field 

is relevant if the map is a new version of an 
existing map. This field can contain any text and 
is mandatory for new versions and branches.

Candidate for baseline This is a blank field.
Baseline label This field lists the frozen baselines that use this 

topic. This field is automatically populated.

Workflow tab

Name Description
Language The language of the object. This field is 

automatically populated

Table continues…
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Name Description
Status Workflow status. Options are:

• Draft

• Editorial review

• Pre-release validation

• Technical review

• Released

You can move an object to the Released state only 
when the object is in the Pre-release Validation 
state.

Author Owner of the map.
Last modified by The last person who modified the topic. Auto-

populated.
Source language This field is blank.
Comments Comments about the workflow. This field can 

contain any text and is optional.

Avaya-specific fields tab

Name Description
Product Family Product category/family that the Product belongs to.

This is a required field.
Product Product that this topic supports.

This is a required field.
Component Product components will be set up by the system 

administrator on a case by case basis. Talk to 
the system administrator if you think a product 
component is appropriate for your product.

Contributor This field is not currently used.
Doc Lead The user who has responsibility for this content 

and can move the object to the Released state in 
workflow. This a required field.

Localization Coordinator For localization team only.

Table continues…
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Name Description
Reviewer You can optionally specify another Tridion Docs 

user as a reviewer for an object. This is useful when 
content is in the editorial review phase in workflow 
and you want the object to appear in the inbox of 
the selected user.

The user that you want to select in the Reviewer 
field must be assigned the role of Reviewer in 
Tridion Docs. Open a ticket on the Infosolutions 
project to add the Reviewer role for the user if the 
name is not available for selection.

Related links
Creating a map on page 44

Important information about copying elements
If you copy elements, such as steps, numbered lines or bulleted lines and paste them within the 
same topic, you need to change or remove the ID of the element when you paste it. When you 
copy an element, the ID is copied also. And unless you change the ID, duplicate IDs will exist 
when you paste the copy.

If you attempt to reuse an element that has a duplicate ID with the same topic, errors might occur. 
For example, the conref might display text from the incorrect element. Duplicate IDs within the 
same topic is invalid XML and might produce various types of errors.

Important:

When you copy a topic, the topic is assigned a new ID but the elements will have the same 
IDs as in the original topic. However, this will not cause any issues because the topic ID is 
always included in the references. Therefore, all references are unique.

If you are copying an element, pasting it, and not modifying the text, set up a conref rather than 
copy. If you are copying an element, pasting it, and modifying the text, be sure that you change 
the ID of the pasted element.

Related links
Copying a topic or map on page 48
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Copying a topic or map
About this task
You generally use the Duplicate option to create a copy of a topic or map. You can use this 
alternate option to copy a map or topic to another folder or to the same folder, but very rarely use. 
You can copy a topic or map and modify it to create a variant of the existing object.
Do not copy a topic or map:

• If you can use the Duplicate option.
• If the topic or map that you need to create is identical to the existing object. You must reuse 

the original object.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the navigation pane, browse to and select the folder where the map or topic is saved.

3. In the right pane, right-click the object, and select Check Out.

The topic or map opens in Oxygen XML Author.

4. On the Oxygen XML Author menu, click SDLTridionDocs > Check in as.

5. In the Select Target Folder dialog box, browse to and select the folder to which you want to 
copy the object, and then click Next.

Save maps in the Maps folder, and set the Content type to Map.

Topics must be created in a folder named Topics and has the Content type set to Topic.

6. In the Add Object dialog box, , and then click OK.

a. Enter a title for the new object, change other properties as appropriate.

b. To edit the content, select the Immediately check out the object check box.

If you skip this step, the new object opens in read-only view. You can check out using 
SDLTridionDocs > Check out .

c. Click OK.

7. If the topic contains a base attribute, remove or modify the value:

a. Check out the topic.

b. Place the cursor in the base attribute at the beginning of the topic.

c. In the Attributes window, remove or change the value in the base field.

You can include only alphanumeric characters, spaces, hyphens, and underscores. 
Do not use characters, like slashes, asterisks, periods, parenthesis, or other special 
characters. The maximum length is 100 characters including spaces.

d. Check in the topic.
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Important:

If a publication contains objects with duplicate values in the base field, represented by 
the Override Output File Name field in the Avaya-specific fields tab, the publication 
fails.

Related links
Important information about copying elements on page 47
Creating a copy of an existing topic on page 73

Creating a copy of a map
About this task
Make a copy of a map only if you want to model the structure.

Before you begin
Create a Maps folder within your content folder, if it does not already exist.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the navigation pane, browse to the folder, and select the maps folder and the map that 
you want to copy.

3. Do one of the following:

• On the toolbar of the right pane, click 

• Right-click, and click Duplicate .

4. Change the title of the map.

5. Complete the fields on each tab as appropriate.

6. Click OK.

Adding objects to a map

Adding a topic or map to a map
About this task
Use this procedure to add topics or component maps to a DITA map.
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Procedure
1. Open the publication in Publication Manager.

2. Expand the map to which you want to add the topic or map.

The map is checked out automatically when you expand it.

3. To add an object before an existing object, right-click the existing object, and then click 
Insert before.

4. To add an object as a child of an existing topic, right-click the parent topic, and then click 
Add within.

5. In the Insert Values dialog box, click Browse and browse to the folder where the object is 
located.

The objects are displayed in the right pane.

6. Select the object that you want to add, and then click Insert.

Tip:

Alternatively, you can drag the object and drop a topic where you want to insert in the 
map. For maps, use the browse method so that the name displays in the publication 
structure. Do not add bookmaps to other bookmaps.

7. Enter data for other attributes in the Insert Values dialog box if appropriate, and then click 
OK.

8. Check in the map when you finish editing it.

Related links
Suppressing linking to nested topics on page 173
Opening a publication on page 30
Checking in a map on page 64

Adding multiple topics to a map
You can add multiple topics to a map at the same time.

Procedure
1. Open the publication in Publication Manager.

2. Expand the map to where you want to add the topics.

3. Open the Browse Repository window if it’s not already open and position it so you can also 
see the map in Publication Manager.

4. In the Browse Repository window, do one of the following:

• To select contiguous topics, press Shift and select the topics you want to add.

• To select noncontiguous topics, press Ctrl and select the topics you want to add.
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5. Drag and drop the selected topics from the Browse Repository window to the map in 
Publication Manager.

6. In the Template Selection dialog box, click Topic Ref, select the Apply to All check box, 
and click OK

7. Reorder the topics if necessary.

8. Check in the map when you finish editing it.

Adding a non-DITA file to a map
You can reference a non-DITA files, such as PDF and Excel in a map.

About this task
You must include the PDF or Excel file that you want to reference in a map regardless of whether 
you want it to appear in the table of content (TOC) or if you just want to insert an xref to it. Insert 
references to objects like PDF or an Excel file only in a publication that is published as HTML.

Important:
A PDF output with references to Excel or PDF fails.

Before you begin
• Import the file into Tridion Docs.
• A user who views the HTML must have appropriate application installed to view the type of 

file you want to include. Therefore, include common file types, such as PDF or Excel.

Procedure
1. Open the publication in Publication Manager.

2. Expand the map where you want to add the reference to the non-DITA file:

• To add an object before an existing object, right-click the existing object, and then click 
Insert before

• To add an object as a child of an existing topic, right-click the parent topic, and then click 
Add within.

3. Click Topic Ref.

The map is automatically checked out and the Insert Values dialog box displays.

4. In the Href field, click Browse and browse to the folder where the object is located.

The objects are displayed in the right pane.

5. Select the object that you want to add, and then click Insert.

Tip:

Alternatively, you can drag the object and drop the file to where you want it inserted in 
the map. If you drag and drop the file into the map, make sure that you edit the XML 
attributes correctly.
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6. Set the attributes for the reference to the non-DITA file:

a. In Navigation Title, type the name in the output for this file.

Provide complete navigation titles, such as Change history and Optimization and 
scalability. Titles such as Change history_SM_Dep and Optm & Scal are incorrect and 
cannot be translated.

b. Click OK.

7. If you are including the non-DITA file to add an xref to it and you do not want the file to 
appear in the TOC:

a. Right-click the topicref, select XML Attributes.

b. In the Toc field, click no.

c. Click OK.

8. Check in the map when you finish editing it.

9. Edit the map in Oxygen XML Author to set the locktitle attribute so that the navtitle displays 
in the TOC or link text rather than the GUID:

a. Right-click the map in the repository and click Check Out With and select Oxygen 
XML Author.

b. When the map opens in Oxygen XML Author, place the cursor in the topicref that 
references the non-DITA file.

c. In the Attributes window, in the Locktitle field click yes.

d. Check in the map.

Related links
Importing non-DITA files to Tridion Docs on page 28
Inserting a cross reference to a non-DITA file on page 180

Inserting a topichead into a map
About this task
Use this procedure to insert a topichead to a DITA map.
When you add objects to maps or bookmaps, the icons next to some elements have red bar 
through them. Icons with a red bar indicates that the element is not directly referencing any 
objects. For example, topichead elements always have a red bar because they contain titles and 
never reference objects. Conversely, chapters that directly reference a map or topic do not have a 
red line.

Procedure
1. Open the publication in Publication Manager.

2. Expand the map to which you want to add the topichead.
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3. Do one of the following:

• To add an object before an existing object, right-click the existing object, and then click 
Insert before.

• To add an object as a child of an existing topic, right-click the parent topic, and then click 
Add within.

4. Select Topic Head.

When you select Topic Head, the map is automatically checked out.

5. In the Insert Values dialog box, , type the title that must appear in the output in the 
Navigation title field, and then click OK.

Provide complete navigation titles, such as Change history and Optimization and 
scalability. Titles such as Change history_SM_Dep and Optm & Scal are incorrect and 
cannot be translated.

6. Check in the map when you finish editing it.

Bookmaps

Bookmap elements
You need a bookmap to generate PDF, HTML, HTML5 and other outputs. Some of the basic 
elements of a bookmap have been added to the template, but you will need to populate those 
elements and add the additional elements that you need to include in the book output. The 
following table lists and describes the bookmap elements.

Element Child elements Description
Booktitle Parent element for:

• MainBook Title

• Book Title Alt

• Book Library
MainBook Title The title appears:

• On Avaya Documentation Center, at the top on 
every page of the document.

• In PDF: The cover of the book and, if Book Title 
Alt is not specified, in the document footer.

Book Title Alt If specified, this title appears in the footer in PDF. 
You can also use Book Title Alt to create a two-line 
title for the avayaquickref-3column output type.

Table continues…
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Element Child elements Description
Book Library Title for the book library if you are creating 

one. Omit this element if you are not creating a 
documentation library.

Book Meta othermeta/bundle name A unique ID for the document that you upload on 
Avaya Documentation Center.

Important:

You provide the book meta, such as release 
number and issue number, in the publication 
properties.

Front Matter Parent element for:

• Notices to add a legal page to the book.

• Book Lists, which is required to include a table of 
contents in the book.

• Notices

• Book Lists

- Table of Contents

The Notices element is used to add a legal page 
to the book if one is required. Notices is a child of 
Front Matter.

Book Lists is the required parent of Table of 
Contents.

The Table of Contents element adds a table of 
contents to the book. Table of Contents is a child 
of Book Lists.

Chapter One chapter is included in the bookmap template. 
You can add as many chapters as you need. You 
should create a map for each chapter to contain the 
chapter contents. Creating chapter-level maps is 
our best practice as it makes it easier to restructure 
a publication and it can facilitate reuse.

Part The Part element is used to divide a document's 
chapters into logical groupings. This element makes 
it possible for you to provide a title and optional 
introduction under which to group the chapters.

Appendix Used for appendices.
Back Matter Parent element for Book Lists, which is required to 

include a glossary or index in the book.
Book Lists

• Glossary List

• Index List

Book Lists is the required parent of Glossary List 
and Index List.

The Glossary List element adds a glossary to 
the book. This element requires a Map Ref that 
references a map of glossary topics or a single 
Topic Ref that references one glossary topic.

The Index List element adds an index to the book.
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Editing a bookmap
About this task
Use this procedure to add the elements required for the book. Not all steps will apply to all books. 
Perform the steps that are appropriate for your book. For example, do not add the legal topic in 
quick reference guides, articles, and video publications.

Before you begin
Create the bookmap. For more information, see Creating a map on page 44.

Procedure
1. In Publication Manager, open the publication that includes the bookmap.

2. Add a title for the book if one does not already exist:

a. In the publication tree, expand Booktitle, and then right-click MainBookTitle and 
select XML Attributes.

b. Type or overwrite the book title in the Insert Values for ‘Main Book Title’ dialog box 
and then click OK.

For information about adding a trademark to the Main Book Title, see Adding a 
trademark to the mainbooktitle in a deliverable map on page 56.

3. (Optional) To include a book library that displays under the book title on the cover page:

a. Right-click the MainBook Title element and then click Insert Before > Book Library.

b. Type or overwrite the book title in the Insert Values for ‘Book Library’ dialog box and 
then click OK.

4. (Optional) Add a short title for the book, which displays in the document footer:

a. In the publication tree, right-click the publication bookmap and select Check Out 
With.

b. Select Oxygen XML Author.
c. Make sure the editor is set to Full Tags.

d. Locate the mainbooktitle element within the booktitle element.

e. Place your cursor after the mainbooktitle element, press Enter and select the 
booktitlealt element.

f. Enter the alternate book title in the booktitlealt element.

g. Save and close the publication bookmap.

5. In Front Matter > Notices, add the legal page.

A few solutions have unique legal content. For most programs, select the Common 
Standard Legal Page topic. For more information, see Adding the common legal topic 
to your publication on page 57.
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6. Add chapters to the book:

a. Right-click the Bookmap element and then click Add Within > Chapter.

Alternatively, right-click the chapter that comes after the chapter you are adding and 
then click Insert Before > Chapter.

b. In the dialog box that is displayed, click Browse, browse to and select the DITA map 
to add to the chapter and then click Insert.

c. Click OK.

Note:
• To divide the chapters into logical groups, you can use the Part element. For 

example, for a large, complicated install guide or upgrade guide that contains 
different deployment or upgrade scenarios, you can use the Part element to create 
main headings for each scenario and then group the relevant chapters under 
the headings. See Creating chapter groupings in a bookmap by using the part 
element on page 60 for more information.

• Do not reference a bookmap within a bookmap because a publication can have only 
one bookmap added at the root level.

7. To add an appendix to the book:

a. Right-click Back Matter in the publication tree and then click Insert Before > 
Appendix.

b. Navigate to the DITA map or topic that you want to add to the appendix.

If required, you can add more than one appendix to the book.

8. To add a glossary to the book:

a. Expand Back Matter > Book Lists in the publication tree.

b. Right-click Index List and then click Insert Before > Glossary List.

If the book does not have an index, right-click Book Lists and then click Add 
Within > Glossary List.

c. Navigate to the DITA map for the Glossary element.

d. To add glossary topics, right-click the map and then click Add Within and navigate to 
the appropriate topic.

9. Check in the bookmap when you finish working with it.

Adding a trademark to the mainbooktitle in a deliverable map
About this task
You can add a trademark or registered symbol to the main title only from Oxygen XML Author. You 
cannot add the trademark symbol in a mainbooktitle from Publication Manager.

Creating and modifying DITA maps

July 2024 DITA and TDocs Work Instructions and Guidelines 56
Comments on this document? 

57

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Procedure
1. Start Publication Manager and open the publication.

The Browse Repository window is displayed.

2. Right-click the bookmap and select Check out with in Oxygen XML Author.

3. In the mainbooktitle element, select the word to which you want to add the trademark, 
press Enter, and click tm the list of elements.

4. Select or double-click the tm element, and in the Attributes dialog box, click reg or tm in 
the tmtype field.

Ensure that you place the word that carries the trademark in the tm element, as instructed 
in step 1. Do not place the tm element after the word because that is semantically 
incorrect.

5. Click SDLTridionDocs > Check in to check in the map.

Working with legal content
Legal content for product documents

Add the legal topic to the Notices element in the Front Matter section of the book map. Do not add 
the legal topic in quick reference guides, articles, and video publications.
The legal team must approve all new legal content requests.

Common legal topic
Use the Common Standard Legal Page topic for all programs. The Hosted Services legal topic is 
obsolete as of November 2023.
Reuse the common legal topic in your publication directly. License types information is no longer 
included in the legal topic. Therefore, most programs do not require a project-specific legal topic.
In Tridion Docs, you can find the Common Standard Legal Page topic at General/Common 
DITA Supporting Content/Legal/Legal page/topics. Do not make any changes in the 
common topic.
You can also access Microsoft Word templates for legal pages and developer content at MS Word 
templates.

Adding the common legal topic to your publication
About this task
A few solutions have unique legal content. For most programs, you do not need a product-specific 
legal topic. Instead, add the Common Standard Legal Page topic directly to Front Matter > 
Notices.
Do not change any text in the Common Standard Legal Page topic. Ensure that you select the 
latest version of the topic in your publication.
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Procedure
1. In Publication Manager, open the publication where you want to add the legal page.

2. In the bookmap, do the following:

a. To add the Notices element, right-click Front Matter and then click Add Within > 
Notices.

b. If your bookmap already contains the Notices element, right-click Notices and then 
click XML Attributes.

3. On the Insert Values for Notices window, click Browse under HRef.
4. Browse to General/Common DITA Supporting Content/Legal/Legal page/

topics and select the Common Standard Legal Page topic.

5. Click OK.

6. Check in the bookmap.

Related links
Checking for newer versions of objects in the baseline on page 226

Creating a legal topic for developer content
About this task
For developer content, such as API and SDK documents, create a legal topic using the Legal for 
developer content template.
You require input from your product team to complete the Schedule 1 section. Do not change any 
other standard text without checking with the Avaya legal team and your product manager.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the navigation pane, browse to and select the topics folder where you want the topic 
saved.

Save the legal topic in the Common folder for the program.

3. On the toolbar of the right pane, click .

4. Select the Legal for developer content template and then click Next.
5. Complete the fields on each tab as appropriate.

6. Click OK.

7. Check out the topic.

8. Update Schedule 1 at the end of the topic:

• Make the updates to Schedule 1 based on the input from the product team and delete 
the note.
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• Remove Schedule 1 completely, including the note, if instructed to do so by your product 
team.

9. Delete the note after the title.

10. Check in the topic.

Next steps
Add the legal page to the bookmap for the publication.

Related links
Editing a bookmap on page 55

Inserting a line break in a book title for a PDF output
About this task
You can create a multiline title with specific line breaks in a PDF output.

Note:
If your publication is being translated, you must add a line break at the end of the 
mainbooktitle after the last word. This has no impact on your outputs but it provides a 
placeholder line break for localization that they can move if they need it for a translated 
version of the output.
If your publication is being translated, add a line break at the end of the mainbooktitle after 
the last word. Adding a new line does not impact your output, but it provides a placeholder 
line break for localization. The localization team can move if additional space is required for a 
translated version of the output.

Procedure
1. Right-click the bookmap and select Check out with in Oxygen XML Author.

2. Put your cursor in the mainbooktitle element where you want to enter a line break.

• To add new lines to an existing title, place the cursor before the word that you want to 
move to the second line.

• To add new lines to a title, place the cursor at the end of the name, insert the new line, 
and type the text to appear on the second line.

Note:

If you include more words in a line than can naturally fit, the line splits when it reaches 
the maximum length for a line.

3. Go to the Text mode, and add the <?Pub _newline?> code before the word from where 
a new line must start.

Example 1: Added a line break in the mainbooktitle element after the word “CCaaS”.
<booktitle id="GUID-xxx">
<mainbooktitle id="GUID-xxx">Using Avaya OneCloud CCaaS <?Pub _newline?> Public 
Omnichannel for supervisors</mainbooktitle>
</booktitle>
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Example 2: Added a line break at the end of the document title to accommodate the 
languages that need additional space after translation.
<booktitle id="GUID-xxx">
<mainbooktitle id="GUID-xxx">Using Avaya OneCloud CCaaS <?Pub _newline?> Public 
Omnichannel for supervisors<?Pub _newline?></mainbooktitle>
</booktitle>

4. Check in the bookmap.

5. Generate the PDF output and verify the document title.

A line break gets added after the word where you inserted the line break.

In the example, a line break is added after “CCaaS” in the document title:

Adding a new chapter to a bookmap
About this task
To divide the chapters into logical groups, you can use the Part element. For example, for a 
large, complicated install guide or upgrade guide that contains different deployment or upgrade 
scenarios, you can use the Part element to create main headings for each scenario and then 
group the relevant chapters under the headings. See Creating chapter groupings in a bookmap by 
using the part element on page 60 for more information.
Do not reference a bookmap within a bookmap because a publication can have only one bookmap 
added at the root level.

Before you begin
Create a map, called component map, to add as a chapter that in turn can contain maps and 
topics..

Procedure
1. Open the publication in Publication Manager.

2. Right-click the Bookmap element and then click Add Within > Chapter.
3. In the dialog box that is displayed, click Browse, browse to and select the DITA map to 

add to the chapter and then click Insert.
4. Click OK.

5. Check in the bookmap when you finish working with it.

Creating chapter groupings in a bookmap by using the part 
element

To divide a document's chapters into logical groupings, you can use the part element to provide a 
title and optional introduction to group the chapter under. The part element will typically be used 
with larger books that contain different types or categories of information. Do not use just to get 
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another level of hierarchy in a standard book. A good example would be a large, complicated 
install guide or upgrade guide that contains different deployment or upgrade scenarios. In this 
case, you can use the part element to create main headings for each scenario and then group the 
relevant chapters under the headings.

About this task
Consider the following rules and restrictions when using part elements in a bookmap.

• If you use the part element, always have more than one part element. Otherwise, there is no 
reason to use it.

• You can include chapters in a bookmap before a part element, but you cannot include a 
chapter after a part element in a bookmap. Chapter elements must either be in part elements 
or before the first part element. This makes sense because of the way that part is intended to 
be used. Do not use as just another level of hierarchy. Rather, use for major separations in a 
book.

• Each part element must have a navtitle or a topic at the top level. If you want to provide just 
a title, apply the navtitle directly to the part element. Or, if you want a topic at the top level of 
the part to be used as a target for links, you can add the href directly to the part element.

• If you use a topic at the top level of a part, ensure the topic contains only a title without any 
content. This way, you can link to the part in the output. Including text in a topic at the top 
level of a part element might give unexpected results. If you choose to include text in a topic 
at the top level of a part element, and you experience issues, remove the text.

Procedure
1. Check out the bookmap in which you want to insert the part elements.

2. Right-click the element before which you want to add the part element and select Insert 
Before > Part.

Remember that you can have chapters before the first part element but you cannot have 
chapters after the first part element. Usually, you will be inserting a part element before an 
Appendix element or Back Matter element.

3. Specify the title or introduction topic for the part:

• To include just a title and not an introduction topic for the part, right-click the part 
element, select XML Attributes, and then type the title in the Navigation Title field of 
the XML Attributes dialog box.

• To include an introduction topic, right-click the part element, select XML Attributes. In 
the XML Attributes dialog box, click Browse, browse to and select the topic, and then 
click OK.

4. Nest the appropriate chapter elements under the part.

5. Repeat steps 2 through 4 for each part element that you want to include.

6. Check in the bookmap when you finish working with it.

If an error occurs while you save and check in the bookmap, address the error. Do not just 
accept it and continue the check in.

Bookmaps
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Adding an appendix to a bookmap
Before you begin
Create a map for the contents of the appendix, or, if the appendix will include a single topic, create 
the topic.

Procedure
1. Open the publication in Publication Manager.

2. Right-click Back Matter in the publication tree and then click Insert Before > Appendix.

3. In the Repository, select the map or topic that you want to add, drag and drop to the 
Appendix.

4. Check in the bookmap when you finish working with it.

Adding a glossary to a bookmap
Before you begin
Create a map for the contents of the glossary, or, if the glossary will include a single topic, create 
the topic. If you use a glossary map, make sure that you nest all of the topics in a topic or a 
topichead with the title glossary.

Procedure
1. Open the publication in Publication Manager.

2. Expand Back Matter > Book Lists in the publication tree.

3. Right-click Index List and then click Insert Before > Glossary List.
4. In the Repository, select the glossary map or topic that you want to add, drag and drop to 

GlossaryList.

5. Check in the bookmap when you finish working with it.

BookMap guidelines
Use component DITA Maps for chapters
When specifying the chapters in a BookMap, use component DITA Maps that list the topics that 
are to be part of the chapter.

Nesting of BookMaps
Nesting of BookMaps is not allowed.

Using a bookmap for Eclipse Help
Use this procedure to create or modify a bookmap to support Eclipse Help.

Creating and modifying DITA maps
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About this task
In addition to specifying a resource ID for the bookmap, the topics must also have resource IDs to 
support context-sensitive help as required.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. Create a new bookmap and add the map to a publication.

3. Select the bookmap, right-click and select Check out with, and click Oxygen XML 
Author, in the Select Editor dialog box, click Editor.

4. Specify the ID for the help:

a. Expand the bookmeta element and place the cursor before the end bookmeta 
element.

b. Press Enter, and select resourceid from the list of elements.

c. In the Id field of the resourceid element, type a value that matches the plugin ID.

You can create the plugin ID or your development team might prefer to 
assign it. If you create the ID, use the string com.avaya.docs.<project>. 
For example, the plugin ID for the Orchestration Designer Developer Guide is 
com.avaya.docs.orchdesigner.

d. Click OK.

5. Check in the map.

Related links
Supporting context-sensitive help for HTML outputs that use context IDs (Eclipse Help, .chm, and 
Heritage Nortel projects) on page 115

Checking out a map to make updates in Publication 
Manager

About this task
You can check out a deliverable map or component map in Publication Manager. You must check 
out a DITA map, to perform the following tasks:

• Add component maps
• Change the order of topics
• Add topics
• Remove topics
• Add or change relationship tables.

Checking out a map to make updates in Publication Manager
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• Add or change XML attributes.
Tridion Docs automatically checks out a map when you perform an action that requires the map to 
be checked out.

Note:
To perform an action such as adding a trademark to the mainbooktitle, check out the bookmap 
in Oxygen XML Author from the browse repository. Do not use this procedure.

Procedure
1. In Publication Manager, open the publication that uses the map.

2. In the publication tree, right-click the map and click Check out with.

A red lock icon indicates that the map is checked out by you and can be modified.

3. In Oxygen XML Author, click Editor in Select editor dialog box.

The ditamap opens in Oxygen XML Author.

Related links
Opening a publication on page 30

Checking in a map
About this task
After editing a map in Publication Manager, check in the map to save the changes in the 
repository.

Procedure
In the publication tree, right-click the map, and then click Check In.

Moving objects in a map
Procedure

1. Open the publication in Publication Manager.

Creating and modifying DITA maps
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2. Check out the map.

3. In the publication tree, select the object to move, and then click the appropriate arrow on 
the toolbar of the publication tree.

Note:

Some arrows may not be available on some objects depending on their position in the 
document.

4. Repeat the previous step until the structure of your publication is as required.

5. Check in the map when you finish editing it.

Removing objects from a map
About this task
You can remove topics, maps, and images from a map or publication.

Procedure
1. Open the publication in Publication Manager.

2. Right-click the object to remove, and then click Delete.

The topic or the map you deleted is removed from the publication.

Note:

The removed objects are available in the repository until you delete the objects 
permanently from the repository.

Next steps
If the removed topic is also available in the relationship table, you must delete the topic from 
relationship table. If you fail to delete the topic from the relationship table:

• The output displays a broken link.
• The baseline fails to freeze.

Tip:
Even after you remove the topic from the map, if the topic still appears in the baseline, 
it indicates that the topic is referenced in one of the maps or in relationship tables of the 
publication. In the baseline, double-click the topic, the topic gets selected in the Content 
pane, delete the topic.

Related links
Removing relationships on page 178

Removing objects from a map
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Adding a trademark to a navtitle in a DITA map
To add a trademark symbol to a DITA map title in a publication, you must check out the map in 
Oxygen XML Author and insert the symbol. You cannot insert a trademark symbol directly in a 
navtitle element from the publication.

Note:

Trademark symbol added in a navtitle attribute might not display correctly. You must remove 
the navtitle attribute and add a navtitle element to the topichead element.

Procedure
1. Start Publication Manager and open the publication.

The Browse Repository window is displayed.

2. Right-click the map and select Check out with in Oxygen XML Author.

3. Locate the topichead element containing the navtitle to which you want to add a trademark.

4. Expand the topichead element and then expand the topicmeta element to view the navtitle 
element.

5. Keep the cursor in the location where you insert the trademark, press Enter, and click ph 
from the menu.

6. Keep the cursor in the ph element, press Enter, and click tm from the menu.

7. In the Attributes window, select reg or tm from the tmtype field and then click OK to 
accept the changes.

8. Type the text that should contain the trademark inside the tm element.

9. Click SDLTridionDocs > Check in to check in the map.

Adding author name in the deliverable map
About this task
When you upload a PDF file to Avaya Support site, you set the following document properties:

• Author = Avaya LLC
• Page layout=single page continuous
• Magnification= 100%

You must add the author name for a publication only once, and every time you publish the PDF, 
Tridion Docs preserves the author and PDF page property values.
For security purpose, you must add the organization name, Avaya LLC, and not expose the author 
who created or edited the document.

Creating and modifying DITA maps

July 2024 DITA and TDocs Work Instructions and Guidelines 66
Comments on this document? 

67

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Procedure
1. Start Publication Manager and open the publication.

The Browse Repository window is displayed.

2. Right-click the bookmap and select Check out with in Oxygen XML Author.

3. In the bookmeta element, add the author element and type Avaya LLC.

4. Click SDLTridionDocs > Check in to check in the map.

5. Generate the Avaya Book output.

The PDF output automatically displays the author and page settings in the document 
properties.

DITA Map guidelines
Number of topics in a DITA Map
You can include as many topics as you need in a DITA Map. In addition to the bookmap, use a 
DITA Map for each chapter in the document.

Hiding a topic from TOC
If your output includes topics that should not be displayed in the table of contents, set the Toc 
attribute to no. For example, use this attribute to ensure that subtopics in an article are not 
displayed in the table of contents.

Create hierarchy by nesting
You can do the following to create hierarchy:

• Add component maps within a chapter map for large chunks of content.
• Nest topicrefs within other topicrefs in a DITA Map.
• Nest topics under a topichead element.

Nesting under topicref vs. topichead
Start a chapter or module with a topic if you have meaningful introductory content to include. If 
not, you can use a topichead. The topichead element provides the navigation title under which the 
topics are displayed.

DITA Map guidelines
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Number of levels in a DITA Map hierarchy
Keep the structure of a chapter simple. Do not add unnecessary levels of hierarchy. The more 
you nest, the harder it becomes for users to read and navigate through the content. For more 
information about heading levels and nesting, see GIS Customer Documentation Standards.
HTML and PDF viewers render limited font sizes, highlighting styles, and indentation levels to 
distinguish headings.

Related links
Using chunking to create aggregated topics on page 69
Customer Documentation Standards: Nesting guidelines

Aggregated topics (chunking)
What is an aggregated topic?
You can use chunking to create an aggregated topic in HTML online help and Documentation 
Center outputs. With chunking, multiple smaller topics appear as a single aggregated topic. 
Aggregation is not useful in PDF outputs.

How is an aggregated topic made?
Aggregated topics are created by nesting topics under another topic and setting the chunking, 
linking, and toc attributes. The topic under which you nest other topics is the parent topic. The 
nested topics are child topics.

Why not combine the information in a single DITA topic?
The following are reasons for aggregating topics:

• You want a group of topics to appear together in context-sensitive help. For example, there 
might be a main topic that describes a feature or page, followed by the supporting task 
topics.

• You have concept topics that should appear as one unit in the output, but you want them to 
be separate topics due to their size or because you plan to use the smaller concept topics in 
different contexts.

• You have complex field description topics. The nature of the content requires the use of 
separate topics, but they need to appear together in the output.

• You are creating articles, which are published on the Avaya Documentation Center. An article 
focuses on a specific task or activity. For more information about creating articles, see GIS 
Documentation Standard for Articles.

Limitation of the chunk attribute
You can only apply chunking at one level in a topic hierarchy. If you apply chunking to a 
higher-level topic and to lower-level topics that have additional topic levels under them, Avaya 
Documentation Center and HTML outputs might fail.
If you require chunking at a lower level in Avaya Documentation Center and HTML outputs, you 
cannot aggregate the topics at a higher level. Instead, you can use a relationship table to link 
topics to the higher-level topic.

Creating and modifying DITA maps
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Using chunking to create aggregated topics
About this task
Chunking is usually applied to the top-level parent topic. DITA Open Toolkit does not support 
applying chunking to nested child topics when the parent topic already uses chunking.
If you need to apply chunking in lower-level child topics, do not apply it in higher-level topics.

Procedure
1. In the DITA map, identify the parent topic under which subtopics will be nested.

2. Right-click the parent topic and then click XML Attributes.

3. Set the following attributes:

a. Set Linking to Target only.

b. Set Chunk to to-content.
4. Add the child topics under the parent topic.

5. To ensure that the child topics are not displayed in the table of contents, click XML 
Attributes for each child topic and set Toc to no.

Related links
Setting up chunking for articles

Aggregated topics (chunking)
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Chapter 6: Creating and modifying topics

Creating a new topic
About this task
Topics must be created in a folder named Topics and has the Content type set to Topic.

See the Basics of creating a document video for steps to create a new topic.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the navigation pane, browse to and select the topics folder where you want the topic 
saved.

3. On the toolbar of the right pane, click .

The system displays the Select Template dialog box.

4. Select the appropriate template for the topic type, and click Next.
5. Complete the fields on each tab as appropriate.

You must complete the Product Family, Product, and Doc Lead fields on the Avaya-
specific fields tab appropriate for your project. Product Family and Product fields are 
used in searches within Tridion Docs and can be used in the future to categorize our 
content.

6. Click OK.

Next steps
The topic that you created is just a place holder. Check out the topic to add content in the topic.

Related links
Topic authoring checklist on page 325
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Topic properties
General tab

Name Description
Title Tridion Docs title for the topic. You can include only 

alphanumeric characters, spaces, hyphens, and 
underscores. Do not use characters, like slashes, 
asterisks, periods, parenthesis, or other special 
characters. The maximum length is 100 characters 
including spaces. The length restriction is important 
because Tridion Docs uses the Tridion Docs topic 
title as part of the topic's temporary filename. This is 
a required field.

Example: Creating a user
In Folder The location of the topic. This field is read-only.
Content type The topic type. This field automatically populates 

the topic type of the template that you selected, for 
example, structure, task, or concept.

Note:

Changing this field has no effect on the topic 
itself so do not change it. To change the type 
of topic, you must create a new topic of the 
correct type and copy the content from the 
existing topic to the new one.

Description A description of the topic. This field can contain any 
text and is optional.

Enable translation management For localization only.
Requested languages For localization only.

Important:

For successful translation, ensure that the field 
is always blank and check box is clear.

Inherited languages For localization only.

Version tab

Name Description
Version Version of the topic. The system automatically 

populates this field.
Changes A description of changes in this topic. This field is 

relevant for the new version of a topic. This field can 
contain any text and is mandatory for new versions 
and branches.

Table continues…

Topic properties
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Name Description
Candidate for baseline This field is blank.
Baseline label This field lists the frozen baselines that use this 

topic. This field is automatically populated.

Workflow tab

Name Description
Language The language of the object. This field is 

automatically populated
Status Workflow status. Options are:

• Draft

• Editorial review

• Pre-release validation

• Technical review

• Released

You can move an object to the Released state only 
when the object is in the Pre-release Validation 
state.

Author The owner of the topic.
Last modified by The last person who modified the topic. This field is 

automatically populated.
Source language This field is blank.
Comments Comments about the workflow. This field can 

contain any text and is optional.

Avaya-specific fields tab

Name Description
Override Output File Name Required HTML file name if the topic is part of 

context-sensitive help or use for chunking. This field 
is auto populated by the base attribute in the topic 
and is read-only. This field has the same character 
and restriction limitations as the Title field on the 
General tab:

• The base attribute can contain alphanumeric 
characters, spaces, hyphens, and underscores. 
Do not use any other characters, like slashes, 
asterisks, periods, parenthesis, or other special 
characters.

• The maximum length of this field is 100 
characters including spaces.

Table continues…
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Name Description
Product Family The product category or family to which the product 

belongs.

This is a required field.
Product The product for which you want to create the 

content.

This is a required field.
Component Product components will be set up by the system 

administrator on a case by case basis. Talk to 
the system administrator if you think a product 
component is appropriate for your product.

Contributor This field is currently unused.
Doc Lead The user who has responsibility for this content 

and can move the object to the Released state in 
workflow. This a required field.

Localization Coordinator For localization team only.
Reviewer You can optionally specify another Tridion Docs 

user as a reviewer for an object. This is useful when 
content is in the editorial review phase in workflow 
and you want the object to appear in the inbox of 
the selected user.

The user that you want to select in the Reviewer 
field must be assigned the role of Reviewer in 
Tridion Docs. Open a ticket on the Infosolutions 
project to add the Reviewer role for the user if the 
name is not available for selection.

Related links
Checking in a topic on page 77
Workflow on page 211

Creating a copy of an existing topic
About this task
Make a copy of an existing topic only if you want to model the content on the existing content. To 
add the same content, add IDs to the elements such as paragraph, steps, lists items in existing 
topic and reuse in the new topic.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

Creating a copy of an existing topic
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2. In the navigation pane, browse to project folder and subfolder, and select the topics 
folder and the topic that you want to copy.

3. Do one of the following:

• On the toolbar of the right pane, click 

• Right-click, and click Duplicate .

4. Change the title of the topic.

5. Complete the fields on each tab as appropriate.

You are required to complete the Product Family, Product, and Doc Lead fields on the 
Avaya-specific fields tab. Make sure you complete these fields as appropriate for your 
project because the Product Family and Product fields are used in searches within the SDL 
repository and can be used in the future to categorize our content.

6. Click OK.

Related links
Copying a topic or map on page 48

Checking out a topic from a publication
About this task
Use the publication to add or check out topics. When you add or update topics from the 
publication, the correct topic version is selected in your document. If you update the topics from 
the repository, the changes might not reflect in your publication.

Procedure
1. From the Start menu, click SDL Tridion Docs > Publication Manager 14.0.

2. Open the publication that contains the topic in Publication Manager.

3. Right-click the topic, and select Check Out.

The topic opens in Oxygen XML Author.

Checking out a topic from the Tridion Docs repository
About this task

Important:
Use the publication to add or check out topics. When you add or update topics from the 
publication, the correct topic version is selected in your document. If you update the topics 
from the repository, the changes might not reflect in your publication.

Creating and modifying topics
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Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the navigation pane, browse to and select the folder where the topic is saved.

3. Right-click the topic, and select Check Out.

The topic opens in Oxygen XML Author.

Adding or modifying content in a topic
Before you begin
Use the correct topic type for the content that you want to add.

Procedure
1. Open Publication Manager, and check out the topic from Browse Repository or the 

publication.

2. Do one of the following:

• Click Tools > Browse Repository, and navigate to the topic.

• Open the publication, and navigate to the topic.

3. Right-click and select Check Out.

The topic opens in Oxygen XML Author.

4. Add the content and images to the topic, and tag the content as appropriate.

For tips on using the XML editor, see Additional XML Author attributes.

5. Right-click and select Check in.

Tridion Docs saves the changes that you made to the database, and checks in the topic.

Changing the font display size in Editor
About this task
You can change the size of the text displayed in Oxygen XML Author. The size you select is for 
the display of the tags and text in Editor only; you cannot change the font size in your outputs.

Procedure
1. In Oxygen XML Author, select Options > Preferences.

2. On the Preferences dialog, click Appearance > Fonts.

Adding or modifying content in a topic
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3. Change the font size.

4. Click Apply and OK.

Restart Oxygen XML Author for the changes to take effect. The size of both the tags and 
the text change.

Adding explanatory text before a step
You can add the stepsection element in the following situations:

• To add a sequence of steps in a procedure. For example, “Perform the next three steps only 
if you installed expansion pack A.”

• To provide some text before the user action that is not appropriate for the cmd element.

Use the stepsection element carefully and only as intended. Overuse of the element might impact 
the readability of your procedures.

Procedure
1. Check out the topic in Oxygen XML Author.

2. Place the cursor before the step element where you want to add the explanatory text, 
press Enter, and select stepsection.

The stepsection element is a peer of step, so it goes before the step rather than within it.

3. Add the explanatory text inside the stepsection element.

Opening a topic in Oxygen XML Author in read-only mode
About this task
You can view a topic in read-only mode when the topic is:

• In the Released state
• Checked out by other user
• Located in a folder to which you do not have permissions

Procedure
1. Start Publication Manager.

2. Do one of the following:

• In Browse Repository, select the topic, right-click, and click Open.

• In Oxygen XML Author, click SDLTridion Docs > Open, navigate to the topic, right-click 
and click Open.

Creating and modifying topics
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The topic opens in read-only mode. You can see details, such as tags, conditions, and 
conrefs.

Checking in a topic
About this task
After you add or update the content in a topic in Oxygen XML Author, check in the topic to save 
the changes in the repository and close the topic.

Procedure
1. From the Oxygen XML Author menu, click SDLTridionDocs > Check in.

The Check in dialog box is displayed.

2. To change the workflow status of the topic:

a. Select Change status.

b. In the Status field, select the appropriate status.

3. Click OK.

Related links
Workflow on page 211
Topic properties on page 71

Creating troubleshooting, alarm, event, and error topics
Troubleshooting, alarm, event, and error topics describe a system issue and provide a 
recommended solution. Two templates are available in Tridion Docs for these types of topics: 
Troubleshooting or Alarm event error. These templates are based on the troubleshooting topic 
model in DITA.

These topics include the following:

• Description or information about a problem, alarm, event, or error

• One or more possible causes

• One or more associated resolution or remedy

The troubleshooting topic model is flexible. You can have one or more cause and one or more 
remedies. The following table describes some possible combinations of cause and remedy.

Checking in a topic
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Scenario Elements to use in topic
A condition with one cause and one remedy. Use one troubleSolution element with one cause 

and one remedy.
A condition with one cause and multiple possible 
remedies.

Use one troubleSolution element with one cause 
and multiple remedy elements.

A condition with multiple causes, each with one or 
more possible remedies.

Use a separate troubleSolution element for each 
cause and its associated remedies. If a cause has 
multiple possible remedies, use a remedy element 
for each remedy.

Related links
Resolution topics on page 21

Identifying migrated topics with duplicate Tridion Docs 
titles

About this task
Tridion Docs uses titles instead of file names to manage topics. When content is converted from 
Astoria to Tridion Docs (erstwhile Trisoft), the DITA topic title is used as the Tridion Docs title. 
Topics in your publications in Astoria with duplicate DITA titles have duplicate Tridion Docs titles 
when they got migrated to Trisoft.
The duplicate Tridion Docs titles do not cause an error. However, might make it difficult for you to 
differentiate the topics. Therefore you can use the Override Output File Name field. This field is 
populated during migration with the filename that was used in Astoria or the name you assigned to 
the topic to support context-sensitive help in an HTML output.

Procedure
1. Open the publication that contains topics with duplicate titles.

2. Click the Baseline tab, and sort by Title column.

3. Locate the duplicate titles in the baseline.

Creating and modifying topics
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4. Look at the Override Output File Name in the second column to differentiate the topics, 
based on what it was named in Astoria or the filename that was specified to the topic for 
context-sensitive help.

5. To easily differentiate the topics, right-click, and select Properties, and modify the Tridion 
Docs name in the Title field.

Modifying the Tridion Docs Title field does not impact the title element in the DITA topic.

Note:

However, do not change the title if:

• The Override Output File Name field is blank

• The topic is part of context-sensitive help that is mapped to the help link on a web 
page

Topic title guidelines
General guidelines
Some general guidelines apply to all topic types:

• Compose titles that are clear and concise.
• Use words that the user would understand in addition to or instead of feature and product 

names.
• Make sure that the title tells users exactly what information is in the topic.
• Create titles that provide a clear indication of the topic scope.
• Use sentence-case.
• Avoid constructions using the word “for”.
• Use plural unless the information specifically refers to a single object.

Task titles
Begin all task topic titles with an ing verb. For example, for a task on adding new users, use a task 
title similar to “Adding new users”.

Topic title guidelines
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Incorrect Correct
Build a Work Flow Building workflows
Administer parameters for voicemail Setting voicemail parameters
Editing the Element Manager Assigning a certificate to the Element Manager

Description concept titles
Use the name of the thing that the topic describes. For example, title a description concept 
“Administrator login type”.
For topics with overview content, avoid titles that begin with an ing form. If renaming the topic to 
avoid starting with a gerund creates an awkward title, use the gerund. Also, try to avoid using the 
words overview or “about in concept titles, unless there is a need to distinguish a concept title from 
the title of a deliverable or another topic.

Graphical concept titles
Use the name of the thing that the topic depicts graphically. For example, title a graphical concept 
“Message server internal view”.

Example topic titles
Include “example” in the title to make it clear. For example, “Dial plan configuration example”.

Scenario topic titles
Use the name of the thing that the topic provides a scenario for.

Field description structure titles
Begin all field description structure topics with the name of the page or dialog box followed by 
“field description”. For example, title a field description structure “Call Profile field descriptions”.

Report output titles
Use the name of the report followed by something like “report results” or “report output”.

Accessibility standards
All Deskphone user guide content we create must comply with Section 508 for people with 
disabilities. Following these standards ensures compliance and avoid a lot of added work later.

The following standards are not specific to DITA content but are required for all source formats:

• You must include an alt tag with ANY image and figure elements to make the intent of the 
image accessible for users using screen readers or text-only readers. Ensure that the text 
you include in the alt tag provides a complete description and does not restate the name of 
the image.

• You must include the name attribute with any objects elements to make the intent of the 
object more accessible for users using screen readers or text-only readers.

• You must include heading rows in all tables and simple tables.
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• Avoid creating complex table layouts that include horizontal and vertical cell spans when 
possible.

Indexing and keywords guidelines and tips
A good index can really help users find the content they’re looking for. Follow these guidelines to 
increase the quality of your indexes.

If there are terms that are relevant to the content that you don’t want to include in the index, you 
can add keywords in the prolog. This is useful for identifying things like terms not used in the 
product that a user might search for (for example, a user might search for an industry-standard 
term instead of the feature name Avaya has assigned to something). Keywords are searchable 
in our HTML outputs. Providing industry-standard terms and other additional relevant terms as 
keywords in the prolog will improve the findability of our HTML content and help the user locate 
the right topic. The keyword element is available under keywords in the prolog at the same level 
as indexterm.

General guidelines
• Every topic that has content must contain an index entry. Topics with just titles and without 

content in it that are created for linking purpose don't necessarily require index entries.
• Do not just index the topic title. Ensure that you index the subjects covered in the topic.
• Include only text in index entries; do not tag the entries.
• The most important consideration for indexing is to ensure that you consider how a user 

might look for information. There might be terms or words not included in the topic text that 
should be included as index terms. For example, there might be an Avaya feature name that 
is also commonly known by an industry standard term.

• Insert index entries that refer to the entire topic in the prolog element 
(<prolog><metadata><keywords><indexterm>). Index entries entered in the prolog link to 
the page in which the topic title displays. It is always best to include index terms in the prolog 
of a topic whenever possible.

• If you have a very long topic and want to add additional index entries, insert the index entry 
immediately following the start tag of the block element. But this should be very rare.

Note:
Do not insert index terms between the <title> element and the first paragraph in a 
<section> as it causes a little extra space to appear in the output. Instead, put the index 
terms in the first paragraph of the section.

• Consider reversing the primary and secondary entries. For example, create “users” as a 
primary entry and “adding” as a secondary entry. Then, create “adding” as a primary entry 
and “users” as a secondary entry.

• Do not create more than two levels of index terms.
• When you have pointed to a particular word or phrase in the text, avoid moving an index tag 

within text that has not changed since the last time it was translated. A moved index term 

Indexing and keywords guidelines and tips
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generates a fuzzy match because the segmentation of the sentence has changed from that 
stored in the translation memory.

• You do not have to include punctuation to separate index entries, as they are automatically 
inserted where appropriate.

• Be careful not to include extra spaces at the beginning or end of indexterm elements. Extra 
spaces in indexterm can cause your build to fail.

• Do not leave empty index terms in any topics.
• Use keywords as appropriate to enhance the findability of the content. Because keywords are 

only searchable in the HTML output, make sure that you include the important terms as index 
entries. Use the keyword element to include other terms that a user might search for that you 
don’t include in the index.

Secondary index entries
A secondary index entry is one that appears like this in an index:
Primary term
    Secondary term

The DITA markup used to express this relationship is this:
<indexterm>Primary term<indexterm>Secondary term</indexterm></indexterm>

Note:
The markup for the 'Secondary term' is entirely contained within the markup for the 'Primary 
term.' In other words, the indexterm containing the 'Secondary term' is a child element of the 
indexterm containing the 'Primary term.'

Tips
• If you see a red underline in an index entry, indicating a spelling error, do not add any blank 

spaces to the beginning or end of the indexterm. If the spelling in the entry is correct, ignore 
the red line. Adding spaces to the beginning or end of the indexterm can cause output build 
issues.

Important information about copying elements
If you copy elements, such as steps, numbered lines or bulleted lines and paste them within the 
same topic, you need to change or remove the ID of the element when you paste it. When you 
copy an element, the ID is copied also. And unless you change the ID, duplicate IDs will exist 
when you paste the copy.

If you attempt to reuse an element that has a duplicate ID with the same topic, errors might occur. 
For example, the conref might display text from the incorrect element. Duplicate IDs within the 
same topic is invalid XML and might produce various types of errors.
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Important:

When you copy a topic, the topic is assigned a new ID but the elements will have the same 
IDs as in the original topic. However, this will not cause any issues because the topic ID is 
always included in the references. Therefore, all references are unique.

If you are copying an element, pasting it, and not modifying the text, set up a conref rather than 
copy. If you are copying an element, pasting it, and modifying the text, be sure that you change 
the ID of the pasted element.

Related links
Copying a topic or map on page 48

Marking a task step or substep as optional
About this task
You can mark steps and substeps in task topics as optional using the importance attribute.

Procedure
1. In the publication, check out the topic in Oxygen XML Author.

2. Double-click or select the step or substep that you want to mark as optional.

3. In the Attributes window, click optional in the importance field.

The word “Optional” appears in bold and parenthesis at the start of the step in the output.

Note:

Do not apply the required value from the importance field to any steps. All steps are 
assumed to be required unless they’re marked optional. Also, no formatting is used 
when you apply required to a step, so the selection has no effect.

4. Click OK.

5. Check in the topic.

Inserting XML comments into topics
You can insert XML comments into your topics to add reminders or notes to yourself or your 
coauthors. XML comments do not appear in outputs and are not translated.

Procedure
1. Check out the topic in Oxygen XML Author, position your cursor where you want to insert 

the XML comment.

Marking a task step or substep as optional
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2. Place the cursor where you want to insert the XML comment, press Enter, and insert the 
comment element.

3. Enter the text into the comment element.

Modifying element attributes
About this task
You might need to modify attributes of an element to add ID for element reuse or set conditions, 
translations, reuse, and so on.

Procedure
1. In Oxygen XML Author, check out the topic and double-click or select the element.

When you double-click the element, the Attributes window opens.

2. In the Attributes window, add or modify the attributes.

In the pop-up Attributes window, click More to expand the view to see more attributes.

Related links
Additional Oxygen XML Author configuration

Replacing tags in the topic
About this task
You can replace one or all occurrences of a tag with a new tag in a topic.

Note:
• We use element, tag, and markup interchangeably in the guidelines.
• After the change, the new tag still retains the ID if it has any. If you are reusing this 

element in other topics, you must change the tag to the new tag in the target topics too to 
ensure that the content is displayed in the output.
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Procedure
1. Check out the topic in Oxygen XML Author.

2. To replace a single occurrence of a tag:

a. Select the tag or put your cursor in the text.

b. From the menu, click Document > Markup > Rename <element-name>.

For example, if you want to change the uicontrol tag to userinput, click Rename 
uicontrol and select a new tag userinput from the list.

c. From the list, select a new tag and press Enter.

Oxygen XML Author replaces the selected tag with the new tag.

3. To replace all occurrences of a tag in a topic:

a. Select the tag that you want to replace.

b. Select Rename Element from the menu Document > Markup or right-click and 
select Refactoring.

c. In New name, select a new tag from the list.

d. Click Rename all elements with the same name, and click OK

Oxygen XML Author replaces all occurrences of the tag in the topic with the new tag.

Important:

If the tag that you want to replace contains an ID, the same ID is retained in the 
new tag.

Inline markup
Elements that can be intermixed with text are called inline elements; text of this sort is said to 
contain inline markup.

Utility
inline markup, such as uicontrol or wintitle, identifies low-level types of information. Tagging 
information in this way provides production software cues that it needs to apply special formatting, 
and it identifies information type for users of the raw files such as translators or technical writers. 
While this information is quite useful, providing too much such information, especially in contexts 
where identifying the low-level information types does is not useful.

When not to use inline markup
In some contexts it does not make sense to tag everything that you can with inline markup. Use 
the semantics of the context to determine whether to apply tagging. The following table provides 
some examples:

Inline markup
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Case Wrong Right
1 <userinput><option>132</option></userinput> <userinput>132</userinput>
2 <userinput><cmdname>cd</cmdname> 

<filepath>/usr/bin</filepath></userinput>
<userinput>cd /usr/bin</userinput>

3 <title>How to use the <cmdname>grep</
cmdname> command</title>

<title>How to use the grep command</title>

Case 1: The semantics of userinput override the semantics of option. The fact that 132 is an 
option is irrelevant to the purpose of the instruction; namely, that the user is to type 132 into some 
field.
Case 2: The semantics of userinput override the semantics of cmdname and filepath. The fact that 
cd is the name of a command and that /usr/bin is a filepath doesn't matter because all we want to 
do is to tell the user to type cd /usr/bin into some field.
Case 3: A purpose of a title is to help readers find content. Involved semantic tagging of title 
content does nothing to help readers find content faster. inline tags that make sense within 
title include sup for superscript, sub for subscript, or inline elements that have content provided 
through conref.

White-space
Placing space characters in the correct place can help you avoid formatting errors in the output.

Case Wrong Right
1 See<cite> Using Avaya's Wonderful Products, 

555–555–555 </cite>for more information
See <cite>Using Avaya's Wonderful Products, 
555–555–555</cite> for more information

2 Click<uicontrol>OK</uicontrol>to continue. Click <uicontrol>OK</uicontrol> to continue.
3 <indexterm> Some index entry 

<indexterm>some sub-entry </indexterm> </
indexterm>

<indexterm>Some index 
entry<indexterm>some sub-entry</
indexterm></indexterm>

Case 1: The space characters should go outside of the cite open tag (<cite>) and the cite close 
tag (</cite>).
Case 2: Space characters are missing before the uicontrol start tag and after the uicontrol close 
tag. The output would look like this: ClickOKto continue.
Case 3: This example has several problems. It was fixed by 1) removing the space after the first 
indexterm start tag. 2) removing the space immediately before the second indexterm start tag, 3) 
removing the spaces before each indexterm close tag.

Tagging code exhibits
When you include code in a DITA topic, the way you tag the content depends on the context in 
which the code is being included.
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Commands or text entries in task steps
When you are authoring a task and you are explicitly telling the user what to enter in a step, tag 
the text/command they enter in userinput and tag any variables in the command with varname. Do 
not tag the command name or parameter names. In this context, it is important for the variables to 
be clear as such but the semantics of the other lower-level elements aren’t key to the purpose of 
the content.
If you need to provide a where statement to define variables that are part of a command:

• When there is one variable, include the complete “where” statement in the cmd and tag the 
variable with varname.

• When there is more than one variable, include the text “where” at the end of the cmd. Then 
provide the definitions of the variable in a ul in an info tag. Tag each variable name with 
varname.

Command reference topics
When you're authoring a command reference topic, where the purpose of the topic is to define 
the command and its syntax, then you do use the more detailed semantic elements, like 
cmdname, parmname, varname because, in this particular context, the more detailed semantics 
are important to the purpose of the content.

General code samples
When you're presenting a code exhibit in any other context, tag the code with the most 
semantically appropriate element, like msgblock, codeph, systemoutput, etc. But do not tag the 
lower-level elements, such as the command names and parameters, because calling out those 
lower-level elements isn’t key to the purpose in this context.

Tagging system-outputted text
There are different types of information that might be output from Avaya products:

• System messages (often have a message number or ID associated with them)

• Information from the system in response to a command or system query

There are different DITA tags to use for each type of information a system displays.

System messages
Use the following DITA elements for content related to system messages:

• For the text of system messages, use the msgph element.
• If you’re listing a multiline system message or a group of system messages, you can use the 

msgblock element.
• If you include the message identifier, tag the message number with the msgnum element.

If you are unsure of whether the system output is a recognized system message or general 
system output, contact your product team.

Tagging system-outputted text
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System output in response to commands, actions, or queries
Use the <systemoutput> element for content related to outputs from the system such as 
responses to commands, actions, or queries.

Copying text into topics from external sources

Copying multiple lines of text into a topic
You can copy and paste text into DITA topics from external sources, like Word files or PDFs. This 
procedure contains the steps for copying and pasting multiple lines of text, including text with code 
symbols.

Procedure
1. Copy the text from the source.

2. Open the topic and position the cursor where you want to insert the text.

3. Select Edit > Paste Special.

You can also right-click on the position where want to paste the text and select Paste 
Special from the menu that displays.

4. When the Paste Special dialog box displays, select Text and click OK.

Related links
Copying text into a codeblock element on page 89
Copying rows and columns from an Excel spreadsheet or Word table on page 89
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Copying text into a codeblock element
There are instances when you need to copy a block of code into a codeblock element. There are 
sometimes brackets in the code that prevent you from simply copying the text directly into the 
codeblock element. The following workaround solves the issue.

Tip:

If the line breaks in the code sample aren’t preserved when you paste into a topic, try pasting 
the code sample into Notepad and then copy and paste from Notepad into Editor.

Procedure
1. In the original source, replace the first bracket (<) with another symbol.

2. Copy the code sample into a codeblock element in a DITA topic.

3. Replacing the symbol with the start bracket (<).

Related links
Copying multiple lines of text into a topic on page 88

Copying rows and columns from an Excel spreadsheet or Word 
table

You can copy and paste text into a table in a DITA topics from an Excel spreadsheet or Word 
table. Russ Pierce contributed this method, which is a much faster way of copying a large amount 
of content.

Before you begin
Create a table in a DITA topic that has the same number of columns as what you’re copying.

Procedure
1. Select the columns/rows you want to copy and select Ctrl+C.

2. Open the topic and position the cursor in the first empty cell in the row where you want to 
insert the rows.

3. Select Edit > Paste Special.

You can also right-click on the position where want to paste the text and select Paste 
Special from the menu that displays.

Copying text into topics from external sources
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4. When the Paste Special dialog box displays, select table (from tabular text) and click OK.

Related links
Copying multiple lines of text into a topic on page 88

Scaling code samples in codeblock
About this task
When you use the codeblock element, the number of characters that appear on each line depends 
on where you’re using the codeblock element. For example, in a reference topic, a codeblock can 
have 83 characters on a line. In an info tag in a step, there are 73 characters. If you’ve got a 
codeblock element with more characters on a line and the line breaks are incorrect, you can scale 
the codeblock element to decrease the size of the text and fit more characters in a line.

Important:
The way the element appears in the editor is not the same as it will appear in your output. 
Therefore, you must generate the output to check the size of the code sample and make sure 
that the text is still readable. Do not reduce the scale to a point where the text cannot easily be 
read.

Procedure
1. Put the code sample in a codeblock element.

2. Double-click or select the codeblock element.

3. In the Attributes dialog box, select a value from the scale menu that represents the 
percentage you want to codeblock to appear.
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For example, if you select 90, the codeblock text will be scaled down to 90% of its normal 
size. The number of characters that fit on a line in a codeblock element depends on where 
the codeblock element is used, therefore, the scaling needs to be changed as appropriate.

4. Click OK.

Tagging filepath elements that contain variables
When DITA content is translated, the filepath element is not translated because information like 
paths, filenames, directory names should remain in English. However, variables within a filepath 
element should be translated. Therefore, for the content to be translated properly, we need to tag 
the variables separately outside of the filepath, but the whole path should be contained with an 
element. This procedure provides the steps for tagging a filepath with variables so that the filepath 
is not translated but any variables are. This process is more complicated than putting the whole 
path in one filepath and including the varname tag within filepath, but it ensures that the translation 
is correct.

Procedure
1. Position the cursor where you want to insert the filepath, press Enter, and select ph.

2. Put the cursor in the ph element, press Enter, and select filepath.

3. Put the cursor in the filepath element and enter the part of the filepath that appears before 
any variables.

4. Put the cursor after the filepath with the ph element, press Enter, and select varname.

5. Put the cursor in the varname element and enter the variable.

6. If the filepath continues after the variable, put the cursor after the varname element within 
the ph, press Enter, and select filepath.

7. Put the cursor in the filepath element and enter the part of the filepath that appears after 
any variables.

8. If the filepath contains multiple variables, repeat the steps to insert additional varname or 
filepath elements within the ph to add the entire path.

Example

Performing a completeness check on a topic
Procedure

1. In Oxygen XML Author, check out the topic.

Tagging filepath elements that contain variables
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2. Click  or select Document > Validate.

The status and error messages are displayed in the lower pane.
The content of element type "step" is incomplete, 
it must match "((note|caution|danger|esd|important|note-
avaya|security|tip|voltage|warning)*,cmd,(choices|choicetable|info|
stepxmp|substeps|tutorialinfo)*,stepresult?)".

3. Correct any errors found and check in the topic.

Inserting links to footnotes in a topic
When you want to add a footnote, you typically just insert the <fn> element and enter the footnote 
text. When you insert a footnote, in the output, the footnote marker with the number appears in the 
text and the footnote appears at the bottom of the page. However, in an HTML output, you can 
also link to the footnote from another element in the same topic by inserting a cross-references to 
the footnote element.

Note:

Links to footnotes are only supported in HTML outputs. Use footnotes sparingly, only when 
they are really needed.

About this task
To use the same footnote in multiple procedures, conref the footnote element into the other 
procedure rather than inserting a cross-reference. That way, the users see the footnote at the 
bottom of the page they’re reading rather than having to jump to another page.
As per the DITA processing standards for footnotes:

• In PDF outputs, the footnote marker does not link to the footnote at the bottom.
• In HTML outputs, the footnote marker links to the footnote text.

Procedure
1. In the publication, check out the topic in Oxygen XML Author.

2. Put your cursor where you want to insert the footnote1, press Enter, and select fn.

3. Insert the footnote text within the fn element.

If you do not need to insert links from other locations in the topic, the adding footnote 
action is complete and you can check in the topic.

4. To insert a link from an element in the same topic to an existing footnote element in that 
topic, you must first add an ID to the footnote element and then insert the xref:

a. Double-click or select the fn element and add an ID for the footnote in the id field.

1
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b. Check in the topic.

You must do this for the ID on the footnote to be available for selection when you 
insert the xref.

c. Check out the topic.

d. Place your cursor in the location where you want to add the cross reference and press 
Enter and insert the xref (cross reference) element.

e. In the Cross reference (xref) dialog box, browse to and select the topic that contains 
the footnote to reference.

f. Select the footnote element to cross reference, and then click Insert and close.

You do not have to enter the number of the footnote for the link text. The correct 
footnote number is automatically inserted in the output during production.

g. Double-click or select the xref element.

h. In the Attributes window, type fn in the type field and then click OK.

5. Check in the topic, publish the output, and verify that the footnotes are appearing as 
expected.

Identifying elements not to translate
In DITA, you can specify an element that is not to be translated.

Note:

The product and application elements are not translated by default.

Before you begin
Consult your Localization Project Manager or Information Architect before setting the translate 
attribute on any content.

Procedure
1. In the publication, check out the topic in Oxygen XML Author.

2. Double click or select the element that you do not want to translate.

3. In the Attributes window, set the translate attribute to no.

4. Click OK.
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Printing the tag view of a topic in Editor
About this task
Printing the tag view of topics is useful if you want to do a tag edit on your topics offline.

Procedure
1. Open Oxygen XML Author and check out the file that you want to print.

2. From the menu, click Options > Preferences .

3. In the Preferences dialog box, select Editor > Print .
4. Select File > Print and select the appropriate settings to print the topic.
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Forcing worksheets and checklists to start on a new page
You can force worksheets and checklists to start on a new page in the PDF output. This allows 
users to print those pages without getting unrelated content. Apply this functionality only to 
worksheets and checklists.

Procedure
1. From the publication, check out the topic that contains worksheet or checklist.

2. Double click or select the topic's root element.

For example, task element in a task template.

3. In the Attributes window, in outputclass, type worksheet.

4. Click OK.

5. Check in the topic and produce the output to validate that the topic starts on a new page.

Forcing worksheets and checklists to start on a new page
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Editing tips
Here are some general tips to keep in mind when using Editor:

• You can create a common topic for your project and add all of the conrefs you need to use 
from the common topics, like products. dita. Then you can just copy and paste the conrefs 
from your common topic into your topics and speed up the time it takes to insert these 
common conrefs.

• When you're working in the codeph element, you cannot press Enter to view the available 
elements. You need to select Insert > Markup and select the elements you want to insert 
from the Insert Markup list.

• When the syntax of a command string is important (for example, you're creating a command 
reference topic), be sure to tag each part of the command string appropriately (cmdname, 
parmname, varname).

Change tracking
When you enable change tracking in a topic and then produce a draft output, the changes in that 
topic are shown in draft PDFs as follows:

• Change bars in the left margin
• Green highlighting for added text
• Red highlighting and strikethrough for deleted text

Markup changes, such as changing an element or applying an attribute, do not appear in the 
outputs, although those changes are tracked in the topics.

Enabling and disabling change tracking in a topic
About this task
You cannot enable or disable change tracking globally. You have to do it in topic by topic.

Procedure
1. Check out the topic open in Oxygen XML Author.

2. To enable track changes, do one of the following:

• Click Edit > Review > Track Changes.

• From the toolbar, click .
• Right-click and select Review > Track Changes.

3. As you make changes to the topic text, the changes are highlighted.

4. To turn off tracking changes, from the toolbar, click .
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Turning off change tracking does not remove the change markings for any changes you 
made to the topic while change tracking was enabled. You must accept or reject the 
changes to clear the change marking.

Related links
Accepting or rejecting changes in topics on page 97

Accepting or rejecting changes in topics
You can accept or reject changes in topics any time in Oxygen XML Author. For example, you 
might clear changes when you are ready to produce an output for a final delivery or if you want to 
clear any changes after a draft delivery and start tracking new changes.

About this task
Important:
You must resolve any changes in topics before you deliver content to Localization or produce 
a final output.

Before you begin
Change tracking is enabled and changes made to the content.

Procedure
1. Check out the topic that has changes you want to resolve.

2. Do one of the following options:

• To accept all of the changes in the topic, from the toolbar or Edit > Review, click 

Accept all changes.

• To reject all of the changes in the topic, from the toolbar or Edit > Review, click 
Reject all changes.

• To move through the changes and accept or reject them individually, click Accept 
Changes and Move to Next or Reject Changes and Move to Next for each 
change.

If you want to change whether additional changes you make are tracked, you can enable 
or disable change tracking.

Alternatively, you can perform the following steps to accept or reject changes.

3. To open the Review window, do one of the following:

• Click Edit > Review > Manage reviews.

• Right-click and select Review > Manage reviews.

• Click Window > Review.

Change tracking
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4. In the Review window, click  (down arrow), for each change, click Accept or Reject.

 

5. Check in the topic.

Related links
Enabling and disabling change tracking in a topic on page 96
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Chapter 7: Working with web interface

Creating a folder from web interface
About this task
You can create a folder from Tridion Docs web interface or the repository.

Before you begin
Ensure that you have write permission to the parent folder.
Submit an issue to the Infosolutions project.

Procedure
1. Right-click the folder under which you want to create a folder, and click the New Folder 

icon.

2. In the Create new folder dialog box, enter a name and the type of content that the folder 
can contain.

To create the folder for a deliverable, for example deploying, set the content type as None. 
Within the deliverable folder, you can create subfolders for:

• topics and set the content type as Topic
• images, and set the content type as Image
• maps, and set the content type as Map
• publications, and set the content type as Publication

3. In Grant read access, click one of the user group.

4. Click OK.

Changing the folder properties from web interface
About this task
You can change the folder properties from Browse repository.

Before you begin
Ensure that you have write permission to the parent folder.
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Procedure
1. Select the folder for which you want to change the properties.

2. Click Properties, and change properties, such as name, author, change description, and 
reviewer.

3. Click OK.

Deleting the folder from web interface
About this task
You can delete a folder from Browse repository.

Before you begin
Ensure that you have write permission to the parent folder.

Procedure
1. Select the folder that you want to delete.

2. On the top-right, click the Delete icon.

3. Click OK to confirm delete.
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Chapter 8: Making metadata changes in 
bulk

Metadata changes in bulk
At a time, you can change the metadata value of multiple objects from the Properties dialog box.

• Requested languages

• Change description

• Status

• Author

• Product family

• Product

• Coordinator

• Doc Lead

• Localization coordinator

• Reviewer

To change properties in bulk, objects must be of the same type. For example, you can change the 
name of the author for multiple maps.

Important:

Tridion Docs overwrites the existing values with new values.

Changing metadata in bulk
About this task
You can change properties of topics, maps, or images in bulk from a browse repository or the 
baseline of the publication.
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Note:
You can also use the procedure to release only some topics, maps, and images. To release all 
objects in the publication, use the workflow on the web interface.

Before you begin
You require a doc lead role to change the metadata in bulk.
For doc lead role, get an approval for the doc lead role from your lead or manager, and open a 
DITA ticket and request for doc lead role.

Procedure
1. Start Publication Manager, and navigate to the project folder.

2. From Browse Repository or the Baseline tab of the publication, select objects of same type 
whose values you want to change.

For example, you can select multiple topics.

3. Right-click and select Properties.

4. On the Properties of Multiple Objects dialog box, change the field values as appropriate in 
General, Version, Workflow, and Avaya-specific fields tabs.

Important:

Tridion Docs overwrites the existing values with new values.

5. Click Yes to confirm the action.

The system displays a message Update Completed with <n> errors, and lists the 
objects that could not be modified. You must click Close.

Correct the error and modify the object properties again.
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Chapter 9: Working with tables

Creating a simple table
About this task
Use simpletable rather than table for tables that do not require more complex features like 
spanning of cells or centering content.

Procedure
1. In Oxygen XML Author, check out the topic.

2. Press Enter and select table (wizard) from the element list.

3. In the Insert Table dialog box:

a. Click Simple.

The CALS option creates a complex table where you can span cells or align cells.

b. Ensure that you select Generate table header.

Header rows are required in tables for Section 508 compliance for people with 
disabilities.

c. Specify the number of Rows and Columns to be included in the table.

d. Click OK.

You can add or remove the rows and columns later if you need to.

4. To add additional rows to the table:

a. Place the cursor where you want to insert the row, right-click and select Insert Rows.

b. In the Insert Rows dialog box, select the number of rows you want to add.

c. Click Above or Below and click OK.

d. (Optional) Alternatively, you can press enter and select row from the context menu.

5. To add a new column to the table:

a. Place the cursor in a cell where you want to add another column, right-click and select 
Insert Columns.

b. In the Insert Columns dialog box, select the number of columns you want to add.

c. Click Before or After and click OK.
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6. To modify the width of each column:

a. Double-click or select the table.

b. In the Attributes dialog box, set the relcolwidth attribute by specifying the percentage 
for each column followed by an asterisk (*) and a space.

For example, in a two-column table, to specify the column widths of 30% and 70% for 
the first and second columns respectively, enter 30* 70* in the relcolwidth field.

Important:

Do not use fixed width for tables that use the full page. Using fixed width can 
cause the table to run off the page. Ensure that you use relative widths using 
percentage.

c. Click OK.

You can also modify a column's width of simple table or complex table by positioning the 
cursor over the column separator until the cursor changes, and then dragging the cursor to 
adjust the width of the column. You cannot use this method to modify the column widths of 
part tables.

7. If you have any empty table rows, do the following so that the rows will be the same height 
as rows with content:

a. In the editor, go to Tools > Preferences..
b. On the Preferences dialog box, click Save.

c. Under Write Non-ASCII Characters As, select Numeric Character References.

d. Click OK.

e. Put your cursor in a cell in the empty row and select Insert > Symbol.
f. Select the Character Entities tab and select nbsp.

g. Click OK.

Creating a complex table
About this task
Complex tables use the table element. Create a complex table only when you need to use 
features like span and center align a column or a cell. Use simpletable for tables that don't require 
use of complex features.

Procedure
1. In Oxygen XML Author, check out the topic.

2. Press Enter and select table (wizard) from the element list.
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3. In the Insert Table dialog box:

a. Ensure that you click CALS.

The Simple option creates a simple table.

b. Ensure that you select Generate table header.
c. Specify the number of Rows and Columns to be included in the table.

d. Click OK.

You can add or remove the rows and columns later if you need to.

4. If you skip the step Generate table header while inserting the table, select the row, 
right-click and click Header in the Row tab.

Header rows are required in tables for Section 508 compliance for users with disabilities.

5. To modify the width of a column:

a. In the table/tgroup element, expand colspecs, and select the colspec element of the 
appropriate row.

b. Change the colwidth attribute in the form percentage followed by asterisk.

For example, for a two-column table where you want the first column to have a proportional 
width of 30% and the second column to have a width of 70% of the table width, enter a 
colwidth of 30* for the first column and then modify the attributes of the second column to 
set the colwidth to 70*.

You can also modify a column's width of simple table or complex table by positioning the 
cursor over the column separator until the cursor changes, and then dragging the cursor to 
adjust the width of the column. You cannot use this method to modify the column widths of 
part tables.

Important:

Do not use fixed width for tables that use the full page. Using fixed width can cause the 
table to run off the page. Ensure that you use relative widths using percentage.

6. To add additional rows to the table:

a. Place the cursor where you want to insert the row, right-click and select Insert Rows.

b. In the Insert Rows dialog box, select the number of rows you want to add.

c. Click Above or Below and click OK.

d. (Optional) Alternatively, you can press enter and select row from the context menu.

7. To merge any cells, select the cells you want to merge, right-click and select Join.

8. To center a column or a cell:

a. Do the following:

• To center a column, double-click or select the colspec element from table/tgroup.

• To center a cell, double-click or select the cell.

Creating a complex table

July 2024 DITA and TDocs Work Instructions and Guidelines 105
Comments on this document? 

106

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


The editor displays the Attributes window.

b. In the Attributes window, select center in the align field.

c. Click OK.

9. If you have any empty table rows, do the following so that the rows will be the same height 
as rows with content:

a. In the editor, go to Tools > Preferences..
b. On the Preferences dialog box, click Save.

c. Under Write Non-ASCII Characters As, select Numeric Character References.

d. Click OK.

e. Put your cursor in a cell in the empty row and select Insert > Symbol.
f. Select the Character Entities tab and select nbsp.

g. Click OK.

Modifying a simple table or a part table
Use the same procedure to modify simple tables or part tables contained in structure topics.

Procedure
1. To add additional rows to the table:

a. Place the cursor where you want to insert the row, right-click and select Insert Rows.
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b. In the Insert Rows dialog box, select the number of rows you want to add.

c. Click Above or Below and click OK.

d. (Optional) Alternatively, you can press enter and select row from the context menu.

2. To add a new column to the table:

a. Place the cursor in a cell where you want to add another column, right-click and select 
Insert Columns.

b. In the Insert Columns dialog box, select the number of columns you want to add.

c. Click Before or After and click OK.

3. To modify the width of each column:

a. Double-click or select the table.

b. In the Attributes dialog box, set the relcolwidth attribute by specifying the percentage 
for each column followed by an asterisk (*) and a space.

For example, in a two-column table, to specify the column widths of 30% and 70% for 
the first and second columns respectively, enter 30* 70* in the relcolwidth field.

Important:

Do not use fixed width for tables that use the full page. Using fixed width can 
cause the table to run off the page. Ensure that you use relative widths using 
percentage.

c. Click OK.

You can also modify a column's width of simple table or complex table by positioning the 
cursor over the column separator until the cursor changes, and then dragging the cursor to 
adjust the width of the column. You cannot use this method to modify the column widths of 
part tables.

4. If you have any empty table rows, do the following so that the rows will be the same height 
as rows with content:

a. In the editor, go to Tools > Preferences..
b. On the Preferences dialog box, click Save.

c. Under Write Non-ASCII Characters As, select Numeric Character References.

d. Click OK.

e. Put your cursor in a cell in the empty row and select Insert > Symbol.
f. Select the Character Entities tab and select nbsp.

g. Click OK.
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Modifying an existing complex table
About this task
Procedure

1. To add a new row to the table:

a. Put the cursor in any column of the row where you want to add a new row.

b. Press Enter and select row.

c. Insert the text in the cells of the new row.

2. To modify the width of a column:

a. In the table/tgroup element, expand colspecs, and select the colspec element of the 
appropriate row.

b. Change the colwidth attribute in the form percentage followed by asterisk.

For example, for a two-column table where you want the first column to have a proportional 
width of 30% and the second column to have a width of 70% of the table width, enter a 
colwidth of 30* for the first column and then modify the attributes of the second column to 
set the colwidth to 70*.

You can also modify a column's width of simple table or complex table by positioning the 
cursor over the column separator until the cursor changes, and then dragging the cursor to 
adjust the width of the column. You cannot use this method to modify the column widths of 
part tables.

Important:

Do not use fixed width for tables that use the full page. Using fixed width can cause the 
table to run off the page. Ensure that you use relative widths using percentage.

3. To merge any cells, select the cells you want to merge, right-click and select Join.

4. To center a column or a cell:

a. Do the following:

• To center a column, double-click or select the colspec element from table/tgroup.

• To center a cell, double-click or select the cell.

The editor displays the Attributes window.
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b. In the Attributes window, select center in the align field.

c. Click OK.

5. If you have any empty table rows, do the following so that the rows will be the same height 
as rows with content:

a. In the editor, go to Tools > Preferences..
b. On the Preferences dialog box, click Save.

c. Under Write Non-ASCII Characters As, select Numeric Character References.

d. Click OK.

e. Put your cursor in a cell in the empty row and select Insert > Symbol.
f. Select the Character Entities tab and select nbsp.

g. Click OK.

Setting the orientation of a table to landscape
For tables with larger number of columns, you can set the table to appear in landscape orientation 
in your PDF output. This option is supported for the Avaya Book, Avaya Jobaid, and Validator PDF 
outputs.

About this task
• When you apply this option, the actual page in the PDF still appears in portrait orientation; 

the table is rotated on the page to appear in landscape orientation.
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• The landscape option is only supported for tables using the <table> element. It cannot be 
applied to <simpletable> or <parttable).

• When you apply this option, a page break is inserted right before and right after the <table> 
element in the output.

• If you include a <title> or <desc> option in the <table> element, the title and description 
appear in landscape orientation as well.

Procedure
1. Check out the topic containing the table that you want to display in landscape orientation.

2. Double-click or select the <table> element.

3. In the Attributes window, select land from the orient field.

4. Click OK.

5. Check in the topic.

Extending a table element to the left margin
You can extend a larger table to start at the left margin and align with the topic heading.

Procedure
1. In the publication, check out the topic in Oxygen XML Author.

2. Double click or select the table element that you want to modify.

3. In the Attributes window, set the pgwide attribute to 1.

4. Click OK.

5. Check in the topic.
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Extending a simpletable and parttable to the left margin
You can extend a simpletable or parttable to align with the left margin and the topic heading.

Procedure
1. In the publication, check out the topic in Oxygen XML Author.

2. Double-click or select the table element that you want to modify.

3. In the Attributes window, set the expanse attribute to page.

4. Click OK.

5. Check in the topic.

Splitting the row in a table
About this task
When you have more content in a row near the page boundary, the entire row moves to the next 
page. To avoid additional white space on the page, you can split the row. When you split the row, 
content that can fit into the page remains on the current page, and moves the additional content to 
the next page.

Extending a simpletable and parttable to the left margin
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Procedure
1. Check out the topic containing the table where you want to split the row.

2. Double-click or select the table or part table element.

3. In the Attributes window, in the outputclass field, type rowsplit, and click OK.

4. Check in the topic.

5. Publish the Avaya PDF output and verify the output.

Suppressing color banding in tables
The tables in PDF outputs use color banding, where the rows alternate between white and light 
gray. The banding appears for all tables with four or more rows. You must leave the banding on 
because it is part of our common formatting. But for some tables, such as those with vertical 
spanning, the banding can look odd. So you have an option to suppress the banding on individual 
tables.

Procedure
1. Open the topic that contains the table you want to suppress banding for.

2. Double-click or select the simple or complex table element.

3. In the Attributes window, type no-shading in the outputclass field.

4. Click OK.
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Chapter 10: Context-sensitive help

Supporting context-sensitive help for HTML outputs 
without context IDs

If you are developing content for context-sensitive help that does not require context IDs, you can 
specify the filename or base attribute to be used in the HTML output.

The processor uses the topic title to create the html file during the output generation. For example, 
the processor creates New_Server_field_descriptions.html file from the New Server 
field descriptions topic that you share with the development team to map to the product 
help.

To avoid the underscores in the html file, you can add a base attribute in the topic. During 
output generation, the processor by default uses the base attribute in the topic and overrides the 
filename. For example, if you set “NewServerFieldDesc” as base attribute, the processor creates 
NewServerFieldDesc.html file from the New Server field descriptions topic.

About this task
Some projects map the project help to the topics published on Avaya Documentation Center.

Before you begin
• Ensure you create a separate publication for the online help deliverable.
• Use a bookmap as a deliverable map in the publication.
• If you are reusing an existing Administering or Using bookmap for online help, use 

appropriate conditions to hide or add content exclusively in product integrated help.

Procedure
1. Open the publication in Publication Manager.

2. Check out the topic in Oxygen XML Author.

3. Double-click or select the root element, for example, the structure element in a structure 
topic.

4. In the Attributes window, enter the filename to be used in the HTML output, without the 
extension, in the base field.

For example, if the topic must have the filename NewServerFieldDesc.html in the 
output, type NewServerFieldDesc in the base field.
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Important:

Use only alphanumeric characters, dashes, and underscores in the base attribute—do 
not use spaces, periods, or special characters. Do NOT include the file extension 
in the base field. The extension is automatically applied during output generation. 
Migrated content includes the .dita extension but that is stripped out during output 
generation. Do not remove the extension from the base attribute from migrated 
content.

5. Check in the topic.

The Override Output File Name in the topic properties reflects the base attribute value 
but is not editable. To modify the html file name to be used, check out the topic and modify 
the base attribute.

6. Share the html file name that is identified for mapping on the product help with the 
developer.

For example, NewServerFieldDesc.html.

Note:

For projects that map the product help to the htmls published on Avaya Documentation 
Center, share the entire path, such as https://documentation.avaya.com/bundle/
UsingDeviceManagementTool_r31/page/NewServerFieldDesc.html.

7. After the developer submits the help to the build, verify that the link works and the content 
shows up correctly.

Result
When you generate the HTML output, the file name of the topic matches with the base attribute 
you specified.

Context-sensitive help
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Supporting context-sensitive help for HTML outputs that 
use context IDs (Eclipse Help, .chm, and Heritage Nortel 
projects)

Projects that produce Eclipse Help and.chm help and content converted from Heritage Nortel 
projects use the resource ID element in DITA to specify the required context IDs in topics. If your 
project does not require context IDs, see the topic Supporting context-sensitive help on page 113 
for the other method of supporting context-sensitive help.

Procedure
1. Check out the topic in Oxygen XML Author.

2. Position the cursor before the end prolog element and press Enter.

If your topic does not already have a prolog element, add one before the taskbody 
element.

3. Select resourceid from the list that displays.

4. Enter the ID for the topic in the resourceid.

For .chm help, enter the id in the format string:context #, where:

string is the name of the topic, such as a concatenated version of the topic title, and 
context # is the context number from development. For example, AddUser:342123.

5. Check in the topic.

When you produce an HTML output, a mapping file will be automatically produced that 
includes the topic you added the resourceid to. For .chm, the information is built into the 
output.

Related links
Using a bookmap for Eclipse Help on page 62

Supporting context-sensitive help for HTML outputs that use context IDs (Eclipse Help, .chm, and Heritage Nortel projects)

July 2024 DITA and TDocs Work Instructions and Guidelines 115
Comments on this document? 

116

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Context-sensitive help support in content migrated from 
Astoria

In GIS, the team used multiple methods to support context-sensitive help. You can use one of the 
supported methods only if you must migrate from Astoria to Trisoft, the old name of Tridion Docs.

If you are creating a new GIS project that requires context-sensitive help, see Supporting context-
sensitive help for HTML outputs without context IDs on page 113.

Projects that used the Astoria filename as the base for context-sensitive help
Many GIS projects used the Astoria filename as the base for context-sensitive help. Tridion Docs 
preserves the Astoria filename in the base attribute on the root element in the topic so that the 
HTML output filenames remain the same. This attribute is represented by the Override Output File 
Name, a read-only field. For new topics in context-sensitive help, you must use the base attribute 
to specify the filename to be used in the context-sensitive help. For information on using the 
base attribute to add a help ID, see the topic Supporting context-sensitive help for HTML outputs 
without context IDs on page 113.

Heritage Nortel projects that use mapping for context-sensitive help
Writers who supported Heritage Nortel projects, applied the help ID for the topic on the topic title 
element. In Tridion Docs (erstwhile Trisoft), the way the help ID is applied is changed because 
Tridion Docs does not support IDs on topic titles. In Tridion Docs, if you must add an ID to a 
topic to support context-sensitive help, you add a resourceid to the topic prolog. See the topic 
Supporting context-sensitive help for HTML outputs that use context IDs (Eclipse Help, .chm, 
and Heritage Nortel projects) on page 115. This change is implemented in topics migrated from 
Astoria.

Projects that used the copy-to attribute on topicrefs to support context-sensitive 
help
Some GIS projects applied the copy-to attribute to topicrefs in DITA Maps to support context-
sensitive help. The copy-to attribute has been preserved in the migration to Trisoft, so the HTML 
filenames in the output continues to use the contents of the copy-to attribute. The copy-to attribute 
does not appear in Publication Manager. Instead, you must check out the map in Oxygen XML 
Author to modify the copy-to attribute. See the topic Supporting context-sensitive help for HTML 
outputs without context IDs on page 113 for information on using the base attribute to supply 
a help ID. To change your project to use the base attribute instead, submit an issue to the 
Infosolutions project.

Note:
The copy-to attribute method is deprecated. Therefore, use the base attribute.

Context-sensitive help
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Chapter 11: Working with output

Supported output formats
Use a BookMap, except for Eclipse help, to produce the outputs. You can produce more than one 
output type simultaneously from a BookMap.

Avaya supports the following output formats from our DITA content in Tridion Docs:

• - Avaya DocPortal: HTML-based output generated to publish the content on Avaya 
Documentation Center Production.

Important:

Except for some legacy products, use this output format to publish documents on 
Avaya Documentation Center.

- zoomindocs.Avaya-staging: HTML-based output generated to publish the content on 
Avaya Documentation Center Stage.

• Avaya book: The standard PDF book layout.
• Avaya Jobaid (PDF): Job aids must be short, without all the surround you see in a typical 

book output, like a cover page, table of contents, and index. To produce a job-aid output, do 
not include a table of contents or index and legal page.

• Quick reference PDF outputs:

- Avaya Quickref 3–Column: The preferred quick reference format. The format is flexible 
because we can create more than a single double-sided page. Space is used efficiently 
because the content begins right after the title in the first column.

- Avaya Quickref: An older 2–column layout used for legacy double-sided, folded, single 
page outputs. The right column on the second side is designed as the cover.

• Validator PDF: This output identifies specific tagging instances that do not adhere to Avaya 
standards and highlights them in the output so that they can be corrected. For information on 
the tagging this output highlights, see “Validator PDF output formatting”.

• Localization Use PDF: This output is for the Localization team’s use if they want to produce a 
PDF with different settings, such as producing a version compare draft.

• Avaya HTML: HTML-based frameset output for online help that is integrated with the product.
• Avaya HTML5: A frameless HTML output optimized for viewing on small devices:

- This output is supported on browsers, such as Firefox and Chrome. However, the output is 
not supported on Internet Explorer.
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- The output contains structural breadcrumbs at the top of each topic that shows the path 
to the topic in the publication structure. If a topic appears more than once in a publication, 
you must apply a copy-to attribute to identify a unique output filename for each duplicate 
instance of the topic. if you do not do this, the breadcrumbs display multiple paths for each 
topic.

• Avaya CHM: Microsoft compiled help (.chm): The .chm format is an old format that we avoid 
using whenever possible. We support .chm only for the legacy products. New projects must 
not use .chm help.

• Avaya Eclipse: This output has specific requirements for deployment and must not be used 
without consulting Information Architect.

• Avaya DOCX: An MS Word (.docx) output. The Word document is used to send the content 
for technical reviews.

Related links
Selecting the output format for a publication on page 122
Deleting and adding a TOC and index to a PDF output on page 144
Validator PDF output formatting on page 131

DITA Open Toolkit
The DITA Open Toolkit (DITA OT) is an open source implementation of the OASIS DITA Technical 
Committee's specification for Darwin Information Typing Architecture (DITA) DTDs and schemas. 
The toolkit uses an open source solution of ANT, XSLT, and Java to implement transformation 
functions from DITA content (maps and topics) into the output formats that we support. This 
description of the DITA OT processing has been taken from the DITA Open Toolkit Document site.

DITA OT processing pipeline
The DITA Open Toolkit implements a multi-stage, map-driven architecture to process DITA 
content. Each step in the process examines some or all of the content; some steps result in 
temporary files used by later steps, while others result in updated copies of the DITA content. Most 
of the processing takes place in a temporary working directory (the source files themselves are 
never modified).
Transformations in the toolkit are designed like a pipeline. Most of the pipeline is common 
between all output formats, and is known as the “preprocess” stage. In general, any DITA process 
begins with this common set of preprocessing routines. Once the preprocessing is completed, the 
pipeline diverges based on the desired output format. Some processing is still common to multiple 
output formats; for example, Eclipse Help and HTML Help both use the same routines to generate 
XHTML topics, after which the two pipelines branch to create a different set of navigation files.
The following image illustrates how the pipeline works for some common output types.
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July 2024 DITA and TDocs Work Instructions and Guidelines 118
Comments on this document? 

119

http://dita-ot.sourceforge.net/1.7/
https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


DITA maps 
and topics

Preprocess

Preprocessed 
DITA maps 
and topics

Topic merge

Transform to 
xsl-fo

Transform to 
PDF

Transform 
topics to HTML

Output PDF

Merged XML

fo file

HTML-based 
outputs

Generate 
Eclipse 

navigation

Generate web 
TOC

Generate 
HTML help 
navigation

Compile HTML 
help

Eclipse Web

HTML
help (chm)

PDF

DITA Open Toolkit

July 2024 DITA and TDocs Work Instructions and Guidelines 119
Comments on this document? 

120

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Output tab options
Output tab

Name Description
New Adds a new output format that you select from the 

Select Output Format dialog box.
Publish Publishes the output for the selected format and the 

language.
Unpublish SDL does not support the Unpublish option for the 

Avaya environment.
Cancel Cancels the publishing job for the selected output.
Download Downloads the output to the default directory.
Release Moves the output from Release Candidate to 

Release.

The Release status indicates that the content is 
released for distribution to Localization team or 
customer.

You can move an output to Release when:

• All publishing errors in the publication are 
resolved. Click View Report to view the errors.

• All objects (topics, maps, images, resources) in 
your publication are released

View Report Lists any errors such as conref, xref resolution 
errors.

Properties Displays the output properties where you can set 
the language and draft output format properties.

Delete Deletes the output format for the selected language.

Publishing Status tab
You can add more relevant columns. To do that, on the column header, right-click and select 
Add/Remove columns.

Name Description
Output format The supported output format in which you want to 

generate the output.
Language The language that you selected for the output 

format.

Table continues…
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Name Description
Status The publishing status, The statuses are:

• To be Published

You must Publish to generate the output.

• Pending

• Publishing

Before publishing, the status momentarily displays 
Pending before this job gets to the publishing 
queue.

• Draft

• Release Candidate

• Released
Published by The user who last generated the output.
Started at Time when the last output started generating.
Finished at Time when the last output finished generating.

Output status
The output for a publication can have one of several different statuses. The following table 
describes the various statuses that are possible. Tridion Docs assigns one of the following 
statuses.

Status Description
To be Published The output format was defined, but the output was 

not generated yet.
Pending Output generation was initiated. The server that 

processes these jobs is busy processing other jobs. 
The job is processed when possible.

Publishing The output is being generated.
Release Candidate The baseline is frozen, and the output generated 

without any errors. All objects were present and 
released, no invalid links, hyperlinks, or conrefs 
were found, and the output format can be released.

Table continues…

Output status
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Status Description
Draft Some objects in the publication are not yet 

released, and/or the output generated with errors. 
Issues can include:

• Objects included in the publication are not present 
at all.

• Images are not present in the requested 
resolution.

The publishing report lists all issues that were found 
during generation of the output.

Out-of-date The content of the publication or output format has 
changed since the output was last generated. Since 
the current content of the output is not current, the 
output should be regenerated.

Selecting the output format for a publication
About this task
You must select the output format for a publication before you can generate an output. The status 
of the output format is To Be Published until the output is generated for the first time.

Important:
When you publish the AvayaDocPortal output, the documents are uploaded on Avaya 
Documentation Center automatically.

Before you begin
Open the publication in Publication Manager.

Procedure
1. Click the Output tab.

2. Click New on the toolbar.

3. On the Select Output Format dialog box, select the output format for the publication, and 
then click Next.

Use output formats that start with Avaya such as “Avaya Book”, AvayaDocPortal, and 
“Avaya HTML”, except Validator PDF.

4. In the Add Publication Output dialog, click en-us in Language combination.

5. (Optional) To publish outputs for languages other than English, in the Fallback languages 
section, select en-us in Topics and maps, images, and Resources fields.

6. (Optional) To publish an output with draft markings, select the Use draft output format 
check box.
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If you select draft output format, Tridion Docs includes any draft-comments, change 
tracking. With change tracking, in the PDF format, you can see added, modified, and 
deleted text highlighted in different colors, and change bars in the left margin.

Important:

This step does not apply for the AvayaDocPortal output.

7. (Optional) To hide line numbers, watermark, and draft comments, select the following 
check boxes:

• Hide draft watermark
• Hide line numbers
• Hide draft comments

Important:

This step does not apply for the AvayaDocPortal output.

8. (Optional) To compare the changes that you made from an earlier version of the 
publication, in Differences with version, select a version.

Important:

This step does not apply for the AvayaDocPortal output.

9. Click OK.

Related links
Generating output on page 125
Supported output formats on page 117
Output properties on page 123

Output properties
Publishing Options tab

Name Description
Output format Format that you selected in the Add Publication 

Output dialog box. This field is auto-populated and 
cannot be modified.

Language combination Language of the book. For English books, select 
en-us.

Output properties
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Fallback languages

Name Description
Topics and maps For AvayaDocPortal output, select en-us.

For all other output types, leave this field blank.
Images For AvayaDocPortal output, select en-us.

For all other output types, leave this field blank.
Resources For AvayaDocPortal output, select en-us.

For all other output types, leave this field blank.

Draft options

Name Description
Use draft output format Adds the following draft markings to the outputs:

• PDFs (Avaya Book, Avaya Jobaid, Avaya 
Quickref 3-Column, Avaya Quickref): draft 
watermark, line numbers, <draft-comment> 
element, proprietary statement, and change 
tracking.

• Avaya HTML: <draft-comment> element and 
change tracking.

• Avaya HTML5: <draft-comment> element.

The draft output format is not supported for the 
Avaya CHM output.

Hide draft watermark Hides the draft watermark on draft PDF outputs. 
Line numbers and draft comments are shown 
unless specifically hidden.

Hide line numbers Hides line numbers on draft PDF outputs. A draft 
watermark and draft comments are shown unless 
specifically hidden.

Tables do not show line numbering.
Hide draft comments Hides draft comments (in draft-comment tags) in 

draft PDF outputs. A draft watermark and line 
numbers are shown unless specifically hidden.

Differences with version Produces an output that compares the current 
publication version with a previous version that you 
select from the list. You must also select the Use 
draft output format box to produce a draft with the 
version compare.

Working with output
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Publishing Status tab

Name Description
Status A status of To Be Published is displayed until 

you generate the output. You must then publish the 
output, which is a separate task.

Published by The user who last generated the output.
Started at Time when the last output started generating.
Finished at Time when the last output finished generating.

Related links
Selecting the output format for a publication on page 122

Generating output
About this task
When you generate an output, Tridion Docs assigns one of the following statuses to the output:

• Draft—Some objects in the publication are not yet released, and/or the output generated with 
errors such as broken hyperlinks or missing objects.

• Release Candidate—The baseline is frozen, and the output generated without errors.
See the Basics of creating a document video for steps to generate an output.

Before you begin
• Open the publication in Publication Manager.
• Select the output format for the publication.

For more information, see Selecting the output format for a publication.

Procedure
1. Click the Output tab.

2. Select the output format you want to publish.

3. Click Publish on the toolbar.

The publish process begins. The time to complete publishing depends on the size of your 
publication.

4. Download the output, and verify the content.

For the AvayaDocPortal output, the document is automatically uploaded to Avaya 
Documentation Center. You do not need to download the zip file from Tridion Docs

Related links
Selecting the output format for a publication on page 122

Generating output
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Programs available on Avaya Documentation Center
Currently, the content of the following products is being published on Avaya Documentation 
Center:

• Appliance Virtualization Platform
• Application Enablement Services
• Avaya Aura®

• AVP Utilities
• Avaya Breeze Platform
• Avaya Call Management System
• Avaya Control Manager
• Avaya Aura® Presence Services
• Avaya Devices Adapter
• Avaya Aura Device Services
• Avaya Enterprise Cloud
• Avaya Experience Platform
• Avaya Experience Platform Connect
• Avaya Solutions Platform
• Avaya Workplace Attendant
• Avaya Workplace Client
• Avaya Meetings Server
• Avaya Media Server
• Avaya Multimedia Messaging
• Avaya Session Border Controller
• Avaya Vantage
• Avaya Aura Web Gateway
• Branch Gateway
• Communication Manager
• Device Enrollment Devices
• IP Office Web Client
• IP Office Manager
• IP Office Web Manager
• J100 Series Phones
• Oceana Solution
• Avaya Workspaces
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• Avaya Analytics
• Session Manager
• System Manager
• Utility Services

Specifying a copyright range for an output
About this task
The copyright we include in our outputs should be a range, where the first year is the date 
the output was first produced and the second year is the current publish date. Use this task if 
you have not already set up your existing publications to show a copyright range. The copyright 
appears in the legal page and in the footer of outputs.
Copyright ranges can be different across books within a project. For example, you might have 
a new book created for a 2016 release, which would have a copyright of 2016. And you might 
have another book that’s been published since 2012, which should have a copyright range of 
2012–2016.

Procedure
1. Open the properties of the publication.

2. Select the Avaya-specific fields tab.

3. Set the Created Date field to the date of the product release for which the output was first 
published.

If you set this date when you first published your output and have used the Revised Date 
for subsequent releases, this date should already be set properly

Important:

If you have been updating the Created Date for every release instead of using the 
Revised Date field, change the Created Date to the proper date. If you do not know 
when the date of the first release the output was published for, check with your GIS 
Program Manager or check the Avaya support site to try to find the date. If you cannot 
determine the date of first publish, leave the Created Date as the current publish date 
and be sure to start using the Revised Date field in future releases

4. For existing outputs, if the Revised Date is not already populated, set it to the current 
publish date.

• You do not have to set the Revised Date if it’s the first release of an output.
• If the Created Date and Revised Date are the same year, the copyright date in the 

output will only show one year
• If you set the Revised Date to a date more than five years ago (so that the output 

always uses the current date), note that the system has been configured to recognize 
this, and will use the current year as the second year in the copyright range.

Specifying a copyright range for an output
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5. Click OK.

Related links
Setting the date of your outputs to the current date on page 128
Publication properties on page 32

Setting the date of your outputs to the current date
About this task
When you set the Created Date and Revised Date fields of a publication, you can choose Today 
as an option. When you do that, the date remains the same unless you change it manually. So if 
you produce an output a month later, it will still have the previous month in the output. If you want 
the date on the outputs to always track to the current date, use the steps in this procedure.

Before you begin
You must have a setting in the Created Date field because it’s always required.

Procedure
1. Open the publication, right-click the publication object, and select Properties.

2. On the Properties dialog, set the Revised Date to a date at least 5 years in the past.

This functionality is only available on the Revised Date field. And it has to be implemented 
using a date because the date fields require a date selection.

a. Click the ellipsis next to the Revised Date field.

b. Click the month and date at the top of the date selection dialog.

The display will change to show the current year at the top and the months under the 
year.

c. Click the left arrow at the top of the dialog to scroll to previous years.

d. Click a month to select something at least five years in the past.

e. Click a date to complete the selection.

f. Click OK on the Properties dialog.

Related links
Specifying a copyright range for an output on page 127
Publication properties on page 32
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Producing a draft output to compare two publication 
versions

About this task
You can produce a PDF output to compare the version of a publication that is open with any other 
version of the same publication. Version compare includes all of the differences between the two 
publication versions. This compare is different from the regular draft output, which uses the active 
Oxygen XML Author change tracking in the topics in the current version.

Note:
You can produce a version compare draft for PDF outputs only.

The formatting of changes are same as the draft output:
• Change bars in the left margin
• Green highlighting for new text
• Red highlighting and strikethrough for deleted text

Procedure
1. Start Publication Manager.

2. From the repository, open the version of the publication that you want to use as the basis 
for the comparison and click the Output tab.

3. Select the PDF output format you want to create the comparison of and click Properties.

4. On the Properties dialog box:

a. Select the Use draft output check box.

b. Select the Differences with version check box.

c. Select the version with which you want to compare.

Ensure that you compare with a different version and do not leave it at the current 
version, or you will have a publishing issue.

d. To suppress the watermark, line numbers, or draft comments, select the appropriate 
check boxes.

Important:

To disable the Differences with version option, remove the output format and add it 
back, or disable in the web interface due to a known Publication Manager issue. The 
information on disabling the check box through the web interface is provided at the end 
of this procedure.

5. Click OK.

6. Publish the output.

Producing a draft output to compare two publication versions
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7. To disable the Differences with version option, do one of the following:

• a. In the Output tab, delete the output format.

b. Add a new output format.

Note:

Deleting the output format and then adding it back is faster and simpler.

• a. On the Tridion Docs web interface, select the publication.

b. Click the Repository tab, and navigate to the publication folder.

c. On the right pane, select the publication, and click the publication title.

d. In the lower pane, select the Version check box on the far left, then scroll to the 
right and select the check box that corresponds to the Output Format and the 
Language Combination.

e. On the lower-right pane, click Properties.

You cannot modify values on the Properties page, and Tridion Docs displays 
Compare with version as unchecked. Ignore and continue with the next step.

f. On the Properties dialog, click Modify.

Producing a Validator PDF output
Before you begin
Open the publication in Publication Manager.

About this task
The Validator PDF output highlights specific tagging issues so that you can locate and correct 
them. See “Validator output formatting” for a list of the elements the output highlights.

Note:
It’s strongly recommended that you produce a Validator output for your outputs during content 
development. It’s especially important that you produce a Validator output before making any 
deliveries to Localization and before releasing your topics. Leave yourself enough time to 
make any necessary corrections.

Procedure
1. Select the Output tab.

2. Click Add.

3. In the Select Output Format dialog box, select Validator PDF and click Next.
4. When the Add Publication Output dialog box displays, select en-us as the Language 

combination.
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5. If you want the validator output to include highlighting for the inline elements that aren’t 
reused, select Hide line numbers under Draft option.

The validator output only checks for reuse of the following elements: <product>, 
<application>, <uicontrol>, <wintitle>, and <version>. Reuse of the <product> and 
<application> elements is required. Reuse of the <uicontrol>, <wintitle>, and <version> 
elements is required for localized content and strongly encouraged for other content.

6. Click OK.

7. Click Publish.

Related links
Validator PDF output formatting on page 131

Validator PDF output formatting
The Validator PDF output format highlights specific tagging instances that fall into the following 
categories Desktop Client:

• Tags that we should not use
• Tagging hierarchies that are not a best practice
• Elements that are not reused that should be reused, especially for content that’s localized.

The following table lists the elements that are highlighted in the Validator PDF output and 
describes the formatting that’s applied.

Element/context Formatting Sample
Elements and contexts that should not be used
<b>: We should never 
use the bold tag in our 
content.

“b: <text>” appears in red 
and in a larger size.

<I>: We should never 
use the italics tag in 
our content.

“i: <text>” appears in red 
and in a larger size.

List in a paragraph. 
List elements should 
always go after the 
end of the paragraph.

The list appears in red, 
and the text “List inside of 
p” appears in red before 
the list.

Table continues…

Validator PDF output formatting

July 2024 DITA and TDocs Work Instructions and Guidelines 131
Comments on this document? 

132

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Element/context Formatting Sample
Admonishment (note, 
warning, etc.) 
in a paragraph. 
Admonishment 
elements should 
always go after the 
end of the paragraph.

The admonishment 
appears in red, and 
the text “Admonishment 
inside of p” appears in 
red before the list.

Ordered list <ol> in a 
step.

The list appears in red, 
and the text “Ordered list 
inside of steps” appears 
in red before the list.

Table in a paragraph. The list appears in red, 
and the text “Ordered list 
inside of steps” appears 
in red before the list.

Empty <p>, 
<abstract>, <title>, 
<shortdesc> elements

The element appears in 
red with the text “Empty 
<element name>”.

Elements that should not be reused
<ph> element that is 
conref’d. Do not reuse 
the <ph> element.

The element appears 
in red with the text 
“Conref not allowed on 
ph: <reused content>”.

Elements that should be reused
<product> element 
that’s not conref'd. 
Reuse of product 
names is required.

Highlighted in bright 
green.

<application> element 
that’s not conref'd. 
Reuse of application 
names is required.

Highlighted in bright 
green.

Table continues…
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Element/context Formatting Sample
<uicontrol> element 
that’s not conref'd. 
Our best practice is 
to reuse <uicontrol> 
elements. For new 
projects and localized 
content, this is 
required

Highlighted in blue.

Reusing <uicontrol> and 
<wintitle> elements is 
required for new projects 
and existing projects 
that are localized. It’s 
strongly encouraged for 
all other projects but 
not mandatory at this 
time. Highlighting the 
<uicontrol> elements that 
are not conref'd can also 
help locate <uicontrol> 
elements that have been 
used improperly to apply 
bold formatting.

<wintitle> element 
that’s not conref'd. 
Our best practice is 
to reuse <wintitle> 
elements. For new 
projects and localized 
content, this is 
required.

Highlighted in light 
purple.

<version> element 
that’s not conref'd. 
Our best practice is 
to reuse <version> 
elements. For new 
projects and localized 
content, this is 
required

Yellow highlighting

Change tracking
Change tracking is 
enabled in a topic.

The text “Change 
tracking is active in the 
next topic” appears in 
red before the topic. 
Change tracking is fine 
while you’re developing 
the content, but it’s very 
important that it be turned 
off before you deliver 
content to Localization or 
you deliver and release 
the final content.

Table continues…
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Element/context Formatting Sample
There is change 
tracking markup in a 
topic.

The text “Change markup 
is present in the 
next topic” appears 
in red before the 
topic. It’s very important 
that you resolve and 
change tracking before 
you deliver content 
to Localization or you 
deliver and release the 
final content.

Related links
Producing a Validator PDF output on page 130

Breadcrumbs in HTML outputs

How breadcrumbs work
The HTML output formats support breadcrumbs at the top of each topic that provide the path to 
the topic in the publication structure.

• Breadcrumbs are optional and are disabled by default. See the topic Adding breadcrumbs to 
an HTML output for information on how to control whether breadcrumbs appear or not.

• Each breadcrumb links to its respective topic. If the path to the topic includes topicheads, 
those will not be links because a topichead can’t be a link target.

• If a topic appears more than once in a publication, you must populate the “copy-to” attribute 
of the additional instances of the topic to specify a unique output filename. You set the 
copy-to attribute on the topicrefs of the additional topic instances. If you do not set the 
copy-to attribute, the breadcrumbs for the topic will include multiple paths for every instance.

Enabling breadcrumbs in HTML outputs
About this task
HTML output formats, Avaya HTML5 and Avaya HTML, support breadcrumbs. The breadcrumbs 
are optional and you can control whether they appear in your outputs.

Procedure
1. Start Publication Manager and open the publication.

The Browse Repository window is displayed.

2. Right-click the bookmap and select Check out with in Oxygen XML Author.

Working with output

July 2024 DITA and TDocs Work Instructions and Guidelines 134
Comments on this document? 

135

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


3. Expand the bookmeta element.

4. Position the cursor before the ending bookmeta tag, press Enter, and select othermeta.

If bookmeta includes a bookid, bookrights, or data element, position the cursor before 
them.

The Attributes dialog box displays.

5. In the content field, type yes.

6. In the name field, type breadcrumbs.

7. Click OK.

8. Click SDLTridionDocs > Check in to check in the map.

9. To disable breadcrumbs, check out the bookmap, remove the othermeta attribute for 
breadcrumbs, and then check in the bookmap.

Specifying a unique output filename for multiple topic instances 
to support breadcrumbs

This topic provides information on using the copy-to attribute to specify a unique filename when 
you include a topic more than once in a publication.

About this task
You must specify a unique output filename when you use a topic more than once in a publication 
that uses the HTML5 output format. The HTML5 output format support breadcrumbs at the top 
of each topic. If you use a topic more than once in a publication and you do not use the copy-to 
attribute to specify a unique output filename, the breadcrumbs for each instance of the topic will 
include multiple paths.
Apply the copy-to attribute only on the additional instances of the topic. However, you can use the 
copy-to attribute for every instance of the topic.

Note:
The copy-to attribute might fail the Avaya DocPortal output generation, therefore, use it only 
when required.

Procedure
1. Start Publication Manager.

2. Open the publication and locate the map that contains the additional instance of the topic.

3. Right-click the map, click Check out with, and select Oxygen XML Author.

4. Double-click or select the topicref to which you want to specify the copy-to attribute.

5. In the Attributes window, select the copy-to field and enter the filename to which you want 
to assign this instance of the topic.

6. Click OK.

7. Check in the DITA Map.
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8. Repeat these steps for any additional instances of the topic.

Downloading output
About this task
You can download output that has a status of Draft, Release Candidate, or Released. For output 
that includes multiple files, for example, online help, the output compressed in a zip file.

Before you begin
Generate the output.

Procedure
1. Click the Output tab.

2. Select the output to download.

You can select multiple outputs to download by pressing Ctrl and selecting the additional 
outputs.

3. Click Download on the toolbar.

4. In the Object Download dialog box, click Save.

5. In the Save As dialog box, browse to the folder on your computer where you want to save 
the output, and then click Save.

The title appears as the filename of the output, additionally, the publication version, 
language, and output format is appended. For example, Administering Communication 
Manager 8.0=3=Avaya Book=en-us. The maximum number of characters in an output 
filename is 116 characters. Out of which, 9 characters are used for the version number, 
language, and separators. The length of the output format name can vary, with the 
maximum being 30 for the “Avaya 3–column Quick Reference”. The remaining characters 
are used for the publication title. If the title is long and if there are no enough remaining 
characters, the complete publication title is not included in the output filename. You can 
rename the output filename after you download it, or you can shorten the name that fits 
within the supported characters.

Checking the publishing logs for errors
When you produce an output it’s important that you always check the logs for errors. The fact 
that the output published doesn’t mean that it published without errors such as missing content or 
broken links.

About this task
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Procedure
1. When you receive the email that your publishing request completed successfully with an 

attached zip file, open the ditaot.log file.

2. For PDFs, scroll to the end of the file where it says “BUILD SUCCESSFUL” and ensure 
that the number of Errors is 0.

3. For HTML outputs, or if there are errors indicated at the bottom of the log, search the log 
for “[ERROR]”.

Searching specifically for “[ERROR]” will find all of the DITA Open Toolkit errors.

4. (Optional) If you do not receive the notification on the publishing status, view the logs from 
web interface:

a. On the Tridion Docs web interface, navigate to the publication for which the publishing 
failed, and select the select it.

b. In the right-bottom pane, select the version, output format, and language by two check 
boxes.

c. On the extreme bottom-right pane, click Status Report.

d. In the Event Details dialog, search for the term, “error”.

e. Read through the details to identify the cause of the output failure.

Related links
Viewing publishing logs on the Tridion Docs web interface on page 138
Viewing publishing logs from Publication Manager on page 140

Viewing the publishing queue
About this task
If a publishing job seems to take longer than expected to complete, you can check the publishing 
queue to see if other requests are in the queue before your request.
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Procedure
1. Log in to the Tridion Docs web interface.

2. Click the Publishing tab.

3. In the left pane, click All Users.

Publishing jobs are listed by category:

• Publishing (currently in progress)

• Pending (in queue)

• Release Candidate (successfully published)

• Draft (successfully published)

• Cancelled

• Failed

4. If the output been published more than two days ago, click Last 4 days or Last 10 days 
from Select time period.

Related links
Logging on to the Tridion Docs web interface on page 26

Viewing publishing logs on the Tridion Docs web interface
About this task
If a publication fails to publish, view the publishing logs in the Web interface to look for the errors 
that caused the failure.

Procedure
1. Log in to the Tridion Docs web interface.

2. Click the Publishing tab.

3. In the left pane, click Current User to view only the publishing jobs that you submitted, or 
click All Users to view publishing jobs that other users submitted.

The refresh might take a couple of minutes.

Publishing jobs are listed by category:

• Publishing (currently in progress)

• Pending (in queue)

• Release Candidate (successfully published)

• Draft (successfully published)

• Cancelled
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• Failed

4. If the output been published more than two days ago, click Last 4 days or Last 10 days 
from Select time period.

5. Scroll to the job for which you want to view publishing logs, and then click the title of the 
publication.

A log for the publishing job is displayed in a new window.

6. Look through the events for the first one that shows the status as Failed and then double-
click the event to view the details.

Tip:

DITA-OT logging contains helpful information.

7. In the Event Details dialog box:

a. Search for the term, “error”.

b. Read through the details to identify the cause of the output failure.

8. (Optional) If you do not receive the notification on the publishing status, view the logs from 
web interface:

a. On the Tridion Docs web interface, navigate to the publication for which the publishing 
failed, and select the select it.

b. In the right-bottom pane, select the version, output format, and language by two check 
boxes.

c. On the extreme bottom-right pane, click Status Report.

d. In the Event Details dialog, search for the term, “error”.

e. Read through the details to identify the cause of the output failure.

Related links
Logging on to the Tridion Docs web interface on page 26
Viewing publishing logs from Publication Manager on page 140
Checking the publishing logs for errors on page 136
Solution on page 305
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Viewing publishing logs from Publication Manager
About this task
If a publication fails to publish, view the publishing logs to look for the errors that caused the 
failure.
You can view the logs from Publication Manager and web interface.

Procedure
1. Open the Publication Manager and click the Output tab.

2. Select the output for which you want to check the publishing error log, right-click and click 
Save DITA Open Toolkit log as.

3. Save the log to your computer, and do the following:

a. Search for the term, “error”.

b. Read through the details to identify the cause of the output failure.

4. (Optional) If you do not receive the notification on the publishing status, view the logs from 
web interface:

a. On the Tridion Docs web interface, navigate to the publication for which the publishing 
failed, and select the select it.

b. In the right-bottom pane, select the version, output format, and language by two check 
boxes.

c. On the extreme bottom-right pane, click Status Report.

d. In the Event Details dialog, search for the term, “error”.

e. Read through the details to identify the cause of the output failure.

Related links
Viewing publishing logs on the Tridion Docs web interface on page 138
Checking the publishing logs for errors on page 136
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Downloading outputs from the Tridion Docs web interface
About this task
Typically, after you publish the output, you download the output from Tridion Docs Publication 
Manager.
However, when you do not need to make changes to the content, you can download outputs from 
the Tridion Docs web interface.

Procedure
1. Log on to the Tridion Docs web interface.

2. On the left pane, click Content Manager and go to the Publishing tab.

3. Locate the output that you want to download and select the check box to the left of the 
publication.

4. Scroll up to the top of the page, click Download, and follow the prompts to open or save 
the output.

Tridion Docs displays the PDF outputs in a separate window, you can view the content.

5. Repeat steps 3 and 4 for any other outputs that you want to download.

6. To download a specific version of a publication:

a. In the Repository tab, browse to the publication.

b. From the bottom-right pane, select a version of the publication and the output format.

c. Click Download in the bottom-right menu.

Checking accessibility and generating a report
About this task
To comply with Section 508, check if images and objects in a document are accessible and usable 
by screen readers. Generate a report if required.

Before you begin
1. Provide a meaningful and short text in the alt tag for each image used in the topic.
2. Publish the Avaya PDF output in Tridion Docs.

Procedure
1. Download and open the PDF in the Acrobat application.
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2. From the menu or the toolbar, click Tools > Accessibility.

3. From the menu, select Accessibility Check.

Acrobat displays the Accessibility Checker Options dialog box.
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4. In Report Options section, click Create accessibility report check box, and click 
Choose, browse to a location where you want to save the report.

5. To create a new folder to save the report, click Make New Folder, else, click OK.

6. Click Start Checking.

The checker tool lists the sections and pass/fail status and the rule description.

7. Fix any issues in the report, such as adding alt text in images and regenerate the report if 
required.

Checking accessibility and generating a report

July 2024 DITA and TDocs Work Instructions and Guidelines 143
Comments on this document? 

144

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


8. Share the accessibility report as required.

Related links
Making images and objects accessible on page 255
Accessibility of images on page 255

Deleting and adding a TOC and index to a PDF output
You can produce a PDF book output without a table of contents or an index. Or if you’ve got 
a publication that doesn’t currently include a TOC or index, you can add one back. If you are 
producing a job aid output, you should not include a TOC or index.

Procedure
1. To suppress the table of contents:

a. Open the publication in Publication Manager and expand the Front Matter element.

b. Right-click the Book Lists element and select Delete.

2. To suppress the index:

a. Open the publication in Publication Manager and expand the Back Matter element.

b. Expand the Book Lists element and determine whether Index List is the only 
element under Book Lists.

c. If the Index List is the only element under Book Lists, right-click the Book Lists 
element and select Delete.

d. If there are other elements under Book Lists, right-click the Index List element and 
select Delete.

3. Save the publication and produce the PDF.

4. If you want to add the table of contents back at some point:

a. Open a publication in Publication Manager that contains a Table of Contents element.

b. Expand the Front Matter element, right-click the Book Lists element, and select 
Copy from the menu that displays.

c. Open the publication to which you want to add the TOC in Publication Manager, 
right-click the Front Matter element, and select Paste.

The publication displays Book Lists and Table of Contents elements within Front 
Matter.

5. To add the index back at some point:

a. Open a publication in Publication Manager that contains an Index List element.

b. Expand the Back Matter element, right-click the Book Lists element, and select Copy 
from the menu that displays.
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If the bookmap you’re copying from also includes a Glossary List, expand Book Lists 
and copy the Index List element instead.

c. Open the publication to which you want to add the index in Publication Manager.

d. If the bookmap doesn't already have a Back Matter element, right-click the bookmap 
element and select Add Within > Backmatter.

e. Right-click Back Matter and select Paste.

Note:

The Book Lists element must be the last element (or only element) under Back 
Matter.

The publication displays Book Lists and Index List elements within Back Matter.

Related links
Supported output formats on page 117

Changing the HTML output extension to .htm
About this task
By default, HTML outputs have an .html extension, but you can change the extension to .htm by 
adding some metadata to the DITA Map file used to generate the output.

Procedure
1. Start Publication Manager and open the publication.

The Browse Repository window is displayed.

2. Right-click the bookmap and select Check out with in Oxygen XML Author.

3. Put your cursor at the start of the ending Bookmeta tag, press Enter, and select 
othermeta from the list that displays.

4. In the Attributes dialog box, enter .htm in the content field and enter htmlExtensionin 
the name field.

The topic Sample DITA Map set to produce .htm output files provides an example of how 
the attributes should be set to produce an output with an .htm extension.

5. Check in the bookmap, save the publication, and produce the HTML output.
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Support for non-Avaya branded outputs
We provide limited support for producing non-Avaya branded outputs (sometimes called OEM 
outputs). You can make the following changes to remove or change the Avaya branding:

• Replace the Avaya logo

• Remove or change the feedback link in the footer

• Replace the copyright holder in the footer of HTML outputs

• Change the color scheme in HTML outputs

Important:

GIS team members should not remove or replace Avaya branding without the direction of your 
GIS Program Manager.

Adding a custom logo in outputs
About this task
You can substitute the Avaya logo with a custom logo in outputs.
If you already have set up a substitute logo by using othermeta, the same setup works, and you 
do not need to change it.

Before you begin
Upload the image to the appropriate project folder in Tridion Docs. Ensure that the file name is 
unique, preferably the project-specific name.

Procedure
1. Start Publication Manager and open the publication.

The Browse Repository window is displayed.

2. Right-click the bookmap and select Check out with in Oxygen XML Author.

3. Place the cursor before the end bookmeta tag, press Enter and click data.

4. Press Enter and insert the image (wizard).

5. On the Insert image dialog box, navigate to the image that you want to use for the logo, 
and click Insert.
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6. In the Attributes dialog box of the image, type one of the following in the outputclass field.

• For PDF outputs, logo-pdf.

• For HTML outputs, logo-html.

If you use the same bookmap to produce both PDF and HTML outputs, you can include 
two data elements in bookmeta, one with outputclass set to icon-pdf and one with 
outputclass set to icon-html.

7. Click OK.

8. Click SDLTridionDocs > Check in to check in the map.

9. Publish the output and verify that the correct logo is displayed.

Removing the comments link in the footer
You can remove the comment link from the footer of outputs. This procedure is only intended for 
outputs for OEM—branded outputs.

Important:

Do not remove the feedback link in Avaya-branded outputs.

Procedure
1. Right-click the bookmap and select Check out with in Oxygen XML Author.

2. Expand the bookmeta element.

3. Position the cursor before the ending bookmeta tag, press Enter, and select othermeta.

If bookmeta includes a bookid, bookrights, or data element, position the cursor before 
them.

The Attributes dialog box displays.

4. In the content field, type no.

5. In the name field, type feedback.

6. Click OK.

7. Click SDLTridionDocs > Check in to check in the map.

Changing the email address in the comments link in the footer
You can remove the change the email address used in the comment link from the footer of 
outputs. This procedure is only intended for outputs for OEM—branded outputs.

Important:

Do not change the email address in the comments link in Avaya-branded outputs.

Support for non-Avaya branded outputs
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Procedure
1. Start Publication Manager and open the publication.

The Browse Repository window is displayed.

2. Right-click the bookmap and select Check out with in Oxygen XML Author.

3. Expand the bookmeta element.

4. Position the cursor before the ending bookmeta tag, press Enter, and select othermeta.

If bookmeta includes a bookid, bookrights, or data element, position the cursor before 
them.

The Attributes dialog box displays.

5. In the content field, type the email address you want to appear in the comments link in the 
footer of outputs.

6. In the name field, type feedback-email.

7. Click OK.

8. Click SDLTridionDocs > Check in to check in the map.

Customizing the copyright holder
About this task
The copyright holder is the company name that appears in the following places:

• After the copyright date in the legal page
• After the copyright date in quick reference outputs
• In the footer of HTML outputs

This topic provides the steps for changing the copyright holder in all of the locations in our outputs.

Procedure
1. Start Publication Manager and open the publication.

The Browse Repository window is displayed.

2. Right-click the bookmap and select Check out with in Oxygen XML Author.

3. Put the cursor at the start of the ending bookmeta element, press Enter, and select 
bookrights.

If bookmeta includes a data element, position the cursor before it instead of the ending 
bookmeta element.

4. With the cursor at the end of the bookrights element, press Enter, and select 
organization.

5. Put the cursor in the organization element and type the name of the copyright holder, 
such as “Company ABC, inc.”.

Working with output
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6. Click SDLTridionDocs > Check in to check in the map.

Changing the color scheme for a frameset HTML output
This procedure provides the steps for changing the colors used for the bar above the main title, 
the title of the active tab in the navigation, and the topic titles. This procedure is only for the 
frameset (traditional) HTML output. If you’re producing an HTML5 output, see “Changing the color 
scheme for an HTML5 output”.

Procedure
1. Start Publication Manager and open the publication.

The Browse Repository window is displayed.

2. Right-click the bookmap and select Check out with in Oxygen XML Author.

3. Position the cursor before the ending bookmeta tag, press Enter, and select othermeta.

If bookmeta includes a bookid, bookrights, or data element, position the cursor before 
them.

The Attributes dialog box displays.

4. In the Attributes dialog box, enter the name or hex code of the color you want to use in the 
content field and enter theme-color in the name field.

If you choose to use the hex code for the color, make sure you include the hash (#) before 
the number, such as #ff4d6c. If you want to find the hex code of a color, you can use a 
color picking site, such as the HTML Color Picker on the w3schools site.

5. Click OK.

6. Click SDLTridionDocs > Check in to check in the map.

7. Produce the output and validate that the correct color scheme appears.

Related links
Changing the color scheme for an HTML5 output on page 149

Changing the color scheme for an HTML5 output
This procedure provides the steps for changing the colors used for the bar at the top and bottom 
of the output. The HTML5 color bar is a gradient, so there are two colors you must specify. 
This procedure is only for the HTML5 output. If you’re producing an HTML frameset output, see 
“Changing the color scheme for a frameset HTML output”.

Procedure
1. Start Publication Manager and open the publication.

The Browse Repository window is displayed.

2. Right-click the bookmap and select Check out with in Oxygen XML Author.

3. Position the cursor before the ending bookmeta tag, press Enter, and select othermeta.
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If bookmeta includes a bookid, bookrights, or data element, position the cursor before 
them.

The Attributes dialog box displays.

4. Enter the name or hex code of the color you want to use at the top of the color bar in the 
content field and enter gradient-light in the name field.

If you choose to use the hex code for the color, make sure you include the hash (#) before 
the number, such as #ff4d6c. If you want to find the hex code of a color, you can use a 
color picking site, such as the HTML Color Picker on the w3schools site.

5. Click OK.

6. Position the cursor before the ending bookmeta tag, press Enter, and select othermeta.

If bookmeta includes a bookid, bookrights, or data element, position the cursor before 
them.

The Attributes dialog box displays.

7. In the Attributes dialog box, enter the name or hex code of the color you want to use at the 
bottom of the color bar in the content field and enter gradient-dark in the name field.

8. Click OK.

9. Click SDLTridionDocs > Check in to check in the map.

10. Produce the output and validate that the correct color scheme appears.

Related links
Changing the color scheme for a frameset HTML output on page 149

Producing the Eclipse help outputs
About this task
Eclipse help is an HTML-based help output. This output type must be used only with Eclipse-
based applications or if you've discussed using it with Information Architect.
Draft output is not supported for Eclipse outputs.
The context IDs, when present, are always contained in the contexts.xml file. The start file can 
be found in toc.xml, the file mentioned in the toc start tag's topic attribute.

Before you begin
Resolve any errors and make final changes in the topics before you produce a final output for 
delivery. In specific, if the content is localized to ensure that content marked for deletion is not 
included in translation.

Procedure
1. Click the Output tab.

Working with output
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2. Click Add, select the Avaya Eclipse Help, and click OK.

3. When the publishing completes, download the output.

The output is automatically placed into a folder with a name that matches the Eclipse 
Plugin ID entered in the resourceid. This means that you can download the .zip from 
Tridion Docs and extract it directly to the Eclipse plugin directory, and the help comes up 
integrated the next time Eclipse starts.

Producing the Eclipse help outputs
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Chapter 12: Publishing documents on the 
Avaya Documentation Center

Guidelines to publish content on Avaya Documentation 
Center

To publish the content seamlessly on Avaya Documentation Center, you must add required 
metadata.
Also, follow best practices to enhance the content search and filter on Avaya Documentation 
Center.

DITA filename titles
• Avoid special characters::  The Title field of the DITA file in Tridion Docs must contain only 

alphanumeric characters, dashes, and underscores.

Important:
Do not include any special characters, such as trademarks , registered marks, and 
special characters, such as +-!(){}[]^"~:\&||#$@€/><,.‘;=%£&¬|`'“.

• Avoid long topic title::  Ensure that the topic title is not too long, truncate the names of the 
existing topics where required and keep it to 50 characters maximum. Examples of long titles:
When I start the Avaya Communicator client Microsoft Outlook 
displays a security notification mess
Avaya 
Equinox_for_iOS_is_matching_local_contact_details_for_incoming_call_
instead_of_aggregate_con

Important:
Change the name from Topic > Properties. You do not need to create a new version.

• Unique Override Output Filenames::  In a publication, ensure that the Override Output 
Filename in the Baseline tab is unique. Checkout the topic, and remove or change the 
value if you find duplicate override filenames within the publication. See Duplicate override 
filenames on page 305.

Metadata
You need to set the following metadata in the document that you want to publish on Avaya 
Documentation Center
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Metadata Element where the value is set Description
Publication type Publication properties To enable content search by 

document type.
Release number Publication properties To enable content search by 

release number.
Product family and product 
names

Topics properties

Map properties

To enable content search by 
product family and product name.

Bundle name Bookmap/bookmeta/othermeta To identify different releases 
of a publication on Avaya 
Documentation Center.

Homepage Map/topicmeta To make a preferred topic as the 
home or landing page.

By default, legal page is set as 
the homepage.

Cross-reference to topic external 
to the publication

xref/@scope To link a topic to another topic 
that is external to the current 
publication.

Related link related-links/link To link to content or a video topic

Avaya Documentation Center publishing checklist
The checklist provides a high-level process of preparing the content and publishing output on 
Avaya Documentation Center.
Use the check list as reference. You do not have to mark each item when you complete the task.

No. Task Notes

1 Open the publication, and update the 
content for the release.

2 Ensure that DITA topic file 
names contain alphabets, numbers, 
underscores, and hyphens only.

Important:

Avoid registered marks, 
trademarks, and special 
characters, such as +-!(){}[]^"~:\&||
#$@€/><,.‘;=%£&¬|`'“

DITA topic file names with special 
characters might not show up on 
Avaya Documentation Center.

Table continues…
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No. Task Notes

3 In the Publication properties, set the 
correct publication type. For example, 
Administering and Using.

4 Ensure that the following are available 
on Avaya Documentation Center, and 
open an INFOSOLUTIONS Jira ticket to 
request if not already available:

• For new program, the product name

• The product release number for the 
document that you want to publish

5 In the Publication properties, ensure 
that you add the correct release 
number.

Note:

If you do not add a release 
number, your document might not 
show up when the user applies 
filter for this product release.

Table continues…
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No. Task Notes

6 In the bookmap element, add the bundle 
name.

Note:

If you publish the output 
without a bundle name, 
the link to the document 
on Avaya Documentation 
Center contains GUID, the 
bookmap ID. For example, https://
documentation.avaya.com/bundle/
GUID-A58BC730-486D-4FEF-
B67D-9F920127FBF2/page/
AboutHostedServices.html

If you add the bundle name 
and republish the output, a 
second entry gets created for 
the same document on Avaya 
Documentation Center, and this 
time with the bundle name. 
https://documentation.avaya.com/
bundle/UsingAvayaSubscription/
page/AboutHostedServices.html

Contact IA to get the document 
with GUID in the URL removed 
from Avaya Documentation Center.

Preparing content for publishing 
on the Avaya Documentation 
Center on page 156

7 Set the homepage in the ditamap that 
contains the topic you want to set as 
home page.

Preparing content for publishing 
on the Avaya Documentation 
Center on page 156

8 (Optional) Set the scope attribute to 
peer in xref to link to a topic that is 
external to the publication.

Inserting a link to an external 
topic on Avaya Documentation 
Center on page 182

9 In the Output tab of the publication, 
add the Avaya Doc portal output, if not 
already available.

To publish the output on the 
development server, select the 
zoomindocs.avaya-staging output 
type.

10 Ensure that the content in the 
publication shows up correctly on Avaya 
Documentation Center.

Avaya Documentation Center publishing checklist
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Preparing content for publishing on the Avaya 
Documentation Center

About this task
To publish content on the Avaya Documentation Center, you must add the required metadata to 
the bookmap and add the new AvayaDocPortal output format.

Before you begin
• Know the metadata values, such as bundle name, product family, and product name that you 

must provide in the bookmap of the document.
• In the Title field of the topic properties, include only alphanumeric characters, dashes, and 

underscores. Avoid special characters.
• Ensure that the topic that you reference using scope=peer is added to the Resources section 

of the publication.

Procedure
1. In the Tridion Docs repository, select the publication, and check if the Publication Type 

has the correct document type set in the properties.

If you do not add the correct publication type, user cannot filter the information by the 
document type on Avaya Documentation Center.

2. In the publication properties, set Release Number correctly.

Publishing documents on the Avaya Documentation Center
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Important:

If you do not add the correct release number, user cannot filter the information by 
release number on the Avaya Documentation Center.

3. To ensure that the correct product family and product name are set in the bookmap of your 
publication:

a. Right-click the bookmap, click Properties > Avaya-specific fields, and change the 
value if the product family and product are set to Common DITA supporting content or 
any other incorrect project name.

b. If you do not see your project name, check with your lead and open an 
INFOSOLUTIONS Jira ticket to get the name added to the list.

c. To change the values in bulk, from Browse Repository or the Baseline tab of the 
publication, select all topics or maps:

a. Right-click Properties > Avaya-specific fields, and change the product family 
and product names.

b. Click OK.

Preparing content for publishing on the Avaya Documentation Center
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4. To set the bundle name:

a. Check out the bookmap by using the Check out with option to open in Oxygen XML 
Author.

The bookmap opens in Oxygen XML Author.

b. From the toolbar or the DITA > Tags display mode menu, click Full Tags.

c. Place your cursor within the bookmeta element, add a new othermeta element, if not 
already available.

d. Set the following bundle parameters:

• name=bundle
• content=<bundle-name>.

Where <bundle-name> is a unique name that identifies document type, product 
name, and release number.

Important:

Use a unique release number to prevent overwriting documents of the older 
release on Avaya Documentation Center. For example

- For Release 8.1 document, UsingSolutionDeploymentManagerClient_r81

- For Release 8.2 document, UsingSolutionDeploymentManagerClient_r82

e. Check in the bookmap.

5. To set the homepage in the publication:

a. Identify the topic that you want to set as home page.

If you do not set the homepage for a publication, the publication displays the first topic 
on Avaya Documentation Center, which is the legal page.

The best practice is to set the overview or purpose topic as the home page.

b. In Oxygen XML Author, check out the map that contains the topic you want to set as 
home page.

c. Place the cursor in the topicref element.

Publishing documents on the Avaya Documentation Center

July 2024 DITA and TDocs Work Instructions and Guidelines 158
Comments on this document? 

159

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


d. In the Attributes window, set outputclass = homepage.

6. To publish the output on the Avaya Documentation Center, do the following:

a. Add the AvayaDocPortal output type.

b. In the output properties, set the Language combination.

c. To publish output for languages other than English, set the fallback languages for 
Topics and maps, images, and Resources to en-us.

d. Publish the output.

Important:

For AvayaDocPortal output, the document is automatically uploaded to the 
Avaya Documentation Center. You do not have to do anything with the zip file 
produced in Tridion Docs.

7. Go to https://documentation.avaya.com, log in using your global handle and password, and 
verify if the document is published correctly, and topics show up.

Related links
Replacing the document or publishing for new release on the Avaya Documentation Center on 
page 160
Inserting a link to an external topic on Avaya Documentation Center on page 182
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Replacing the document or publishing for new release on 
the Avaya Documentation Center

About this task
The bundle name that you add to the bookmap of a publication must be unique to avoid any 
accidental overwriting of the content on the Avaya Documentation Center. However, if you have to 
make changes to the existing publication, use the existing bundle name.

Procedure
1. To publish content for the new release on the Avaya Documentation Center:

a. Create a new version of the bookmap.

b. Update the bundle name in the newer version of the bookmap.

For example, if the bundle name of the existing publication is 
UsingSolutionDeploymentManagerClient_r70, and you created a new version of 
the bookmap, v.5 to update the content, update the bundle name to 
UsingSolutionDeploymentManagerClient_r80 in the bookmap v.5.

2. To replace the content that is already published on the Avaya Documentation Center:

a. (Optional) Create a new version of the bookmap only if the bookmap is released.

b. Keep the existing bundle name in the bookmap.

For example, if the bundle name of the existing publication version 4 
is UsingSolutionDeploymentManagerClient_r70, and you created a new version 
v.5 of the bookmap to update the content, keep the bundle name 
UsingSolutionDeploymentManagerClient_r70 in the bookmap v.5.

Related links
Selecting the output format for a publication on page 122

Avaya Documentation Center postpublishing checklist
The checklist provides the high-level process to verify the content uploaded on Avaya 
Documentation Center.

Note:
This is a mandatory checklist, and you must mark each item when you complete the task.
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No. Task Action

1 Ensure that the following metadata is 
displayed correctly:

• Product family

• Product name

• Release number

• Document type

Set the properties in:

• Publication: Release number 
and Document type

• Bookmap: Product family and 
product name.

2 From Library or the product landing 
page, open the document, and ensure 
that it does not display Content not 
found message.

Add the legal page in the 
bookmap of the publication if not 
already added.

If you still see the error message, 
open an INFOSOLUTIONS Jira.

3 Ensure that the bundle name defines 
the product name, documentation type, 
and release number of the document, 
instead of the default GUID.

Add the bundle name in the 
bookmap.

4 From Library or the product landing 
page, open the document, and ensure 
that the default home page is set to 
a meaningful topic. For example, an 
overview topic.

If you do not set the homepage, 
the page displays the legal page as 
homepage for the document.

Add the homepage in the topicref 
element in the ditamap where the 
preferred topic is available.

5 From Library or the product landing 
page, ensure that the document does 
not contain a duplicate entry for the 
same release.

The page displays the duplicate entry 
if you republish the same document on 
Avaya Documentation Center with an 
updated bundle name.

Identify the duplicate entry, open 
an INFOSOLUTIONS Jira and 
request to delete the duplicate 
entry.

6 Ensure that you fix any empty 
navigation links at the chapter level.

In the chapter map, add topics 
within the topichead instead of 
adding them directly.

Table continues…
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No. Task Action

7 Ensure that when you open the topic, 
the page does not display Content 
not found.

DITA topic file names with special 
characters does not show up on Avaya 
Documentation Center.

Ensure that the title field 
in DITA topic properties 
contains alphabets, numbers, 
underscores, and hyphens only.

Important:

Avoid registered marks, 
trademarks, and special 
characters, such 
as +!(){}[]^"~:\&||#$@€/><,.
‘;=%£&¬|`'“

8 Work with Information Architect, and 
make the documents for the new 
product release available to customers 
and partners on the GA deadline.

Important:

If you do not perform 
the step, customers and 
partners cannot view the 
documents for this product 
release.

Related links
Preparing content for publishing on the Avaya Documentation Center on page 156

Adding videos in a document

Videos in documents
As part of GIS Cloud Strategy, we deliver video content in documentation that is delivered to 
Avaya Documentation Center. The videos include the product videos created by Avaya learning 
team and Avaya mentor videos hosted on You Tube.

Avaya Documentation Center supports the following:

• Direct access to videos through the Video publication

• Jump to the relevant video from a topic

• Search and filter videos

Preparing for adding videos in a document
About this task
Some high-level tasks that the GIS Lead/Writer needs to perform before adding videos in a 
document.

Publishing documents on the Avaya Documentation Center
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Procedure
1. Arrive at the video topic list, video duration, video type and audience/persona.

Note:

Arrive at the video topics, list the user/audience persona and arrive at the top 10 or 
20 topics these persona will be performing on your product. In your documents, map 
these topics to your content.

2. Map the video topic with the content in your document. Identify the documents (Using, 
Quick Reference, Deploying, Administering, Overview and Specification) vis-a-vis videos 
that you will add in the document.

Here is a sample spreadsheet for mapping videos to your content.

Table 1: Sample spreadsheet

Document Overview & 
Specifications

Administering Using Troubleshooting
Title

Understanding 
J179 IP Phone

-

Setting up users - -

Adding an 
account

- -

Reindexing the 
site

- - -

3. Work with the Avaya Learning team on story-boarding these topics.

4. Review and approve videos.

5. Involve the Localization team if your program is being localized.

Implementing videos in a document
About this task
Implementing videos in documents involves two major tasks.

Procedure
1. Create a video publication and add all video topics for the project.

2. Provide references to the video topics in documents, such as Using and Administering.

Adding videos in a document
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Creating a video publication
About this task
Create a separate publication where you can add all video topics.

Procedure
1. Create a new publication using the new Video Publication template.

Ensure that the Publication type is set to Videos.

2. Create a new bookmap using the new Videos map template.

Note:

Do not add the legal topic or any normal topic such as, concept, task, and reference in 
the Videos bookmap.

3. Create chapter maps to organize your video topics.

4. Create a reference type topic and check out the topic.

5. Press Enter, select the object element, and add the following attributes from the 
Attributes window:

• data: <url of the video>

Example: https://cdn.avaya-learning.com/CDN_EU/CCaaS/21380W/sav/index.html?
id=52984896d532adecb88a0333dc1c037a

To reference videos from YouTube, for example, the caUGylLdw08 video, enter 
https://www.youtube.com/embed/caUGylLdw08. Note that the path must 
contain /embed/.

• outputclass: iframe

6. In Oxygen XML Author, go to the Text view at the lower-left corner, and add the full view 
parameter <param name="allowfullscreen" value="true" /> inside the object 
element.

For example:
<object data="https://cdn.avaya-learning.com/CDN_EU/xxxxxx" outputclass="iframe">
<param name="allowfullscreen" value="true" />
</object>

7. Repeat Steps 4 through 6 for each video.

Note:

Add one video in a topic.
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8. Add maps into the video publication and add the video topics into appropriate maps 
logically organizing the topics.

9. Publish the AvayaDocPortal output to upload the videos publication on Avaya 
Documentation Center.

Linking video topics in documents
About this task
You can reference the video topics in documents, such as Using, Overview and Specification, 
Deploying, and Administering.

Procedure
1. Open the publication, such as Using <product> and check out the topic where you want to 

reference the video topic.

2. At the end of the topic, place the cursor between body and root elements, press Enter 
and add the related-links element.

For example, between the end of taskbody and task elements.

3. Inside related-links, press Enter and do the following:

a. Select link (web link).
b. In the URL field of the Web Link dialog box, type <link to the video topic on 

doc center>.

Example, https://documentation.avaya.com/
bundle/ExperiencePlatformApplicationCenterAdministrationVideos/page/
Assigning_agents_for_Proactive_Outreach.html

c. Click OK.

The Avaya Documentation Center output displays the complete URL as the link text.

Adding videos in a document
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4. To change the link text, place your cursor in the link element, press Enter and click 
linktext, and enter the video title.

5. In the Attribute window of the link element, set the following attributes:

• href: <link to the video topic on doc center>, if not already provided in the 
Web Link dialog box.

• scope: external
• type: video

Type video if you do not see the option in the type field.

In the Text view of the editor, you will see <link href="https://documentation.avaya.com/
bundle/page/<video topic.html>" format="html" scope="external" type="video">Video 
title</>

6. Check in the topic.

Note:

You can link more than one video topic in a topic. Add a new link element for each 
video topic that you want to link.

7. Repeat Step 2 through 5 for all topics where you want to reference video topics.

8. Publish the AvayaDocPortal output to upload the content on Avaya Documentation Center.

9. Verify that the links to video topics appear and are active.

Publishing video content on Documentation Center
Procedure

1. Publish both the video publication and the documents where you have linked the videos 
on Avaya Documentation Center, for example, Using, Getting Started, Overview and 
Specification, Deploying, and Administering.

2. To verify your video content, using the zoomindocs.avaya-staging output format, publish 
the content on the development server https://avaya-dev.zoominsoftware.io/.

You may then publish the content on Avaya Documentation Center production.

Publishing documents on the Avaya Documentation Center
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3. Using appropriate credentials for development and production Avaya Documentation 
Center sites, log in and verify the published videos and links to videos.

Verifying video content on Documentation Center
Procedure

1. Open Avaya Documentation Center, log in if required, and navigate to the document that 
has videos.

2. Run the videos.

3. Verify that the Full view option is available.

4. Ensure that the download option is disabled.

Maintaining video content on Documentation Center
Procedure

1. Periodically, check if the video topics are available and ensure that they are not removed 
from the publications.

2. In the documents, check if the video links under the Related videos section are active.

3. Periodically, check if Avaya learning team has:

• Added any new videos for the program.

• Removed any existing videos for the program.

• Updated links to videos for the program.

4. Get approval from your Doc lead or Product Owner before you add a video publication.

5. Review the guidelines or consult your Doc lead if you are creating a new video publication 
or adding a new video to an existing publication for the first time.

Removing videos from Documentation Center
About this task
If the content of the video is obsolete, not relevant anymore, or not required in a document, you 
need to do one or both as appropriate:

• Remove the link to the video from the content.
• Remove the video topic completely from the document.

Procedure
1. From Tridion Docs, open the publication that contains references to videos, such as Using 

and Administering, and do the following:

a. Check out the topic where you referenced the video topic.

b. Remove the link element or the entire <related-links> element.

c. Republish the document on Avaya Documentation Center.
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d. On Avaya Documentation Center, in the referenced topic, verify that the reference to 
the video has been removed in the Related Videos section.

2. From Tridion Docs, open the Videos publication, and do the following:

a. Remove the video topic.

b. Republish the document on Avaya Documentation Center.

c. On Avaya Documentation Center, verify that the video has been removed from the 
document.

Considerations for linking Videos in documents
• You can combine the following types of linking for a topic in a publication:

- Link to one or more video topics using the <related-links>/link element in the source topic.

- Link to one or more content topics using relationship table in the ditamap.

• Do not use relationship tables in ditamap to link video topics. If you do so, the video topics 
will appear within Related links instead of Related videos, which is incorrect.

Best practices

Avoiding accidental overwriting of output on Avaya 
Documentation Center

• Uploaded documents for the major release, for example, 4.0, on Avaya Documentation 
Center.

• Started work on a Feature Pack or Service Pack for that product.

Potential issue
If you accidentally publish the Avaya Documentation Center output of the working copy, the 
content gets updated on Avaya Documentation Center.
Avaya Documentation Center overwrites the output because the publication for Feature 
Pack\Service Pack and the major release share the same bundle name.

Best practice 1
This applies when you are updating the content for Service Pack of the current release where 
you need to replace the document on the Avaya Documentation Center.
1. Delete the Avaya Documentation Center output formats from the current working copy of 

the publication in Tridion Docs.
2. Add the AvayaDocPortal output format only when you plan to upload the content on the 

Avaya Documentation Center.

Publishing documents on the Avaya Documentation Center
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Best practice 2
This applies when you create or update content for a new release, and upload as a new 
document on the Avaya Documentation Center.
1. In the new version of the publication that you created for a new product release, set the 

new release number for which you are creating the content.
For example, 4.0.

2. Update the bundle name in the new version of the bookmap.
For example, change the bundle name from DeployingOceanaSolution_r3.9 to 
DeployingOceanaSolution_r40.
With the new bundle name and the release number, even if you accidentally publish 
the AvayaDocPortal output, Avaya Documentation Center creates a new entry of the 
document, and does not overwrite the existing document.

Related links
Preparing content for publishing on the Avaya Documentation Center on page 156

Best practices

July 2024 DITA and TDocs Work Instructions and Guidelines 169
Comments on this document? 

170

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Chapter 13: Linking and references

Types of linking in DITA
There are two basic types of linking in DITA:

• Links in topics (inline links): Cross-references

• Links in maps: Hierarchical links and relationship table links

Links in maps
Related links are links that do not appear in the topic source. These links are automatically 
generated from DITA Maps.

There are two types of related links:

• Hierarchical

• Relationship table

Because related links are automatically generated from the DITA Map, they allow the topics to be 
used in different contexts. Related links are less disruptive to flow than inline links. But it’s still 
important to make sure that you use them appropriately so that you don’t overwhelmed users with 
too many links.

A couple of examples of good related links

• A topic might include instructions for a command that has a lot of  parameters and variables. 
A relationship should be created in the relationship table between the task and command 
reference topic.

• A task topic might need related links to other task topics. For example, a task about 
performing a system backup might need to link to a task topic about restoring the system 
database from a backup.

Cross-reference links in topic
You can use cross-references to link to information to another topic, an external webpage, or file.

Where possible, manage links between topics in relationship tables. The use of cross-references 
can cause issues, especially with reused content.

• If you own common content that is reused, avoid using cross-references to topics wherever 
you can. When you use xrefs to topics and someone reuses your content, if they aren’t 
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reusing the topic that’s the target of the xref, they’ll end up with a broken link in their output. It 
also causes potential problems related to localization, which are explained below.

• If you reuse a topic that contains an embedded xref and the target topic is not included in 
your deliverable, your output will contain a broken link. If you’re reusing topics that include 
xrefs to topics, request that the content owner move the xref to a relationship table link 
instead.

• When you reuse content that contains embedded xrefs, that creates a dependency on the 
topics that are the target of the xrefs. If the content is localized, all content that is referenced 
is included in the package sent for translation. So if you’re reusing content that includes xrefs 
to other topics, those other topics are included in the package for localization, even if you are 
only reusing an element in that topic that does not include the xref. This increases translation 
costs.

• If you create relationships between topics, you do not need to include a text reference to that 
topic.

You can use cross-references in the following situations, but consider the implications for reuse 
and ensure that you also include the target topics in the publication:

• High-level tasks or checklists.

• Complicated task topics that document multiple pages or dialog boxes in an application.

• New in this release or Change history topics.

• Reference to external targets, such as websites.

• The user might lose the context of the link unless the link is included in the appropriate text 
element.

Related links
Inserting a cross reference to another topic on page 179

Hierarchical links and relationship table links

Hierarchical links
When you nest topics within a ditamap, Tridion Docs automatically generates hierarchical links in 
the output. The links are created from the parent to the nested child topic and vice versa.

Hierarchical links do not show in the topic source like the relationship table links. You can view the 
links only in the output.

You do not require the hierarchical links to be visible in the output for the following reasons:

• The nested child topics immediately follow the parent topic.

• The parent topic displays links to all the nested topics that might distract the reader.

Hierarchical links and relationship table links
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You can hide the hierarchical links generated from nesting topics by updating the XML attributes of 
the topics in the map.

Ensure that the hierarchy that you create between topics adds value. For example, an overview 
topic should be a peer of the other topics in a component rather than a parent. You can use a topic 
head to organize topics and avoid the hierarchy.

Related links
Suppressing linking to nested topics on page 173

Linking attributes
Use the Linking attribute to control the behavior of relationship table links or parent/child topics 
in the topic hierarchy (top part of a map). These settings only apply to the topics in the specific 
context. For example, if a topic appears twice in a relationship table, setting the linking attribute in 
one relationship does not affect the linking behavior of the topic in another relationship.

Child topics inherits the Linking attribute from the parent. If you produce an output and don’t see 
the linking you expect, it could be because the Linking attribute is set on the parent topic.

Attribute Description
(None) This is the default behavior:

• In the topic hierarchy, parent topics contain links 
to nested child topics in the output, and the child 
topics have a link to the parent topic.

• In relationship tables, links go both ways.
None There is no linking—the topic cannot be linked to 

and it cannot link to other topics.
Normal This is the same as the default behavior. A topic 

can be linked to and can link to other topics. Use 
this only to override the linking value of a parent 
topic.

Target only A topic can only be linked to and cannot link to 
other topics. This is used often to suppress links 
from parent to nested child topics and to define one-
way relationships in relationship tables.

Source only A topic cannot be linked to but can link to other 
topics. We typically use Target only on the parent 
topic, but you can use this attribute if there are 
multiple child topics and some require different 
behavior than others.

If you use Source only in the topic hierarchy, you 
must set the Linking attribute on the child topics to 
Normal or Target only.
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Suppressing linking to nested topics
Procedure

1. Open the publication and navigate to the topic with nested topics that you want to suppress 
the links to.

2. Right-click the topic and select XML Attributes.

3. In the Insert Values for ‘Topic Ref’ dialog box, select None or Target only from the Linking 
menu.

4. Click OK.

Related links
Linking attributes on page 172
Hierarchical links on page 171

Topic sequences in HTML outputs
In a DITA Map, you can create topic sequence type of linking when there’s an order to topics that 
you want to show in the related links. The sequence type of linking is used in HTML outputs and 
shows as next and previous links at the bottom of the topics.

Note:

In PDF outputs, the related links does not show sequencing.

Important:

Create sequences only when a definite order in which the topics should be read or performed 
in a specific order. Creating sequences of your entire publication is not appropriate because 
there’s not a real sequence to many topics, like topics in your overview or a group of 
administration tasks that can be performed at any time in any order. If there are related topics 
you’d like to point the user to, you should use regular relationship table links.

To set up sequencing, you can use the topicgroup element in a reltable row in the DITA Map. 
When setting up a sequence, consider the following:

• If the topic order in the hierarchy matches the order that you listed within the map, you can 
just wrap the topics in the hierarchy with the topicgroup element instead of using the reltable. 
This won’t be very common.

• If the sequence is different than the topic order, you can set up the topicgroup in the reltable, 
copy the topics into the topicgroup, and use the toc attribute to hide the duplicate topics in the 
TOC.

• If you use the same map in a publication from where you produce a PDF, you can use the 
HTML condition to hide the sequence topicgroup in the PDF if you do not want the related 
links to appear in the PDF.

• If you use the same publication to produce the PDF and HTML outputs and you want to use 
the HTML condition to hide the topicgroup in the PDF, you must consider creating a separate 
publication for the HTML. Alternatively, you need to change the conditions back and forth to 
produce the outputs and that introduces risk, and not recommended.

Hierarchical links and relationship table links
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• You can technically set up a topicgroup in the topic hierarchy of a DITA Map. If you do 
that, ensure that you apply the HTML condition to the topicgroup to exclude it from the PDF 
output. Otherwise, the topics will appear in the PDF twice.

Use the topic sequencing only in situations where it adds value and there’s an actual sequence to 
the topics.

Defining topic sequence linking for an HTML output
Use this procedure to define a topic sequence in a DITA Map that will display as next and previous 
topic links at the bottom of the topics in an HTML output.

Procedure
1. Open the publication and navigate to a reltable in the map where you want to define the 

sequence.

2. Add a new relationship table row.

3. Right-click one of the elements in the row and select Add Within > Topic Group.

All of the topics you want to include in the sequence might not be the same topic type. In 
this case, just choose the topic type that most of the topics belong to.

4. When the Insert Values for Topic Group dialog box, displays:

a. Select Sequence as the Collection type.

b. If the map is also being included in the PDF and you don’t want the related links to 
appear in the output, set the Condition to HTML.

c. Click OK.

5. Copy the topics that make up the sequence into the topicgroup

If you didn’t set up a topicgroup separately from the topic hierarchy, as noted in step 2, skip the 
following step.

6. For each topic in the topicgroup, set the toc attribute to no.

Linking and references
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Relationship tables
Relationship tables overview

Each DITA Map or BookMap can contain an optional relationship table, which identifies the links 
between the topics in the map.

Each row of a relationship table represents a relationship. For example, if you include a task topic 
and a reference topic in a row of a relationship table, those topics will have links to each other 
when you generate an output. If you have multiple topics that relate to another topic, yet those 
topics do not relate to each other, you must create individual rows in the relationship table for each 
relationship.

Create rows in a relationship table to link within each component. For cross-component linking, 
you can create the relationships in the parent map that includes those components.

Links can go out of control, therefore, create relationships between topics that have a strong 
relationship, rather than just linking to topics with tangential relationships. For example, linking all 
tasks in a component to every task does not make sense because the user can see those tasks 
in the table of contents and will understand that they are all related to the same general topic. If 
topics have a strong relationship to each other, you can add the relationship in the relationship 
table.

Relationship table guidelines
Add topicrefs to the correct column
When adding topicrefs to a row in a reltable, make sure that you add the topicref to the 
appropriate column based on the topic type. For example, all topicrefs to concept topics should be 
added to the Concept row. Structure topic references should be added to the Structure column.

Including multiple topics of the same type in a row
You can include multiple topics of the same type in a row of a relationship table and create 
links between those topics. To do this, enclose the topicrefs in a topicgroup element and set the 
collection-type attribute to family for that topicgroup.

Avoid xrefs to topics
Every link you need to create to topics should be defined in a relationship table rather than as an 
xref in a topic, if possible. There are issues with using xrefs to create links to topic, especially with 
reused content:

• If you own common content that is reused, avoid using cross-references to topics wherever 
you can. When you use xrefs to topics and someone reuses your content, if they aren’t 
reusing the topic that’s the target of the xref, they’ll end up with a broken link in their output. It 
also causes potential problems related to localization, which are explained below.

• If you reuse a topic that contains an embedded xref and the target topic is not included in 
your deliverable, your output will contain a broken link. If you’re reusing topics that include 
xrefs to topics, request that the content owner move the xref to a relationship table link 
instead.

• When you reuse content that contains embedded xrefs, that creates a dependency on the 
topics that are the target of the xrefs. If the content is localized, all content that is referenced 
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is included in the package sent for translation. So if you’re reusing content that includes xrefs 
to other topics, those other topics are included in the package for localization, even if you are 
only reusing an element in that topic that does not include the xref. This increases translation 
costs.

• If you create relationships between topics, you do not need to include a text reference to that 
topic.

There are some limited cases where it's better to embed the xref directly in the topic content. For 
example, in an installation checklist or when the context of the link would be completely lost by not 
embedding it in the text.
It’s not an issue to include xrefs to external targets, such as Web sites.

All topics included in the relationship table must be included in the map hierarchy
A known current limitation is that links to topics external to the map cannot be resolved. So, if you 
have a reference in a relationship table that is not part of the output you’re producing, the link 
won’t be resolved. So you must include any topics that you want to link to in the hierarchy of the 
map. If you do not want the topic to be included in the PDF output, set the print attribute to no. If 
you do not want the topic included in the table of contents of the HTML output, set the toc attribute 
to no.

Text references in content to topics participating in relationship tables
Don’t include text references to a topic that you’re linking to via a relationship table unless 
necessary. Benefits of using reltables include the flexibility of where you use the topic and 
minimizing distractions for the reader. When you add a reference in the topic text, you create 
a dependency, even if the dependency is not a physical one. And it’s queue to the reader that they 
should stop reading this topic and go to the one that’s being referenced. If you do feel that a text 
reference is important, tag the text reference with the <q> element.

Include information about relationship table links in topics
It’s a really good practice to include an XML comment at the top of topics to indicate any topics 
they have relationship table links to. This is especially important for topics that are reused so that 
writers reusing that topic can see the topics the writer is linking to in a relationship table and can 
set up the same relationships in their maps.

One relationship link type that does not work
Relationship table links do not work from topics that are the first or only topic in a chapter or 
appendix.

Adding relationships
Relationship tables define the relationships between topics. Each row or the Relation element in 
the relationship table represents a relationship. The links appear in the output at the bottom of 
each topic as related links.

About this task
You can add relationships between topics using a relationship table in the map. If you are using 
the same relationship table in a DITA map and a bookmap, you can reuse the relationship table 
rather than create it in both places or copy it from one to the other.

Linking and references

July 2024 DITA and TDocs Work Instructions and Guidelines 176
Comments on this document? 

177

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


You can create relation between two or more topics of any type. However, you must group topics 
that you want to relate using the topic group element. A topic group under a Relation element 
must contain topics of same topic type.

Note:
Relationship table links do not work from topics that are the first or only topic in a chapter or 
appendix.

Before you begin
Create a DITA map or bookmap.

Procedure
1. Open the publication in Publication Manager.

2. Check out the map where you want to create or modify the relationship.

3. To add a relationship to the relationship table:

a. Expand an empty row in the Relationship Table element, or, if the table does not 
contain empty rows, right-click the Relationship Table element, and then click Add 
Within > Relationship Row.

A Relation element indicates a row or a relation. A relation element or a row contains 
a relation element for each topic type, such as Relation task, Relation concept, and 
Relation reference.

Note:

Add topic of type that match with the Relation element. For example, add all task 
topics under the Relation task element and set the link attribute to each topic.

b. Right-click the Relation element that matches the topic type of the topic that you want 
to add, and then click Add Within > Topic Ref.

For example, to add a task topic to the relationship table, right-click the Relation task 
element, and then click Add Within > Topic Ref.

c. Click Browse, and then browse to and select the topic to add to the relationship.

d. In the Linking field, set an attribute to the topic.

• Target only: To link the topic from other topics in the relationship but prevent the 
topic from linking to other topics in the relationship.

With Target only, other topics in the relationship does not appear in the current topic 
as related topics.

• Source only: To link other topics in the relationship to this topic but prevent the topic 
from appearing in other topics.

e. Click OK.

f. Repeat steps b through e to specify the topics that are related to the first topic.
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4. To create a relationship between more than one topic of the same type, add a topic group 
within the Relation element for that topic type, for example, Relation task:

a. Right-click the Relation element where you want to add the topic group and select 
Add Within > Topic Group.

Ensure that you add the topic group to the appropriate Relation element. For 
example, if you are creating a relationship between two tasks, add the Topic Group to 
Relation task.

b. In the Collection type field of the Insert Values of ‘Topic Group’ dialog box, select 
Family, and then click OK.

c. Right-click the Topic Group element, and then click Add Within > Topic Ref.
d. Click Browse, and then browse to and select the topic to add to the Topic Group.

e. Set any other attributes required for the topic relationship, and then click OK.

f. Repeat steps c through e to specify other topics in the topic group.

5. Repeat steps 3 and 4 as necessary to add relationships to the relationship table.

6. Check in the map.

Note:

It’s a really good practice to include an XML comment at the top of topics to indicate 
any topics they have relationship table links to. This is especially important for topics 
that are reused so that writers reusing that topic can see the topics the writer is linking 
to in a relationship table and can set up the same relationships in their maps.

7. (Optional) If you want to reference topics that you created links to using a reltable, you 
can include text references to those topic and wrap the topic title with the <q> element.

Related links
Linking attributes on page 172

Removing relationships
About this task
Use this procedure to remove a relationship and all topic references that it contains (Relation 
element), a specific topic reference in a relationship, or a topic group in a relationship.
When you remove a topic from the map in a publication, you must remove all relationships that is 
set to the topic.

Procedure
1. Open the publication in Publication Manager.

2. Check out the map from which to remove a relationship.

3. Expand the relationship table.

4. Right-click the element to remove, Relation, Topic Group, or Topic Ref, and then click 
Delete.
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Cross-references (inline links)

Inserting a cross reference to another topic
About this task
Create links between topics in relationship tables rather than cross referencing using the xref 
element. You use xrefs for specific purpose, such as checklists.
When you insert an xref to a topic that has multiple versions, the link automatically goes to the 
version of the target topic that you’re using in your publication. So you don’t have to worry about 
selecting the wrong version to link to.

Procedure
1. Check out the topic in which you want to insert the cross reference.

2. Place your cursor in the location where you want to add the cross reference and press 
Enter and insert the xref (cross reference) element.

Alternatively, from the toolbar, click the link icon ( ) and select Cross Reference.

The Cross reference (xref) dialog box is displayed.

3. Click the Tridion Docs icon ( ), browse and select the topic that you want to reference.

4. Click Insert and close.

Related links
Cross-reference links in topic on page 170

Inserting cross references to elements within a topic
About this task

Important:
Linking to elements within the same topic creates circular references. If number of circular 
references in a publication reaches a threshold number, Publication Manager crashes while 
opening the publication. Therefore, avoid linking to elements within the same topic.
Instead, add the element in a common topic and reference in the topic any number of times.

Do not link to title elements within other elements. Link to the parent element instead. For 
example, to link to a table within a topic, add the ID to the table element rather than to the 
title element.

Important:
Link text for cross references to specific elements is not updated automatically if you change 
the title of the cross-referenced element. For example, if you cross reference a figure with a 
title of “Front view of server” and use that title for the link text of the cross reference, the link 
text is not automatically updated if you change the figure title to “Front view of S8800.” If you 
change the title of an element that is cross referenced, you must manually update the link text 
of the cross references.

Cross-references (inline links)
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Procedure
1. Assign an ID to the element that you want to link to if it does not already have an ID.

Do not use numbers for IDs, and never use a single number. Use a descriptive ID instead.

2. Save and check in the topic that has the element ID.

3. Check out the topic in which you want to insert the cross reference.

4. Place your cursor in the location where you want to add the cross reference and press 
Enter and insert the xref (cross reference) element.

Alternatively, from the toolbar, click the link icon ( ) and select Cross Reference.

The Cross reference (xref) dialog box is displayed.

5. Click the Tridion Docs icon ( ), browse and select the topic that you want to reference.

6. From the window, select the element that you want to reference.

7. Click Insert and close.

Related links
Adding an ID to elements on page 193

Inserting a cross reference to a non-DITA file
About this task
You can insert a cross-reference to a PDF or Excel spreadsheet. A user who views the HTML 
must have appropriate application installed to view the type of file you want to include. Therefore, 
include common file types, such as PDF or Excel.

Before you begin
Before you can link to a non-DITA file, like an Excel spreadsheet or PDF, you must do the 
following:

• Import the file into Tridion Docs.
• Include the file in the appropriate DITA map.

Procedure
1. Check out the topic in which you want to insert the cross reference.

2. Place your cursor in the location where you want to add the cross reference and press 
Enter and insert the xref (cross reference) element.

Alternatively, from the toolbar, click the link icon ( ) and select Cross Reference.

The Cross reference (xref) dialog box is displayed.

3. In the Cross reference (xref) dialog box, browse and select the file that you want to 
reference.

4. Click Insert.

Linking and references
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5. For Excel spreadsheet or Word file, set the format attribute on the xref:

a. Double-click or select the xref element.

b. In the Attributes window, enter xslx, xsl, doc, or docx in the format field.

You do not need to set the format for PDFs. RWS supports PDF, Excel, and Word file 
formats.

c. Click OK.

Related links
Importing non-DITA files to Tridion Docs on page 28
Adding a non-DITA file to a map on page 51

You can reference a non-DITA files, such as PDF and Excel in a map.

Inserting a link to a web site
Procedure

1. Check out the topic in which you want to insert the cross reference.

2. Place your cursor in the location where you want to add the link and press Enter and 
insert the xref (web link) element.

Alternatively, from the toolbar, click the link icon ( ) and select Web Link.

The Web Link dialog box is displayed.

3. In the Web Link dialog box, type the full URL address in the URL field, for example, 
https://documentation.avaya.com.

Important:

Avoid any empty spaces in the address to keep the address valid. Ensure you include 
%20 for any spaces in the address.

4. (Optional) To add the link text, at the bottom of the editor, click the Text tab:

Change:
<xref href="https://documentation.avaya.com" format="html" scope="external"/>

To:
<xref href="https://documentation.avaya.com" format="html" scope="external">Avaya 
Documentation Center</xref>

By default, the link text is the URL that you type in the URL field.

5. Click OK.

Cross-references (inline links)

July 2024 DITA and TDocs Work Instructions and Guidelines 181
Comments on this document? 

182

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


The scope attribute is automatically set to external when you use the xref (web link) 
element.

Important:

If the scope is not set to external, Tridion Docs processes the link as internal, and 
converts the address to all caps.

Inserting an email link in a topic
Procedure

1. In Oxygen XML Author, check out the topic.

2. Place your cursor in the location where you want to add the link and press Enter and 
insert the xref (web link) element.

Alternatively, from the toolbar, click the link icon ( ) and select Web Link.

The Web Link dialog box is displayed.

3. In the Web Link dialog box, enter the email Id in the format mailto:<email address>.

For example, mailto:jmiller@avaya.com
4. To add the link text, at the bottom of the editor, click the Text mode:

Change:
<xref href="mailto:jmiller@avaya.com" format="html" scope="external"/>

To:
<xref href="mailto:jmiller@avaya.com" format="html" 
scope="external">jmiller@avaya.com</xref>

5. Click Insert and close.

Inserting a link to an external topic on Avaya Documentation 
Center

About this task
If you are developing content to publish on Avaya Documentation Center, you can link to a topic 
that is part of another HTML output already published on Avaya Documentation Center.
The link must be active on Avaya Documentation Center though the target topic is unavailable in 
the same publication. You can apply the scope=peer attribute on the xref element so that when 
you produce the HTML output, the system inserts the link without trying to locate the target. If you 
publish a PDF, the link will be inactive and the link text in the xref element will be formatted as a 
text reference.

Important:
Do not set the scope attribute to peer on xref elements unless you are publishing to Avaya 
Documentation Center. If you need to use scope=peer, contact Information Architect.

Linking and references
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Before you begin
The target topic must be available in at least one of the publication on Avaya Documentation 
Center.

Procedure
1. Check out the topic in Oxygen XML Author.

2. Place your cursor in the location where you want to add the cross reference and press 
Enter and insert the xref (cross reference) element.

Alternatively, from the toolbar, click the link icon ( ) and select Cross Reference.

The Cross reference (xref) dialog box is displayed.

3. Click the Tridion Docs icon ( ), browse and select the topic that you want to reference.

4. Click Insert and close.

5. Double-click the xref element, in the Attributes window, set the scope attribute to peer.
6. Click OK.

7. To add the link text, at the bottom of the editor, click the Text tab, and add the following link 
text:

<xref href="<GUID or link to the topic>" format="html" scope="external"><Add link 
text here></xref>

8. Add topics that you have referenced with scope=peer to the Resources folder located at 
the bottom of the publication.

a. Open the publication in Publication Manager if not already open, and go to the 
Contents tab.

b. In the desktop repository, locate the topic that you referenced using scope=peer and 
drag it to the Resources at the bottom of the publication.

Important:

Do not include topics under Resources that are not set with scope=peer.

Cross-references (inline links)
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Example
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Chapter 14: Reusing content and viewing 
reuse information

Reuse in DITA
With DITA, reuse is not limited to single-sourcing multiple types of output from the same source 
topics. Reuse allows you to create a chunk of content in one topic and reuse that content in 
multiple topics, DITA maps, or patterns, even across several projects. A reusable chunk of content 
can be a component with multiple topics, a single topic, or a content element within a topic.
Implemented properly and consistently, this strategy provides the following benefits:

• Simplifies and reduces the time required for maintenance of content with automatic updates 
when the source content is modified.

• Eliminates the possibility of contradictory information in documentation caused by 
inconsistently applied updates.

• Enhances usability and user comprehension with more standardized wording.
• Reduces localization costs with fewer unique words to translate.
• Allows for a more balanced division of responsibility between writers on a project.

You can also incorporate content from other documentation sets, if those other projects 
are in DITA. For example, the Avaya one-X® Portal implementation requires configuration of 
Communication Manager and Modular Messaging. If documentation for those two products was 
in DITA, Implementing Avaya one-X® Portal could reuse the appropriate topics, instead of sending 
users out to find the content in the other documentation sets.

Note:
If you implement reuse in a way that is not mentioned in these guidelines and examples, 
share this information with the rest of the team. We all benefit from increased reuse.

Reuse types
Component reuse
A component is a group of topics and a related DITA map that are intended to be reused as 
a complete set. For example, you can create a DITA map with a series of topics that describe 
how to troubleshoot issues in the Administration application. You can use this DITA map in the 
Administration application deliverable and in the central troubleshooting deliverable.
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Topic reuse
You can reuse a single topic between deliverables. For example, an overview topic that describes 
a feature can be used in the What's New deliverable, the feature-specific deliverable, and the user 
guide.

Content element reuse
A content element is the chunk of content contained inside a DITA element. Examples of content 
elements include a bulleted list, a step in a procedure, an application name, a product name, and 
a field or menu option name from a user interface.

Common topics
A common topic is a DITA topic that can store content that we expect to reuse in other 
publications of same product or another product. Depending on the content, you may reuse the 
entire topic, a paragraph, tip, or other content element in the topic.
Common topics with reusable elements are not included in a deliverable or ditamap. These 
common topics are used as containers to hold product-specific or other common text elements 
that we meant to reuse in other topics.

Location of common topics
Common topics are usually stored in folders named Common in the repository. Common folders 
exist at multiple levels, according to the expected type of reuse for the content.

Cross-project common topics
Cross-project topics are intended for use in all projects or a large number of projects. Cross-
project common topics include the following content:

• Reusable elements for the names of Avaya products, applications, or snap-ins, such as 
Applications, Product names, or Snap-in names. These files are stored in Tridion 
Docs under Common DITA Supporting Content/Products Applications and 
Languages/topics.

• Legal page elements, such as Notices. The file is stored in Tridion Docs under Common 
DITA Supporting Content/Legal/Legal page/topics.

• Common document titles: each project should maintain a list of their document titles under 
Common DITA Supporting Content/Project document titles.

• Glossary topics: The editors maintain common glossary topics in Tridion Docs under Avaya 
Standards Processes and Glossary Terms from where all writers can reuse. When 
you’re building a glossary, you must check if the terms you need are already available. If not, 
you can provide the content to the editors and request them to create glossary topics.

Project-level common topics
Project-level common topics are intended for use in the deliverables for a single project. These 
common topics must include project-specific terms, names, and phrases that may change and 
need be referenced into multiple topics or components. The project team maintains these topics in 
a Common subfolder of the project folder in the repository.

Reusing content and viewing reuse information
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Project-level common topics can include one or more of the following types of content:
• Product or application features
• List of project deliverables
• Frequently used admonishments or other content elements
• Standard troubleshooting topics

Deliverable-level common topics
Deliverable-level common topics are intended for use in a single deliverable. These common 
topics can include steps, admonishments, or descriptions that may change and need be 
referenced into multiple topics or components. The deliverable or component owner can maintain 
these topics in the deliverable folder or in the Common subfolder of the project folder in the 
repository.
Deliverable-level common topics can include one or more of the following types of content:

• Frequently used descriptions or admonishments
• Frequently used steps in a task, such as opening a settings dialog box.
• Names of application elements, such as dialog boxes, windows, and pages.
• Reusable information for alarm topics

Reuse and localization
Even if your deliverables are not currently translated into other languages, you must create your 
topics to make them translation-ready for future.

Based on customer requests or business needs, translation request might come even after the 
release of a product.

Element reuse
You can reuse inline elements, such as uicontrol, wintitle, and cite. This helps the Localization 
team and writers to manage the common elements well.

• Create separate common topics for the uicontrol and wintitle elements that you reuse. 
Depending on the complexity of your product and the number of interfaces, you can decide 
to have separate common topics based on the types of users (for example, administration 
versus users) or separate interfaces.

• The Localization team requests that you create separate common topics for inline elements 
that are part of the interface versus those that aren’t. For example, a filename that they 
double-click during installation must be tagged with uicontrol but it is not an element in the 
interface. Therefore, the filename must be added in a separate common topic from the actual 
interface elements. You can contact your Localization team member to request a list of the 
strings from the interface.

• You must reuse inline elements only where it is semantically appropriate. For example, if a 
term is used as both a uicontrol and a generic word, reuse only the uicontrol element when it 
is specifically referencing the interface element and not when it is a generic reference.

Reuse and localization
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• Each project must have a common topic for titles in cite elements.
Do not reuse the following inline elements.

• emphasis
• indexterm
• pre
• q
• simple-equation
• sstitle
• title
• tm

Use of xrefs to topics
When content contains embedded xrefs, it creates a dependency on the topics that are the target 
of xrefs. If the content is localized, all content that is referenced is included in the package sent for 
translation. Therefore, if you are reusing content with xrefs to other topics, those other topics are 
included in the package for localization, even if only an element in that topic is being reused that 
does not include the xref. This increases the translation costs.

Reuse icons with alt text
If your content contains a lot of icons, create a common topic with icons and the alt text in the 
image element. With this, the Localization team can translate the common topic that includes the 
alt text only once, and do not require to retranslate separate instances of the alt text.

Guidelines for reusing content
When you plan and implement content reuse, consider the following guidelines.

Reuse content at the highest level possible
Always reuse the content at the highest level possible. For example, if a step contains a command 
and a note and you want to reuse both, reuse the step rather than reusing each individual 
element.

Always reuse product and application names
Reuse product names, application names, and snap-in names. If you do not see a name in the 
common topic, submit an issue to the Infosolutions project.

Do not use product or application names for generic references
You should only reuse the common product and application names when referring to the specific 
product or application. Do not reuse a product or application name when you’re making a generic 
reference. For example, if you’re talking about the Conferencing product, reuse the name. But 
if you’re just making a generic reference to the concept of conferencing, type the text and do 
not reuse the product name. Inappropriate use of the common product and application names is 
incorrect from a DITA perspective and it also has an impact on localization.

Reusing content and viewing reuse information
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Reusing inline elements
You can reuse inline elements, such as uicontrol, wintitle, and cite.
Do not reuse the following inline elements:

• emphasis
• indexterm
• pre
• q
• simple-equation
• sstitle
• title
• tm

Avoid reuse of part of a sentence
To reuse a complete sentence in a paragraph, you can wrap the sentence in the ph element and 
reuse it. However, you should only reuse at the full sentence level. Do not reuse a few words in a 
sentence. This can create unexpected results in the English and issues in localized content.

Avoid conditions in the content that is set for reuse
When you add ID to element for reuse later, and if you need to set conditions to the element, do 
the following:

1. Checkout the topic and add an ID to the element that you want to reuse.
2. Reference the element in the target topic where you want to reuse.
3. Add the condition to the element that you reused.

Important:
If you add ID to the element in the source topic, add condition in the source topic itself, and 
later reuse in the target topic, Tridion Docs displays errors during the baseline freeze and 
publication release fails.

Store reusable elements in container topics
Create separate common topics to reuse text in uicontrol and wintitle elements. Each project must 
also have a common topic for document titles in cite element. If you reuse other inline elements, 
you can use a single common topic, unless you have several inline elements to reuse and you 
want to create separate common topics.

Avoid content duplication across projects
For solution documents and products with several models, such as J100 phones, you might have 
to create common content for common features in the product suite. During the content planning 
and creation phase, check if the content is already present in other product documents.
Keeping multiple copies of similar content in the content source might increase the maintenance 
and translation efforts.
Here are some tips to look for common content during the content research phase:
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Tip:
• Search for the content you plan to create already exists on Avaya Documentation Center 

or Avaya Support Site.
• Consult your documentation lead for your product or cross products and confirm if similar 

content is already created for the product.
If you find similar content, reuse the content from the source file in Tridion Docs rather than 
creating a new topic.

Avoid using xrefs to topic within topics that are reused
Where possible, manage links between topics in relationship tables. The use of cross-references 
can cause issues, especially with reused content.

• If you own common content that is reused, avoid using cross-references to topics wherever 
you can. When you use xrefs to topics and someone reuses your content, if they aren’t 
reusing the topic that’s the target of the xref, they’ll end up with a broken link in their output. It 
also causes potential problems related to localization, which are explained below.

• If you reuse a topic that contains an embedded xref and the target topic is not included in 
your deliverable, your output will contain a broken link. If you’re reusing topics that include 
xrefs to topics, request that the content owner move the xref to a relationship table link 
instead.

• When you reuse content that contains embedded xrefs, that creates a dependency on the 
topics that are the target of the xrefs. If the content is localized, all content that is referenced 
is included in the package sent for translation. So if you’re reusing content that includes xrefs 
to other topics, those other topics are included in the package for localization, even if you are 
only reusing an element in that topic that does not include the xref. This increases translation 
costs.

• If you create relationships between topics, you do not need to include a text reference to that 
topic.

Avoid duplicate IDs in a topic
When you copy an element, Tridion Docs copies the associated ID thus creating duplicate ID error 
in a topic.
To avoid duplicate IDs, copy only the text or copy the element with ID and delete the ID.

Content reference direction
To prevent circular references that cause delays in opening publication and Publication Manager 
crash:

• Always make references to common topics instead of the peer topics used in the project.
• Ensure that the direction of references must be in the direction depicted in the image.
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For example, add frequently used content, such as steps, uicontrols, and wintitles in a common 
topic and reuse the content in Adding users, Editing users, and Deleting users. Do not reuse 
content from the Adding users topic in the Editing users topic.

Reuse icons with alt text
If your content contains a lot of icons, create a common topic with icons and the alt text in the 
image element. With this, the Localization team can translate the common topic that includes the 
alt text only once, and do not require to retranslate separate instances of the alt text.

Planning your content reuse
About this task
Successful reuse of content in DITA requires good planning and frequent communication between 
the owners and writers who reuse the content. Reuse planning and communication do not end 
when you begin content development. Some good candidates for reuse will not be obvious until 
after you start to create topics.
Use these steps to identify and implement content reuse during various stages of planning and 
content development:

Procedure
1. Identify the content that is a candidate for reuse between deliverables or in the same 

deliverable.

Reusable content can be a group of topics, a single topic, or a content element within a 
topic.

2. Identify the appropriate source topics for the reusable content.

The reuse source determines where the reusable content is maintained and which author 
is responsible for creating and updating the content. Source topics can be stored in a 
common folder or with the content for a specific deliverable.

Planning your content reuse
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Ensure that the source topic title where you add reusable elements reads something like 
common uicontrol_SM.

3. Implement the reuse in your topics.

The implementation steps depend upon the type of reuse and the location of the source 
topics.

4. Document how you reused content in a deliverable or across deliverables. Update the 
content plan and design document, if necessary, to include detailed information about how 
the reused content elements in each deliverable.

Identification of reusable content
One of the first steps in the planning phase of your deliverable and of the documentation set 
requires that you identify content elements for reuse.
Use the following factors as a guideline to identify content as a good candidate for reuse:

• Two or more topics require the same content.
• Two or more deliverables require the same content.
• The content is typically subject to frequent changes during a release cycle or between 

releases.
• Standardization of the text or phrase is vital for business or usability reasons.

Identification of source topics
After you identify content that you want to reuse, you must next identify the source topic where the 
content will be created and maintained. The source topic determines who owns the content and 
where the topics with the reusable content is stored.
Typically, the writer who is responsible for the deliverable that includes the source topic is also 
responsible for creating and updating all reusable content in that deliverable. If the source topic 
is in the Common folder for your project, then the project team should assign an owner for the 
content.
When you identify the source topic for reusable content, consider the answers to the following 
questions:

• What type of content is being reused? Will you reuse the entire topic or only one or more 
content elements in the topic?

• If the content is a whole topic, is it a single topic or multiple topics with a component DITA 
map?

• What type of topic will include the reused content? Will the content always be in a task topic 
or will it be in multiple topic types?

• If the content will be in multiple topic types, is there a natural base topic type? For example, 
the base topic type for user interface elements can be the structure topic for fields and 
buttons or a common topic that lists the names of dialog boxes and windows.

• What deliverables will include the reused content? Will it be reused across multiple 
deliverables or in one deliverable?
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• If the content is reused across multiple deliverables, is there a natural home for the content? 
For example, overview topics are typically maintained with the product overview deliverable, 
and administration tasks are typically included with the administration application deliverable.

Adding an ID to elements
About this task
You can add an ID to an element, such as p, step, cmd, ul , table, and graphic, to reuse in another 
topic. Tridion Docs automatically assigns IDs to some elements such as section. For elements 
that have an ID assigned by Tridion Docs, you do not need to manually add an ID to reuse the 
element.

Important:
Always create IDs to content set for reuse in a common topic. The content from the common 
topic can be reused across projects.

Before you begin
• You require write permissions to a topic to add IDs within the topic.
• If you do not own the topic, contact the topic owner who could add IDs to the content that you 

want to reuse.

Procedure
1. Check out the topic from which you want to reuse elements.

2. Double-click or select the element.

The Attributes window opens.

3. In the id field of the Attributes window, type a string, for example, AddUserInfo.

Provide an ID that is descriptive and relevant to the content in the element. Do not use the 
wand icon next to the Id field.

Note:

In tables, you can reuse the following:

• elements in a cell

• entire cell

• rows in the table

Click OK.

4. Check in the topic.

Related links
Inserting cross references to elements within a topic on page 179
Reusing an element on page 194
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Reusing an element
About this task
You can reuse an element (text, table, or graphic) from another topic. For example, you might 
want to reuse a p, step, cmd, or ul element.

Before you begin
Add an ID to the element that you want to reuse if not already added.

Procedure
1. Check out the topic in which you want to insert the reused element.

2. Place the cursor where you want to insert the reused element.

Do not insert the element that you want to reuse. However, you must insert any required 
parent elements. For example, to reuse a list item, you must insert a list element. To insert 
a cite element, your cursor must be in a p tag.

3. In Oxygen XML Author, click SDL Tridion Docs > Conref > Insert conref.
4. In the Reuse Content dialog box, browse to and select the topic from which you want to 

reuse content.

The Reuse Content dialog box displays the list of elements, IDs, content set for reuse, and 
preview of the content.

5. Select the reusable content and click Insert and close.

6. To reuse a table row:

a. Place the cursor in the location where you want the reused row, before or after a row 
element.

Do not add a row and place the cursor in that row.

b. Complete Step 3 through Step 8 to select the row to reuse.

7. To reuse a table cell, you must enter the topic and element ID for the element that you 
want to reuse:

a. Get the ID of the element that you want to reuse and the topic the element is present.

You can open the topic, select or double-click the root element to open the attributes, 
and copy the entry from the id field to get the topic ID. To get the element ID, select or 
double-click the element and copy the entry from the id field.

b. Place the cursor in the empty cell element where you want to insert the conref.

c. In the Attributes window, select the conref field and enter the ID of the topic and 
element in the following form: topic id#topic id/element id
For example, GUID-2057F68D-0BA1-4E58-
B13A-26A4BE2B51F6#GUID-2057F68D-0BA1-4E58-B13A-26A4BE2B51F6/
MONITORSPECS
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where GUID-2057F68D-0BA1-4E58-B13A-26A4BE2B51F6 is the topic ID and 
MONITORSPECS is the element ID.

d. Click OK.

The reused text appears in the topic.

8. Check in the topic.

Related links
Adding an ID to elements on page 193

Creating a common topic for document titles
About this task
Every project must have a common topic that contains a list of all of the publication titles for your 
project. Writers for that project or other projects can reuse the titles in the topic. The topics are 
stored in the same folder to which everyone has access.

Important:
If you have to change or add new titles for a release and you have to create a new version of 
the topic, you must include the product release for which the doc titles apply in the Changes 
field. This will help writers who reuse your topic know which version to use.

Procedure
1. In the Tridion Docs repository, go to the folder Common DITA Supporting Content/

Project document titles/topics.

2. On the toolbar of the right pane, click .

The system displays the Select Template dialog box.

3. Select the Document titles template and click Next.
4. Complete the fields on each tab as appropriate.

Important:

Ensure that the Tridion Docs title includes the product name, so that writers are aware 
of the project for which they need the document titles to be reused. For example, “CM 
Document Titles”.

5. Click OK.

6. Check out the topic.

7. Put each document title in a cite element in a list item.

If the title includes a product name, reuse the product name in the cite element. If your 
document has a document number, you can put the cite element and document number in 
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a ph element. You can then reuse the ph element in other topics so that you get both the 
document title and number.

8. Add an element ID to each cite element, as well as any other elements that you might want 
to reuse.

For example, if you wrapped a cite element and a document number in a ph element, 
apply an id to the ph element.

9. If you include any text in the topic, such as descriptions or instructions that are not part 
of the titles and will not be used in any output, set the translate attribute to no in the 
attributes for that element

10. Check in the topic.

Reuse of inline elements and document titles
Reuse of product and application names

• Reuse product names, application names, and snap-in names. If you do not see a name in 
the common topic, submit an issue to the Infosolutions project.

• Refer to the Product Naming Rules (CID 150002) for the official product names. Contact your 
GIS Program Manager or Program Owner for changes to the naming rules.

• Some product teams allow articles to precede the product name and some do not. Consult 
your GIS Program Manager or Program Owner and the Product Naming Rules document for 
the correct usage for your product.

• Add the following names in the common topics:
- Avaya products
- Applications within Avaya products. This includes mobile application names.
- Snap-in names
- Interfaces with their own names. This does not refer to generic names like the “web 

application”, but for named interfaces, such as “Messaging Web Application” for Avaya 
Aura® Messaging or “Web Manager” for IP Office.

Important:
If your product is localized, before you request IA to add an application name or interface 
name to the common Applications topic, contact your Localization Project Manager to 
determine if the name must be localized. Include this information in your request.

• If a product name has been changed, however, if your product still uses the earlier version of 
the product, select earlier version of the topic with the older name in your publication.

• You should only reuse the common product and application names when referring to the 
specific product or application. Do not reuse a product or application name when you’re 
making a generic reference. For example, if you’re talking about the Conferencing product, 
reuse the name. But if you’re just making a generic reference to the concept of conferencing, 
type the text and do not reuse the product name. Inappropriate use of the common product 
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and application names is incorrect from a DITA perspective and it also has an impact on 
localization.

Inline element reuse
• Create separate common topics for the uicontrol and wintitle elements that you reuse. 

Depending on the complexity of your product and the number of interfaces, you can decide 
to have separate common topics based on the types of users (for example, administration 
versus users) or separate interfaces.

• The Localization team requests that you create separate common topics for inline elements 
that are part of the interface versus those that aren’t. For example, a filename that they 
double-click during installation must be tagged with uicontrol but it is not an element in the 
interface. Therefore, the filename must be added in a separate common topic from the actual 
interface elements. You can contact your Localization team member to request a list of the 
strings from the interface.

• You must reuse inline elements only where it is semantically appropriate. For example, if a 
term is used as both a uicontrol and a generic word, reuse only the uicontrol element when it 
is specifically referencing the interface element and not when it is a generic reference.

• Each project must have a common topic for titles in cite elements.
Do not reuse the following inline elements:

• emphasis
• indexterm
• pre
• q
• simple-equation
• sstitle
• title
• tm

Document title reuse
• All products must have a topic including the document titles for that product. The common 

topics are located in Tridion Docs under Common DITA Supporting Content/Project 
document titles. If you do not see a common topic for a product from where you need 
to reuse the names, contact the writer for that project. If you don not know the topic owner, 
consult your Doc Lead or Documentation Manager or create a ticket in the Infosolutions 
project.

• When you reuse titles from a common topic, the version that you use is important. Always 
review the Changes field to know the version and ensure that it suits the product release that 
is appropriate for your product. For example, when writers start work on a new release, they 
might need to create a new version of the document titles topic to make changes for the new 
release on which they are working, and they must mention the release number of the product 
in the Changes field. In this case, you would not use the latest version of the topic because 
it’s for an unreleased version of the product. If you have any questions about the version of a 
document titles topic, contact the writer for that project.
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Locating the source of a conref
About this task
You can find the topic where the content is set for reuse, or the source of a reused element. You 
can view the source topic even if you do not own or that is in released state.

Procedure
1. Check out the topic that reuses the content in Oxygen XML Author.

2. Place the cursor in the conref for which you want to locate the source.

3. In Oxygen XML Author, click SDL Tridion Docs > Conref > Open source object.

The source topic opens in a read-only mode.

4. To locate the source topic in Tridion Docs, click SDLTridion Docs > Properties.

Viewing where an object is used from the web interface
About this task
You can view maps or topics in which an object is used or referenced. With this functionality, you 
can see which documents and products reuse a topic on which you are working. Use the Tridion 
Docs web interface to perform this procedure. You can also view “where used” information from 
the publication baseline in Publication Manager or from Oxygen XML Author.

Procedure
1. Log on to the Tridion Docs web interface.

2. Click the Repository tab.

3. Browse to and select the folder where the object is located.

The objects in the folder are displayed in the right pane.

4. Select the a topic or a map for which you want to find the references made from other 
objects.

5. On the toolbar, click Reports.

6. In the report window, click Referenced by, and then click Show Report.

The page displays a list of the topics and maps that use the object.

7. (Optional) To download a .csv file of the report, click Download Report in the toolbar.

The Download Report option generates a report listing all topics and maps that uses or 
references the selected topic, map or image.

Related links
Viewing where an object in the baseline is used on page 230
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Viewing where a topic is used from Oxygen XML Author on page 199

Viewing where a topic is used from Publication Manager
About this task
You can view maps or topics in which a topic is used from Publication Manager. With this 
functionality, you can see which documents and products reuse a topic on which you are working. 
You can also view “where used” information from the Oxygen XML Author or Tridion Docs web 
interface.

Procedure
1. Start Publication Manager, and open the publication.

2. Select the topic for which you want to find the topics and maps that reference this topic.

3. Click VIEW > Where used.

4. On the Where Used dialog box, click Look in current publication or Look in entire 
repository.

The Where Used dialog box lists the maps and topics that reference this topic or map 
within the publication or the entire repository based on your selection.

5. (Optional) Right-click and click Check out or Open.

Viewing where a topic is used from Oxygen XML Author
About this task
Use this procedure to view maps or topics in which a topic is used. With this functionality, you 
can see which books and products reuse a topic on which you are working. You can also view 
“where used” information from the publication baseline in Publication Manager or Tridion Docs 
web interface.

Procedure
1. Log in to the Tridion Docs web interface.

2. Check out the topic for which you want to view where it is used.

3. On the Oxygen XML Author menu, click SDLTridionDocs > Where used.

The Where Used dialog box lists the maps and topics that reference this topic or map.

4. (Optional) Check out or open the topic, or close the Where Used dialog box.

Related links
Viewing where an object is used from the web interface on page 198

Viewing where a topic is used from Publication Manager
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Viewing where an object in the baseline is used on page 230

Viewing where an element is used
About this task
You can find where an element that is set for reuse is being used in the repository. You might need 
this information to assess the impact if you need to change the content in the reused element, 
delete the element itself.
For example, you can identify all topics in the repository that reuse a specific product 
element from the file Common DITA Supporting Content\Product and application 
names\topics\Product names.

Procedure
1. Get the ID of the topic that contains the element:

a. Right-click the topic, select Properties.

b. Copy the GUID from the Identifier field.

c. Close the Properties dialog box.

2. Get the ID of the element:

a. Check out or open the topic, usually, common topic, that contains the element.

b. Double-click or select the element that is set for reuse.

c. In the Attributes window, copy the entire string in the id field.

3. In the Tridion Docs repository, click the Search tab.

4. In the Find what field, type conref=<topic GUID>#<topic GUID>/<element ID>.

For example, conref="GUID-D2F34A51-7BBE-4B11-8A33-93E782075B1C#GUID-
D2F34A51-7BBE-4B11-8A33-93E782075B1C/SELECTREQUIREDKEYBOARDTYPE 
where GUID-D2F34A51-7BBE-4B11-8A33-93E782075B1C is the topic ID and 
SELECTREQUIREDKEYBOARDTYPE is the element ID.

5. To restrict the search, use the fields in Advanced options.

For example, to find instances of the element in content for a particular product, use the 
Product field to choose your product.

6. Click Search.

It might take several minutes for the system to display the search results because the 
search is done in the entire repository.
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Chapter 15: Working with conditions

Conditional content
Conditional content makes it possible to show and hide different content for different deliverables. 
For example, a topic might be used in both the Installation Guide and Administration Guide. You 
might want to show one paragraph in the Administration Guide, and hide it in the Installation 
Guide. To accomplish this, you could apply the Administration condition to the paragraph. When 
you produce the Installation Guide, you could hide content that has the Administration condition 
applied.
You can conditionalize inline elements, such as uicontrol, wintitle, and cite. But do not tag a word 
or group of words with <ph> to apply a condition because it can cause major issues.
Tridion Docs uses the Condition Builder feature to manage conditions. All conditions that are 
available in the system are displayed in Condition Builder. Conditions are organized into three 
categories:

• Product— includes conditions for different product names.
• Platform—includes conditions for different operating systems, hardware platforms, and a few 

other items.
• Other properties—includes conditions for release numbers, deliverable type, for example, 

Installation, Administration, Print, and HTML, and a few other items.
• Audience— includes conditions for different users, such as end user, admin.

In Condition Builder, you can view all available conditions, select conditions that you will use in 
your content, and build a custom list of just the relevant conditions. You will use the custom list to 
select the conditions to apply to specific elements. You can add or remove conditions from your 
custom list at any time. Removing conditions from your list does not remove conditions from the 
content.
If you need new conditions added to the system, contact a Tridion Docs administrator/information 
architect.
Before publishing a deliverable that includes conditional content, select conditions that you want to 
show and conditions that you want to hide.
If you need to show different conditions for variations of a publication, for example, PDF and 
online help, create different publications for the two deliverables. Do not use the same publication 
and change the conditions that show because that creates a lot of risk that the conditions will be 
set improperly for an output.
Tags with a condition applied include an ishcondition attribute in the tag. For example, 
a section tag that has a condition of Administration applied looks like this: section 
ishcondition=”otherprops=Administration”
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Condition states in Tridion Docs
Beginning from Tridion Docs 14.0, behavior of Publication Manager with conditions has been 
improved, especially when conditions are absent or not defined in the Conditions tab.

You might see the following three states for the conditional context:

1. No conditional context is defined or has an empty field value. The message This 
publication has no context set, so upon publishing all conditional 
content will be included. is displayed in the Conditions tab and the conditional 
filtering is disabled.

Figure 1: Conditions tab with no condition context

As a result, all conditioned content within this publication is displayed in green in the 
preview and the content is displayed on publishing the output.

In the example, the condition audience=admin is not defined in the Conditions tab, 
however, the content in the step with audience=admin is still displayed.

Figure 2: Conditioned content in the preview with no condition context
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2. Conditional context is available, however, no condition or no condition value is defined. 
The conditional filtering excludes (hides) all conditioned content in the publication while 
publishing.

Figure 3: Conditions tab with empty condition context

All conditioned content is displayed in red in the preview.

Figure 4: Conditioned content in the preview with empty condition context

3. Condition and condition values are defined, and content is included or excluded as defined 
by the conditions. The content is displayed in green or red accordingly in the preview.

Condition states in Tridion Docs
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Figure 5: Conditions tab with a conditional context value

The content is displayed in green or red accordingly in the preview.

In the example, the condition audience=admin is defined in the Conditions tab. 
Therefore, the content in the step with audience=admin is displayed.

Figure 6: Conditioned content in the preview when condition and condition values are 
defined

Applying conditions to elements in topics
About this task
You can conditionalize inline elements, such as uicontrol, wintitle, and cite. But do not tag a word 
or group of words with <ph> to apply a condition because it can cause major issues.

Procedure
1. Check out the topic.
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2. Place the cursor inside the tag to which you want to apply the condition.

3. In Oxygen XML Author, click SDL Tridion Docs > Conditional text > Set condition.

The page displays the Condition Builder dialog box.

4. If no conditions are listed on the Conditions tab of Condition Builder, or if the condition that 
you need to apply is not listed:

a. Click the Tree tab.

b. In the left pane, expand All Condition Names, and then select the category of 
conditions that you need to apply, such as otherprops and Product.

The conditions in the selected category are displayed in the right pane of the Tree tab.

c. Select the required condition, and then click Add.

5. On the Condition tab, select the condition that you want to apply, and then click OK.

To apply more than one condition, press and hold down Ctrl while selecting all conditions 
to apply, click Or, and then click OK.

6. Check in the topic.

7. In the Content tab of Publication Manager, preview the topic in the right pane to 
validate that the element where you added the condition shows with either red or green 
highlighting.

Next steps
• In the Conditions tab of the publication, select the appropriate condition.
• Publish the output and verify if the conditionalized text is visible or hidden based on what you 

set in the Conditions tab.
Related links

Applying conditions to table columns on page 206
Applying conditions to table rows on page 206
Selecting conditions in a publication on page 210

Removing conditions from elements in topics
Procedure

1. Start Publication Manager and open a publication or browse repository.

2. Check out the topic.

3. Place the cursor inside the tag from where you want to remove the condition.

4. In Oxygen XML Author, click SDL Tridion Docs > Conditional text > Remove condition.

Removing conditions from elements in topics
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Applying conditions to table rows
Procedure

1. Check out the topic in Oxygen XML Author.

2. Click View > Tables > Table Markup.

3. Depending on the table type, place the cursor inside the row, strow, or partrow element to 
which you want to apply the condition.

Do not apply condition to table rows in a section of a table that has spanning. When 
you span rows, the number of rows is calculated. When you apply conditions and do not 
include that condition in your output, the number of rows for spanning is taken incorrectly. 
In the output, the table is displayed correctly.

4. In Oxygen XML Author, click SDL Tridion Docs > Conditional text > Set condition.

The page displays the Condition Builder dialog box.

5. To apply conditions to other rows in a table, repeat from Step 3.

6. Check in the topic.

7. In the Content tab of Publication Manager, preview the topic in the right pane to 
validate that the element where you added the condition shows with either red or green 
highlighting.

Next steps
• In the Conditions tab of the publication, select the appropriate condition.
• Publish the output and verify if the conditionalized text is visible or hidden based on what you 

set in the Conditions tab.

Applying conditions to table columns
Important:

Conditionalizing table elements adds complexity to the table. Depending on the size and 
complexity of your publication, you might encounter a publishing issue where the PDF you 
produce will not open. If you have this issue, see “Error opening PDF: “There was an error 
opening this document. The file is damaged and could not be repaired.”

Procedure
1. Check out the topic in Oxygen XML Author.

2. In the first table row, place the cursor in the entry element (entry, stentry, partentry) that 
corresponds to the column you want to apply the condition to.

Working with conditions

July 2024 DITA and TDocs Work Instructions and Guidelines 206
Comments on this document? 

207

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


For example, to apply a condition to the second column in the table, put your cursor in the 
second entry element in the row.

3. In Oxygen XML Author, click SDL Tridion Docs > Conditional text > Set condition.

The page displays the Condition Builder dialog box.

4. Repeat steps 3 through 6 for every row in the table.

Tip:

Once you apply the condition to the first entry element, you can put your cursor in the 
second entry element and press Ctrl+Y to repeat the action.

It’s very important that you apply the condition to the same entry in every row or else the 
entire column will not be conditionalized.

5. Check in the topic.

6. In the Content tab of Publication Manager, preview the topic in the right pane to 
validate that the element where you added the condition shows with either red or green 
highlighting.

Next steps
• In the Conditions tab of the publication, select the appropriate condition.
• Publish the output and verify if the conditionalized text is visible or hidden based on what you 

set in the Conditions tab.
Related links

Error opening PDF: “There was an error opening this document. The file is damaged and could 
not be repaired” on page 304

Conditionalizing a topic or map
Procedure

1. Open the publication in Publication Manager.

2. Check out the map.

3. Right-click the topic or map reference to which to apply a condition, and then click XML 
Attributes.

4. In the Condition field, click the Browse button .

Condition Builder is displayed.

5. If no conditions are listed on the Conditions tab of Condition Builder, or if the condition that 
you need to apply is not listed:

a. Click the Tree tab.

Conditionalizing a topic or map
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b. In the left pane, expand All Condition Names, and then select the category of 
conditions that you need to apply, such as otherprops and Product.

The conditions in the selected category are displayed in the right pane of the Tree tab.

c. Select the required condition, and then click Add.

6. On the Condition tab, select the condition that you want to apply, and then click OK.

To apply more than one condition, press and hold down Ctrl while selecting all conditions 
to apply, click Or, and then click OK.

Removing condition from topics in a map
Procedure

1. Open the publication in Publication Manager.

2. Check out the map.

3. Right-click the topic or map reference to which to apply a condition, and then click XML 
Attributes.

4. Clear the Condition field, and then click OK.

Removing conditions from your list in Condition Builder
About this task
Use this procedure to remove a condition from your list of conditions in Condition Builder. You will 
probably want to remove conditions that are not used in the deliverables that you are currently 
working on. This procedure removes conditions only from the list. It does not remove conditions 
from content to which they are applied. You can add conditions back to the list at any time.

Procedure
1. Check out a topic.

2. In Oxygen XML Author, click SDL Tridion Docs > Conditional text > Set condition.

The page displays the Condition Builder dialog box.

3. On the Conditions tab of Condition Builder, select the condition to remove, and then click 
Delete.

4. Click OK when prompted to confirm the deletion.

5. Click Close.
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Viewing all conditions used in a publication
Procedure

1. Open the publication in Publication Manager.

2. Click the Conditions tab.

The conditions that are currently selected to show in the publication are listed in the top 
pane.

3. Click Modify on the top left.

The Select Conditions dialog box displays all conditions that are used in the publication 
topics.

Viewing where conditions are used
About this task
Use this procedure to view where a specific condition is used in a publication.

Procedure
1. Open the publication in Publication Manager.

2. Click the Conditions tab.

The conditions that are currently selected to show in the publication are listed in the top 
pane.

3. Select a condition, and then click  at the very bottom of the bottom, left pane.

If you don’t see the Where Used tab at the bottom of the pane, go to View > Where Used 
and it should appear again.

All topics in the publication that use the condition are listed.

Previewing conditions in a topic or map
About this task
You can view which content in a topic or map is conditionalized and which conditionalized content 
is hidden or shown based on the current condition settings for the publication. In the preview, red 
content is conditionalized and hidden, and green content is conditionalized and shown.

Procedure
1. Open the publication in Publication Manager.

Viewing all conditions used in a publication
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2. In the Content pane, click the map or topic to preview.

A preview of the topic or map is displayed in the bottom-right pane.

Selecting conditions in a publication
About this task
If a publication contains conditional content, use this procedure to select the conditions to show 
in the output. The conditions that you select apply to all output formats for the version of the 
publication. However, different versions of a publication can have different conditions selected. 
When you select a condition, all elements that are tagged with that condition are included in the 
output.
If you need to show different conditions for variations of a publication, for example, PDF and 
online help, create different publications for the two deliverables. Do not use the same publication 
and change the conditions that show because that creates a lot of risk that the conditions will be 
set improperly for an output.

Procedure
1. Open the publication in Publication Manager.

2. Click the Conditions tab.

3. Click Modify on the top left.

4. In the Select Conditions dialog box, select Display Conditions Used in Publication from 
the menu in the upper-right corner of the dialog box to only show the condition that have 
been applied to the content in the publication.

5. Select the conditions that you want to show in the output.

6. (Optional) Before saving your selections, verify the conditions that are included or 
excluded from the publication.

a. To verify the conditions that are included, select Display Selected Conditions from 
the drop down menu in the top right corner.

b. To verify the conditions that are excluded, select Display Unused Conditions from 
the drop down menu in the top right corner.

Tip:

To view all conditions available in the repository, select Display All Conditions from the 
drop down menu in the top right corner of the Select Conditions dialog box.

Working with conditions
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Chapter 16: Workflow

With the workflow feature in Tridion Docs, you can manage the content development process. Every 
object in Tridion Docs such as topic, map, and image must move through specific workflow states. 
Because each object has a workflow, you can manage the content development process at the topic 
level rather than as a book or help system. When a topic, map, or graphic is complete, reviewed, 
and approved, you can change the workflow state for that object to Released. Releasing chunks of 
content is relevant in an Agile methodology. You must also release objects before translation.

Workflow states
The following chart shows the sequence of workflow states and the role responsible for each 
change in state.

The following table describes each state in the workflow.
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Sequence in 
flow

Workflow state Description

1 Contribute Only for a non-GIS resource to contribute 
content by using Content editor, such as 
RWS Collective Spaces.

Avaya does not use RWS Collective Spaces 
currently.

2 Draft Initial default state of all new objects. 
Objects are in draft state during the 
development phase.

3 Editorial Review Content that is in review. Reviews can 
include reviews by the GIS editors, informal 
peer reviews, a CE review, or a DITA 
content review. You can use the Reviewer 
field in object properties to indicate the 
internal resource performing the review.

4 Technical Review Content that is going through a technical 
review.

5 Pre-Release Validation Content in which all required quality checks 
and reviews are validated.

6 Released Content that is complete. When content is in 
the Released state, it cannot be modified.

Important:

User with Doc Lead role can change 
content from Pre-Release Validation 
state to Release state.

7 Obsolete Content that is no longer used in new 
deliverable. You cannot delete the object 
because it is used in frozen baselines.

Note:
You can change the workflow status on multiple objects simultaneously by using the following:

• Workflow from web interface
• Browse repository
• Publication Manager baseline

Move content object through each relevant state so that we can view the progress of the content 
development in Tridion Docs. Some workflow states, such as Pre-release Validation state are 
mandate, therefore, you cannot skip this step. Objects must have the Pre-release Validation state 
before you can release them.

Roles
As an author, you manage most of the workflow states for your content, but only the Doc Lead 
role can make the final transition, from Pre-Release Validation to Released. The Doc Lead role is 
intended for someone who is responsible and accountable for validating that the content has gone 
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through all necessary quality checks, testing, reviews. The author or another team member can take 
this role.

Related links
Checking in a topic on page 77
Topic properties on page 71

Changing the workflow status when checking in a topic
About this task
Use this procedure to change the workflow state of a topic when you check in the topic to the 
repository.
All topics, maps, and images must have a status of Pre-release Validation before they can be 
released. Other states, including Technical Review or Editorial review, are recommended when 
they are applicable but can be skipped.

Procedure
1. From the Oxygen XML Author menu, click SDLTridionDocs > Check in.

The Check in dialog box is displayed.

2. To change the workflow status of the topic:

a. Select Change status.

b. In the Status field, select the appropriate status.

3. Click OK.

Related links
Workflow on page 211

Changing the workflow status of an object from the 
Desktop Repository

Before you begin
Open the Browse Repository window.
All topics, maps, and images must have a status of Pre-release Validation before they can be 
released. Other states, including Technical Review or Editorial review, are recommended when 
they are applicable but can be skipped.

Changing the workflow status when checking in a topic
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Procedure
1. Right-click the object of which to change the status, and then click Properties. Alternately, 

you can click on the toolbar.

2. In the Properties dialog box, click the Workflow tab.

3. In the Status field, select the new workflow status for the object.

Related links
Workflow on page 211

Delivering content to localization
This topic provides the basic process for submitting content to the GIS Localization team for 
translation. For 80% and 100% drops, you must release the objects and freeze the publication 
baselines.

Important:

You must accept or reject change tracking in all topics before submitting content for 
localization.

About this task
This procedure does not provide the complete process for working with Localization. These are 
only the steps required in Tridion Docs to prepare for delivery of the content to Localization. If 
you have questions about the Localization process for content, contact the Localization Project 
Manager (LPM) for your project.

Procedure
1. When you are ready to submit your content for the 80% drop to Localization:

a. Produce a Validator PDF output to ensure that there are no errors and to check for 
issues such as elements tagged with <b> or <i>, uicontrol and wintitle elements not 
reused that must be corrected before translation.

b. Produce your output and make sure that there are no errors.

c. Release all topics, maps, and images in the publication.

d. Freeze the publication baseline.

You must freeze the baseline for the 80% drop to ensure that the testers validating the 
translated content see the translated content and not the English version of updated topics 
in the output.

2. For a new project, inform the Localization coordinator to get the user group added to the 
ServiceUser.

3. When you need to make changes, create a new version of the publication and then create 
a new version of any topics, maps, and images that you must modify.

Workflow
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4. When you’re ready to submit your content for the 100% drop to Localization:

a. Produce the output and ensure that there are no errors.

b. Release all topics, maps, and images in the publication.

c. Freeze the publication baseline.

You must freeze the baseline for the 100% drop to ensure that the testers validating the 
translated content see the translated content and not the English version of updated topics 
in the output.

5. If you need to make changes after the 100% drop before the product release, create a new 
version of the publication and then create a new version of any topics, maps, and images 
that you must modify.

Note:

When you have finalized the content for a product release and have delivered it, you 
must release the version of the publication.

Related links
Checklist for preparing content for Localization on page 332

Releasing a publication
You must release the publication version after you make your final delivery for product releases, 
including maintenance releases. You can release publications at additional intervals if you choose. 
For example, if you have a lengthy Controlled Introduction or a similar situation where you want 
to ensure that the version of the content you delivered is preserved. Localization drops and final 
delivery are the only required times when you must release a publication.

About this task
When you release the output for a publication, the status of the publication changes to Released.
Tridion Docs automatically changes the output status to Release Candidate when all referenced 
content for a publication is in released state and no errors or serious warnings occur during the 
output generation. When the output is in the Release Candidate status, you can release the 
output. This process archives a record of everything in that publication.
When an output format for a publication version is in Released state, you cannot make changes 
to the contents or output of that publication. However, you can add additional output formats that 
use the same contents. To update a released publication, you must create a new version of the 
publication.

Before you begin
• Freeze the baseline
• Generate the output
• Check that the output is correct, conditions in specific

Releasing a publication

July 2024 DITA and TDocs Work Instructions and Guidelines 215
Comments on this document? 

216

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Procedure
1. Click the Output tab.

2. Select an output format with the Release Candidate status.

3. Click Release.

Related links
Checklist for releasing a publication on page 329

Preparing topics for an editorial review
Procedure

1. Create an Jira in the Infosolutions project to request that the editor has permissions to your 
project.

Provide the path to the project the editors will be reviewing and the editor's name.

2. Modify the properties for each topic to be reviewed:

a. In the publication or repository, right-click the topic and select Properties.

b. On the Avaya-specific fields tab, select the editors name in the Reviewer field.

c. On the Workflow tab, change the Status to Editorial review.

If the editor is already specified as the Reviewer and you just need to change the 
workflow on a group of topics. You can use your existing publication or, if you just 
need to change the workflow on a subset of topics, you can create a publication that 
contains a map with only the topics you want to change the workflow for.

d. Click OK.

Next steps
Once the editorial review is complete and you have implemented the comments from the editors, 
change the workflow status of the content appropriately.

Setting up a peer review
Procedure

1. Create an Jira in the Infosolutions project to request that the writer(s) performing the 
review have permissions for your project and are assigned the Reviewer role.

Provide the path to the project your peer will be reviewing and the reviewers' name.

2. Modify the properties for each topic marked for review:

a. In the publication or repository, right-click the topic and select Properties.

Workflow

July 2024 DITA and TDocs Work Instructions and Guidelines 216
Comments on this document? 

217

https://jira.forge.avaya.com/projects/INFOSOLUTIONS/summary
https://jira.forge.avaya.com/projects/INFOSOLUTIONS/summary
https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


b. On the Avaya-specific fields tab, select the writer’s name in the Reviewer field.

c. On the Workflow tab, change the Status to Editorial review.

d. Click OK.

Next steps
Once the editorial review is complete and you have implemented the comments from the reviewer, 
change the workflow status of the content appropriately.

Generating a workflow report
About this task
A workflow report has two sections. The first section contains statistical information, including the 
number of each type of object and the percentage of objects in each workflow state. The second 
section displays the details of all of the objects in the publication.

• Statistics: Provides contains statistical information that includes:
- The number of objects of each type.
- The percentage of objects in each workflow state.

• Details: Displays the details of all objects in the publication.

Procedure
1. Log in to the Tridion Docs web interface.

2. Click the Repository tab.

3. Navigate to the folder that contains the publication for which you want to generate a 
workflow report.

The page displays the contents of the folder in the right pane.

4. Click the title of the publication for which you want to generate the report.

When you only select the box next to the title, the page does not display the details of the 
publication.

The page displays versions in the lower right pane.

5. Select the check box next to the publication version for which you want to generate the 
report, and then click Workflow in the toolbar of the lower right pane.

The page displays a Workflow management window.

6. In the Workflow management window, click use baseline information only, and click OK.

A new window opens and the reports begins to display. A message displays to confirm if 
you want to load the details section of the report, as it can take several minutes to display 
depending on the number of objects in the publication.

Generating a workflow report
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7. Select one of the following:

• To change the status of a category of objects using the top part of the report, click 
Cancel to only display the statistics.

• To select individual objects to change the status, click OK to display the details section.

If you select OK to display the details section, it takes a few minutes to display the details. 
Do not make any changes to the top part of the report until the details finish displaying. If 
you do, it might cause delay or displays an error.

8. (Optional) If you choose only to display the statistics section of the report and then decide 
to see the details, scroll down and click the line Click here to start loading 
details section.

9. To capture the statistical information at the top of the report, take a screen capture.

10. To export the Details section of the report:

a. Click Download Statistics Report in the toolbar.

b. Click Save in the File Download dialog box.

c. Browse to and select a location to save the report, and then click Save.

Note:

Send and Export or Export options buttons on the toolbar export only the publication 
and not the report.

The report is exported as a .csv file. This file does not include the Statistics section of the 
report.

Workflow
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Changing the workflow status of objects from the web 
interface

About this task
All topics, maps, and images must have a status of Pre-release Validation before they can be 
released. Other states, including Technical Review or Editorial review, are recommended when 
they are applicable but can be skipped.
You can use this procedure to move the objects from draft to Pre-release Validation and Pre-
release Validation to Release states.

Procedure
1. Log in to the Tridion Docs web interface.

2. When the system prompts to load the details, click Cancel.

If you choose to load the details, it might take several minutes to complete.

3. Generate a workflow report for the publication that contains the objects.

Wait for the details section of the workflow report to fully load before making changes. 
You can use the scroll bars to view the Details section. If the Details are not displayed as 
expected, refresh the browser window.

4. To change the status of specific objects:

a. In the report, scroll to the second section that shows all objects in the publication.

b. Select the check box of the object for which you want to change the workflow status.

You can select multiple objects that you will change to the same workflow status.

5. To change all topics, maps, images, or all objects to the same workflow status, select the 
check box to the left of the type of object that you want to change the workflow status, for 
example, Draft Pre-release Validation.

You can select more than one type, such as all Topics in Draft status and Editorial review 
status. Or you can select all Draft Topics and Maps. You can also choose to move objects 
in all types from one status to another by selecting the check box to the left of the status.

Changing the workflow status of objects from the web interface
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6. Scroll to the toolbar at the top of the report.

7. In the Select workflow action field, select the action that you want to do, and then click 
Send.

You cannot move to the Released state from any state other than Pre-Release Validation. 
If objects are in another state and you want to release them, you must first move them 
to Pre-Release Validation, then generate the workflow report again, and move the objects 
from Pre-Release Validation to Released.

If status change requests are invalid, the system indicates that it could not transition all of 
the request objects. For example, if you try to move directly from Draft to Released, the 
request is not processed because you cannot move from Draft straight to Released.

The updated report does not automatically update to reflect the new workflow status. To 
confirm the changes, regenerate the report.

8. Repeat the process to move the objects from Pre-release validation to Release.

Related links
Generating a workflow report on page 217
Workflow on page 211

Workflow
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Viewing workflow status of objects from the publication 
baseline

Procedure
1. In Publication Manager, open a publication.

2. Click the Baseline tab.

3. Click the Status column heading to sort by workflow status.

This view makes it possible for you to see the workflow state of all objects in the 
publication.

Inbox
Inboxes help you manage the workflow of content that you own or have a role in. At each step of 
the workflow, objects appear in the inbox of the user who is responsible for the next step in the 
workflow process.

You have an inbox for each role that you are assigned, so some users will have multiple inboxes. 
The Author and Doc Lead Project inboxes show all of the objects to which you are assigned the 
respective role. Inboxes for other roles, including Contributor, Editorial review, Technical review, 
and Doc lead, show the objects for which you are assigned the respective role and that have been 
placed in a workflow state that requires your action. For example, if you are assigned a role of 
Doc Lead for a publication, objects in the Pre-Release Validation state appear in your inbox. After 
reviewing the objects, you can change their state to Released, and they are removed from your 
Doc Lead inbox.

Viewing your inboxes
Procedure

1. Log in to the Tridion Docs web interface.

2. Click the Inbox tab.

3. In the left pane, click the role for which you want to view the inbox.

Releasing a publication
You must release the publication version after you make your final delivery for product releases, 
including maintenance releases. You can release publications at additional intervals if you choose. 

Viewing workflow status of objects from the publication baseline

July 2024 DITA and TDocs Work Instructions and Guidelines 221
Comments on this document? 

222

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


For example, if you have a lengthy Controlled Introduction or a similar situation where you want 
to ensure that the version of the content you delivered is preserved. Localization drops and final 
delivery are the only required times when you must release a publication.

About this task
When you release the output for a publication, the status of the publication changes to Released.
Tridion Docs automatically changes the output status to Release Candidate when all referenced 
content for a publication is in released state and no errors or serious warnings occur during the 
output generation. When the output is in the Release Candidate status, you can release the 
output. This process archives a record of everything in that publication.
When an output format for a publication version is in Released state, you cannot make changes 
to the contents or output of that publication. However, you can add additional output formats that 
use the same contents. To update a released publication, you must create a new version of the 
publication.

Before you begin
• Freeze the baseline
• Generate the output
• Check that the output is correct, conditions in specific

Procedure
1. Click the Output tab.

2. Select an output format with the Release Candidate status.

3. Click Release.

Related links
Checklist for releasing a publication on page 329

Workflow

July 2024 DITA and TDocs Work Instructions and Guidelines 222
Comments on this document? 

223

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Chapter 17: Working with publication 
baselines

Baselines
The baseline of a publication is a table that identifies all objects in a version of a publication. 
Tridion Docs identifies objects by GUID and version. Use a baseline to correspond to a 
deliverable for a specific product version. For example, Using_Avaya_J16_ SIP_IP_Phone-v12-
GUID-123ABC-2022/04/23 07:13:01 is a baseline and Using_Avaya_J16_ SIP_IP_Phone-v13-
GUID-123ABC-2022/10/18 05:14:05 is a new baseline.
You can use the baseline to identify the versions of the objects that are included in a publication. 
However, the baseline does not contain the languages, output formats, or the conditions you 
specified when publishing. By omitting this information, you can change condition settings and 
output formats to produce different, custom output from the same, frozen publication baseline.

Object versions in a baseline
When creating a publication, you must select the version to use for each topic, map, and library 
that the publication references.
When you add a topic or map to a publication, the latest version is selected by default, select an 
earlier version of the object if necessary.
If you create a new version of an object from:

• the repository, the new version does not automatically gets selected in the publications where 
the object is being used.

• Publication Manager, the new version is automatically selected in the baseline.
Versions do not have to match within the publication. For example, you can use version 3, which 
may be the latest version of an object, and use version 1, which may be an older version of 
another object.

Important:
Use the Autocomplete option on the Baseline tab cautiously.
Here are some considerations to use autocomplete:

• Use Autocomplete when you create a latest version of the publication for the new release 
of the product.

• Sort by the Newer version column, and select new versions of topics only if the 
changes in the latest version applies to the release of the product. This applies when 
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you are publishing outputs of older versions and projects that reuse content from other 
publications and projects.

Baseline freezing
After you publish a deliverable, and all content, that includes topics, maps, and images in 
the publication is released, you can freeze the content as the publication baseline. After you 
freeze the baseline, you cannot change the content. The baseline becomes an archive of your 
publication. If the baseline is frozen, you can find the version of each object that was used for the 
publication.
When you freeze a baseline, each object version that is used in the publication is labeled using 
the baseline name (Baseline label property). You cannot delete the object versions contained 
within a frozen baseline.

Baseline cleanup
You can use Clean Up to remove all objects from the baseline that are not used in the publication 
anymore.

Related links
Versions and branches on page 231

Information provided in a publication baseline
The baseline provides important information about the content in your publication. The following 
screen capture shows the first few columns of a sample baseline. Solid rows indicate that the 
object is currently being used in the publication. Greyed out objects are currently not being used in 
the publication, but were used at some point in the past.

Icons in the baseline
The icons displayed in the first two columns in the baseline indicates the object type and status.

Working with publication baselines
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Icon Description
Object 
type

The type of object. The options are:

• : Indicates that the object is a topic.

• : Indicates that the object is a map.

• : Indicates that the object is an image.
Status • : Closed lock indicates that the object is in draft state.

• : A green check mark indicates that the object is currently released.

• : Open lock indicates that the object is checked out.

Columns in the baseline
The baseline includes the following columns. You can sort the columns by clicking the column title.

Column Description
Title The Tridion Docs title of the object.
Override Output 
File Name

The base attribute of the topic.

To modify the Override Output File Name, you must check out the topic and modify 
the base attribute.

Status The workflow status of the object. The values are:

• Draft

• Prerelease Validation

• Release
Author The writer specified in the Author field on the Workflow tab in the object properties.
Version The version of the object used in the publication.
Date modified The last date this object was updated.
Checked out by The user who checked out the topic.

If the object is checked in, the column is blank.
Last modified by The user who last updated the object.
In Folder The full path to where this object is stored in the repository.
Product The product name assigned on the Avaya-specific fields tab in the object properties.
Doc lead The user assigned as the Doc Lead on the Avaya-specific fields tab in the object 

properties.
Type Indicates if the object is a topic, map, or an image.
Newer Version Indicates if there’s a newer version of the object in the repository. If there is a newer 

version, you can go to the Contents tab and choose the newer version if you want to 
use it in the publication.

Table continues…

Information provided in a publication baseline
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Column Description
Used Indicates if the object is currently used in the baseline. Content that appears with a 

blue background is currently being used in the publication. Objects that appear with a 
white background are not currently used in the baseline but were at some point in the 
past.

Added by The user who added the object to the system.
Added on The date when the object was added to system.

Manually selecting the object versions used in a 
publication

About this task
Use this procedure to manually select the version of an object that is used in a publication. By 
default, the publication includes the latest version of the object that is available when you add the 
object to the publication. The following procedure makes it possible for you to manually select a 
different version. You might use this procedure if a newer version of an object becomes available 
than the version that was available when you added the object to your publication.

Procedure
1. Open the publication in Publication Manager.

View the Baseline tab to see if newer versions are available for objects used in the 
publication. The New Version column displays Yes if a newer version of the object exists 
or No if the latest version is used in the publication.

To see where a specific object is located in the publication, select the object, and then click 
Locate in the tool bar. Or right-click the object, and then click Locate in Publication. The 
content pane is displayed, and the object is selected in the publication tree.

2. In the publication tree, select the object for which you want to assign or change the 
version.

All versions of the object are displayed in the right pane. The Changes column should 
indicate the changes made in any newer versions.

3. In the right pane, select the version that you want used in this publication baseline.

Checking for newer versions of objects in the baseline
You can use the baseline tab to check for objects that contain a newer version. Objects in the 
baseline can include topics, maps, or images. Use this procedure to identify whether you need to 
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use the latest versions of the objects for your publication. This is especially important if you are 
reusing the common content.

Procedure
1. Open the publication in Publication Manager.

2. Click the Baseline tab.

3. Click Newer Version column heading to sort the baseline report.

All objects for which a newer version is available are grouped together. The New Version 
column displays Yes if a newer version of the object exists or No if the latest version is 
already used in the publication.

4. To locate a specific object in the publication, select the object, and then click Locate in the 
tool bar or right-click, and select Locate in Repository.

The system displays the content pane, and selects the object in the publication tree.

5. In the upper-right pane, view the Changes column to determine whether the newer version 
applies to your specific release.

The Changes column provides a description of the change or product release number for 
which the changes apply.

Next steps
If a newer version applies to your release, go to Changing the version of an object used in a 
publication.

Related links
Changing the version of an object used in a publication on page 239

Freezing the baseline
You must freeze a publication baseline before you can release the publication.

About this task
After the baseline is frozen, you cannot change the content. You can, however, change the 
condition settings and output formats to produce different, custom output from the same frozen 
publication baseline.

Note:
To identify errors ahead of baseline freeze, freeze the baseline before you release all objects 
in the publication. That way, if there are errors that require you to modify the content, you have 
the opportunity to make the changes in the draft version before you release the topics and 
maps.

Before you begin
• Review the “Checklist for releasing a publication” checklist.

Freezing the baseline
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• Generate the output and check for any errors in the log file.
• Check the baseline for any topics that are reused from other project folder. See the In Folder 

column to identify the location.
If you do not have write access to the reused topics, request the topic owner to resolve the 
errors.

• Ensure that all objects in the publication are in the Release state.
This does not apply if you are performing a preliminary baseline freeze to look for any errors 
before releasing all objects.

Procedure
1. Open the publication in Publication Manager.

2. Click the Baseline tab.

3. Click Freeze.

The Freeze Baseline report pane displays Frozen.

If a baseline cannot be frozen, a Freeze Baseline Report is displayed at the bottom pane 
that contains location and cause of the baseline freeze error.

If the freeze operation fails, fix all errors and retry the freeze.

Related links
Checklist for releasing a publication on page 329

Freeze Baseline report
The following error messages might be displayed in the Freeze Baseline Report.

Error message Description Action
Object is not released The object is not released in the 

working language.
Review and release the objects.

Object no longer 
available

The object or the version of the 
object does not exist anymore.

Select another version of the 
object or delete the object from 
the publication.

There is no value 
assigned to this variable

The variable has no value and 
cannot be resolved.

Provide a value for the variable in 
the resource file associated with 
the publication.

Table continues…
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Error message Description Action
Link could not be 
resolved

Some links cannot be resolved. Set the scope attribute to external 
for all links to files or locations 
that are not part of the actual 
publication, for example, PDF 
files, additional images, or URLs. 
For xrefs that are not related to 
external links, locate the topic 
that includes the broken links and 
correct them. This will require you 
to create a new version of the 
object if you already released it. 
Checking your publication logs 
will reduce the risk of this issue.

Note:

This error can also be 
caused when topics in your 
baseline are referencing 
topics not used in your 
publication. For example, if 
you’re reusing part of a topic 
and that topic includes an 
xref in a section you’re not 
reusing.

Related links
Baseline freeze fails even though publishing log shows no errors on page 294

Cleaning up the baseline
About this task
While developing the content, you might delete topics, maps, and images that do not apply for the 
release or the product. The objects that are removed are displayed in gray in the publication. You 
can clear the baseline to remove all the gray objects that are not being used in the current version 
of the publication.

Procedure
1. Open the publication in Publication Manager.

2. Click the Baseline tab.

3. Click Clean Up.

Tridion Docs removes from the baseline all objects that are displayed in gray, and keeps 
objects that are used in the current version of the publication.
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If you still see topics in gray, it implies that the topics have been removed from the map, 
but are still being referenced in the relationship table. You must delete the topic from the 
relationship table.

Viewing where an object in the baseline is used
About this task
Use this procedure to view maps or topics in which a specific object in a baseline is used. With 
this functionality, you can see if a topic on which you are working is reused in books for other 
products. You can also view where used information from the Tridion Docs web interface or 
Oxygen XML Author.

Procedure
1. Open the publication in Publication Manager.

2. Click the Baseline tab.

3. Select the object for which you want to view where used.

4. In the menu bar, click VIEW > Where used.

The Where Used pane that is below the Baseline pane, displays topics and maps that use 
this object.

Related links
Viewing where an object is used from the web interface on page 198
Viewing where a topic is used from Oxygen XML Author on page 199
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Chapter 18: Working with versions and 
branches

Versions and branches
Each object in Tridion Docs has one only instance (one file). To change a released object or make 
different changes for different versions of a publication, create a new branch or new version of the 
object.

When you create a new version of a publication, create a new version or branch only of topics or 
maps that you need to modify. You do not need to create a new version of all topics and maps in 
the new publication. Versions of topics that were released in a previous publication version and do 
not require modification can be used in the new publication version.

Objects in a publication can have different version numbers and do not need to correspond in any 
way to the software version of the product they support.

Tridion Docs does not support propagation of changes across multiple versions or branches of an 
object. This means if the same change applies to multiple versions or branches of an object, you 
must make the change manually in each branch and version to which it applies.

For changes that apply to the latest released version of an object, you create a new version. For 
changes that apply to an earlier released version of an object, you create a branch off of the 
earlier version.

A video about release management and creating versions and branches is available at Working 
with branches and versions.

Related links
Baselines on page 223

July 2024 DITA and TDocs Work Instructions and Guidelines 231
Comments on this document? 

232

https://documentation.avaya.com/bundle/GettingStartedWithDocTools/page/Creating_branches_and_versions.html
https://documentation.avaya.com/bundle/GettingStartedWithDocTools/page/Creating_branches_and_versions.html
https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Whether to create a new version or branch

Scenario 1: Changes required in the latest version of an object

In this scenario, changes are required in version 3 of a topic for a reissue of a publication. Version 
3 is the latest version of the topic, and it is in the Released state. When you need to update the 
latest version of a released object, create a new version.

Note:
You technically can create a branch from the latest version for maintenance updates. But 
when it’s time to create the next version, you have to remember to do create it from the 
previous full version and not from the branch (you can’t create a version 3 from branch 2.1.1). 
And any changes that you made to the branch will not be included in the new version and will 
have to be added manually. So this is not recommended.

You can create a new version of an object that is in Draft state. You might want to do this if you are 
still working on one release but starting work on the next release. But, for any changes that apply 
to both versions, you will have to make those changes manually in both versions. To minimize 
maintenance, we recommend waiting until the first version is as stable as possible before you 
create the new version.

Working with versions and branches
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Scenario 2: Changes required in an earlier version of an object

In this scenario, changes are required in version 2 of a topic, which is in a Released state. 
Because version 2 is not the latest version of the topic, you must create a new branch off of 
version 2.

Related links
Branching best practice on page 236

Scenario 3: Changes required in all released versions of an object
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In this scenario, changes are required in all versions of a topic. All versions are in Released state. 
For the latest version (version 3), you create a new version (version 4). For each of the two earlier 
versions, version 1 and version 2, you create a new branch, branch 1.1.1 and 2.1.1. Even if the 
changes required are the same, you must manually make the change in each branch and version.

Scenario 4: Changes required in earlier released version of an 
object and in the current draft version

In this scenario, changes are required in version 2 of a topic, which is in a Released state. A 
newer version exists, version 3, and is in a Draft state. Because version 2 is not the latest version 
of the topic, you must create a new branch off of version 2. If the changes that you are making to 
version 2 also apply to version 3, you can update version 3 since it is in a Draft state.

Related links
Branching best practice on page 236

When to create a new version of objects in a publication
When you have to update a publication, it can be hard to know which objects you need to update. 
For example:

• To update a topic, do you have to create a new version of the map? No, you only need to 
create a new version of the topic. The maps control the objects that are included in the map, 
their sequence, and their attributes. But the map does not control the version of the topic that 
is used in the map. That means, you can use the same version of a map in two different 
publications or different versions of the same publication, and select different versions of the 
topic in a map.

Working with versions and branches
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• To change the XML Attributes of a topic, do you need to create a new version of the topic? 
No, but you do need to create a new version of the map because you’re modifying the 
topicref and not the contents of the topic.

To determine which object needs a new version, you need to understand what each object 
controls:

• Map: Controls the topics and maps that are referenced and the order/structure.

• Publication: Controls the version of the objects that are being used.

• Topic: Controls the content.

The table lists cases where you need to create new versions of objects.

Important:

To make changes to a publication that is released, you must create a new version of the 
publication.

What you need to change What you version if it’s Released
Update the contents of a 
topic

Create a new version of the topic. You do not need to create a new 
version of the chapter map or bookmap.

Update the XML Attributes of 
a topic

Create a new version of the map but not the topic.

You are not changing the contents of the topic, but modifying the attributes 
of the topicref element in the map.

Note:

If you try to access the XML Attributes of a topic in a map that is 
released, the system prompts you to create a new version of the 
map, so you will know for which object you need to create a version.

Modify the structure of a 
chapter (such as, adding or 
removing a topic)

Create a new version of the chapter but not of the bookmap.

Add a new chapter Create a new version of the bookmap but you do not need to create a new 
version of the map you’re adding or deleting.

Update the XML Attributes of 
a map

Create a new version of the bookmap or map that includes the topicref.

Similar to the topic, you are not changing the contents of the map in this 
case. You are only modifying the attributes of the topicref element in the 
bookmap or higher-level map.

Note:

If you try to access the XML Attributes of a map and the bookmap 
or higher-level map is released, the system prompts you to create a 
new version of the bookmap or higher-level map, so you will know 
which one you need to version.

Table continues…
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What you need to change What you version if it’s Released
Change the version of a topic 
or map being used in a 
publication

Create a new version of the publication if the publication is released.

Changing the publication 
properties

Create a new version of the publication if the publication is released.

Branching best practice
Create branches of objects to update content for older product releases.

You must follow the correct branching practices of objects in Tridion Docs when working on 
various product releases. This applies to all objects, such as publications, bookmaps, maps, and 
topics.

• Create only versions from the latest version
• Create a branch to modify the content from the older topic, map, or publication version for 

older product releases and you have already started work on the new release.

Correct Incorrect
Create a new v9 from v8 for product release 8.0

Create a new v10 from v9 for product release 8.1

Branch created from the latest available topic, map, 
or publication v8

Localization projects
For localization projects, you might have more than one version for the publication and map/topics 
within it for each product release. For example:

1. V12 for Product Release 8.1 [Draft and work in progress]
2. V 11 for Product Release 8.0 GA
3. V 10 for Product Release 8.0 [Object released for localization 100% drop]
4. V 9 for Product Release 7.2.3 updates
5. V 8 for Product Release 7.2.3 [Object is released and content frozen]

Working with versions and branches
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Why should you avoid branches
• Branches are not visible in the repository and the publication baseline
• Branches are easy to miss out
• The next main version does not reflect the changes made in the branch.

In the example, version 9 does not reflect the changes from version 8.1.1, 8.1.2, and 8.1.3. 
You must add changes made in the branch again in version 9, which the writer might easily 
miss out thus making the content incomplete in the latest versions.

• You can view the branch only from the Version field in the repository and the Version 
selection pane in Publication Manager

When should you create a branch
Create a branch from the older version of the publication, map, or a topic:

• When you already have a draft version for the current product release
• When you need to update the content for the older product releases

Note:
In all other scenarios, create versions only.

Tips for managing concurrent versions
If you must maintain multiple concurrent versions, use the following tips to manage your content:

• Create new versions of only those maps and topics that require updates. You do not have to 
create new versions of all topics and maps to update a publication.

• When you must update multiple versions of the same topic, open all versions at the same 
time and make the change in all versions simultaneously. The topic “Selecting the version of 
a publication or topic to modify” includes the steps for selecting a specific version of a topic to 
check out.

• Use the publication baseline to manage the versions of topics and maps used in each 
publication. As you create new versions of topics and maps, you must select those new 
versions immediately in the appropriate publication to avoid having to go back later and try to 
sort out which version of topics and maps belong in which version of the publication.

• You can create a new version from a draft version of content. You do not need to release 
content to create a new version. However, to adhere to the process, you release content 
when it’s complete and delivered for a release. But creating a new version from a draft 
version is appropriate when you must have more than one working version of the content.

• The maps control the objects that are included in the map, their sequence, and their 
attributes. But the map does not control the version of the topic that is used in the map. 
That means, you can use the same version of a map in two different publications or different 
versions of the same publication, and select different versions of the topic in a map.

Tips for managing concurrent versions
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Viewing the version of all objects in a publication
About this task
The publication baseline displays the version of all objects included in a publication.

Procedure
1. Open the publication in Publication Manager.

2. Click the Baseline tab.

Tip:

The New Version column displays Yes if a newer version of the object exists or No if 
the latest version is used in the publication.

Checking for newer versions of objects in the baseline
You can use the baseline tab to check for objects that contain a newer version. Objects in the 
baseline can include topics, maps, or images. Use this procedure to identify whether you need to 
use the latest versions of the objects for your publication. This is especially important if you are 
reusing the common content.

Procedure
1. Open the publication in Publication Manager.

2. Click the Baseline tab.

3. Click Newer Version column heading to sort the baseline report.

All objects for which a newer version is available are grouped together. The New Version 
column displays Yes if a newer version of the object exists or No if the latest version is 
already used in the publication.

4. To locate a specific object in the publication, select the object, and then click Locate in the 
tool bar or right-click, and select Locate in Repository.

The system displays the content pane, and selects the object in the publication tree.

5. In the upper-right pane, view the Changes column to determine whether the newer version 
applies to your specific release.

The Changes column provides a description of the change or product release number for 
which the changes apply.

Next steps
If a newer version applies to your release, go to Changing the version of an object used in a 
publication.
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Related links
Changing the version of an object used in a publication on page 239

Changing the version of an object used in a publication
About this task
Use this procedure to manually change the version of an object that is used in a publication. By 
default, the latest version of objects is used but you can choose to use an older version. This is 
useful for maintenance releases and when you’re reusing from a project but can’t use the latest 
version of the content.

Note:
You cannot use different versions of the same topic in the same publication.

Procedure
1. Open the publication in Publication Manager.

View the Baseline tab to see if newer versions are available for objects used in the 
publication. The New Version column displays Yes if a newer version of the object exists 
or No if the latest version is used in the publication.

2. In the publication tree, select the object for which you want to assign or change the 
version.

All versions of the object are displayed in the right pane. The Changes column should 
indicate the changes made in any newer versions.

3. In the right pane, select the version that you want used in this publication baseline.

Related links
Checking for newer versions of objects in the baseline on page 226

Creating new versions or branches

Using Publication Manager to create a new version or branch
About this task
Use this procedure to create a new version or branch for a map or topic. When you use 
Publication Manager to create a new version or branch for a map or topic, the new version or 
branch replaces the version that is currently in the publication. When you use Publication Manager 
to create a new version or branch for a publication, the new version is opened, and the previous 
version is closed.

Changing the version of an object used in a publication
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Important:
• If you are creating a new version or branch for a publication, you must open the 

publication version to use as the initial baseline for the new version or branch. For 
example, to create a branch 2.1.1, open version 2 of the publication. Or to create version 
3 of a publication, open version 2.

• If the publication is released, you have to create a new version of the publication before 
you can create new versions of any maps or topics from the publication in Publication 
Manager.

Procedure
1. Open the publication in Publication Manager. To open a version other than the latest:

a. Click Versions in the bottom, right corner of the Open Publication dialog box.

b. In the Select Version dialog box, select the version that you want to open, and then 
click OK.

c. In the Open Publication dialog box, click Open.

2. In the publication tree, browse to and select the object for which to create the new version 
or branch, and then click Versions at the bottom, right corner of the window.

The Select Version dialog box displays all versions and branches of the object.

3. Right-click the version for which to create a new version or branch, and then click New 
Version or New Branch.

If the new version or branch is for a map or topic, the Create version of object dialog box or 
Create branch of object dialog box is displayed.

4. Complete or modify the fields on each tab of the dialog box, and then click OK.

The fields in the dialog box are the same fields that must be completed when you create 
a new map or topic. The Changes field on the Version tab is mandatory for new versions 
and branches.

Related links
Map properties on page 45
Topic properties on page 71

Using the desktop repository to create a new version or branch
About this task
Use this procedure to create a new version or branch for a publication, map, topic, or image.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the navigation pane, browse to and select the folder where the object is saved.

Working with versions and branches
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3. In the right pane, select the object, and then click Versions at the left-bottom corner of the 
window.

The Select Version dialog box displays all versions and branches of the object.

4. Select the version for which you want to create a new version or branch, and then click one 
of the following in the tool bar:

•  to create a new version

•  to create a new branch

5. Complete or modify the fields on each tab of the dialog box, and then click OK.

The fields in the dialog box are the same fields that must be completed when you create 
a new map or topic. The Changes field on the Version tab is mandatory for new versions 
and branches.

6. To close the Select Version dialog box, click OK.

Related links
Map properties on page 45
Topic properties on page 71

Using the publication baseline to create a new version or branch
About this task
Use this procedure to create a new version or branch for a map or topic.

Before you begin
Determine if the version in the baseline is the latest version or an earlier version to help you 
determine if you need to create a new version or a new branch. The Newer Version column of the 
baseline can help you.

• If this field displays No for the object, the version in the baseline is the latest. You should 
create a new version if you need to update and it’s released or you need to start working on 
the next release before the current release is done.

• If this field displays Yes for the object, a newer version exists, and you need to create a new 
branch.

The desktop repository and Content pane of Publication Manager might be more helpful because 
they display a list of all versions available for the object. Publication Manager also displays which 
version is currently used in the publication.

Procedure
1. Open the publication in Publication Manager.

2. Click the Baseline tab.

3. Right-click the version for which to create a new version or branch, and then click New 
Version or New Branch.

Creating new versions or branches
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If the baseline is frozen, the New Version and New Branch options are not available. 
You’ll need to create a new version or branch of the publication before you can make any 
updates to the content.

The Create version of object dialog box or Create branch of object dialog box is displayed.

4. Complete or modify the fields on each tab of the dialog box, and then click OK.

The fields in the dialog box are the same fields that must be completed when you create 
a new map or topic. The Changes field on the Version tab is mandatory for new versions 
and branches.

Related links
Map properties on page 45
Topic properties on page 71

Using the publication baseline to create new versions of multiple 
released topics

About this task
You can create new versions of multiple topics that are in released state in a publication. Use this 
procedure only for released topics.

Procedure
1. Open the publication in Publication Manager.

2. Select topics for which you want to create new versions, right-click and select Check Out.
3. In the Check Out dialog box, click Create a new version (the default), select the Apply To 

All check box, and click OK.

Tridion Docs displays the Create version of object dialog box for the first topic.

4. Click the Version tab, and type a description in the Changes field, then click OK.

Tip:

If the same description applies, copy and paste the description in the Changes field for 
each topic.

Tridion Docs opens the topic in XML Editor and displays the Create version of object dialog 
for the next topic. The Editor window takes precedence when the topic opens, so you 
might need to minimize the window to see the Create version of object dialog.

5. Repeat step 4 for each topic you selected.

6. When all new topic versions are created and open in Editor, you can edit the topics.

When you create new versions from the Baseline tab, Tridion Docs automatically selects 
new versions for this publication.
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Selecting the version of a publication or topic to modify
About this task
You can modify an earlier version of a publication or topic. If an earlier version is released, the 
system prompts you to create a new branch if you attempt to check out a released object.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the navigation pane, browse to and select the folder where the object is saved.

3. In the right pane, select the object, and then click Versions in the left-bottom corner of the 
window.

The Select Version dialog box displays all versions of the object.

4. Right-click the version that you want to open, and then click Check Out.

Selecting the version of a map to modify
About this task
To modify maps within the publication tree of Publication Manager, you must open a publication 
that uses the map version that you need to modify.
However, you can add or update XML attributes of a map, such as bundle name, by opening from 
Oxygen XML Author. To select a version of the map, you can use the Versions option available at 
the lower-left corner.
If a map is released, and you want to check out, the system prompts you to create a new version 
or a branch. Always, create a new version for the latest version of the map. You must create a 
branch only when you are checking out an older version of the map.

Procedure
1. Open a publication that uses the map version that you need to modify.

2. In the publication tree, modify the map.

3. When you are finished with the modifications, right-click the map in the publication tree, 
and then click Check In.

Selecting the version of a publication or topic to modify
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Deleting an unused version or branch of a topic, map, or 
image

If you accidentally create a new version or branch in Tridion Docs and the new version is not being 
used in any publications, you can delete it.

Do not delete any versions that are being used. If you do delete a version that’s being used, when 
you open the publication using that version, you’ll see the version listed with a caution icon next to 
it. You’ll must select the previous version.

Procedure
1. Log in to Tridion Docs web interface.

2. In Repository, locate the folder, and on the top-right pane, click the file.

3. When the topic details display in the bottom pane, select the left check box for the version 
that you want to delete and then select the check box at the far right for the language.

You must select the check box at the far right for the language even if the object is 
English-only.

4. Click Delete from the menu on the far right side to delete the selected language.

Important:

Ensure that you select Delete on the right side. You might need to expand your 
browser window or use the horizontal scroll bar to view the Delete option.

5. Click Yes to confirm the deletion, and click Close.

If you try to delete the version without deleting the language first, the system displays an 
error message that the object could not be deleted.

6. Select the left check box for the version again and then click Delete from the options that 
run across the top of the topic details to delete the version.

7. Click Yes to confirm deletion, and then click Close.

Deleting an unused version of a publication
If you accidentally create a new version or branch of a publication in Tridion Docs, you can delete 
it.

About this task
You cannot delete a publication version if you freeze the baseline and release the publication.

Procedure
1. Start the Publication Manager.
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2. Locate the publication in the Repository and click Versions in the bottom-left corner of the 
page.

3. When the Select Version dialog box displays, highlight the version that you want to delete 
and click .

4. When prompted to confirm, click Yes.

5. Click OK to close the Select Version dialog box.

Comparing versions and revisions

Comparing topic versions from Publication Manager
In Publication Manager, you can compare two versions of the same topic to see the differences. 
You can also compare versions of a topic from the desktop repository and web interface.

Note:

Comparing the versions is different than comparing the revisions.

Procedure
1. Start the Publication Manager.

2. Open a publication that contains the topic.

3. Select the topic for which you want to compare the versions.

The version selection pane on the right side displays the versions for the selected topic.
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4. Right-click the version that you want to compare and click Compare.

5. In the Differences dialog box, in the Compare version field select the version to use as the 
basis for the comparison.

6. In the To version field, select the version with which you want to compare.

7. Click OK.

The Differences dialog box displays the differences between the two topics. Content that 
appears in green and underlined is content that has been added in the version specified in 
the Compare version field. Content that has been removed is crossed out, and appears in 
red.
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Related links
Comparing topic revisions in the Tridion Docs web interface on page 249
Comparing topic versions from the desktop repository on page 247

Comparing topic versions from the desktop repository
In the desktop repository, you can compare two different versions of the same topic to see the 
differences. You can compare the versions of the topic from an open publication in Publication 
Manager.

Note:

Comparing the versions is different than comparing the revisions.

Procedure
1. Start Publication Manager, and click Tools > Browse Repository.

2. Locate the topic for which you want to compare the versions, in the lower-left corner, click 
Versions.
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3. In the Select Version dialog box, click Compare.

4. In the Differences dialog box, in the Compare version field select the version to use as the 
basis for the comparison.

5. In the To version field, select the version with which you want to compare.

6. Click OK.

The Differences dialog box displays the differences between the two topics. Content that 
appears in green and underlined is content that has been added in the version specified in 
the Compare version field. Content that has been removed is crossed out, and appears in 
red.

Related links
Comparing topic revisions in the Tridion Docs web interface on page 249
Comparing topic versions from Publication Manager on page 245
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Comparing topic revisions in the Tridion Docs web interface
You can compare the revisions (checkins) without a topic version in the Tridion Docs web 
interface.

Note:

Comparing topic revisions is different than comparing topic versions. You can also compare 
topic versions in Tridion Docs.

Procedure
1. Go to the Repository tab in the Tridion Docs web interface and locate the topic for which 

you want to compare revisions.

2. Select the check box to the left of the topic for which you want to compare revisions.

The details of the topic are listed below the topic list.

3. Select the check boxes on the left and right of the row of the version of the topic.

4. Click Show History on the extreme right.

5. In the History dialog box, click Show/Hide Revisions to see all the revisions of the topic 
version.

6. Select the check box to the left of the revision of the topic that you want to use as the basis 
for the comparison and click Preview.

7. When the preview displays, select a revision from the Comparing Revision version # 
with menu

The display changes to show the differences between the two versions. Content that 
appears in green and underlined is content that has been added in the version specified in 
the Compare version field. Content that has been removed is crossed out, and appears in 
red.
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Related links
Comparing topic versions from Publication Manager on page 245
Comparing topic versions from the desktop repository on page 247

Comparing publication versions in the Tridion Docs web interface
You can generate a PDF that displays the differences between two versions of a publication. You 
can only compare between versions of publications; the compare is not available for revisions 
within versions.

About this task
The publication version comparison only works with the Avaya Book output format.
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Procedure
1. Add the Avaya Book output format if you have not already added to the publication in 

Publication Manager.

2. Go to the Repository tab in the Tridion Docs web interface and locate the publication you 
want to compare versions for.

3. Select the check box to the left of the publication for which you want to compare versions.

The details of the publication are listed at the bottom of the page.

4. Select the check boxes on the left for the version of the publication that you want to use as 
the basis for the comparison.

5. Select the check box on the right side of the page next to the Avaya Book output format.

6. Click Properties on the right side of the page.
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7. In the Publication Output Properties dialog, ensure that Compare with version is checked 
and select the version for which you want to compare.

8. Click Modify.

9. Publish the Avaya Book output format.

10. When the publishing request completes, download the output.

Content that is added to the version that you selected as the basis appears in green and 
underlined; content that is removed appears in red and is struck through.
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Chapter 19: Managing graphics

Image guidelines
Conventions

• Use 1920x1080 screen resolution without any upscale when taking screenshot.

• Ensure the image is not more than 6 inches width and 10 inches length. If you do not include 
a title for the figure, you can keep the length up to 10.25 inches.

Note:
If the image is larger than the text box, it is automatically scaled during production to fit if 
the placement attribute is set to break on the graphic.

• Resize images using the source tool. However, you can use attributes on the image element 
to scale an image in the output.

• Ensure that the font size is 14, see step 4 in Embedding text in an object on page 371 for 
more information.
The Localization team might need to reduce font size to fit longer translated strings into 
image objects.

File naming conventions for images
Use the file naming conventions that you use for your XML/DITA files. The file name need to 
be meaningful, in camel-case with no spaces. For example, use “VustatsDisplayExample”. Avoid 
using file names that imply a logical or hierarchical order. For example, do not name your files as 
Fig2-2 or Chap3Image. The location of your image might change and this naming convention will 
not make sense if the image is reused in other deliverable or media.

Supported images formats
You can include the following image formats in DITA topics:

• png
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• gif
• svg

Important:
HTML and HTML5 outputs do not support eps (Encapsulated PostScript) images. Therefore, 
you cannot view these images in the HTML files opened in browsers. You must convert eps 
images to the png format by using applications, such as Inkscape and Adobe Illustrator.

Scalable vector graphics (SVG) is an XML-based image format with the following benefits:
• SVG is a vector-based format rather than bitmap-based, such as png and gif. Vector-based 

graphics, line drawings and text in specific, do not lose image quality when scaled.
• SVG has higher resolution than the image formats we currently use.
• Because SVG is XML-based, the text in SVG can be translated to different languages.

Use the Inkscape software that is freely distributed to create and edit an SVG image. For 
instructions to create SVG using Inkscape, see Creating SVG images using Inkscape on 
page 364.

Text in drawings
Do not embed text in png or gif drawings unless the drawing does not make sense without 
callouts. You can embed text in SVG images that can be translated to various languages.
When uploading images in Tridion Docs, only select the Enable translation management check 
box for SVG images with embedded text. Do not select this check box for other image types that 
are not localized.

DITA elements for images
You can use one of the two ways to tag an image within a DITA topic:

• Image element if you do not need to add supporting information, such as a title or legend for 
call-outs (simpletable element) with your image.

• Image element inside a fig element to:
- Include a title or description (desc element) with your image.
- Provide a legend for your call-outs in simpletable element.

Accessibility
Ensure that you include an alt element inside the image element to make the image accessible for 
users using screen readers or text-only readers.

Placement attribute
When you insert an image into a topic, use the placement attribute to determine if the image 
breaks to a separate page in the output when appropriate or always stays with the text around it:

• Set the placement attribute to break when the image must be independent of the text 
around it and break to a new page in the output when appropriate. Use break in almost all 
cases.

• Set the placement attribute to inline when the image must stay with the text around it. This 
value can cause awkward page breaks in outputs and must only be used when an image is 
nested within text. Do not use the Inline attribute.
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When the placement attribute is set to break, images that are large for the page are automatically 
scaled to fit in the text box.

Test image in the output
Generate the output and verify how the image is displayed. The way the image displays in Editor 
is not always a true representation of how it appears in an output.

Related links
Scaling images in topics on page 265

Accessibility of images
Add the alternate text for images to make the image compliant with Section 508 of the 
Rehabilitation Act, which was enacted to make electronic and information technology accessible 
to people with disabilities. When you add the alternate text, screen readers or text-only readers 
can read the text in a tagged PDF. In DITA, we use the alt element to add additional description 
to images or objects like embedded tutorials. If we do not provide the necessary alt text, you 
cannot produce a tagged PDF on request, which might impact on making certain sales, especially 
Government sales.

Note:

Alt text is required only for images in the following:

• End user content: User Guides, Quick Reference Guides, endpoint Installation and 
Maintenance guides

• Overview content: Solution Descriptions, Overview and Specifications

Avoid using images that require long descriptions in the alt tag.

To limit the description in the alt tag, use callouts in a table below an image or provide a 
description that introduces the image. See the information on using alt text in the Accessibility 
section of the Avaya GIS Customer Documentation Standards (CID 156561).

Avoid puncutation marks in the description text.

Related links
Making images and objects accessible on page 255

Making images and objects accessible
About this task
For screen readers or text-only readers to read the text to support content access to users with 
disabilities, you can add description to images and objects.

Accessibility of images
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Procedure
1. Check out the topic in Oxygen XML Author.

2. To add a description to an image:

a. Double-click or select the element.

b. In the Attributes window, click alt and type a description for the image.

The reader using a screen reader must understand the drawing by your description. 
Descriptions might be quite long. If the alt text is a sentence fragment, do not add any 
punctuation at the end. For example, if the text is “Folder icon”, do not add a period at 
the end.

3. To add a description to an object element:

a. Double-click or select the element.

b. In the Attributes window, click name and type a description for the object.

Ensure that the description you provide is sufficient to help the reader using a screen 
reader understand the purpose of the object.

Related links
Checking accessibility and generating a report on page 141
Accessibility of images on page 255
Accessibility of images on page 255

Line drawings
Unless you are creating a flow diagram or a very simple block diagram, it is recommended that 
you use a graphic artist.

The existing projects have many hardware drawings that writers created. It might take time to get 
the drawings redone by a graphics artist, if it is determined that the cost is worth the benefit. This 
will have to be decided on a project basis.

Create line drawings in SVG format so that they appear in a higher resolution in outputs and the 
text can be translated.

Screenshot considerations and guidelines
Use guidelines while documenting installation and configuration tasks and other tasks that 
describe how to use features within a product.
Include screenshots when screenshots:

• Help reassure the user that where they are in the UI is the right place to be
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• Help call attention to a specific area of a complex UI
• Support an example that is hard to visualize otherwise, for example, setting up a 

configuration that is not quite straight forward
Where they add value, documentation maintenance and localization might be time-consuming and 
costly. However, just as you would with words, omit the obvious and whatever does not add value.
Strive for an additive approach (add screenshots when the words seem inadequate) over a 
subtractive approach (do not include screenshots if they seem superfluous). In other words, be 
more open to screenshots in the future, but understand that they have to work in the document, 
not just be there because they can.

Considerations
Before you include screenshots in documentation, consider the following points:

• Task-oriented content requires fewer screenshots than a descriptive approach. Avaya 
DITA/XML information model dictates a task-oriented approach that reduces the need for 
screenshots.

• Usability studies show that users can confuse screenshots with the real application. Users 
must scroll screenshots to get to the next piece of information. Screenshots slow down the 
user access to information.

• Content that describes in detail in text is more accessible to users with disabilities than 
content with text plus pictures. If a screenshot does not provide additional technical 
information, then the content becomes complex for disabled users.

• Every screenshot requires accessibility text. You must update this text each time the 
screenshot is updated. There is a risk of the accessibility text being out-of-step with the 
screenshot, or with the application. These factors add to the maintenance load for the writer, 
and can confuse the disabled user. The alternate text must also be localized, which adds 
time and cost.

• Screenshots, in general, add to the translation burden and cost. The localization team has to 
capture all screenshots in each language. Also, translators have to translate the accessibility 
text associated with each screenshot into each language.

• Assess the requirements for all publication methods and how the intended audience will use 
the content. Some Avaya products have a requirement to group documentation covering 
broad topics into “libraries” of information and PDF files which cover may areas of the 
product, such as administration and end user tasks. These deliverables bring together and 
reuse DITA/XML topics that may also appear as online help. PDF files are not always used in 
conjunction with the application.

Guidelines
Use the following guidelines for including screenshots in documentation:

• Do not use screenshots as a matter of course. Remember that the user usually has the 
application open, so that a screenshot does not provide any additional information and may 
cause confusion.

• Include a screenshot only when a procedure or step is complex and a screenshot will 
alleviate the need for numerous, convoluted steps. (In most cases, if a task is that 
complicated, you must suggest changes to the user interface which would make the task 
easier for the user.)
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• Do not substitute screenshots for writing the text for the steps the user needs to perform and 
must only be used to provide clarification or validation. Do not use a screenshot to avoid 
including the appropriate text that tells the users what to do.

Note:
Where there are no screenshots, the procedure must clearly include the screens to 
select (show path) and the fields to click (or tab to) and mention the purpose of the 
screen, dialog box or field depending on where you are in the steps.

• Include a screenshot in the first concept topic of a component map to verify that the content 
describes the same interface that the user is viewing online (this is not mandatory if it is 
already clear). For example, use it to set context and to describe general navigation within 
an interface. The trade off is that when the user interface changes, you must recapture the 
screenshot and rewrite the text that increases the localization cost.

• Do not use screenshots for aesthetic purposes or because it looks better to start all 
procedures with screenshots. For example, do not use screenshots to break up long 
passages, or to show that every step in a task has been completed correctly.

• Ensure that a screenshot supports the text, rather than verifies or repeats what the text says.
• You do not get the higher resolution or ability to translate text in SVG graphics. But if you plan 

to include any text callouts with your screen capture, use SVG because the text callouts can 
be translated.
To avoid text callouts, you can use PNG image, add numbers to identify specific portions in 
the image, and add the text description in a simple table that follows the image.

Tool recommendations
You may use

• Snipping Tool to capture screenshot.
• Gimp or Inkscape to create and edit images and add text.

Icons
You can use icons in DITA topics. However, you must follow these requirements:

• An image element must include an alt tag with a description of the icon that can be read by a 
screen reader for persons with vision impairment.

• If your content contains a lot of icons, create a common topic with icons and the alt text in the 
image element. With this, the Localization team can translate the common topic that includes 
the alt text only once, and do not require to retranslate separate instances of the alt text.

• The height attribute on the image element must be set to 11pt to maintain the size of all icons 
same, and to maintain the line spacing.
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Important:

If the icon is complicated that it cannot be read at 11 pt, you must not include it in steps 
and paragraphs. Instead, provide it in a reference table with other graphics and use the 
icon label in steps and paragraphs.

• If an icon size on Avaya Documentation Center is larger even after the height is set to 11, set 
the outputclass attribute of the image to icon in Oxygen XML Author.

Photographs
In most cases, you must involve a graphic artist to convert your photograph into a graphic. If 
you must use a photograph, ensure that you test visibility in all your outputs, and remember that 
photographs rarely look good in print. Export the photograph as a JPEG file.

Importing images
About this task
Image files must be in the svg, gif, or png format. Use the jpg format only if you are unable to 
get the file in svg, gif, or png format.

Photographs
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Save the images in a folder with content type set to Image. Usually, this folder is named images 
for consistency. However, you can give a different name based on your project. You can import 
multiple images at a time from the same source folder.
See the Importing and adding an image to a topic video for steps to add images to a topic.

Before you begin
Create the images folder within your content folder, if it does not already exist.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

2. In the navigation pane, browse and select the folder to which you want to upload the 
image.

3. On the right pane, click the import ( ) icon.

4. On the Import File dialog box, browse and select one or more files to import, and then click 
Open.

The system imports the files and displays the Add Object dialog box.

5. In the Title field, add a name to identify the image.

Add SVG in the title to distinguish an SVG image from other formats.

For example, ConfigurationDiagram_SVG.

6. For SVG images, on the Add Object dialog box, click Enable translation management.

Do not select any languages; the Localization team must do that.
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7. Complete the fields on each tab as appropriate.

8. Click OK.

Related links
Image properties on page 261
Creating a new folder from Browse Repository on page 24

Image properties
These properties are displayed in the Add Object dialog box and Properties dialog box for an 
image.

General tab

Name Description
Title Title for the image. The title can contain 

alphanumeric characters, spaces, hyphens, and 
underscores. Do not use slashes, asterisks, or other 
special characters. This is a required field.

Example: Managing users
In Folder Path to the file.
Identifier Unique identifier of this file. This field displays only 

for the existing images.
Content type The type of image. The options are:

• Block diagram

• Icon

• Network Topology diagram

• Other illustration

• Process Flow diagram

• Screenshot
Description A description of the image. This field can contain 

any text and is optional.
Date created The date when the image was imported to Tridion 

Docs.
Date modified The date when the image was modified in Tridion 

Docs.

Table continues…
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Name Description
Enable translation management The option to set the image for translation.

Important:

• For SVG, select the check box

• For other type of images, leave the field at 
the default

Requested languages For localization use only.
Inherited languages The field is auto populated.

Version tab

Name Description
Version The version of the image. The field is auto 

populated.
Changes A brief description of changes made in this version 

of the image. This field is relevant if the image is a 
new version of an existing image.

Candidate for baseline
Baseline label This field lists the frozen baselines that use this 

topic. This field is automatically populated.

Workflow tab

Name Description
Language The language of the object. This field is 

automatically populated
Status Workflow status. Options are:

• Draft

• Editorial review

• Pre-release validation

• Technical review

• Released
Author The owner of the image.
Last modified by The last person who modified the image. The field 

is automatically populated.
Resolution Image resolution. The values are low and high.

PNG, GIF, and JPG images are of low resolution.
Source language This field is blank.
Comments Comments about the workflow. Use this field to 

create a history of changes you make. For example, 
SMGR-1234 updates and R10.2 updates.
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Avaya-specific fields tab

Name Description
Product Family The product category or family to which the product 

belongs.

This is a required field.
Product The product that this image supports.

This is a required field.
Contributor This field is not currently used.
Doc Lead This is a required field.
Localization Coordinator For localization use only.
Reviewer You can optionally specify another Tridion Docs 

user as a reviewer for an object. This is useful when 
content is in the editorial review phase in workflow 
and you want the object to appear in the inbox of 
the selected user.

The user that you want to select in the Reviewer 
field must be assigned the role of Reviewer in 
Tridion Docs. Open a ticket on the Infosolutions 
project to add the Reviewer role for the user if the 
name is not available for selection.

Related links
Importing images on page 259

Inserting an image in a topic
About this task
If you are referencing an image that has multiple versions, you can select the version of the image 
that you want to use in the publication. If a topic referencing an image is used in different versions 
of a publication, you can select different versions of the image to use in the different versions of 
the publication, even if the version of the topic is the same. But if you are referencing the same 
image multiple times in the same publication, you cannot use different versions of it.

Before you begin
Import the image into the Tridion Docs repository. See Importing images on page 259.

Procedure
1. Check out the topic in which you want to insert the image.

2. (Optional) To add a title for the image:

a. Place the cursor where you want to insert the image in the topic and insert a figure 
(fig) element.

Inserting an image in a topic
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b. Insert a title element within the fig element, and type a title for the image.

3. Place the cursor where you want to insert the image in the topic and insert an image 
element.

4. In the Insert image window, browse and select the image.

5. Preview the image to see if you selected the correct image.

6. To add a title to the image, type a text in the Figure title field.

The editor wraps the image element within the figure element.

7. For larger images, such as block diagrams set the placement attribute to break.

The placement attribute determines whether the image can break to a new page when 
appropriate or stay with the text around it. If you leave the placement attribute at the 
default of inline, it can cause some strange page breaks in your PDF output and it will 
prevent the image from being automatically scaled to fit in the width of the text box. For 
images that are too long, use the height attribute to constrain the height.

8. In the Attributes dialog box, set one of the following attributes to control the size of the 
image in the output:

• width: If the image is too wide, set the width in inches. Enter the number followed by “in” 
to indicate inches.

When you set the width, the height is proportionally scaled.

• height: If the image is too long, set the height in inches. Enter the number followed by 
“in” to indicate inches.

When you set the height, the width is proportionally scaled. The maximum height you 
can use is 8.75in. If you are using an image and not the fig element, or you are using fig 
but not including a title, you can set slightly higher than 8.75in.

• scale: To scale the image to a specific percentage. Do not enter the percentage 
character; it is assumed.

9. If you need to use the image for an end user output, within the image element, add an alt 
element, and type a description of the image to make the image accessible for users using 
screen readers or text-only readers.

Do not use the Alternative text (alt) attribute in the Image element.

10. Click Insert.

If an image has multiple versions, and you want to select an older version, you cannot 
do that when you insert the image. But after you insert the image, you can locate where 
the image is being referenced on the Content tab in Publication Manager and select the 
version.

The image with selected attributes gets added in the topic.
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Scaling images in topics
About this task
You can apply attributes to an image element to scale the size of an image up or down in your 
output. The attributes do not impact the image itself; but the size displayed in the output. This 
means that if you use a image in more than one topic, you can control the size in each topic in 
which the image is used.

Procedure
1. Check out the topic in Oxygen XML Author.

2. Double-click or select the image element.

3. In the Attributes dialog box, set one of the following attributes to control the size of the 
image in the output:

• width: If the image is too wide, set the width in inches. Enter the number followed by “in” 
to indicate inches.

When you set the width, the height is proportionally scaled.

• height: If the image is too long, set the height in inches. Enter the number followed by 
“in” to indicate inches.

When you set the height, the width is proportionally scaled. The maximum height you 
can use is 8.75in. If you are using an image and not the fig element, or you are using fig 
but not including a title, you can set slightly higher than 8.75in.

• scale: To scale the image to a specific percentage. Do not enter the percentage 
character; it is assumed.

Example
In the following example of an image, the height is limited to 3 inches.

Related links
Image guidelines on page 253

Scaling images in topics
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Setting the orientation of a figure to landscape
If a figure in a topic requires more width to display properly, you can set the figure to appear 
in landscape orientation in your PDF output. This option is available for the Avaya Book, Avaya 
Jobaid, and Validator PDF outputs.

About this task
• When you apply this option, the actual page in the PDF still appears in portrait orientation; 

the figure is rotated on the page to appear in landscape orientation.
• Landscape is supported only for the <fig> element. You cannot apply it to an <image> 

element.
• When you apply this option, a page break is inserted right before and right after the <fig> 

element in the output.
• If you include a <title> or <desc> in the <fig> element, the title and description appear in 

landscape orientation.

Before you begin
Ensure that the image is inside a <fig> element.

Procedure
1. Start the Publication Manager.

2. Check out the topic that contains image that you want to display in landscape orientation.

3. Double-click or select the <fig> element containing the image.

4. In the Attributes window, type land in the outputclass field.

5. Click OK.

6. Check in the topic.

Extending an image to the left margin
For a larger image, you can extend it to start at the left margin and align with the topic heading.

Before you begin
Ensure that the image element is added inside the parent fig element.

Procedure
1. In the publication, check out the topic in Oxygen XML Author.

2. Double click or select the figure element, the parent of image element that you want to 
modify.

3. In the Attributes window, set the expance attribute to page.
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You can set this property only on the fig element and not cannot extend the margin for an 
image element.

4. Click OK.

Extending an image past the right margin
By default, images are scaled during PDF generation to 6.25” in width to align with the text box, 
if the placement attribute is set to break on the image element. To extend an image beyond the 
right margin, but still within the page, you can override the default setting.

Procedure
1. In the publication, check out the topic in Oxygen XML Author.

2. Double click or select the image element.

3. In the Attributes window, type a value between 6.3in and 6.75in in the width field.

The value you enter depends on how far you want the image to extend past the text box 
margin. If the image is available on the first page of a chapter, you can extend beyond 6.75 
inches.

Extending an image past the right margin
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Updating an image by checking it out and modifying it
Before you begin
If the status of a image that you want to modify is released, create a new version of the image 
in the desktop repository. This is especially important if you are working on multiple releases 
simultaneously and have multiple active versions of publications.

Procedure
1. In the Tridion Docs repository, navigate to the folder that contains the image that you want 

to update.

2. Right-click the image and click Check Out With.
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3. On the Open With dialog box, select the application that you want to use to modify the 
image and click OK.

4. Modify the image, save your changes, and close the file.

5. In the Tridion Docs repository, right-click the image and click Check In.

6. On the Check In dialog box, click OK.

7. In Publication Manager, open the publication, navigate to the topic that contains the image 
you updated, and check the preview to validate that the changes that you made in the 
image.

Updating an image by uploading a new version in the web 
interface

Before you begin
If the status of an image that you want to modify is released, create a new version of the image 
in the desktop repository. This is especially important if you are working on multiple releases 
simultaneously and have multiple active versions of publications.

Procedure
1. In the Tridion Docs web interface, navigate to the folder that contains the image that you 

want to update.

2. From the list, select the image that you want to update.

The details about the selected image appear in the lower part of the page.

3. Select the appropriate version and language check boxes.

The version check box is the check box shown below to the far left that appears under the 
Filter button. The language check box is the check box shown to the far right below. If the 
image is not translated, only one language for English is displayed.

4. Click Check In from the menu on the right side of the page.

Updating an image by uploading a new version in the web interface
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5. When the InfoShare — Document Window displays, click Browse next to the File field, 
then navigate to the updated version of the image that you want to upload and click Open.

6. If the image that you are uploading is a different format than the original, select the 
appropriate option from the Format menu.

7. Click Modify.

8. In Publication Manager, open the publication, navigate to the topic that contains the image 
that you updated, and check the preview to validate the changes that you made.

Forcing a large image to the next page in a 3-column quick 
reference guide

About this task
Some projects might need to include large images, such as a navigation map of keypresses or 
options, in a Quick Reference output. These images are unreadable if constrained to a column. 
We cannot span the columns due to limitations in processing, but we can make the large images 
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appear to take up a whole page. To try this functionality and you have any questions, contact 
Information Architect.

Before you begin
• The topic must contain only the large image besides the topic title.
• You must already have an image that is approximately the right size for the landscape page 

in the 3–column quick reference output.

Procedure
1. In the publication, check out the topic with the large image in Oxygen XML Author.

2. Double click or select the topic's root element.

For example, task element in a task template.

3. In the Attributes window, in outputclass, type worksheet.

4. Click OK.

5. Check in the topic and produce the output to validate that the topic starts on a new page.

Creating images with links
DITA provides support for image maps, which are images with “hot spots” that link to other topics 
or files. The linked topics or files can be displayed in the active window or in a new pop-up 
window. Image maps are supported only for HTML outputs.

Before you begin
Create the image that you want to use as an image map and import it into Tridion Docs.

Procedure
1. Open the image in any tool such as Microsoft Paint.

Creating images with links
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2. Do the following to record the coordinates of each object or shape for which you want to 
create a link.

The number of coordinates that you need to record depends on the shape of the object 
(rectangle/square, circle, or polygon):

• For a rectangle or square, record the coordinates of the top left corner and bottom right 
corner.

• For a circle, record the center coordinates and right center coordinates (radius).

• For a polygon, record the coordinates of all angles. Start at the top left angle. Or you can 
simply identify coordinates of an area that surrounds the polygon. It depends on how 
closely you want the image map area to follow the shape of the object and how many 
coordinates you want to capture. The first and last coordinate pair must always be the 
same to close the polygon.

The method used to capture the coordinates of a shape varies across image editor 
applications. For example, in Microsoft Paint, when you hover the pencil tool over a point 
in the drawing, the coordinates are displayed in the lower-right corner of the screen. In 
the sample below, the coordinates of the upper-left corner of the XMPP Director box are 
198,104 as shown in the lower-right corner of the screen.

Managing graphics

July 2024 DITA and TDocs Work Instructions and Guidelines 272
Comments on this document? 

273

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


3. In the Tridion Docs repository, locate the image that you want to use for the image map, 
right-click the image and select Properties.

4. In the Properties dialog box, copy the GUID value from the Identifier field.

5. In the publication, check out the topic in Oxygen XML Author.

6. In the topic, insert an imagemap element, click the Tridion Docs icon and browse to the 
image that you want to add as image map.

The editor adds an image element within the imagemap element.

7. In the image element, click Image Map Details.

The editor displays the following fields:

8. In Image Map Details, select a shape for the first linkable area that you want to define in 
the image:

• rect: Define a rectangular, square, or triangle region. If you leave the shape element 
blank, a rectangular shape is assumed.

• circle: Define a circular region.

• poly: Define a polygonal region.

The area element is located immediately after the image element.

9. Within the area element, in coords, type the coordinates for the linkable area that you are 
defining, separating each coordinate with a comma:

• For a rectangle, square, or triangle, enter the top left coordinates and bottom right 
coordinates, for example 65,74,119,128.

• For a circle, enter the center coordinates and the radius, for example, 263,348,41.

Tip:

To calculate the radius, subtract the center first coordinate (center x coordinate) 
from the right first coordinate (right x coordinate). For example, if the center 
coordinates are 263,348 and the right coordinates are 304,348, subtract 263 from 
304 to calculate the radius of 41.

• For a polygon, type the coordinates of every angle. The first and 
last coordinates must be the same to close the polygon, for example, 
192,135,357,132,217,158,216,238,192,135.
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10. Within the area element, in the xref element, define a target for the linkable area that you 
are defining:

• To link to another topic, get the GUID (ID) of the target topic, and paste it in the href field 
of the source, and click OK.

• To link to an external target, select the xref element, and in Attributes window, enter the 
full path to the target location in the href field, set the scope to external, and click OK.

11. (Optional) If the xref target must display in a new pop-up window instead of the active 
window, perform the following steps:

a. Double-click or select the xref tag.

b. In the Attributes dialog box. type popup in the outputclass field.

c. Click OK.

12. To add more linkable areas, place your cursor before the ending imagemap tag, press 
Enter, select New area, and then repeat Steps 7 through 10 for each area element.

The editor adds a new row 2 below where you can add the details for the second linkable 
area.

13. Check in the topic.

14. Produce the HTML output and test the links from the image.
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Chapter 20: Working offline

Local storage
In Tridion Docs, you can make content available in your local storage, and work on that content 
when you are not connected to the Tridion Docs repository. When you connect to Tridion Docs 
again, you can check in the topics that you modified locally.

All topics that you open in Oxygen XML Author are added to your local storage. You can modify 
only the topics that you checked out. However, you can view the content in your local storage 
that is not checked out. If you have checked out topics in Oxygen XML Author, and you are 
unexpectedly disconnected from the network and Tridion Docs, you can continue to work on topics 
that you have checked out.

You cannot edit topics in your local storage that others checked out.

Note:

Do not keep topics checked out in your local storage for longer. Use local storage only when 
you need and then check in topics immediately after you make the updates so that the 
repository has the latest version of the content.

You must be connected to Tridion Docs to make topics available in your local storage.

Important:

Your local storage can grow large over time, and due to which Publication Manager might 
close unexpectedly while you are working. Therefore, delete content from your local storage 
regularly.

Viewing a list of topics in your local storage
About this task
In the local storage, the Mode column displays the status of a topic. When disconnected from 
the network, you can work on topics in the Checked out status. You cannot work on topics in 
Checked in and Released states when you are disconnected from the network.

Procedure
In Oxygen XML Author, click SDL Tridion Docs > Open local storage.
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The Local storage window displays the topics, maps, images available in your local storage.

Checking out a topic in preparation for working offline
You can check out a topic and save it to your local storage so you can work on the topic while you 
are offline.

About this task
Before going offline, you must check out the topics that you want to work when you are offline. Or 
if you lose your connection to the repository while you are working, you can continue to work on 
files that are currently checked out to you and then save them to your local storage.

Procedure
1. Check out the topic or topics that you want to work while you are offline.

2. In Oxygen XML Author, click SDL Tridion Docs > Make Available in Local Storage.

If you unexpectedly lost connectivity while working on a topic, perform this step when you 
finish working on the topic.

The system saves the topic to your local storage and closes.

Next steps
Modify the topic in the local storage and check in the topic to the Tridion Docs repository as soon 
as you are reconnected to the repository.

Managing topics open in Editor if you lose your 
connection

If you lose your network connection, you can save the topic to your local storage and continue 
to work on it. When you connect to Tridion Docs again, you can check in the updated topic into 
Tridion Docs.

About this task
You might notice that the network connection is unavailable or you might not notice until you try to 
check in the topic. In either case, you can save the changes to your local storage and then either 
close the topic or continue to work.

Procedure
1. In Oxygen XML Author, click SDL Tridion Docs > Make Available in Local Storage.

If you unexpectedly lost connectivity while working on a topic, perform this step when you 
finish working on the topic.

Working offline
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The system saves the topic to your local storage and closes.

2. You can continue to work on the topic or close the editor.

3. If you close Editor, you can reopen it and work on the topic stored locally.

4. Check in the topic into Tridion Docs when you are connected.

Related links
Modifying a topic in local storage on page 277
Checking in a locally stored topic to the Tridion Docs repository on page 279

Modifying a topic in local storage
About this task
You can modify a topic when you are disconnected from the network. If the system displays 
the following message, click OK to continue: Unable to reach the SDL repository 
‘avaya001.sdlproducts.com’.... This message might be displayed at different points in 
the following procedure.

Before you begin
The file that you want to modify must be checked out by you before you disconnect from the 
network.

Procedure
1. Open the file in Oxygen XML Author if it is not already open:

a. In Oxygen XML Author, click SDLTridionDocs > Open Local Storage.

b. In the Local Storage window, select the topic to modify, and then click Check Out.
2. Modify the topic as required.

3. Click SDLTridionDocs > Make Available in Local Storage to save the updates to local 
storage on your hard drive.

The system closes the topic.

4. Repeat this procedure to modify the locally saved topic any number of times.

Next steps
Check in the topic to Tridion Docs as soon as you can so that the repository has the latest version 
of the content.

Related links
Managing topics open in Editor if you lose your connection on page 276
Checking in a locally stored topic to the Tridion Docs repository on page 279

Modifying a topic in local storage
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Comparing a topic in Local Storage with the version 
stored in the Tridion Docs repository

You can compare the version of a topic stored in Local Storage with the version currently stored 
in the Tridion Docs repository. This is helpful if you have topics checked in your Local Storage and 
you want to determine if there are changes you should check in.

Before you begin
You must be connected to the Tridion Docs repository to compare a topic in Local Storage with the 
topic that is stored in the repository.

Procedure
1. In Oxygen XML Author, click SDL Tridion Docs > Open local storage.

The Local storage window displays the topics, maps, images available in your local 
storage.

2. Locate the topic in the Local Storage dialog box, right-click the topic, and click Compare.

The Differences dialog box highlights any differences in the topics.

3. To exit the Differences dialog box, click Close.

Opening a topic in Oxygen XML Author in read-only mode
About this task
You can view a topic in read-only mode when the topic is:

• In the Released state
• Checked out by other user
• Located in a folder to which you do not have permissions

Procedure
1. Start Publication Manager.

2. Do one of the following:

• In Browse Repository, select the topic, right-click, and click Open.

• In Oxygen XML Author, click SDLTridion Docs > Open, navigate to the topic, right-click 
and click Open.

The topic opens in read-only mode. You can see details, such as tags, conditions, and 
conrefs.
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Checking in a locally stored topic to the Tridion Docs 
repository

About this task
You can check in a topic that you have modified in the local storage.

Before you begin
You must be connected to the Tridion Docs repository to perform this procedure.

Procedure
1. In Oxygen XML Author, click SDL Tridion Docs > Open local storage.

The Local storage window displays the topics, maps, images available in your local 
storage.

2. Select the topic that you want to check in to the repository, click Open, and then click 
Check In from the editor.

The system displays the Check in dialog box.

3. To change the workflow status of the topic:

a. Select Change status.

b. In the Status field, select the appropriate status.

4. Click OK.

Related links
Managing topics open in Editor if you lose your connection on page 276

Deleting content from your local storage
About this task
Your local storage can grow large over time, and due to which Publication Manager might close 
unexpectedly while you are working. Therefore, delete content from your local storage regularly.

Important:
Do not delete checked out topics from your local storage unless you do not want to save your 
changes to the repository. Check in the topics before deleting them.

Procedure
1. In Oxygen XML Author, click SDL Tridion Docs > Open local storage.

The Local storage window displays the topics, maps, images available in your local 
storage.

2. Select the topics to delete, and then click Delete in the tool bar.

Checking in a locally stored topic to the Tridion Docs repository
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Chapter 21: Troubleshooting

SDL server maintenance schedule
SDL performs the following standard maintenance operations of Tridion Docs servers:

Database jobs
• Full backups: 10:30 PM BST (3:00 AM IST, 5:30 PM EDT) every Friday for about a day and 4 

hours.
• Differential backup: 10:45 PM BST (3:15 AM IST, 5:45 PM EDT) daily for about 45 minutes.
• Standard InfoShare Job: 1 :30 AM BST (6:00 AM IST, 8:30 PM EDT) every Monday, 

Wednesday, and Friday for about 2 to 2.5 hours to clean event logs, revisions, check 
database, and index maintenance.

Server maintenance
• Monday to Friday: 02:00 AM BST to 04:00 BST (6:30 AM to 8: 30 AM IST, 9:00 PM to 11:00 

PM EDT)
• Saturday and Sunday: 02:00 AM BST to 08:00 BST (6:30 AM to 12:30 PM IST, 9:00 PM EST 

to 3:00 AM EST)

The SDL server continues to run during these maintenance periods. The system performance 
might be slower during the daily database maintenance. However, backups do not have impact on 
system performance.

Requesting assistance with the DITA authoring tools

DITA Authoring Tools support
When you have questions, issues, or requests related to the DITA authoring environment, submit 
requests to the Infosolutions project. You can view Jira tickets that other team members submitted 
and the resolution.
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Note:
• Before you create a support ticket, consult DITA and Tridion Docs Guidelines for the 

information you need.

• Log in to Avaya Documentation Center to view the content in DITA and Tridion Docs 
Guidelines.

Creating a new support request
Before you begin

• Log in to the Avaya network to use the Jira software.
• Request for access to the INFOSOLUTIONS project.

Procedure
1. Go to the Infosolutions Jira project.

2. Click Create.

3. Provide the issue type, priority, and severity of the issue.

4. In Components, select an appropriate value.

See Create the DITA support ticket.

5. Click Create.

The form is submitted and the assignee is notified of the issue.

Requesting assistance with the DITA authoring tools
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Example

Figure 7: Create a DITA ticket in Jira

Related links
Create DITA support ticket on page 283

Troubleshooting
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Create DITA support ticket
General tab

Name Description
Issue type Type of issue. The options are:

• Bug

• Enhancement

• Task

Tridion Docs title for the topic. You can include only 
alphanumeric characters, spaces, hyphens, and 
underscores. Do not use characters, like slashes, 
asterisks, periods, parenthesis, or other special 
characters. The maximum length is 100 characters 
including spaces. The length restriction is important 
because Tridion Docs uses the Tridion Docs topic 
title as part of the topic's temporary filename. This is 
a required field.

Priority To determine, how urgently you need the fix.

• P1: Resolve immediately

• P2: Give High Attention

• P3: Normal Queue

• P4: Low Priority
Severity To determine the impact of the issue.

• 1: Critical

• 2: High

• 3: Medium

• 4: Low
Components The request or problem area. The options are:

• Documentation Center

• Oxygen license and Tridion Docs account & 
Folder Permissions

• SDL Tridion Docs-Oxygen Editor

Table continues…

Requesting assistance with the DITA authoring tools
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Name Description
Description The detailed description of the issue or request.

Also, provide the following details to get the issue 
resolved on time:

• Publication name and version number.

• Location of the publication in Tridion Docs.

• Topic name and version number.

• Any other information that can help identifying the 
cause.

Attachment Add a screen capture or any supporting email or 
document that helps resolving the issue or providing 
the support.

Affected versions Area that this issue belongs. The options are:

• Documentation Center

• SDL Tridion Docs

• Oxygen XML Author
Create Saves and submits the form.

Also, the assignee receives an email notification 
with the issue details.

Filtering or sorting the Jira tickets
About this task
By default, all requests display in the list. But you can filter the list of requests based on the status, 
by the originator of the ticket, the status, etc.

Procedure
1. Go to the Infosolutions Jira project.

2. From the menu, click Issues > Search for issues.

3. Select the filters, such as type, status, assignee.

4. Click More and add more search filters, such as create date, and components.

5. Click Search.

6. Click Save as at the top to save the search results.

How support requests are managed
Submitted requests for support are handled by Information Architect, Russ Pierce, and DITA 
Mentors.

Troubleshooting
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Standard working hours for support are:

• United States:

- 6AM to 4PM Mountain time

- 8AM to 6PM Eastern time

• India – 9.30AM to 6.30PM IST

The following is the expected response and resolution times:

• Priority 1 – Picked up within one hour and resolved ASAP (during standard hours)

• Priority 2 – Picked up within four to six hours and resolved within one working day

• Priority 3 – Picked up within six to eight hours and resolved within five working days

• Priority 4 – Enhancement will be reviewed 1x/month and action taken if appropriate

However, issues that require a support ticket with a vendor or that require modifications to our 
stylesheets might take longer. We always try to resolve issues as quickly as possible

Examples of issues at different priority levels:

• Priority 1: SDL system is not reachable, no one can publish any outputs, you have installed 
or reinstalled the software and you are unable to use it.

• Priority 2: Errors in logs you cannot troubleshoot, outputs does not appear as expected, need 
assistance releasing content, need a permissions change, or request for addition of new 
product or application name, and request for a new condition.

Capturing log files for troubleshooting
About this task
When you report an issue through Jira ticket in the Infosolutions project, provide SDL client log 
files, such as Oxygen Connector.log and Publication Manager.log files.

Procedure
1. Go to C:\Users\<username>\AppData\Local\SDL\InfoShare 

Client\14.0\Log.

From View, enable Hidden items if you are unable to see hidden items like the AppData 
folder.

2. Add the log files to zip.

3. Attach the zip file to your support ticket.

Capturing log files for troubleshooting
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Capturing data on a Tridion Docs connection issue
About this task
When you experience continuous connection issue or slowness with the RWS server outside the 
maintenance window of RWS, you must capture the data necessary for RWS to investigate the 
issue.

Important:
You must capture the data only while you experience the slowness or connectivity issue. 
Capturing data after the issue is resolved or the connectivity resumed might mislead RWS's 
investigation.

Before you begin
• Download Fiddler, a free web debugging tool.
• Ensure you have access to the DITA Authoring Tools sharepoint.
• Go to the Trisoft connection issue tracking, and download the TEMPLATE_Trisoft Connection 

Incident Report.

Procedure
1. Open a Infosolutions Jira ticket, and mention the following in the ticket:

• Time when you first got the timeout error or when the performance significantly dropped.

• Take a screen capture of the error message, and attach with the DITA ticket.

2. Capture the Fiddler data:

a. Start the Fiddler tool and click File > Capture Traffic to capture the traffic data.

b. To limit the data capture to Publication Manager, select the crosswire icon ( ) from 
the menu, drag and drop into the Publication Manager window.

The application captures the traffic data only from and to Publication Manager.

c. To stop filtering, right-click on the crosswire icon.

The status changes of the icon changes back to Any process.

d. Save the file in the format username_date, for example, KavithaSamudrala_1120.

e. Upload the Fiddler data at Trisoft connection issue tracking.

3. Do the traceroute and ping tests:

a. In the TEMPLATE_Trisoft Connection Incident Report, capture the requested 
information.

b. Save the file with the name username_date, such as KavithaSamudrala_927.docx.

Troubleshooting
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c. Upload the report at Trisoft connection issue tracking.

Alternatively, you can attach the report to the ticket.

Conref errors appear in the Publication Manager preview
You might see the following conref unresolve error message:

The error typically caused due to one of the following reasons:
• When you do not select the correct version of the referenced topic that has the ID in your 

publication.
• When the ID has been removed from the referenced topic.

Solution
Procedure

1. In Publication Manager Content tab, click the arrow sign before the topic name that has the 
conref error.

Publication Manager displays Topics and Conrefs within the topic.

2. Expand the Conrefs folder to view the topics being reused from.

3. Select the first topic listed under Conrefs to display the versions in the upper-right corner 
of the Content tab.

4. Validate that you are using the correct version of the topic and select a different version if 
necessary.

5. Repeat steps 3 and 4 if multiple topics are listed within Conrefs.

6. Validate that the conrefs are resolved correctly in the preview.

Conref errors appear in the Publication Manager preview
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Conref was not expanded error
Condition

• Reused content does not show up in the PDF output.
• The reused element displays the “Conref was not expanded” error in the editor.
• Displays the following message if you use a product element to reuse content from an 

application element that is set for reuse. In specific, if you add GUID#GUID/ReuseID in the 
conref attribute of the product element in the target topic.
The source element "product" with class value "+ topic/ph ai-d/
product " is not a generalization of target element "application" 
with class value "+ topic/ph ai-d/application "

Cause
A mismatch between the source element that has the ID and target element that references the ID 
is the cause for the missing reused content.

Solution
1. Check out the topic in Oxygen XML Author.
2. In Oxygen XML Author, click SDL Tridion Docs > Conref > Insert conref.
3. In the Reuse Content dialog box, browse to and select the topic from which you want to 

reuse content.
The Reuse Content dialog box displays the list of elements, IDs, content set for reuse, and 
preview of the content.

4. Select the reusable content and click Insert and close.
5. Check in the topic.

Publication Manager crashes while opening a publication
Condition

• Publication Manager crashes while opening a publication.
• Publication fails to open.

Cause
Publication either takes unusually longer to open or fails to open due to multiple circular 
references within topics. If the number of recursions cross the threshold in a publication, 
Publication Manager crashes before the publication opens.
You must avoid these loops by removing the circular references.
The following are some examples of circular references in the order of severity:

1. Para A from Topic 1 referenced in Topic 2, para B from Topic 2 referenced in Topic 3, and 
para C from Topic 3 referenced in Topic 1.

Troubleshooting
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For example, a step from “Adding users” topic is referenced in “Editing users” topic, a 
paragraph from “Editing users” topic is referenced in “Duplicating users” topic, and a step 
from “Duplicating users” topic is referenced in “Adding users” topic.

2. Step 1 from Topic 1 referenced in Topic 2, Step 2 from Topic 2 referenced in Topic 1.
For example, a step from “Adding users” topic is referenced in “Editing users” topic, and a 
paragraph from “Editing users” topic is referenced in “Adding users” topic.

3. A para or a step from a topic referenced in the same topic.

Circular references also applies to content references made by using xref element.
Solution

1. Start Publication Manager and open a publication.
Publication Manager lists errors in the publication in the Error list section at the bottom, if 
any. For example, any unresolved hyperlinks, conrefs, and circular references.

Publication Manager crashes while opening a publication
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2. Note the topics with circular references:

3. In Error list, double-click the error message to navigate to the topic, and check out the 
topic.

4. If the content is referenced in the same topic, do one of the following:
a. If a simple paragraph or a step is reused, copy from the first location, and paste in the 

second location.

b. If the reused content is a complex step with substeps, an ordered list, or unordered 
list, and if you want to reuse more than once, move the content to a common topic, 
and reuse in all applicable topics.

5. If the first topic references content from the second topic, and the second topic references 
content from the third topic, and the third topic references content from the first topic:

a. From the three topics, remove the reused content and add the content in a common 
topic.

Troubleshooting
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b. Reuse the appropriate content from the common topic in three topics.

Important:
In a common topic, do not reuse content from other common topics. Because common 
topics are used across publications and programs, reuse from other common topic 
multiplies the references very quickly causing loops resulting in delays in opening 
publication or publication crashes.
The only exception is common topics: Product names, Applications, Snapin-names, 
and Languages.

6. After you resolve the circular references in topics, consult Information Architect to replace 
the topics in the publication that fails to open.
This step applies only if the publication fails to open and crashes Publication Manager.

To prevent circular references, when you reuse content:
• Always make references to common topics instead of the peer topics used in the project.
• Ensure that the direction of references must be in the direction depicted in the image.

Publication Manager crashes while opening a publication
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For example, add frequently used content, such as steps, uicontrols, and wintitles in a common 
topic and reuse the content in Adding users, Editing users, and Deleting users. Do not reuse 
content from the Adding users topic in the Editing users topic.

Link text of cross reference does not match the target 
topic

The link text of a cross reference does not match the title of the target topic.

Solution
About this task
When you insert an xref to another topic, the Text to display field shows the current title for the 
target topic. You should always clear the Text to display field unless you want to enter different link 
text. If you don’t clear the field and you later change the title of the target topic, the link text will no 
longer match the title of the target topic.
Use the following procedure to change the link text to the title text in the topic.

Procedure
1. Check out the topic that contains the cross reference with incorrect link text.

2. Remove the text between the xref tags. There should be no blue, underlined text between 
the tags.

3. Check in the topic.

Directories appear to be empty
If you try to view the contents of a directory, like a topic directory, and it appears to be empty even 
though you know there’s content in it, there are a couple of possible reasons:

• You’ve got the wrong type selected in the Objects of type menu.
• There’s an issue with the permissions of the folder and you don’t have permissions to view 

the files.

Procedure
1. In the Tridion Docs repository, navigate to the directory that appears empty and do the 

following:

a. Refresh the directory.

b. Check that the Objects of type menu at the bottom of the right side of the page is set 
to All.

Troubleshooting
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2. If this does not solve the issue, submit an issue to the Infosolutions project because the 
cause could be a permissions issue.

Local storage is blocked by another application error
When you have to stop Publication Manager and try to restart immediately, you might see the 
following message . This error indicates that the local storage is blocked because the previous 
session of Publication Manager or Oxygen XML Author still has it open.

Solution
Procedure

1. Exit Oxygen XML Author if the application is open.

2. Open the Windows Task Manager and click the Details tab.

3. Locate the process Trisoft.PublicationManager.Host.exe.

Tip:

Click Name to sort the processes alphabetically.

4. Select the process and click End Process.

5. When the Task Manager Warning displays, click Yes.

6. Start Publication Manager.

Local storage is blocked by another application error
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Error that configuration file could not be saved because it 
is in use

When you are starting Publication Manager and Oxygen XML Author at the 
same time, if you try to open a publication or try to check out a topic from 
Publication Manager, you might see an error message The configuration file 
C:\Users\<username>\AppData\Local\SDL\InfoShare Client...could not be 
saved. The process cannot access the file because it is being used by 
another process. This is typically a timing message because your local client configuration is 
being accessed by both Publication Manager and Oxygen XML Author. Wait a minute and try the 
task again. If the message persists, submit an issue to the Infosolutions project.

Error when trying to generate workflow report about no 
information found

If you try to generate a workflow report on a publication that has never been opened in Publication 
Manager, you get an error with the message “No information found to generate translation 
statistics off” and the report will not generate.

Solution
Procedure
To generate the workflow report, do one of the following:

• Open the publication in Publication Manager, save it, and close it, and then try to generate the 
workflow report again.

• Try to generate the report again, but on the Workflow management window, select the option to 
“use the latest available versions (if there is no information in the baseline)”.

Baseline freeze fails even though publishing log shows no 
errors

In DITA, any topics that are referenced in topics you use in a publication become part of the 
dependency chain. For example, if you’re reusing elements from a topic that includes xrefs to 
other topics, those other topics become part of the dependency chain for your publication, even 
if you aren’t reusing the elements that contain the xrefs. In this case, if you are not reusing the 
topics that are the link targets of the xrefs, this will not cause publication errors—because you 
aren’t including the content that contains the links in your output. However, when you attempt to 
freeze your publication baseline, it will fail, and the Baseline Freeze report displays errors about 
references that cannot be resolved. If your baseline freeze activity fails after publishing an output 
with no errors in the log, submit an issue to the Infosolutions project.
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Related links
Freeze Baseline report on page 228

Table goes off the page in the PDF output
A table might run off the page in a PDF output. This occurs when a table uses fixed column width 
that exceeds the available width of the page.

Solution
Tables should use relative column widths rather than fixed widths. Relative widths are represented 
as a number followed by an asterisk. The values are converted to percentages during production.

Procedure
1. Check out the topic in Editor.

2. If the table uses the table element:

a. In the table/tgroup element, expand colspecs, and select the appropriate colspec 
element.

b. If the width is a set value (such as 3.25in), modify the value to be a number followed 
by an asterisk (such as .75*).

c. Repeat for all of the columns in the table.

3. If the table uses simpletable or parttable:

a. Double-click or select the table.

b. If the values in the relcolwidth are set values (such as 4.25in 3.75in), modify the 
values to be percentages (numbers each followed by an asterisk), modify the values 
to be percentages followed by an asterisk (such as .25* 1.75*).

c. Click OK.

Tables cells are blank in the output even though the table 
cells contain content

The table cells might appear empty in the output even when the cell in the DITA topic contains 
content. The cause for the issue could be:

• A condition applied to the cell and the condition is not included in the publication.
• Invalid character in the char attribute of the cell in the table. This character gets included cells 

of table that you have created by copying from another table.

Table goes off the page in the PDF output
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Solution
Procedure

1. Open the topic that has the missing content in the table cells.

2. Double-click or select the table element.

The Attributes windows displays all attributes applied to the table.

3. Look for any conditions applied to the table element and, if you find any, determine which 
of the following applies:

• Select the applied condition to your output to display the content in your output.

• Change the condition to apply to the whole row rather than cells so that the whole row 
does not appear in the output.

4. Select cells, in the Attributes window, look for an entry in the char attribute and, if you find 
any, do the following:

a. Remove value in the char attribute.

b. Click OK.

5. Check in the topic, generate the output, and verify if the content appears correctly.

Elements in Oxygen XML Author are right aligned
Condition
Tags and text in Oxygen XML Author are right aligned instead of left side.

Cause
The Region format on your computer might be set to the region based on your locale. For 
example, Arabic and Hebrew. These language use right to left scripts.
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Solution
1. From Control Panel, go to Region.

The page displays Region dialog box.
2. In Formats tab, click English (United States) in the Format field.
3. Click Apply and OK.

Images appear smaller on Documentation Center
Condition
On Avaya Documentation Center, the page displays some images smaller than others, though you 
have set to the same size.

Cause
When you add an image element inside a <p> element in the topic, in the Avaya Documentation 
Center output, the .css file imposes a maximum height restriction of 16 pts.

Solution
1. Check out the topic with images.

Images appear smaller on Documentation Center
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2. Identify the image that appears smaller on Avaya Documentation Center and move the 
image element out of the <p> element.

3. Delete the empty <p> element.
4. Publish the output on Avaya Documentation Center and verify that the page displays the 

image size correctly.

Icon size is larger than expected
Condition
The icon size on Avaya Documentation Center is larger than expected, specifically in French, 
Spanish, German, Japanese, and Chinese (Simple & TW) languages. This issue occurs despite 
the alt text has the word 'icon‘ and its height set to about 11 or 12 points.
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Cause
The word ‘icon’ in the alt text of the image makes the icon appear smaller than other images. 
However, you might still see the following issues:

• Writer might miss adding an alt text to the image or miss adding ‘icon’ in alt element in the 
image.

• When content in alt text is translated, the condition icon term is not met, therefore, the page 
displays the image larger.

Solution
1. Check out a topic that has the icon in Oxygen XML Author.
2. Select the image element of the icon.
3. Add the word icon in the alt element.

For example, the Accept Voice Interaction icon.

Icon size is larger than expected
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4. In the Attributes dialog box, type icon in the outputclass field.

Note:
If you reuse the image element, add the attribute in the source image topic and not in 
the target topic.

5. Check in the topic and generate the Avaya Documentation Center output.
6. Verify that the page displays the icon size correctly.

Copyright year in the legal page is incorrect
Condition
The legal page displays 1234 instead of the copyright year on Avaya Documentation Center. For 
example, © 2015-2023, Avaya LLC.

Cause
The legal page is incorrectly added in the bookmap in the Front Matter element.

Solution
1. In Publication Manager, open the publication with incorrect copyright year.
2. Right-click Front Matter and then click Add Within > Notices.
3. On the Insert Values for Notices window, click OK.

Troubleshooting
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4. Within the Notices topic head, add the legal topic.
5. Click OK.
6. Check in the bookmap.

Unable to add accounts
Condition
Adding an account in RWS Tridion Docs fails with Access Denied error.

Cause
• A difference in time clock between the user's laptop and the server.
• The issue is related to connectivity to the RWS server.

Solution
1. Connect to the Avaya network or VPN and close all Microsoft applications.
2. Press and hold the Windows logo key on your keyboard and then press the L key to lock 

your Windows computer.
3. While connected to the VPN, do the following to unlock your Windows computer:

a. Press and hold the Windows logo key on your keyboard and then press the L key.

The lock screen displays.
b. Wait for 5 minutes.
c. Enter your correct Windows credentials and log in.

The unlock action refreshes your Kerberos or Windows security protocol ticket and 
restores the connectivity to the server again.

4. Add your user account information in Publication Manager.
Addition of the account in RWS completes successfully.

Publishing-related issues

Locating a GUID referenced in a publishing log error
When you produce an output from Tridion Docs, you receive a notification message when the 
publishing request completes. You must always open the log and look for errors. The error 
message uses the GUIDs of the objects in many cases and it might be difficult to determine which 
topics or maps the error is referencing.

Unable to add accounts
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Procedure
1. When you receive the email notification from Tridion Docs, open the log file and search for 

the “error” word.

The following is a sample of common error:
[xslt] [DOTX006E][ERROR]: Unknown file extension in href: 
'GUID-93A613C9-3646-4104-849E-F52017049DB6'. If this is a link to a non-DITA 
resource, set the format attribute to match the resource (for example, 'txt', 
'pdf', or 'html'). If it's a link to a DITA resource, the file extension must 
be 'dita' or 'xml'. Set the format attribute and specify the format of the 
file if href link doesn't point to dita topic file. Otherwise, change the file 
extension name to 'dita' or 'xml'.The location of this problem was at (File 
= W:\InfoShare\Data\PublishingService\Data\DataExports\GUID-570C1EE4-F4A9-4A89-
BF6F-DA9DC6C3886E.20130123195114668\1\en-us\workset\GUID-B57F8CAC-246F-4327-
A81A-6EEDA79B879F.ditamap, Element = topicref:12)

The sample error indicates that there is an issue with a topicref in a map. The issue is 
specifically with the 12th topicref in GUID-B57F8CAC-246F-4327-A81A-6EEDA79B879F . 
And the object being referenced in the topicref is GUID-93A613C9-3646-4104-849E-
F52017049DB6.

2. To identify the objects, go to the Search tab in the Tridion Docs desktop repository.

3. Expand the Advanced Options.

4. Copy and paste the GUID in which the issue occurs in the Identifier field and click Search.

If the GUID refers to a DITA Map, do not include the extension in the Identifier field.

The Browse Repository window displays the name and location of the object in the results 
pane on the right side of the page, similar to the following sample.

5. (Optional) Repeat Step 4 to identify the object that is causing the error.

Troubleshooting
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Publishing fails with error [DOTJ013E][ERROR] Failed to parse 
the referenced file

When you publish a HTML output, you might see an error similar to the following sample in a 
log. The error indicates that a topic could not parse because a required element is missing. In 
this sample, the topic included an unordered list without at least one li (list item) element. The 
cause could be that you have applied conditions, however the conditions are not included in the 
publications.
[DOTJ013E][ERROR] Failed to parse the referenced file 'AccessbilityStandards.dita. The 
XML parser reported the following error:
AccessbilityStandards.dita Line 15:The content of element type "ul" is incomplete, it 
must match "(li)+".

Solution
About this task
Only HTML and HTML5 outputs fail due to missing elements.

Procedure
1. Locate the topic referenced in the error.

The easiest way to find the topic is typically to look at the publication baseline.

2. Check out the topic and locate the element causing the error.

The element type will be noted in the error. In the sample error, the element where the 
error occurred is a ul (unordered list).

3. Identify the cause of the error and correct it.

If you cannot determine the cause of the error in the element, ask for assistance.

Publish fails with null error in log file
When a publishing request fails and there is a log attached, a common error that you might 
see in your log is [ERROR] Topic reference (href : #null) not found !. This error 
indicates that a topic in the publication has an invalid character in the Tridion Docs Title field.

Solution
Procedure

1. Open the publication in Publication Manager.

2. Go to the Baseline tab and look at the values in the Title column to locate topics that have 
invalid characters in the Title.

The title can contain alphanumeric characters, spaces, hyphens, and underscores.

3. When you the topic with an invalid character in the title, right-click the object, select 
Properties, and remove the invalid characters from the Title field.

4. Save the publication and generate the output again.

Publishing-related issues
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Error opening PDF: “There was an error opening this document. 
The file is damaged and could not be repaired”

Condition
When you try to open a PDF produced from Tridion Docs, the displays “There was an error 
opening this document. The file is damaged and could not be repaired” error, and you cannot open 
the PDF.

Cause
When a table breaks across pages in the PDF, the text “Table continues” appears at the bottom 
of the table to indicate that the table continues on the next page. When certain tagging, such as 
conditionalizing columns is used in tables in a larger publication, the combination of the tagging 
and the “Table continues” can cause an issue in Antenna House, which is one of the applications 
used in our DITA processing.
If you encounter this issue, you can turn off the “Table continues” at the publication level.

Solution
1. Right-click the bookmap and select Check out with in Oxygen XML Author.
2. Expand the bookmeta element.
3. Position the cursor before the ending bookmeta tag, press Enter, and select othermeta.

If you are using the <bookid> element, position the cursor before < bookid> instead of 
putting the cursor before the ending <bookmeta> element.

4. In the Attributes dialog box, type yes in the content field and turnOffTableContinues 
in the name field.

5. Click OK.
6. Click SDLTridionDocs > Check in and follow the prompts to check in the map.

If you have the publication open that uses the bookmap that you edited, Tridion Docs 
displays a reload message “The object bookmap-name has been changed by another 
application and the new content has been loaded.”

[DOTX031E][ERROR] File is not available to resolve link 
information

An error similar to the following sample in a publishing log typically indicates a broken xref. The 
error can occur for a couple of different reasons. For example, it can occur if you have an xref to 
a topic that has not been included in your publication or if you have a link to a web site and you 
haven’t set the scope attribute to external.
[DOTX031E][ERROR]: The file file:/W:/InfoShare/Data/PublishingService/Data/DataExports/
GUID-83353436-0BE6-4DEF-8BC5-44350CC70F6B.20140220070729305/2/en-us/workset/temp/GUID-
CED91A5D-3923-4762-B90E-0F2B56996D21 is not available to resolve link information.  
The location of this problem was at (File = 
W:\InfoShare\Data\PublishingService\Data\DataExports\GUID-83353436-0BE6-4DEF-8BC5-44350C
C70F6B.20140220070729305\2\en-us\workset\GUID-BD163880-2936-4512-9022-B09AEF6D5A23.xml, 
Element = xref:1;11:349)

Troubleshooting

July 2024 DITA and TDocs Work Instructions and Guidelines 304
Comments on this document? 

305

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Solution
Procedure

1. Locate the topic referenced in the error using the GUID provided in the error.

For example, in the sample error, the GUID is GUID-BD163880-2936-4512-9022-
B09AEF6D5A23 and you would search for that ID.

2. Check out the topic and locate the element that is causing the error.

The element is noted in the error. In the sample error, the element occurred in the first xref 
in the topic (Element = xref:1).

3. Correct the error and check in the topic.

If you cannot determine the cause of the error in the element, ask for assistance.

Publication fails with no log included in the zip file
When you get a failed publication notification with no log file included in the zip file, typically, 
the reason would be that two or more objects with the same Override Output File Name (base 
attribute) exists in the publication. When this occurs, you can identify the duplicate name by 
looking at the publishing log in the web interface.
In the publication logs, double-click the SHELL command output event and scroll down to look 
for the following message to identify the duplicate name:
ERR AvayaPublUtil::RenameObjects -> Rename file <file name> to <file 
name> failed since there is already an existing file with this name. 
Please check the metadata of the objects in your publication to correct 
this duplicate filename.

Solution
About this task
The Override Output File Name field is populated by the base attribute in the topic. This attribute 
specifies the filename for the topic that will appear in HTML and HTML5 outputs.
If a topic does not have a base attribute, the parser uses the topic file name to process.
Here are some scenarios on topic file name and Override Output Filename:

Topic filename (Title) Override Output 
Filename (OOF)

Output Example
Filenames OOF

Same topic filenames OOFs are different Successfully publishes avtar avtar_01
avtar avtar_02

Same topic filenames OOF set in one topic 
which is unique

Successfully publishes avtar None
avtar avtar_02

Table continues…

Publishing-related issues
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Topic filename (Title) Override Output 
Filename (OOF)

Output Example
Filenames OOF

Different topic 
filenames

OOF of one topic is 
set and matches with 
topic name of other

Output fails avtar avtar_02
avtar_02 Not set

Same topic filenames OOF not set in two 
topics

Output fails avtar Not set
avtar Not set

This example applies for two or more topics with duplicate filename or override output filenames.

Procedure
1. Open the publication in Publication Manager.

2. Click the Baseline tab.

3. Click the Override Output File Name column heading to sort the baseline report by the 
values in that column.

4. Look for duplicate text strings in the Override Output File Name column.

5. For each duplicate file name that you see:

a. Check out the topics with the duplicate file name.

b. Double-click or select the root element, for example, the structure element in a 
structure topic.

c. In the base field, remove the text string or enter a unique text string, and then click 
OK.

Troubleshooting
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Important:

Do not include the file extension in the file name.

Related links
Logging on to the Tridion Docs web interface on page 26
Viewing publishing logs on the Tridion Docs web interface on page 138

[exec] AHFCmd :WARNING: Error Code : 11792 (2E10)
Condition
An error message similar to the following is in the log file that is e-mailed to you when you publish 
a publication.
[exec] AHFCmd : AH XSL Formatter V5.3 MR3 for Windows (x64) (2011/11/16 
16:00:35)
     [exec]          Copyright (c) 1999-2011 Antenna House, Inc.
     [exec] 
     [exec] AHFCmd :WARNING: Error Level : 2
     [exec] AHFCmd :WARNING: Error Code  : 11792 (2E10)
     [exec] AHFCmd :WARNING: Duplicate id value: 
id="unique_38_Connect_42_GUID-F2EFC027-1605-450E-A615-B501A5D8CAE5".
     [exec] AHFCmd :WARNING: Line 1192, 
Col 295, file:///W:/InfoShare/Data/PublishingService/Data/DataExports/
GUID-44C88502-FF3A-48AE-A01D-435F5EE63724.20120925215134543/1/en-us/out/
topic.fo
The id value varies. This error message usually appears toward the bottom of the log file. There 
can be multiple instances of this error message in a log file.

Publishing-related issues
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Cause
These error messages come from Antenna House, which generates the PDFs. The error indicates 
that there are two or more elements in a topic that have the same ID. This can happen when you 
copy a conreffed element that has an ID assigned.

Solution
These errors do not impact the output or prevent you from releasing the content, so you can 
ignore them.

Publish report includes a note that “Illustration xxx en-us High is 
unavailable”

When you click View Report on the Output tab in Publication Manager, you might see a note in 
the report that is similar to Note: Illustration "1100-SIP-Icon-Inbox_Nov07-rev5 v 
1 en-us High" is unavailable.
You can typically ignore this note in the Publish report. But there have been a couple of cases 
where someone set the resolution for an image to High somewhere in Tridion Docs when the 
image is Low resolution. Low and High resolution are based on the graphic type. For example, 
png and gif files are Low resolution.

Solution
When the image is a low-resolution file, this error will cause issues in the outputs or prevent you 
from releasing your content.

[DOTX019W] [WARN]: The type attribute on a topicref element 
does not match the target topic

You might see the following warning in the publishing logs:
[xslt] [DOTX019W] [WARN]: The type attribute on a topicref element does 
not match the target topic. The type attribute was set to 'concept', 
but the topicref points to a more specific 'reference' topic. This may 
cause your links to sort incorrectly in the output. Note that the type 
attribute is inherited in maps, so the value 'concept' may come from an 
ancestor topicref. Check and make the type of topicref match with the 
actual type of topic.The location of this problem was at...

Solution
You can typically ignore these warnings. They can be caused when the parent topic is one 
topic type and the child topics are other types. The type is inherited, so the processing finds a 
mismatch, even though the type is correct on the topic. It doesn't cause any issues in the output 
and it won't prevent a baseline freeze.

Troubleshooting
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Publishing fails with error: “Expected scheme-specific part at 
index 5: http:”

Condition
When the output you published fails, review the DITA-OT log. You might see the following error:
[filter] Processing file:/D:/InfoShare/Data/Publish/Data/<outputid>/work/<version>/
<lang>/<GUID.xml
 to file:/D:/InfoShare/Data/Publish/Data/<outputid>/work/temp/<GUID>.xml
Error: java.lang.RuntimeException: Expected scheme-specific part at index 5: http:

Solution
1. In Tridion Docs web interface, search for the topic using the GUID.
2. Look for the <xref> element that has a URL issue.
3. Do one of the following:

a. Ensure that the URL added in the href attribute in the xref element is valid.
b. To provide a format or an example of URL and not the actual URL, use the cite 

element instead of xref.
• <cite>http://username:password@...</cite>
• <cite>http://localhost:nnnn</cite>
• <cite>http://IDP_IP</cite>

Localization-related issues

Unable to translate objects
Condition
Translation Management (TM) sequence not selected on production job.

Cause
Objects with the Requested languages field value set fail to translate. Therefore, ensure that the 
Requested languages field is blank for all objects in a publication that is getting localized.
Objects include topics, maps, and SVG images.

Solution
1. Start Publication Manager.
2. Open the publication, and click the Baseline tab, sort by first column, the object type.
3. Select objects of the same type, for example, all images, right-click Properties.
4. Ensure that the Requested Languages check box is clear, and the field is blank.
5. Click OK.

Localization-related issues
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Unable to translate
Condition
Tridion Docs does not integrate with Translation Management (TM).

Cause
Objects with the GUID number in the title field breaks the Tridion Docs and TM integration.

Solution
1. Start Publication Manager.
2. Open the publication.
3. Select object with GUID in the title and select Properties.
4. Keep the name and remove the GUID, version, and the language that follow the name.
5. Click OK.

Unable to translate objects for the new program
Condition
The translation of the publication for the new program fails with the following error:
Expanding failed with error: Unable to complete your request, 
you are not allowed to alter publication version "GUID-ABC76443-
BB67-454A-9885-78D31AB82B96=1". [c:6286332 ce:GUID-30BFB5CE-FADD-4F6B-
B0BA-4885045EEBFC ct:CTPUBLICATIONV] [102009;ObjectIsReadOnly]
Cause
When a user group for the new program is added in the Tridion Docs repository, the new user 
group value might not be available to the service user, the user that Localization team uses for 
translation job.

Solution
The localization coordinator must ensure the following:

1. Send a request to Information Architect (IA) to add the new program to the ServiceUser 
user in the Tridion Docs web interface.

2. If you still see the issue, report the issue to the IA or create a Jira ticket in the Infosolutions 
project.

3. When the issue is resolved, ensure that IA gets the RWS support team restart the 
Translation Builder Service on the RWS server.
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4. When IA resolves the issue, delete the failed translation job.
5. Restart the translation job.
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Chapter 22: Defining variables using key 
references

Key references
The key-reference mechanism in DITA provides a layer of “abstraction” so that referenced 
content strings can be defined externally at the DITA map level instead of locally in each 
topic. Key references (keyrefs) are conceptually similar to content references (conrefs) in that 
they’re references that point to content that resides somewhere else. There are many possible 
implementations of key references in DITA. Currently in GIS we’re using keyrefs to define 
variables.

When you use DITA topics in different publications, there might be names of objects that should 
have different values, depending on the context. With keyrefs, you name the variables using the 
<keydef> element. For example, you might have a keydef for the name of a server that changes 
depending on the implementation When you insert a <keydef> element in a topic, it has no defined 
value—it’s just a placeholder reference. You define the <keydef> value in special “key” DITA 
Maps. Each key map can contain different values for the <keydef> elements that you’ve defined. 
Then, depending on which key map you include in your bookmap, the value of the <keydef> 
is applied during production. You can change the value of the variable by using a different key 
maps in different bookmaps. Or you can include multiple key maps in single bookmap and apply 
conditions to them. You can then use the bookmap in different publications and select different 
conditions to achieve different values in the outputs.

Using existing elements as keyrefs
You can also use existing elements as variables using the keyref mechanism. This implementation 
has an additional level of indirection, but it allows us to use elements already set up for reuse as 
keyrefs. You can think of keyrefs defined directly in key maps as “direct” keyrefs and keyrefs that 
reuse elements as “indirect” keyrefs.

Important:
Because of the way that keys are referenced in the topics, each variable you want to 
use must always be specified directly in the maps or must always be referenced indirectly 
through reuse. You cannot define a key reference that’s defined directly in some contexts and 
indirectly in other contexts.

Key references vs. conditions
Keyrefs can be used in some cases in ways that are similar to conditions. In the case of 
conditions, the possible values reside in the topics, with conditions applied, and the conditions 
used in the publication determine the value that appears in the output. With keyrefs, you include a 
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single placeholder (keydef) and the possible values are defined externally in key maps. Whether 
conditions or keyrefs are the right approach really depends on the specific situation and what you 
need to implement. If you think your project has a use for keyrefs, contact Sue.

Creating key maps to define key references for variables
Before you begin
Before setting up any key references, consider the variables you need for your project. Create a 
list of the keys and the possible values. Only define keyrefs for things that require more than one 
possible value, where the value will be consistent across every use in a particular context.

About this task
This procedure provides the steps for defining the key definitions (keydefs) and their associated 
values in special maps (referred to as key maps).

Procedure
1. Create a DITA map to use for the key definitions.

Give the map a descriptive name that’s specific to the context and makes it clear that 
the map is for keys. You’ll create multiple maps that define the values of the keys for the 
different contexts in which the keys are used.

2. Open the DITA Map in Arbortext Editor.

3. If the map contains a topichead element, delete it.

4. Put the cursor after the map element, press Enter, and select keydef.

5. When the Modify Attributes dialog displays, type a name for the key in the keys field and 
click OK.

This is the name that you’ll use in the topics to point to this key reference. The keynames 
are case-sensitive and should not include any spaces or special characters.

6. Position the cursor at the end of the keydef element, press Enter, and select topicmeta.

7. Position the cursor at the end of the topicmeta element, press Enter, and select 
keywords.

8. Position the cursor at the end of the keywords element, press Enter, and select keyword.

9. Type the value of the key in the keyword element.

This is the value of the keydef that will appear in outputs that include this key map.

10. Repeat for each key you want to define in this key map.

11. Check in the map.

12. Create as many key maps as you need for your project to define the possible key values.

Creating key maps to define key references for variables
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It’s very important that you use the same keydef names in the key maps in which you 
define different values for the keydefs.

13. Add a new last chapter to the publication and then add the key map to the chapter and set 
the format attribute to ditamap like you do for other maps.

The use of the keydef elements signal the processor that the map contains key references 
instead of topics.

14. If you want to use the same bookmap and apply different values in different outputs, repeat 
step 5 for each key map and then apply the appropriate condition to each map.

15. If you added multiple conditionalized keymaps to your publication, select the Conditions 
tab in Publication Manager to select the condition to apply.

Next steps
Use the variables (keydefs) in your topics.

Using keydef variables in your topics
About this task
Use this procedure for adding keyrefs to your topics that have been defined in key maps using the 
keyword element. This procedure includes steps for setting up the keywords for reuse since you’ll 
be using the keyrefs multiple times across your content.

Before you begin
Create the key maps that define the key references.

Procedure
1. Create a common topic to store the keywords that contain the keydefs.

2. To set up common elements that use keyrefs directly defined in a map:

a. Position the cursor where you want to add the variable, press Enter and select 
keyword.

b. Put the cursor in the keyword element and press Ctrl+D to open the Modify 
Attributes dialog box.

c. In the keyref field, enter the name of the key that you defined in the map.
d. Insert a name in the ID field; you can use the same name as the keyref.
e. Click OK.
f. Repeat steps a through e for each keyword you need to set up for reuse.
g. Check in the common topic.

3. Reuse the keyword elements in any topics where you want to insert the key variables.

If you’re inserting a variable in a bookmap or DITA map, you must check out the map in 
Arbortext Editor from the desktop repository.

Defining variables using key references
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Setting up variables using key references that reuse 
existing elements

Before you begin
Create the necessary keymaps. See the topic “Creating key maps to define key references for 
variables”.

About this task
This procedure provides the steps for defining the key definitions (keydefs) in special maps that 
reuse existing elements (indirect keyrefs). You can include indirect keydefs in the same maps as 
keyrefs that define the values directly in the maps.

Important:
• The elements you want to reuse must be in different topics.
• Because of the way that keys are referenced in the topics, each variable you want to use 

must always be specified directly in the maps or must always be referenced indirectly 
through reuse. You cannot define a key reference that’s defined directly in some contexts 
and indirectly in other contexts.

Procedure
1. Add the keyref attribute to the elements you want to reuse:

a. Open a topic that contains one of the elements you want to reuse as a keyref.

b. In Arbortext Editor, put the cursor in the element and press Ctrl+D to open the 
Modify Attributes dialog box.

c. In the keyref field, type the name of the key.

This is the name that you’ll use in the topics to point to this key reference. 
The keynames are case-sensitive and should not include any spaces or special 
characters.

d. Repeat for at least one other topic that contains elements you want to reuse as 
keyrefs.

2. Check out one of the maps that you have created for the keys.

3. Put the cursor after the map element, press Enter, and select keydef.

4. When the Modify Attributes dialog display, type a name for the key in the keys field.

5. When the Modify Attributes dialog displays, type a name for the key in the keys field and 
click OK.

This is the name that you’ll use in the topics to point to this key reference. The keynames 
are case-sensitive and should not include any spaces or special characters.

6. In the desktop repository, navigate to the topic that contains the element you want to 
reference in this map, right-click and select Properties, and copy the Identifier.

7. Paste the identifier you copied into the href field.
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8. Click OK.

9. Check in the map.

10. Repeat steps 2 through 9 for each of your key maps.

It’s very important that the href field for the keyrefs in each map point to a different topic.

11. Add a new last chapter to the publication and then add the key map to the chapter and set 
the format attribute to ditamap like you do for other maps.

The use of the keydef elements signal the processor that the map contains key references 
instead of topics.

12. If you want to use the same bookmap and apply different values in different publications, 
apply the appropriate condition to each key map.

13. If you added multiple conditionalized keymaps to your publication, select the Conditions 
tab in Publication Manager to select the condition to apply.

Next steps
Use the variables (keydefs) in your topics.

Adding a keydef variable that reuses an existing element
About this task
Use this procedure for adding a keyref to your topics that reuses an existing element. This will be 
much less common than a direct keyref.

Before you begin
• Create the key maps that define the key references and add the key(s).
• If you are going to use any keyrefs that reuse existing elements, you must know the element 

the existing content is contained in.

Procedure
1. To use a keyref that reuses an existing element:

a. Position the cursor where you want to add the variable, press Enter and add the 
appropriate element.

The element you should insert depends on the element you’re reusing that has the 
keyref applied. For example, if the keyref is based on a <uicontrol> element, you 
should select uicontrol.

b. Put the cursor in the element and press Ctrl+D to open the Modify Attributes dialog 
box.

c. In the conkeyref field, enter the name of the key that was applied to the element 
you’re reusing, followed by a slash, followed by the ID of the element.
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For example, if you want to reuse an element that has keyref of 
“APPLICATIONNAME” and an id of “Portal”, you would insert APPLICATIONNAME/
PORTAL.

When you assign IDs to elements in topic, they’re converted to all caps when they’re 
checked in. So it’s important to double-check the ID of the element to make sure you 
enter it correctly in the conkeyref field.

d. Click OK.

2. Check in the topic.

Adding a keydef variable that reuses an existing element
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Chapter 23: Searches and metrics

Searching the repository

About searches
Search text is not case-sensitive. You can type search text in uppercase or lowercase letters.

• The wildcard operator * can be used only for single word searches.

• In phrase searches, * is not interpreted as a wildcard character. For example, search text 
comput* produces results, such as computer and computing.

• When searching for multiple words, the search engine interprets the search text differently if 
the text includes quotation marks.

• When you do not use quotation marks, the search engine searches for each word in the text 
string.

Results that contain all words in the search string rate higher than results that contain only 
one or two words in the string.

• When you use quotation marks, the search engine searches for the exact text string that you 
typed. Only instances of that exact string are included in the results.

For example, searching “content management system” finds instances of that exact 
phrase. Whereas, searching content management system will finds all instances of the 
words content, management, and system.

Performing searches
About this task
Use this procedure to search for a topic, map, image, or other object in the Tridion Docs 
repository.

Procedure
1. On the Publication Manager menu bar, click Tools > Browse Repository.

The Browse Repository window is displayed.

2. In the left pane, click the Search tab.

3. In Find what, type the text that you want to search.
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4. Enter and select other search parameters to limit the scope of your search.

5. To filter the search results by type of object, in the Object types field, click topics, maps, or 
images.

6. To narrow down the search results, complete the appropriate fields in the Advanced 
options section.

For example, GUID, author, topic type, and date modified.

7. Click Search at the bottom of the left pane.

Search results are displayed in the right pane. Tridion Docs displays 100 search results at 
a time. Use the navigation buttons on the toolbar to move forward or backward through the 
results.

8. To change or remove the search text, click Reset.

Search parameters
Use search parameters to limit the search scope when you search the Tridion Docs repository.

Name Description
Latest versions Searches only the latest versions of objects.
All versions Searches all versions of objects.
Object types Type of object to search for. The options are:

• All

• Images

• Library Topics

• Maps (maps)

• Topics (topics)

• Other (Word, PDF..)

• XML object types, includes topics, maps, and library topics

Advanced options

Name Description
Identifier The unique identifier or GUID of the object that you want to search.
Title The title of the object that you want to search.
Topic type Topic type that you want to search.
Library Currently Tridion Docs library is not in use.

Table continues…
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Name Description
Illustration type The type of graphic as set in the properties for the graphic. Options are:

• Block diagram

• Component diagram

• Icon

• Other diagram

• Other illustration

• Process diagram

• Screenshot
Map type Type of map, book map or DITA map, that you want to search.
Version The version of the object that you want to search.
Language The language of object as set in the object properties.
Status Workflow status that you can search. The options are:

• Contributor draft

• Draft

• Editorial review

• In translation

• Obsolete

• Pre-release validation

• Ready to be translated

• Released

• System

• System Read Only

• Technical review

• To be translated

• Translated

• Translation rejected
Author Name of author as set in the object properties.
Last modified by The author who last modified this object.
Resolution Resolution of graphics as set in the graphic properties. Options are High, Low, 

Source.
User group User group that has permission to objects. Only system administrators with rights 

to give user groups permissions to specific folders in the repository use this search 
parameter.

Checked out by The name of author who has objects checked out.

Table continues…
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Name Description
Date created Date that objects were created in Tridion Docs.
Date modified Date or date range that objects were last modified in Tridion Docs.
Product Family Product family as set in the object properties.
Product Product as set in the object properties.
Component Component as set in the object properties. Values for the component are created on 

a per project basis by request.
Localization 
Coordinator

For use by translation only.

TMS Project code For use by translation only.
Translation 
Vendor

For use by translation only.

Searching for an element and attribute in a topic
About this task
You can search for the following in a topic:

• An element
You can also search by the text in an element

• An attribute used within an element
You can also search by the text in an attribute.

To search for an element or an attribute in a publication, search in the associated bookmap.

Procedure
1. Start Oxygen XML Author, and open a topic.

2. From the menu, click Find > Find All Elements.

Oxygen XML Author displays the Find All Elements dialog box.

3. To search for an element, in Element name, type the element name that you want to 
search.

4. To search for an attribute, in Attribute name, type the attribute name that you want to 
search.

5. Click Find All.

Oxygen XML Author displays all occurences of the element and the attribute in the 
message window.

You can click each entry to go to the occurrence of the element or attribute.

Searching for an element and attribute in a topic

July 2024 DITA and TDocs Work Instructions and Guidelines 321
Comments on this document? 

322

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Capturing metrics

Tridion Docs dashboard
You can use the dashboard tab in the Tridion Docs web interface to gather information about 
content stored in the system and to compare publications. You can get the following information in 
the dashboard:

• Number of objects by type (topics, maps, images)

• Number of objects in each workflow status

• Number of objects owned by system users in different roles (Author, Reviewer, Doc Lead)

• Number of objects in a user group (user groups are how we manage permissions)

• Number of objects for a product family (these are the high-level folders in the repository)

• Number of objects for a product

• Number of objects in a folder

You can narrow the scope of the metrics by combining categories. For example, you can capture 
the number of objects by product and then narrow the scope by adding the object type to find 
the number of topics for each project. You can refine the results further by limiting the scope. For 
example, you can limit the metrics to the number of objects for one project.

You can also use dashboard to locate a publication and compare two publications.

Searches and metrics
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Capturing metrics using the dashboard
You can use the Dashboard to capture a wide variety of metrics by selecting different options. 
This procedure provides the basic steps for generating metrics. But specifics for capturing different 
metrics are not provided because of the number of combinations that you can create.

Procedure
1. Log into the Tridion Docs web interface and click the Dashboard tab.

2. On the Dashboard, in Source Language, select the way you ’want to view the information.

Source Language is English. To view the information for other languages, select an option 
under Translation. The numbers are determined by the metadata assigned to objects in the 
database. If the metadata is assigned incorrectly, for example, you did not select the right 
product in the topic properties, the metrics show up incorrectly.

The results are displayed on the right pane. For example, if you select By Product, the 
total number of objects for each product are listed. Because of the amount of data on the 
system, it might take some time to display and update results.

3. (Optional) To add another dimension to the metrics, such as searching not just by product 
but also see the number of objects owned by each author in each project, select an option 
from the selections under the title on the right pane. For example, Object Type, Status, and 
Author.

The page displays the updated results.

4. (Optional) To limit the scope of the metrics (for example, maybe you want to capture the 
metrics for a specific project):

a. Click Refine from the options above the title on the right side of the page.

The page displays a list of fields on the right pane.

b. Click the browse button next to the field that you want to use to scope the metrics.

c. On the dialog box with the value, select the options in Available values and move 
them to the Selected values box.

d. Click OK.

e. To add additional categories to the scope, repeat a through c.

f. Click Apply at the bottom of the list.

The display changes based on the values you selected.

5. To change or clear the selections you made in step 4, click Refine and then select Clear 
All and Apply.
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Example

Creating reports from the Dashboard
About this task
You can view or save the Dashboard results in a spreadsheet. The charts that you see in the 
Dashboard display are not included in the report.

Procedure
1. Log into the Tridion Docs web interface and click the Dashboard tab.

2. Use the Dashboard to set up and display the results that you want to capture.

3. Click Export as CSV from the list above the title on the right side of the page.

4. When the File Download dialog box displays, click Open or Save.

The results display in a spreadsheet.

Saving Dashboard selections as favorites
About this task
You can save Dashboard selections as favorites to view updated results whenever you want.

Procedure
1. Log into the Tridion Docs web interface and click the Dashboard tab.

2. Use the Dashboard to set up and display the results that you want to capture.

3. Click Add Favorite.

4. If you see a message prompting you to allow scripted windows, click the message and 
select scripted windows temporarily and then click Add Favorite again.

5. In the Explorer User Prompt, enter a name for the favorite in the field and click OK.

The saved report displays under Favorites on the left pane. You can get an updated view 
of the report any time by selecting the report under Favorites.

6. To delete a favorite, click the red X symbol next to the favorite.
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Appendix A: Checklists

Project checklists
In the Summer of 2020, the GIS team created a new series of checklists that supplement the 
checklists shown in this appendix. The checklists are stored on ADMS and should be downloaded 
and used for every project. When you start a new project, always download a new set of checklists 
in case the checklists have been updated since your last project was completed.

• Program Owner Checklist – https://adms.avaya.com/documents/192368

• Preparatory Checklist – https://adms.avaya.com/documents/192369

• General Checklist – https://adms.avaya.com/documents/192370

• GA Publishing Checklist – https://adms.avaya.com/documents/192371

• Post-GA Checklist – https://adms.avaya.com/documents/192372

Topic authoring checklist
Use the check list as reference. You do not have to mark each item when you complete the task.

# Task

1. Create a new topic in Tridion Docs or check out an existing topic.
2. Give the topic a title that is correct for its type. For converted and renamed topics, 

change the title if it is not correct for the type.
3. Insert a comment at the top of the topic to list any topics for which a relationship 

should be identified. You will create those relationships in the map topics.
4. Insert the required content, and tag all the content semantically. If you have any 

questions on the correct tag to use, look at the tag help or contact your IA.
5. Ensure that you are using conrefs and reusable topic elements appropriately, as 

determined by your project.
6 Ensure that you add conditions in topics and maps, preview conditions, and select 

the conditions in the Conditions tab of Publication Manager, as determined by your 
project.

Table continues…
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# Task

7. Add the appropriate index entries.
8. Delete any empty elements. For example, if you are working on a task topic and 

you do not have any prerequisites, delete the prereq element.
9. Remove any comments from the default topic or tag template.
10. Perform a spell check on the topic (Edit > Check spelling).
11. Perform a completeness check on the topic (Document > Validate).

Related links
Creating a new topic on page 70

Checklist for creating a new publication
This checklist provides the high-level process of creating and managing a publication.
Use the check list as reference. You do not have to mark each item when you complete the task.

No. Task Description Notes

1 Open Browse Repository 
and create the product 
name folder if the folder is 
not already available.

Creating a new folder 
from Browse Repository on 
page 24

2 In the product name folder, 
create a folder for the 
deliverable, for example, 
Administering.

3 Create the following child 
folders and set the correct 
content type:

• images

• maps
• topics
• publications

4 In the publications 
folder, create a new 
publication.

Creating a new publication on 
page 30

Table continues…
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No. Task Description Notes

5 In the maps folder, create 
the following:

• One bookmap, called 
deliverable map

• Maps for each chapter 
and component maps as 
required

Creating a map on page 44

6 In the topics folder, 
create topics.

Creating a new topic on 
page 70

7 Open the publication and 
add the deliverable map to 
the publication.

8 To each chapter, add maps. Editing a bookmap on 
page 55

9 Add topics to chapter 
maps.

Adding a topic or map to a 
map on page 49

10 Select the output format for 
the publication.

Selecting the output format for 
a publication on page 122

11 Generate and download 
output as needed.

Important:

Verify the log files 
attached to the 
notification email each 
time for error and 
resolve them.

• Generating output on 
page 125

• Downloading output on 
page 136

12 Manage the workflow of 
topics, maps, and images 
in the publication.

Workflow on page 211

13 Verify that you select 
correct versions of objects 
in the publication.

Use the baseline to view the 
version of all objects that 
are used in the publication. 
See Working with publication 
baselines on page 223.

Note:

The Baseline tab 
does not display 
branches that 
are not selected. 
You can view 
branches from the 
version selector in 
the right pane in 
the Content tab.

Table continues…
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No. Task Description Notes

14 Freeze the baseline when 
the deliverable is finalized, 
and all components have 
released status.

Freezing the baseline on 
page 227

15 Generate the final output. Generating output on 
page 125

(Optional) Download the 
final Avaya Book output.

• Avaya Doc 
Center output: http://
documentation.avaya.com.

• Avaya Doc Center 
development output:

https://avaya-
dev.zoominsoftware.io/.

• For Avaya Book: 
Downloading output on 
page 136

16 Release the publication. Releasing a publication on 
page 215
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Checklist for releasing a publication
You must release your publications right before or right after you deliver your final content.

You release the publication to:
1. Submit the publication source files to the Localization team for translation.
2. Complete the changes for a product release and publish all documents for GA.

Complete the steps in this checklist each time you release a publication. Failure to complete all 
the steps can result in issues during the release process.

Note:
This is a mandatory checklist, and you must mark each item when you complete the task.

No. Task Notes

1. Before you prepare the content for release, ensure that 
you accept or reject change tracking in all topics and 
turn off the Use draft output format option in the output 
properties.

To check for any final change 
tracking, you can produce a 
Validator output.

2. In Publication Manager, check the Newer Version column 
in the Baseline tab to determine if there are newer 
versions of the objects that you are using in your 
publication. If so, determine if you must select the new 
version and, if so, click Locate to find the object in the 
Contents tab and then select the newer version from the 
list of versions in the upper-right corner.

3. Generate output and check the logs attached to the 
notification email for any errors. For more information on 
generating output and viewing the publishing logs, see 
Working with output on page 117.

You must check the logs every 
time you publish your outputs, 
not just at the end of the cycle.

Note:

Generate a Validator PDF 
output to check for issues, 
such as elements tagged 
with <b> or <i>, that 
you must correct before 
freezing the publication 
baseline.

4. Correct any errors present in the publication log and 
republish the output.

If you fail to correct any errors, 
the freeze baseline fails.

Table continues…
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No. Task Notes

5. On the Output tab in Publication Manager, click View 
Report to view the publish report and ensure that there 
are no errors.

This report might show 
additional errors that are not 
in your output logs that could 
prevent the baseline freeze. 
Therefore, check the report as 
you get ready to release your 
content.

6. In Publication Manager, check the In Folder column in 
the publication baseline to determine if you’re reusing any 
objects from other writers. If you are reusing objects from 
other writers and the Status is anything but Released, 
contact the writers and inform them when you need them to 
release their objects.

Perform this step ahead of time to give the topic owner 
time to resolve the error if any.

You can sort the In Folder 
column to see any reused topics 
that are located in folders for 
which you do not have write 
access.

7. When you are ready to release the content, try freezing 
the baseline before releasing the objects. If the freeze 
operation reports issues, you have the opportunity to make 
corrections in the content before you release the objects.

Freezing the baseline on 
page 227.

8. Release all objects in your publication that you own. For information on changing 
the workflow status of individual 
objects, see: Changing the 
workflow status of an object 
from the Desktop Repository on 
page 213, Changing metadata 
in bulk on page 101, or 
Changing the workflow status 
when checking in a topic on 
page 213. You can use the 
workflow report in the Tridion 
Docs web interface to change 
the status of multiple objects 
simultaneously on page 219.

9. Check the Status column in the publication baseline to 
validate that all objects are in the Released state.

You can sort by the Status 
column to identify and locate 
any objects not in the Released 
state.

10. Freeze the publication baseline. Freeze the publication 
baseline on page 227.

11. If the Freeze operation fails, check the Freeze Baseline 
report on page 228 for errors and correct them.

12. After you freeze the baseline, produce the output again so 
that it shows a Release Candidate status when complete.

Table continues…
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No. Task Notes

13. To correct any errors in the baseline freeze, go to the 
Output tab and click View Report to view the publish 
report again and ensure that there are no errors.

14. On the Output tab, select the output with a Release 
Candidate status and click Release.

15. Repeat steps 11 through 13 for any other output formats for 
the publication.

After all outputs are released, 
release the publication.
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Checklist for preparing content for Localization
Ensure that you complete every step in this checklist before you deliver the content to 
Localization. Some of these items require an investment of time, such as completing an editorial 
review and the associated updates. If there are items that you cannot complete, ensure that you 
have discussed those items with your Localization Project Manager. It is critical that you prepare 
the content well and release by the scheduled date.

Important:
This is a mandatory checklist, and you must mark each item when you complete the task.
Failure to complete these items according to schedule can result in changes after translation, 
which increases our costs and can cause delays.

No. Task Description

Quality checks
1. Run a spell check on your content.
2. Submit your content for an editorial review and 

make the updates.
3. Run a Validator output on page 130 and ensure 

that all issues are addressed.
Content
4. Ensure a manual line break at the end of the 

mainbooktitle is included in the bookmap for 
publications to be produced as PDF.

5. Ensure that all strings from the product interface 
are set up for reuse.

Reuse and localization on 
page 187

6 Ensure that no conrefs used in bookmap titles, 
topic titles, and index.

7. Ensure that you use uicontrol and wintitle:

• Only to reference an item on the user interface 
(UI)

• Do not use as common words in a sentence 
even if you must use the same word or phrase.

Images
8. Ensure that all images with embedded text are 

created in SVG.
Creating a new vector image in 
Inkscape on page 367

9. Select the Enable translation management box 
in the Properties for all SVG images with text to 
be translated.

Do not enable translation 
management for topics or images 
that do not include text to be 
translated.

Table continues…
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No. Task Description

10. Validate that all SVG images allow for text 
expansion.

11. Validate that all image elements have alt text on 
page 255.

Avoid any punctuation marks in 
the alt text.

12. Reuse icons that are used more than once.
Before you deliver
13. Check log files on page 136 and ensure that all 

errors are corrected.
14. Remove all change tracking from topics on 

page 97.
15. Release the publication version. Checklist for releasing a 

publication on page 329.
16. For a new project, inform the Localization 

coordinator to get the new user group added to 
the ServiceUser.

Related links
Delivering content to localization on page 214

Checklist for preparing content for Localization
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Appendix B: DITA element definitions

DITA element reference
The following table lists frequently used DITA elements, and elements that we can use inline and 
translate.

A complete list of DITA elements is available in the subsequent sections.

Element Description Inline (Y/N) Translatable (Y/N)
application To tag application 

names.

Always reference 
from the common 
Applications.dita 
topic.

Do not add the 
Application element 
directly.

Y Y

cite To refer the title of a 
document or article.

To refer a topic from 
the same document, 
create the relationship 
table link.

Y N

choices Use in table rows 
and step elements to 
describe more than 
one way a user can 
accomplish a current 
step.

Y Y

Table continues…
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Element Description Inline (Y/N) Translatable (Y/N)
cmdname To represent the name 

of a command used in 
an application.

When the cmdname 
is part of a command 
string or a block of 
code, wrap the entire 
string in a container 
element.

If the string is:

• what the user 
must enter, use 
<userinput> as the 
container, and then 
tag the command 
with <cmdname> 
and variables with 
<varname>.

• a code phrase 
or block of code, 
use <codeph> 
or <codeblock> 
depending on the 
string size.

Y N

codeblock To present a block of 
code as an example.

N N

codeph To add code snippets 
within the main flow of 
text.

Y N

feature To tag a product 
feature

Y Y

Note:

Do not reuse the 
feature element in 
titles, specifically 
when the title 
contains only the 
reused feature 
element and does 
not contain any 
additional text.

Table continues…
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Element Description Inline (Y/N) Translatable (Y/N)
ph Use to organize 

content for reuse or 
conditional processing. 
For example, when 
part of a paragraph 
applies to a particular 
audience.

Y N

Important:

Avoid using the ph 
element to prevent 
any translation 
issues.

filepath Use for:

• A file, directory, or a 
directory path.

• URL that is not part 
of an xref.

msgph Use for the system 
message, usually, 
associated with an ID.

Y Y

msgblock Use for multiline 
system message or 
a group of system 
messages.

Y Y

menucascade To represent a path or 
cascade of menus. 
Usually used as a 
container for two or 
more uicontrol 
elements. For 
example: 
<menucascade><uicon
trol>File</
uicontrol><uicontrol>Pr
int</uicontrol></
menucascade>.

Y Y

systemoutput Use for system 
output in response to 
commands, actions, or 
queries.

If the text must be 
translated, use msgph 
or msgblock.

Y N

Table continues…
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Element Description Inline (Y/N) Translatable (Y/N)
uicontrol To specify the names 

of elements in a user 
interface.

For example, buttons, 
field labels, menu 
items, or any object 
that allows the user to 
control the interface.

You also use 
<uicontrol> inside 
<menucascade>.

Y Y

userinput To tell users that they 
must enter the text. 
Use <varname> if the 
text has a variable.

Y Y

wintitle To specify the name of 
a window, dialog box, 
or the static title on a 
page.

For example, wizard 
title, wizard page title, 
section title on a page, 
and window pane title.

Y Y

Tip Additional information 
to help users 
better understand 
the benefits and 
capabilities of the 
product or technology.

Y

Product To tag Avaya or third-
party product names.

Always reference from 
the common Product 
names.dita topic.

Do not add the Product 
element directly.

Y N

Info To provide additional 
information about a 
step. Add the element 
inside step.

N Y

Table continues…
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Element Description Inline (Y/N) Translatable (Y/N)
xref (cross reference) To create a link to:

• Another topic within 
the same deliverable.

• A different location 
within the current 
topic.

Note:

Avoid linking to 
the content in 
the same topic 
to prevent 
circular 
references issue 
that might result 
in Publication 
Manager crash.

xref (web link) To create a link to an 
external source such 
as a web page.

Tags to annotate content
Element Description
avaya-note Use to call attention to neutral information or 

positive information that:

• Supplements the main text

• Is valuable information that is independent of the 
main text

important Use to call attention to a situation that can cause 
serious inconvenience.

caution Use to call attention to situations that can result in 
harm to software, loss of data, or an interruption of 
service.

warning Use to call attention to a situation that can result in 
harm to hardware or equipment.

danger Use to call attention to situations that can result in 
harm to personnel.

Table continues…

DITA element definitions

July 2024 DITA and TDocs Work Instructions and Guidelines 338
Comments on this document? 

339

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Element Description
esd Use to call attention to situations that can result in 

electrostatic discharge (ESD) damage to electronic 
components.

Add the following text as is, and include any 
additional information in a new paragraph if 
necessary.

Electrostatic alert:

ESD can damage electronic circuits. Do not 
touch electronic hardware unless you wear a 
grounding wrist strap or other static-dissipating 
device.

Related links
Elements that are not used on page 363

A
abstract
Use to provide a brief overview of the topic to help the user decide whether this topic is relevant 
to them. Introduce the topic and provide a concise answer to the question "What is this?" and in 
some cases "Why do I care about this?" Avoid using the abstract to lead in or build up to a topic. 
Use complete sentence rather than sentence fragments, and do not repeat the title. Avoid starting 
abstracts with phrases such as "This topic describes . . . ." or "This topic is about . . . ."
Use the shortdesc element for single paragraph with within 50 words.

alt
Use to describe visual elements to users who cannot see them, either because the image failed to 
load or because they are using a screen-reader.
Use to describe the contents of an image that makes the image accessible to users who use a 
screen reader.
Use to describe the contents of an image to:

• Make the image accessible to users who cannot see it and use a screen reader.
• Enable search engines to better crawl and rank your website.
• Enable translation tools access alt text easily for translation than the alt attribute.

Therefore, do not use the alt attribute for alternative image text.

apiname
Indicates the name of an application programming interface (API).
For example, wrap the <apiname> element around a Java class name or method name.

A
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application
Use the <application> element for names of applications, include names of mobile applications, 
and interfaces within a product. Rather than typing each occurrence of an application, reuse the 
defined application elements from the reusable elements topic.

C
category
We do not currently use this element.

cause
Use the <cause> element in a resolution topic to describe a possible cause of the issue. A 
resolution topic can include more than one cause.

caution
As defined in the Avaya Style Guide, use the <caution> element to call attention to situations that 
can result in harm to software, loss of data, or an interruption of service.

chdesc
Describes a choice presented in a Choice table. Choice tables are part of a task topic.
Use the <chdesc> element in the second column of the Choice table. You must include a 
<chdesc> element for each <choption> you define.
The text in each <chdesc> element explains why the user would choose that option. The text can 
also explain the result of the choice when it is not immediately obvious.

chdeschd
Specifies a heading for the Description column in a Choice table. Choice tables are part of a task 
topic.
If you do not specify a <chdeschd> element, the Description column will display the default 
heading “Description”.
Use the <cheschd> element with the <choptionhd> element. Both elements must be inside a 
<chhead> container element.

chhead
Specifies the header row for a Choice table.
The <chhead> element is a container element inside the Choice table. The <chhead> element 
must contain the two header elements: <choptionhead> and <chdeschd>.
To specify a header row for a Choice table:

1. Use the <chhead> element .
2. Define the <choptionhd> and <chdeschd> elements inside the <chhead> element.
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choice
Describes one way that a user can accomplish a current step.
You must define more than one <choice> element. Every <choice> element must included in a 
<choices> element.

choices
Contains a list of <choice> elements.
Use the <choices> element when a user must choose one of several actions within the steps of a 
task.
If you are presenting a series of possible actions, use the phrase “Perform one of the following 
actions” in the step.

choicetable
Contains a series of optional choices available within a step of a task.
Use the <choicetable> element when a user must choose one of several actions within the steps 
of a task and you want to provide additional information. For example, use the <choicetable> 
element if you need to explain why the user would choose that option or the result of the choice.

choption
Indicates the name of an option in a Choice table. Choice tables are part of a task topic.
Use the <choption> element in the first column of a Choice table. You must include a <chdesc> 
element for each <choption> you define.
Each <choption> in a Choice table contains a choice that a user can make to accomplish a step of 
a task.

choptionhd
Specifies a heading for the Option column of a Choice table. Choice tables are part of a task topic.
If you do not specify a <chdeschd> element, the Option column will display the default heading 
“Option”.
Use the <choptionhd> element with the <cheschd> element. Both elements must be inside a 
<chhead> container element.

chrow
Identifies a row inside a Choice table. Choice tables are part of a task topic.
The <chrow> element contains the two row elements: <choption> and <chdesc>.

cite
Use the <cite> element to refer to the title of a book or article. For references to other topics, our 
best practice is to use a reltable link and no reference. You can still use an xref if it meets one of 
the criteria.

cmd
Provides the required first element inside a <step>.

C
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The <cmd> element provides the active voice instruction that the user needs to complete a step in 
a task topic. The text should not be longer than one sentence.
If appropriate, provide context for the action at the beginning of the command, such as “On the 
Add User page,...”.
If the step requires additional explanation, include that information in an <info> element after the 
<cmd>.

cmdname
Indicates the name of a command used in an application.
When the <cmdname> is part of a command string or a block of code, the entire string should be 
wrapped by a container element. If the string is something you're instructing the user to enter, use 
<userinput> as the container for the string, and then tag the actual name of the command with 
<cmdname> and any variables with <varname>. If you're presenting a string or block of code, the 
appropriate container element is <codeph> or <codeblock>, depending on the size.

codeblock
Use <codeblock> for code samples. If you are presenting a block of code as an example, and the 
semantics of each element within the block of code is not critical in the particular context, you do 
not have to tag each individual element within the block of code.
In the output, all text you enter in the <codeblock> element has preserved line endings and is 
displayed in a monospaced font.
If you're using <codeblock> within a step, note that you cannot insert it directly within a <cmd>, but 
you can insert it in an <info> element after the <cmd> within the step.
If you are directing the user to enter some code, use the <userinput> element instead.

condition
Use the <condition> element to describe the problem, alarm, event, error in a resolution topic if the 
title doesn’t provide enough information

codeph
Use codeph element for snippets of code within the main flow of text. The code phrase is 
displayed in a monospaced font for emphasis.

component
We do not currently use this element.

conbody
Provides the main body-level element for a Concept topic.
The <conbody> element can include paragraphs, lists, and other elements. If you use the 
<conbody> element for a section or an example, you can only follow that element with other 
sections or examples.

concept
Provides the top-level element for a concept topic that answers the question "what is?" All concept 
topics must include the <concept> element.
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Concepts provide background information that users must know before they can successfully work 
with a product or interface. A concept can also include an example or a graphic.

condition
Use the condition element to provide a description of the problem or condition within a resolution 
topic. You can provide one or more recommended corrective actions for each condition.

context
Provides background information for the task. This information helps users understand what the 
purpose of the task is, when to perform the task, and what they will gain by completing the task. 
This element should be brief and does not replace or re-create a concept topic on the same 
subject, although the context might include some conceptual information.
This element is optional and should only be included when a context provides value to the user. If 
the <abstract> element for the task includes some context information, you can use <context> to 
elaborate further on that information.

D
danger
As defined in the Avaya Style Guide, use the <danger> element to call attention to situations that 
can result in harm to personnel.

dbitem
Use for database item names. The <dbitem> element appears as plain text in outputs.

dbtable
Use for database table names. The <dbtable> element appears as plain text in outputs.

dd
Describes a term (<dt>) in a Definition list <dl> entry.
You must include a Definition description <dd> element for each <dt> element. Include both 
elements inside a <dlentry> container element.
A <dd> should provide a simple description. If you require a longer, more complex description, 
consider using a different element, such as <section> or <subsection>.

ddhd
Provides the heading for a column of descriptions or definitions in a Definition list. This element is 
optional. You do not need to have a heading on columns in a Definition list.
You must include a <ddhd> element for each <dthd> element. Include both elements inside a 
<dlhead> container element.

desc
Provides the description for a table or a figure.
The text in the <desc> element must provide more information than the title.

D
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Include a <desc> in a <table> or <figure> element to reuse the description and the <image> within 
a <figure> element or a <table> element.

dl
Provides a list of terms and corresponding definitions.
Use the <dl> element to provide a brief list of descriptions, such as a list of command parameters 
or a list of hardware requirements.
You can include an optional Definition list heading <dlhd> in a Definition list. To add a heading to a 
Definition list, insert a <dlhead> element in the <dl> element before the first <dlentry> element.

dlentry
Defines a list item in a Definition list.
The <dlentry> entry element must include a term <dt> and associated description <dd>.

dlhead
Provides the heading for the term and description columns in a Definition list. This element is 
optional. You do not need a heading on columns in a Definition list.
The <dlhead> element must contain a heading <dthd> for the column of terms and a heading 
<ddhd>for the column of descriptions.

draft-comment
Includes any questions or comments that you do not want to appear in the final output.
For example, use the <draft-comment> element for questions to reviewers or comments for the 
next owner of the topic.

dt
Provides the term in a Definition list <dl> entry.
Each <dlentry> container element includes a Definition term <dt> and its associated description 
<dd> element.

dthd
Provides the heading for a column of terms in a Definition list. This element is optional. You do not 
need to have a heading on columns in a Definition list.
You must include a <dthd> element for each <ddhd> element. Include both elements within the 
<dlhead> container element.

E
email
Use the <email> element for e-mail addresses.

emphasis
Use the <emphasis> element to indicate text that requires emphasis.
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Note:
Do not use this element when a semantically specific element is available, for example, 
uicontrol, cite, and wintitle.

entry
Defines a single cell in a table.
If no data is appropriate for an entry, insert a centered em dash (—) into the cell (Insert > 
Symbol) so that the reader knows that the omission is not an error.

esd
As defined in the Avaya Style Guide, use the <esd> element to call attention to situations 
that can result in electrostatic discharge (ESD) damage to electronic components. Use the first 
two sentences exactly as those sentences appear in the following example. Add other text if 
necessary.

Electrostatic alert:
ESD can damage electronic circuits. Do not touch electronic hardware unless you wear a 
grounding wrist strap or other static-dissipating device.

example
Contains examples that illustrate or support the current topic. The <example> element is a section 
element.
You can include an example in concept, task, and reference topics.
To create a topic-length example, use the Scenario information type.
This element automatically inserts a heading above the text.

F
feature
Use this element to tag official product feature names. Before using this element, get a definitive 
list of features from your Product Manager. Do not use the feature element to tag anything other 
than feature names and do not include anything other than the feature name in the element. For 
example, do not use the feature name to tag functionality or industry-standard names.

fig
Provides a container element around an <image> element when you want to provide a description 
<desc> for that image.
Include a <fig> element in a conref to reuse the image and its description.

filepath
Indicates the name of a file, directory, or a directory path.
For example, <filepath>C:\Program Files\Avaya\index.html</filepath> or <filepath>setup.exe</
filepath>.

F
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Also use filepath for a URL that is not part of an xref.
In the output, the text you enter in the filepath element is displayed in a sans serif font.

fn
Use footnote (<fn>) to annotate text with notes that are not appropriate for inclusion in line or to 
indicate the source for facts or other material used in the text.
Don’t use footnotes in table header rows due to an issue in the software we use to produce our 
PDF outputs (Antenna House).

G
glossdef
Specifies the definition of glossary term within a glossary topic.

glossterm
Specifies the glossary term being defined in a glossary topic.

I
image
Identifies artwork or images in a topic.
The <image> element has optional attributes that indicate whether the graphic or artwork should 
be:

• Inline, such as a button or icon
• On a separate line, such as a larger image

An href attribute is required on the <image> element. The href attribute creates a pointer to the 
image, and allows the output formatting processor to bring the image into the text flow.
To make the intent of the image more accessible for users using screen readers or text-only 
readers, always include a description of the image content in the <alt> element. If you want to 
include a description of the image for reuse, include the <image> and a <desc> element inside a 
<fig> element.

important
As defined in the Avaya Style Guide, use the <important> element to call attention to a situation 
that can cause serious inconvenience.

indexterm
Defines an index entry.
The text in an <indexterm> element is not output as part of topic content.
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When you're adding index entries, any index entries that relate to the whole topic should be 
inserted in the prolog section of the topic. Index entries that apply to a specific section of the topic 
should be inserted in that element as an inline. This ensures that the link to that index entry goes 
to the right location in the topic (helpful in cases where the topic is not all contained on the same 
page in an output). It also ensures that the index entry is moved or deleted with the content that it 
relates to.
To create multi-level indexes, nest the elements as follows:
<indexterm>users
<indexterm>adding</indexterm>
</indexterm>
Nest index entries to one level only.

info
Provides additional information about a step.
Always use the <info> element inside a <step> element.

K
keyword
<keyword> represents a word or phrase with relevance to the content. This is useful for identifying 
things like terms not used in the product that a user might search for (for example, a user 
might search for an industry-standard term instead of the feature name Avaya has assigned to 
something). Keywords are searchable in our HTML outputs. Providing industry-standard terms 
and other additional relevant terms as keywords in the prolog will improve the findability of our 
HTML content and help the user locate the right topic.

keywords
The <keywords> element contains a list of key words (using indexterm or keyword elements) that 
can be used by a search engine.

L
li
Identifies a single item in a list.
An <li> element can be a list item in an ordered <ol> or unordered <ul> list.
List items should:

• Start with a capital letter, unless the first word is context-sensitive and lowercase.
• Ensure that each item in the list is parallel in both purpose and structure.

K
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• When possible, ensure that items in a list are either all sentence fragments or all complete 
sentences, and not a mixture of both. If you must include both sentences and sentence 
fragments, end each entry in the list with a period. In a list that consists of sentence 
fragments only, do not include punctuation at the end of any item, including the last item.

lq
The long quote (<lq>) element indicates content quoted from another source. Use the quote 
element <q> for short, inline quotations, and long quote <lq> for quotations that are too long for 
inline use, following normal guidelines for quoting other sources. You can store a URL to the 
source of the quotation in the attribute.

M
menucascade
Indicates a series of menu choices.
The <menucascade> element can contain one or more <uicontrol> elements. For example: 
<menucascade><uicontrol>File</uicontrol><uicontrol>Print</uicontrol></menucascade>. If the 
<menucascade> element includes more than one <uicontrol> element, connecting characters are 
inserted automatically between the menu items to represent the menu cascade.

metadata
The <metadata> section of the prolog contains information about a topic such as audience and 
product information. Metadata can be used by computational processes to select particular topics 
or to prepare search indexes or to customize navigation.

msgblock
Identifies a multi-line system message or set of system messages.
The <msgblock> element can contain multiple message number <msgnum> elements. The 
<msgblock> element can also contain just the text of the message.

msgnum
Contains the number or identifier of a message produced by an application or program.
The <msgnum> element is an optional element inside a <msgblock> element.
Use the <msgnum> element with the message description <msgph> element.

msgph
Identifies the text content of a message produced by an application or program.
The <msgph> element can also contain the variable name (varname) element to illustrate where 
variable text content occurs in the message.
Use the <msgnum> element within a <msgph> element when you need to include the message 
number or identifier.
Use <msgph> only for specific messages generated by the system. Use <systemoutput> for 
general computer output or responses to a command or situation.
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N
note-avaya
As defined in the Avaya Style Guide, use the <note-avaya> element as a general note to call 
attention to neutral information or positive information that:

• Supplements the main text
• Is valuable information that is independent of the main text

You do not want readers to ignore a note. However, use a general note only when the situation 
that you describe does not have serious consequences for the user who ignores the note. 
Specifically, do not use notes to call attention to situations that can result in data loss, damage to 
software or hardware, or harm to personnel. When a situation is that serious, use the appropriate 
admonishment.

O
object
DITA's <object> element corresponds to the HTML <object> element. The <object> element 
allows authors to include animated images, applets, plug-ins, ActiveX controls, video clips, and 
other multimedia objects in a topic for rendering after transformation to HTML. In our environment, 
we use the object element when projects need to embed external tutorial files in a topic.

ol
Provides an ordered list. Items in an ordered list are numbered and sorted by sequence or order of 
importance.
The <ol> element must contain one or more <li> elements.

option
Use the option element for command line interface options. However, make sure you use 
userinput element for any text entries that you explicitly tell the user to make.

P
p
Indicates a paragraph element. Each paragraph is a block of text containing a single main idea.
Some elements automatically include a <p> element.

parml
Use the parameter list (<parml>) element to document a list of terms and definitions that describes 
the parameters for a command or an API. Parameter lists contain a series of parameter entries 
<plentry>.

N
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If you are referencing the name of a parameter within the text flow of your topic or in a syntax, use 
<parmname>.

parmname
Use <parmname> when referencing the name of a command parameter or API parameter within 
the text flow of your topic or in a syntax.
If you're documenting a list of parameters and their descriptions, use <parml>.

partdesc
Use the <partdesc> element to define the heading of the description column in a parts table. The 
default value for this element is Description.

parthead
The <parthead> element defines the heading row of the parts table and includes the <partname> 
and <partdesc> elements.

partname
Use the <partname> element to define the heading of the name column in a parts table. The 
default value for this element is Name.

partrow
The <partrow> element contains <partname> and <partdesc> elements that you can use to 
provide the names and descriptions in a parts table.

parttable
Use the <parttable> element within a structure topic type to create a parts table that describes the 
components of a container of some kind, such as a product interface or a hardware component. 
The <parttable> element contains the <parthead> and multiple <partrow> elements.

ph
The phrase (<ph>) element is used to organize content for reuse or conditional processing (for 
example, when part of a paragraph applies to a particular audience).
Take care not to overuse the <ph> element for reuse to the point that it becomes difficult to 
manage and maintain. See Guidelines for reusing content on page 188 for more information about 
reuse through conrefs.

pd
Use a parameter definition (<pd>) to provide a command or API parameter term description within 
a parameter list entry (<parml>). Each <pd> must have a corresponding parameter term (<pt>).
If you are referencing the name of a parameter within the text flow of your topic or in a syntax, use 
<parmname> instead of a parameter list.

platform
The <platform> metadata element contains a description of the operating system and/or hardware 
related to the product being described by the <prodinfo> element.
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plentry
The parameter list entry element (<plentry>) contains one or more parameter terms and definitions 
(pd and pt) within a <parml>. Parameter entries document terms and definitions that describes the 
parameters for a command or an API.

postreq
Describes steps or tasks that the user must perform after the successful completion of the current 
task.
The <postreq> element is optional. This element automatically inserts a heading above the text.

pre
Use <pre> for samples of preformatted ASCII outputs, such as log files or report outputs.
In the output, all text you enter in the <pre> element has preserved line endings and is displayed 
in a monospaced font.
Do not use <pre> for code samples; use <codeblock> instead because it is more semantic.

prodinfo
The <prodinfo> metadata element in the prolog is a container for prodname, platform, featnum, 
component, vrmlist.

prodname
The <prodname> metadata element contains the name of the product that is supported by the 
information in this topic.

prereq
Describes steps or tasks that user must perform before starting the current task. Do not include 
concept or reference information in a <prereq> element.
The <prereq> element is optional. This element automatically inserts a heading above the text.

product
Use the <product> element for names of products. Rather than typing each occurrence of a 
product name, reuse the defined product elements from the team reusable elements topic.

propdesc
Provides a short description of a property type and its values in a properties table. Properties 
tables are part of reference or structure topics.
You must use the <propdesc> element with a <property> element.

Tip:
You can also use the <propvalue> element to provide the values for the property type.

propdeschd
Specifies a heading for the Description column in a properties table. Properties tables are part of 
reference or structure topics.
You must use the <propdeschd> element inside a <prophead> container element.
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properties
Provides a list of properties, typically rendered in a table format. Properties tables are part of 
reference or structure topics.
Each property in a <properties> element can include the type, value, and a description.
To represent multiple values for a type, create additional property elements. Use the <propvalue> 
element for each successive value. You can also use <propdesc> when needed.

property
Defines a property in a Properties table. Properties tables are part of reference or structure topics.
The <property> element contains three optional elements: type, value, and description.

prophead
Specifies the header row for a Properties table. Properties tables are part of reference or structure 
topics.
The <prophead> element is a container element inside the Properties table. The <prophead> 
element can contain the following header elements: <propdeschd>, <proptypehd>, and 
<propvaluehd>.

proptype
Defines the type for the current property in a Properties table.

proptypehd
Specifies a heading for the Type column in a Properties table.
You must use the <proptypehd> element inside a <prophead> container element.

propvalue
Defines the value or values of the current property type in a Properties table. Properties tables are 
part of reference or structure topics.
If each value for the property needs a separate description, enter the values in separate rows of 
the table and leave the <proptype> element blank.

propvaluehd
Specifies a heading for the property value column in a Properties table. Properties tables are part 
of reference or structure topics.
You must use the <propvaluehd> element inside a <prophead> container element.

pt
Use a parameter term (<pt>) to provide a command or API parameter term name within a 
parameter list entry (<parml>). Each <pt> must have a corresponding parameter definition (<pd>).
If you are referencing the name of a parameter within the text flow of your topic or in a syntax, use 
<parmname> instead of a parameter list.
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Q
q
A quotation element (<q>) indicates content quoted from another source. This element is used 
for short quotes which are displayed inline. Use the long quote element (<lq>) for quotations that 
should be set off from the surrounding text. If the quote ends a sentence, do not include the period 
within the <q> element unless it is part of the actual quote.
Do not use the q element to:

• Text reference to other topics.
Instead, you can reference other topics using a relationship table or an xref element.

• Set off new words or phrases you are introducing. For example, to quote someone else.
• Highlight or emphasize a phrase or a word.

R
refbody
Provides the main body-level element for a Reference topic.
The <refbody> element can include the following elements in any sequence or number:

• Simple and standard tables
• Property lists
• Generic sections
• Generic examples

report-element
Use this element to tag elements in a report output, such as the report column title, the data 
elements in the report, etc. These elements are not for elements in the product interface that are 
used to generate the reports. Instead, these elements are for resulting reports that are generated.

report-name
Use this element to tag the names of reports that are generated by a product.

reference
Provides the top-level element for a reference topic, which provides necessary facts about a 
subject. All reference topics must include the <reference> element.
Reference topics typically provide facts that a user needs to successfully complete a task or to 
work with a product or interface. For example, a reference topic can include commands and field 
descriptions. A reference topic cannot include an explanation of concepts or procedures.

related-links
Provides links to the related information of a topic.

Q
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In the output, the related links are displayed at the end of the topic similar to the relationship table 
links. You must add the link to topics in related-links/link/link text element.

relcell
Identifies a cell in the Relationship table.
A <relcell> element contains <topicref> elements. These elements are related to <topicref> 
elements in other cells of the same row.
By default, <topicref> elements in the same cell are not related to each other. To make <topicref> 
elements in the same cell related to each other, you must change the collection-type attribute of 
the <relcell> element.

relcolspec
Defines a column in a Relationship table.
Use the <relcolspec> column definition to set the default attributes for <topicref> elements in the 
column. For example, set type="concept" to treat all untyped <topicref> elements in the column as 
concepts.

relheader
Identifies a row of column definitions in a relationship table. Each column definition is a 
<relcolspec> element inside the <relheader> element.
Each relationship table can have only one set of column definitions.

relrow
Identifies a row in a relationship table.
The <relrow> element creates a relationship between the cells in the row. In the output, this 
relationship is expressed as links among the <topicref> elements in the cells.

reltable
Identifies a relationship table, which defines the relationships between topics.
The <reltable> is based on the table model of the following elements:

• Rows contained in <relrow> elements
• Columns identified by <relheader> elements
• Cells contained in <relcell> elements

The <relcell> elements can contain <topicref> elements. <topicref> elements are then related to 
other <topicref> elements in the same row. <topicref> elements do not have to be in the same cell.
By default, the contents of a <reltable> element are not output for navigation purposes or in the 
table of contents. The contents of the <reltable> element define relationships that are output as 
related topic links.
See Relationship tables overview on page 175 for a more detailed description of relationship 
tables.

remedy
Use the <remedy> element within a resolution topic to provide steps to solve the issue. You can 
include more than one remedy in a resolution topic if there’s more than one possible solution. The 
elements used are the same as for steps in task topics.
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resolution
Use the resolution topic type to provide information about detecting and resolving product issues, 
events, alarms, and errors. The resolution type can include an identifying name or number, a 
description, and one or more recommended resolutions.
When creating a new resolution topic, use the Resolution tag template.

resolutionbody
The <resolutionbody> element is the main body-level element of a resolution topic. The 
<resolutionbody> element allows the <condition>, <corrective-action>, <example>, <postreq>, and 
<result> elements.

required-cleanup
Provides a placeholder for cleanup that needs to be take place after a conversion.
Clean up the text or other content contained in this element and delete the element from the topic.

result
Describes the expected outcome of the current task.
Do not use the <result> element to describe the outcome of a step in the task. Do not include 
concept or reference information in a <result> element.
The <result> element is optional.

S
section
Represents an organizational division in a topic. Sections are not available in task topics.
Use sections to organize subsets of information that are directly related to the topic. You can 
include multiple <section> elements in a topic. However, the sections do not represent a hierarchy. 
They represent peer divisions of that topic.
You cannot nest sections. You can modify the attributes of a <section> element to add a title to a 
section.

security
As defined in the Avaya Style Guide, use the <security> element to call attention to situations that 
can increase the potential for unauthorized use of a telecommunications system.

shortcut
Identifies a keyboard shortcut for a menu or window action inside a <uicontrol>. The character that 
you identify as a shortcut is underlined.
For example, <uicontrol><shortcut>P</shortcut>rogram</uicontrol>.

S
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shortdesc
The short description represents the purpose or theme of the topic, using which readers can 
determine whether a topic might be of interest to them. You can add the element both in topics 
and maps.
Keep the short description to a single, concise paragraph with one or two sentences of about 50 
words. Otherwise, use the <abstract> element to provide richer content around the <shortdesc> 
element.
shortdesc is used in link previews and HTML outputs as hover text, and in search results.

simpletable
Creates tables with a s structure that do not need a caption.
The <simpletable> element must contain the following elements:

• An <sthead> element to define for column headings.
• One or more <strow> elements to define for rows of data in the table.
• One or more <stentry> elements to define table cells.

Use <simpletable> instead of table whenever possible. If you do require a more complex table, 
use the <table> element.
Do not include tables within the paragraph element for the preceding paragraph. Make sure that 
you insert any tables after the closing tag.

simple-equation
Use the <simple-equation> element when you are including a simple equation in your content.

sstitle
Provides the heading in a <subsection> element.
This element is automatically inserted when you select the <subsection> element. The <sstitle> 
element is only supported for use within a <subsection> element. If you select <sstitle> in 
any other context, auto-generated text warns you that this element is only supported with a 
<subsection>.

stentry
Represents a single table cell in a simple table.
Use the <stentry> element in the <simpletable> element. You can place any number of <stentry> 
cells in the following elements:

• An <sthead> element if the cell will be part of a column heading.
• An <strow> element if the cell will be part of a table row.

step
Represents a particular action that a user must complete to accomplish the overall task in the 
topic.
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Each <step> element task must contain a command <cmd> element. The step element can also 
contain the following optional elements:

• <info> element for additional information
• <substep> element for one or more substeps
• <stepxmp> for an example related to the step
• <choices> for choices that need to be made during the step
• <stepresult> for the rare occasion when the result of the step is not obvious

If a step is optional, insert the word Optional in parenthesis at the beginning of the step.

stepresult
Provides useful information on the expected outcome of a step.
Only use the <stepresult> element if the result is not obvious and only when the result will provide 
value to the user.

steps
Provides the main content of a task topic.
The <steps> section includes a series of steps that the user must follow in the specified order to 
accomplish the task. The <steps> section of a task must contain one or more <step> elements.

stepsection
The <stepsection> element provides expository text before a step element. This element is useful 
if you need to describe a series of upcoming steps or if there’s important information you need to 
include before a step that isn’t appropriate to include in the previous step. This element should not 
be used to insert a title before a group of steps. In the output, the stepsection appears without a 
step number.

steps-unordered
Contains one or more steps that must be performed to complete a task.
Use the <steps-unordered> element when the order of steps may vary from one situation to 
another, or when the task requires only a single step.
The <steps-unordered> element must contain one or more <step> elements.

stepxmp
Describes an example that illustrates how to perform a step in a task. The example can be a 
single sentence or an entire paragraph.
Do not use the <stepxmp> element to provide an example of the entire task. Use the <example> 
element to provide an example of the entire task.

sthead
Specifies the header row for a simple table.
The <sthead> element is a container element inside the simple table.
The header row is optional in a simple table.
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strow
Identifies a row in a simple table>.
The <strow> element must contain at least one <stentry> element.

structbody
The <structbody> element is the main body-level element for a structure topic. The <structbody> 
element allows <structbody> and <required-cleanup> elements.

structsection
The <structsection> element represents an organizational division in a topic. Sections are used to 
organize subsets of information that are directly related to the structure. Multiple sections within a 
single topic do not represent a hierarchy, but rather peer divisions of that topic. Sections cannot be 
nested and may have an optional title.

structure
Use the structure topic type to describe the components of a container of some kind, such as a 
product interface or a hardware component. For a user interface, this can include application fields 
and icons, report fields, etc. For hardware components, this can include a list of components of a 
server or an image followed by a description of the image contents.
When creating a new structure topic, use the Structure tag template.

sub
Indicates that the text must be subscripted, or placed lower in relationship to the surrounding text.
The <sub> element determines the appearance of the text in the output.

subsection
Use this element to create run-in headings, where the text of the paragraph immediately follows 
the title and the entire contents is contained with the <subsection> element. <subsection> should 
only be used for single paragraphs.
The difference between <section> and <subsection> is related to the scale of the content. You 
should use <section> when you need to break the topic into parallel groups of content, basically 
creating a level of hierarchy in the topic. Use <subsection> when you have a group or list of items 
that with titles that don’t require breaking the topic into major groupings or creating another level of 
hierarchy.
Never add additional paragraphs after the subsection element that you intend for the sstitle to 
be grouped under. The subsection element is intended only for use as a run-in heading, and no 
additional structure or paragraphs should be added.

substep
Indicates an action that is part of a step.
The <substep> element has the same structure as a <step>. However, you cannot include lists 
of choices or substeps within a <substep> element. This restriction prevents unlimited nesting of 
steps.
You must contain a <substep> element inside a <substeps> element.
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substeps
Breaks a step down into a series of separate actions.
Only use the <substeps> element after you have tried to describe the steps of a task in a single 
level of steps. If you need to use more than one level of substep nesting, rewrite and simplify the 
task.
The <substeps> section of a task must contain one or more <substep> elements.

sup
Indicates that the text must be superscripted, or placed higher in relationship to the surrounding 
text.
The <sup> element determines the appearance of the text in the output.

systemoutput
Identifies computer output or responses to a command or situation. This is typically intended for 
messages that come out from scripts or a command line, such as the Windows command line.
Do not use the <systemoutput> element for messages generated by an application, use the 
<msgph> element instead.
In the output, all text you enter in the <systemoutput> element is displayed in a monospaced font.

T
table
Presents tabular information in a standard table markup.
The <table> element column or row spanning and table captions or descriptions. Use the optional 
<desc> element inside the table element to add a description of the table to be included when you 
conref the <table> element.
Use the <simpletable> element for tables that do not require complex presentation, such as 
spanning.
Avoid decision tables, which are also known as “if-then” tables. The format of a decision table is to 
use the table headings to begin and complete a “sentence.” Many languages do not support this 
sentence-like structure. Use <choicetable> for these types of tables instead.
Do not include tables within the paragraph element for the preceding paragraph. Make sure that 
you insert any tables after the closing tag.

task
Provides the top-level element for a task topic that answers the question of "how to?" All task 
topics must include the <task> element.
Task topics typically provide step-by-step instructions that enable a user to perform a task. A task 
must tell the user precisely what to do and specify the order in which to perform the steps.
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taskbody
Provides the main body-level element for a Task topic.
The <taskbody> element must include steps.

tbody
Contain the rows in a table.
The <tbody> element must include one or more <row> elements.

tgroup
Contains column, row, spanning, and the body elements of a table.
The <tgroup> element must include a <tbody> element.

thead
Defines the heading row in a complex table.
The <thead> element must precede the <tbody> element.

tip
As defined in the Avaya Style Guide, use the <tip> element to provide information that helps users 
apply the techniques and the procedures that are described in the text. Information in a tip can 
include keyboard shortcuts, or alternative methods that might not be obvious. You also can use 
tips to help users better understand certain benefits and capabilities of the product.

title
Provides a heading or label for the main parts of a topic, a topic itself, or a table or figure.
Use sentence capitalization for topic titles.

tm
The trademark (<tm>) element in DITA is used to markup and identify a term or phrase that 
is trademarked. Trademarks include registered trademarks, service marks, slogans and logos. 
When you insert a trademark, the Modify Attributes dialog box displays so that you can select the 
trademark type.

topicgroup
Creates groups of <topicref> elements.
The <topicgroup> element does not affect or imply a structural hierarchy of <topicref> elements. 
The <topicgroup> element is typically used outside a hierarchy or within a relationship table to 
identify groups for linking without any impact on the table of contents or the navigation output.

Tip:
To imply a structural hierarchy, nest <topicref> elements within a <topicref>.

topichead
Provides a title-only entry in a navigation map.
Use the <topichead> element as an alternative to the fully-linked title provided by the <topicref> 
element.
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U
uicontrol
Indicates the names of elements in a user interface.
For example, use the <uicontrol> element to identify buttons, entry fields, menu items, or other 
objects that allow the user to control the interface. The <uicontrol> element is also used inside 
the <menucascade> element to identify a sequence of menu choices in a nested menu, such as 
File > New.
In the output, all text you enter in the <uicontrol> element is displayed in bold text.

ul
Provides an unordered list. Items in an unordered list are bulleted. The sequence or order of 
importance of an unordered list is not significant.
The <ul> element must contain one or more <li> elements.
Do not include lists within the paragraph element for the preceding paragraph. Make sure that you 
insert any unordered lists after the closing tag.

userinput
Indicates the text a user must input or keys the user must press. For example, use the 
<userinput> element to identify user-entered text in a UI or a command-line interface. This 
includes when you are specifying a range of entries.
In the output, all text you enter in the <userinput> element is displayed in a monospaced font.
Tag any code that you are presenting as an example and are not instructing the user to enter with 
the <codeblock> or <codeph> element instead of <userinput>.

V
varname
Identifies a variable in the text.
The variable is text that will be different, depending upon something that cannot always be 
predicted in the documentation, such as a system configuration. For example, use the <varname> 
element to identify a variable in a user input command.
In the output, all text you enter in the <varname> element is displayed in italics.

version
You can use the <version> element to tag the number of the version. This element can be useful 
for reuse so that you can easily change the version number used in topics. Only include the 
number in the element; do not include any text such as the words “version” or “release”.

U
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voice-prompt
Use the <voice-prompt> element to indicate audio prompts voiced by a system, such as 
messages voiced by a messaging system's telephone user interface.

voltage
use the <voltage> element to warn of situations in which a high voltage can cause physical injury 
and/or damage equipment.

vrm
The vrm empty element contains information about a single product's version, modification, and 
release, to which the current topic applies.

vrmlist
The <vrmlist> element contains a set of <vrm> elements for indicating the version, release, and 
modification information for multiple products or versions of products to which the topic applies.

W
warning
As defined in the Avaya Style Guide, use the <warning> element to call attention to a situation that 
can result in harm to hardware or equipment.

wintitle
Identifies the names of windows, dialog boxes, or other static titles on a page.
For example, you can use the <wintitle> element to identify wizard titles, wizard page titles, 
section titles on a page, and window pane titles.

X
xref
Creates a link to a different location.
The href attribute in the <xref> element provides the location of the target.
You can use the <xref> element to create a link to:

• A different topic within the same deliverable.
• An external source such as a web page.
• A different location within a topic.
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Note:
Referencing a location within the same topic might create circular references. When 
circular references in a publication reach a threshold, the publication might fail to open. 
Therefore, avoid adding links to content within a topic.

Use relationship tables to create relationship between topics in a document. Use the <xref> 
element only when necessary. See Cross-reference links in topic on page 170 for guidance about 
when to use an xref.

Elements that are not used
This is an evolving list, visit this section for latest additions to the element list.
The following list contain elements you might see in Oxygen XML Author that we do not use:

• b
• i
• indextermref
• sl and sli
• synonym
• version

Elements that are not used
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Appendix C: Creating SVG images using 
Inkscape

Creating SVG images using Inkscape

Introduction
Scalable Vector Graphics (SVG) is an XML-based image format.

• SVG images have higher resolution than png and gif images. Therefore, have high image 
quality.

• SVG is XML-based, therefore, you can extract and translate the text from an SVG image.

Inkscape is an open-source SVG tool similar to Adobe Illustrator or CorelDraw. Inkscape is 
available to download and use at no cost and produces clean SVG files.

Use Inkscape as the image tool to create and edit SVG images.

Using Inkscape, you can create images and save them as .svg. When you produce a PDF 
output, the SVG image will be included. When you produce an HTML output, the SVG image will 
be automatically converted to a png image if the browser does not support SVG.

Example
For more information about features such as layers and groups, see the resources available from 
the Help menu in Inkscape, such as a Tutorial, User Guide, and FAQ

Note:
When you preview topics in Editor or Publication Manager, if the SVG images does not display 
or displays a small box with a red x instead, ensure that the image is correct in the output. 
Otherwise, fix the issue.

Using Inkscape you can create images and save them as .svg.

• When you produce a PDF output, the output includes the SVG image.
• When you produce an HTML output, the SVG image will be automatically converted to a png 

image if the browser does not support SVG.

The Inkscape interface
The Inkscape interface provides a drawing area and a collection of toolbars, palettes, and guides 
to help you create illustrations.
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Menus

Commands Bar Rulers, Guides, and Grids

Toolbox

Canvas

Color 
Palette

Snap Controls Bar Controls Bar

The following section list the functions of the main tools in Inkscape.

Name Description
Menus Provides access to all of the functionality available 

in the tool. The options available from the toolbars 
and toolboxes is also available from the main 
menus.

Commands Bar Contains shortcuts to commands otherwise 
accessible from the menus or shortcut keys. It 
also provides other controls for manipulating the 
document and drawing objects.

Table continues…
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Name Description
Snap Controls Bar Lets you easily align items (snap to guides), force 

objects to align to paths (snap to paths), or snap to 
bounding boxes and edges.

Rulers, Guides, and Grids Guides along the topic and left side of the interface 
to help you size illustrations.

Tool Controls Bar Selecting a tool in the Toolbox changes the Tool 
Controls Bar to show the options associated with 
that tool. Depending on context, some of these 
options affect a selected object while some take 
effect only when drawing a new object; others can 
affect either existing or new objects.

Canvas The drawing area. It can be extended outside the 
viewable area and can be panned (scrolled left/right 
and up/down) and zoomed.

Toolbox Main editing controls that contains the basic set of 
drawing utilities, including those for creating and 
editing shapes.

Color Palette Controls fill and stroke color options . Colors can 
be dragged from the palette onto objects to change 
their Fill. Using the Shift key while dragging will 
change the Stroke color instead. The color used by 
some tools can be set by clicking on a color swatch.

The Inkscape toolbar
The Inkscape Tools or Controls bar is the main editing tool. It contains the set of tools for drawing 
and editing objects.

Icon Name Function
Selector Selects objects with the mouse.

Node tool Edits individual nodes of an object to 
resize, morph the object.

Sculpt or tweak tool Changes the shape or style of only those 
objects (or parts thereof) that the tweak 
brush touches.

Zoom tool Zooms in, out, and fit the drawing in the 
viewable area of the canvas.

Rectangle tool Creates four-sided polygons. Use 
Ctrl+drag to draw squares.

3D box tool Draws 3D objects.

Table continues…
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Icon Name Function
Ellipse tool Creates polygons with infinite number of 

sides .

Ctrl+drag to draw perfect circles.

Star/Polygon tool Draws stars and other multi sided 
polygons.

Spiral tool Creates spirals.

Pencil tool Draws lines both straight and freehand.

Bezier or pen tool Draws lines.

Calligraphy tool Draws calligraphic characters.

Paint bucket tool Edits or fills an object color.

Text tool Creates text objects from keyboard input.

Connector tool Draws lines connecting two or more 
objects.

Gradient tool Adds and edits linear and radial color 
gradients of an object.

Eye dropper tool Edits or fills the color of the object.

Downloading and installing Inkscape
Procedure

1. In your Web browser, go to: https://inkscape.org/en/download/windows/

2. Go down to Previous version (0.48.5) and click installer.
3. When you are prompted if you want to run or save the file, click Save.

4. When the file finishes downloading, run the executable file and choose the default 
prompts.

Using Inkscape
Creating a new vector image in Inkscape

About this task
Some sample Inkscape graphics are available in Tridion Docs under Samples/SVG Library. 
You can use these examples as a starting point for images that you create by duplicating the 
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image or using the Check Out With option to open the drawing in Inkscape, then save it locally 
as a new file, and undo your checkout. After you modify the drawing, you can then import it into 
Tridion Docs.

Procedure
1. Open an Inkscape window or, if Inkscape is already open, select File > New > Default.

The system opens a new file.

2. To change the document size, click File > Document Properties.

3. Set Page orientation, Page size, or create a custom size by setting the Width and Height 
in the Custom size section.

4. To remove white space around the image:

a. Select the elements in the image (you can select Edit > Select All.
b. In the Document Properties, expand Resize page to content.
c. To leave a margin around the selection, use the margin fields.

d. Click Resize page to drawing or selection.

5. To change the units of measure in the file, change the default units under General.

6. When you finish working on the file:

a. Select File > Save.

The Save dialog displays.

b. In File name, type a name.

c. Leave the Save as type field as Inkscape SVG (*.svg).

Important:

Do not save graphics as Compressed Inkscape SVG (*.svgz) or Compressed 
Plain SVG (*.svg). Our environment does not support compressed formats.

d. Click Save.

Related links
Importing images on page 259

Drawing shapes
Like other drawing programs, Inkscape offers creation of basic shapes, such as ellipses, 
rectangles, stars, polygons, and spirals, as well as the ability to transform and manipulate these 
basic shapes by rotation, stretching, and skewing.

Procedure
1. Click on the shape in the left tool pane, drag it to the canvas, and drop it.

2. Click the selector tool , select the shape, and resize using the arrows.
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3. To change the appearance of the shape, select Object > Fill and Stroke ) to open the Fill 
and Stroke panel.

• Use the Fill tab to select a solid color, a linear or radial gradient, or no color.

• Use the Stroke paint tab to change the color of the outline of the shape or click X to 
choose to not have an outline.

• Use the Stroke style tab to change the appearance of the line to 1.5 px, which is our 
standard line width.

4. To close the Fill and Stroke panel, click the X in the upper-right corner of the panel.

Drawing a diamond shape
About this task
Diamond shapes are common used in flow diagrams, and can be easily created in Inkscape 
starting with a standard rectangle.

Procedure
1. Select the rectangle tool.

2. Hold down the Ctrl key and drag to create a square.

Holding down the Ctrl key while creating the shape forces it to a square.

3. To convert a square to a triangle, select the Selector tool, then click the square twice to 
get the rounded arrows, and rotate while holding down the Ctrl key.
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Drawing lines
Procedure

1. Select the Bezier tool .

2. Click (not drag) on the canvas where you want the start of the line and then click again 
where you want the next point of the line.

3. To end the line, press Enter.

4. To change the line style:

a. Select Object > Fill and Stroke to open the Fill and Stroke panel.

b. Click the Stroke Style tab.

c. Set the Width to 1.00 px.

d. Modify the other fields as appropriate.

e. To close the Fill and Stroke panel, click the X in the upper-right corner of the panel.

Related links
Drawing arrows on page 370

Drawing arrows
To draw arrows in Inkscape, you first draw a line and then you attach the arrowheads to the ends 
of the line appropriately. If you want to manipulate the line and arrows together, you can group the 
line and arrowheads into one object.
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Procedure
1. Draw a line.

2. Click the Selector tool and select the line.

3. Select Object > Fill and Stroke to open the Fill and Stroke panel.

4. Click the Stroke Style tab.

5. Set the Start Markers to TriangleInL and set the End Markers to TriangleOutL.

If you don’t want to add an arrow to one end of the line, leave that field set to None.

6. To close the Fill and Stroke panel, click the X in the upper-right corner of the panel.

Related links
Drawing lines on page 370

Embedding text in an object
Inkscape treats text as an object and thus, a text object has attributes that can be set in Inkscape. 
Therefore, you can extract and replace the text object appropriately during translation.

Important:

Leave sufficient space in your objects for text expansion during translation. You must leave 
space for at least 20% text expansion, even if the illustration isn’t initially going to be 
translated.
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Before you begin
Create the object in which you want to embed the text. For example, create a rectangle with the 
necessary properties into which you will write the text.

Procedure

1. Click on the text tool .

2. Position cursor where you need the text to be and start typing.

Important:

Do not drag the text tool to create a text box. This creates what’s called “flowed text”, 
and this is not fully supported in SVG. If you do this, the text will not appear in the 
graphic in your output. Instead just position the cursor and start typing as stated in the 
step.

3. Allow enough space for expansion during translation:

a. Copy the text you entered and paste it into the shape (typically text won’t expand 
more than double during translation).

b. Increase the size of the object if necessary.

c. Remove the second instance of the text.

4. To set the text style and size:

a. Select Text > Text and Font.
b. On the Text and Font dialog, set the Font family to Arial, the Style to Normal, and 

the Font size to 14.

Note:

Arial 14 is the required size because it is the minimum size necessary for Asian 
characters to be readable in translated images. The way Inkscape renders text, a 
font size 14 actually looks like Arial 11 in other tools. When you set Arial as the 
font style and set the size to at least 14, select Set as Default on the Text and 
Font panel.

c. Click Apply and then Close.
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To change the color of the text, select Object > Fill and Stroke to open the Fill and 
Stroke panel, change the settings, and click Apply and then Close.

5. To center the text in the object, do the following:

a. Select the text object.

b. Press the Shift key and select the object in which you want to align the text.

c. Select Object > Align and Distribute.

d. In the Align and Distribute menu, under Align, select Last Selected in the Relative to 
field.

e. Click Center on Vertical axis (icon is third from the left in the first row)

f. Click Center on Horizontal axis (icon is third from the left in the second row).

Example
The figure shows the Align and Distribute menu values for centering the text:

Creating SVG images using Inkscape

July 2024 DITA and TDocs Work Instructions and Guidelines 373
Comments on this document? 

374

https://onecare.avaya.com/customercare/en/documentation/feedback?formId=1399859460448&p1=S3&p2=DITAandTDocsWorkInstructionsandGuidelines&p3=6


Center on Vertical Axis

Center on Horizonal Axis

Altering the dimensions of an object
Procedure

1. Click the Selector tool  and select the object.

2. Use one of the following methods to modify the object’s size:

• Drag the handles on the object to increase or decrease its size.

• Use the X, Y, W, or H fields in the toolbar above the drawing area to modify the object’s 
size.

3. To skew an object.

a. Click on the object twice to change the handles.

b. Drag the handles to rotate and skew the object.

Importing graphics into Inkscape
Inkscape imports non-native files as flattened graphic files, so you can't edit anything within the 
graphic.

Important:

A non-SVG graphic that you import has lower resolution compared to the SVG graphic 
created in Inkscape, and the Localization team cannot extract text from non-SVG graphics for 
translation. Therefore, to build a drawing, import only non-SVG graphics that do not contain 
text and components.

Procedure
1. Open or create a file in Inkscape.

2. Navigate to File > Import.
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3. The Select file to import menu pops up.

4. Navigate to the graphics file to import.

5. Click Open.

A pop-up menu displays prompting you to select embed or link.

6. Select Embed and click OK.

The selected graphic displays in the Inkscape file.

7. Reposition the imported graphic to ensure it is contained within the work area.

Inkscape ignores parts that do not lie within the work area.

Menu shortcut keys
Shortcut keys for file manipulation
Shortcut key Task
Ctrl+N Create a new document
Ctrl+O Open an SVG document
Shift+Ctrl+E Export to PNG
Ctrl+I Import bitmap or SVG
Ctrl+P Print document
Ctrl+S Save document
Shift+Ctrl+S Save under a new name
Shift+Ctrl+Alt+S Save a copy
Ctrl+Q Exit Inkscape

Shortcut keys to open dialogs
Shortcut key Dialog
Shift+Ctrl+F Fill and Stroke
Shift+Ctrl+W Swatches
Shift+Ctrl+T Text and Font
Shift+Ctrl+M Transform
Shift+Ctrl+L Layers
Shift+Ctrl+A Align and Distribute
Shift+Ctrl+O Object Properties
Shift+Ctrl+H Undo History
Shift+Ctrl+X XML Editor
Shift+Ctrl+D Document Preferences
Shift+Ctrl+P Inkscape Preferences

Table continues…
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Shortcut key Dialog
Shift+Ctrl+E Export to PNG
Ctrl+F Find
Shift+Alt+B Trace Bitmap
Shift+Ctrl+7 Path Effects

Checklist for delivering SVG graphics to Localization
If you are delivering SVG graphics to Localization for translation, it’s very important that you 
validate the following steps. Failure to do so can cause issues with translation.

No. Task

1 Ensure that only Arial font is used in the graphic for all textboxes.
2. Ensure that the vector graphics containing lines and curves does not include any text. 

The translation tool does not process as text for localization.

Texts should never be in vector graphics consisting of lines and curves, otherwise it can’t 
be processed as a text for localization.

3. Validate that the Enable translation management box is checked in the graphics’s 
properties.

4. Create image directly in Inkscape or other image editor unless it’s a picture that you 
must copy and paste into the SVG drawing. If you have objects that you can create in 
Inkscape that have been copied into the drawing, re-create the objects in Inkscape.

Note:

Resolution of the bitmap objects that you copy into Inkscape have lower than the 
native SVG drawings.

And the text copied into an Inkscape drawing from another source cannot be 
translated.

5 For long sentence, the text is rendered as a single line because SVG 1.1 does not 
provide text wrapping. Therefore, break the content by separating text into multiple 
lines within the same textbox during SVG design stage. Do not split the text label into 
separate text boxes. Use the Enter key to break the text into multiple lines.

6 To support text expansion in other languages, use proper text justification in textbox and 
decide the textbox location that can handle text expansion up to 2.5 times the English 
text.

7 Ensure that the text flow or alignment does not interfere with the image or other text.

If the text expands after translation in some languages, the text alignment and the 
textbox position ensure the overall aesthetic of the image..
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Glossary

baseline A baseline lists the specific versions of the topics, graphics, and variable 
libraries that are used in a publication. This baseline is saved for future 
use, so that it is always possible to know which version of an object was 
used for the publication. A publication always contains one baseline.

GUID Globally unique identifier. Tridion Docs assigns each object a unique 
ID, called a globally unique identifier, and uses GUID for addressing 
and linking. Because Tridion Docs uses GUID instead of a file name or 
location, you can freely move or rename objects or folders to different 
locations without breaking links or references.

publication Object that manages how a deliverable is generated. Publications provide 
the context for how DITA content in the repository is assembled for 
output. For example, the publication controls the version of topics, maps, 
and graphics that are included in the deliverable (by means of the 
baseline), the conditions that are included or excluded, and the output 
format.
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[DOTJ013E] Failed to parse the referenced file ................ 303
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changes in topics ..........................................................97
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graphics ...................................................................... 255
guidelines ..................................................................... 80
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accessibility check ............................................................. 141
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conditions to elements ................................................204

adding common legal topic .................................................. 57
adding metadata

Zoomin ........................................................................156
adding navigation title .................................................... 51, 52
adding videos .....................................................................162
adding videos in a topic ..................................................... 164
adding YouTube videos in a topic ...................................... 164
aggregated topics .......................................................... 68, 69
alarm topics, creating ...........................................................77
appendix, adding to a bookmap ...........................................62
application name reuse ......................................................196
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arrows, drawing ................................................................. 370
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format ......................................................................... 180

attributes
linking ......................................................................... 172
modifying ...................................................................... 84

author
adding to bookmeta ...................................................... 66

authoring principles ..............................................................13
Autocomplete .....................................................................223
Avaya Documentation Center

preparing content ................................................153, 160
publishing output ................................................ 153, 160

B
backup schedule ................................................................280
banding

suppressing color banding in tables ............................112
baseline

checking for newer object versions .................... 226, 238
clean up ...................................................................... 229
cleaning up ................................................................. 223
creating new versions of multiple released topics ...... 242
freeze fails .................................................................. 294
freezing ...............................................................223, 227
information provided ................................................... 224
report .......................................................................... 228
selecting object versions ............................................ 226

benefits, reuse ................................................................... 185
best practice

branching ....................................................................236
blank table cells in output .................................................. 295
bookmap .............................................................................. 44
bookmaps

about .............................................................................53
adding appendix ........................................................... 62
adding chapter ..............................................................60
adding elements ........................................................... 55
adding glossary ............................................................ 62
editing for Eclipse Help .................................................62
guidelines ..................................................................... 62
inserting line breaks into the mainbooktitle ...................59
modifying ...................................................................... 55
overview ....................................................................... 43

bookmeta
adding the book author .................................................66

branches
about ...........................................................................231
creating new ....................................................... 239–241
deleting an unused branch of a publication ................ 244
deleting an unused branch of a topic, map, or 

graphic .................................................................244
when to create .................................................... 233, 234

Branching best practice ..................................................... 236
breadcrumbs ......................................................................134

disabling ..................................................................... 134
enabling ...................................................................... 134
specifying a unique filename for topics .......................135

browsing repository from Editor ........................................... 22
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C
capturing

data on SDL connection issue ....................................286
metrics using the Dashboard ......................................323

capturing logs for troubleshooting ......................................285
centering text in an object ..................................................371
change

elements ....................................................................... 84
markup ..........................................................................84
tags ...............................................................................84

change folder properties ...................................................... 99
change in bulk

author ......................................................................... 101
change description ..................................................... 101
Localization coordinator ..............................................101
product ........................................................................101
product family ............................................................. 101
reviewer ...................................................................... 101
status .......................................................................... 101

change markup .................................................................... 84
change tracking ................................................................... 96

accepting or rejecting changes .....................................97
disabling in a topic ........................................................ 96
enabling in a topic .........................................................96

changing
Author names for more than one topic ....................... 101
email address in comments link ................................. 147
font size in Editor .......................................................... 75
HTML output extension .............................................. 145
metadata for more than one topic ...............................101
product family for more than one topic ....................... 101
product for more than one topic ..................................101
reviewer for more than one topic ................................ 101

chapters
adding to bookmap ....................................................... 60
grouping under parts .................................................... 60

check out to local drive ...................................................... 275
checking in

map ...............................................................................64
topic .............................................................................. 77
topic in local storage ...................................................279

checking out
different version of map .............................................. 243
different version of publication or topic ....................... 243
map ...............................................................................63
topic from publication ....................................................74
topic from repository ............................................... 74, 75

checking publishing logs ....................................................136
checklist

authoring topics .......................................................... 325
creating content .......................................................... 325
forcing to start on new page ......................................... 95
localization ..................................................................332
new publication ...........................................................326
releasing a publication ................................................329

checklist for delivering SVG to Localization .......................376

checklists ........................................................................... 325
chunk content ...................................................................... 68
chunk to-content .................................................................. 69
chunking .............................................................................. 68

limitation ....................................................................... 68
circular references ............................................................. 288
Clean Up ............................................................................229
code sample copying into a codeblock ................................ 89
code, tagging samples .........................................................86
codeblock, scaling ............................................................... 90
colors

changing color scheme for frameset HTML output .....149
changing color scheme for HTML5 outputs ................149

Command Reference ...........................................................18
comments link

removing from footer .................................................. 147
comments link, changing the email address ......................147
common legal topic

adding to publication .....................................................57
common topics ...................................................................186
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publication versions in the web interface ....................250
topic revisions .............................................................249
topic versions in Publication Manager ........................ 245
topic versions in repository ......................................... 247

completeness check ............................................................ 91
complex tables

align cells ....................................................................104
creating .......................................................................104
join .............................................................................. 104
merge ......................................................................... 104
modifying .................................................................... 108

concept topics ......................................................................16
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conditional content .............................................................201
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applying to elements in topics .................................... 204
applying to table columns ........................................... 206
applying to table rows .................................................206
applying to topics or maps ..........................................207
previewing .................................................................. 209
removing from Conditions tab .....................................208
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removing from topics in map ...................................... 208
selecting in a publication ............................................ 210
viewing for a publication ............................................. 209
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